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Using This Manual
This preface is divided into the following sections:

1.What’s In This Manual
2.The Contents of the Fluent Manuals
3.Where to Find the Files Used in the Tutorials
4. How To Use This Manual
5.Typographical Conventions Used In This Manual

1. What’s In This Manual

The ANSYS Fluent Tutorial Guide contains a number of tutorials that teach you how to use ANSYS Flu-
ent to solve different types of problems. In each tutorial, features related to problem setup and postpro-
cessing are demonstrated.

The tutorials are written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent navigation pane and ribbon structure. Some steps in
the setup and solution procedure will not be shown explicitly.

Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

All of the tutorials include some postprocessing instructions, but Postprocessing (p. 879) is devoted entirely
to postprocessing.

2. The Contents of the Fluent Manuals

The manuals listed below form the Fluent product documentation set. They include descriptions of the
procedures, commands, and theoretical details needed to use Fluent products. These manuals are all
available on the ANSYS Customer Portal (http://support.ansys.com/documentation).

• Fluent Getting Started Guide contains general information about getting started with using
Fluent and provides details about starting, running, and exiting the program.

• Fluent Migration Manual contains information about transitioning from the previous release of Fluent,
including details about new features, solution changes, and text command list changes.

• Fluent User's Guide contains detailed information about running a simulation using the solution
mode of Fluent, including information about the user interface, reading and writing files, defining
boundary conditions, setting up physical models, calculating a solution, and analyzing your results.

• Fluent Meshing User's Guide contains detailed information about creating 3D meshes using the
meshing mode of Fluent.

xiii
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

http://support.ansys.com/documentation


• Fluent in Workbench User's Guide contains information about getting started with and using Fluent
within the Workbench environment.

• Fluent Theory Guide contains reference information for how the physical models are implemented in
Fluent.

• Fluent Customization Manual contains information about writing and using user-defined functions
(UDFs).

• Fluent Tutorial Guide contains a number of examples of various flow problems with detailed instructions,
commentary, and postprocessing of results.

Tutorials for release 18.0 are available on the ANSYS Customer Portal. To access tutorials and
their input files on the ANSYS Customer Portal, go to http://support.ansys.com/training.

• ANSYS Fluent Meshing Tutorial Guide contains a number of examples of general mesh-generation
techniques used in ANSYS Fluent Meshing.

Tutorials for release 18.0 are available on the ANSYS Customer Portal. To access tutorials and
their input files on the ANSYS Customer Portal, go to http://support.ansys.com/training.

• Fluent Text Command List contains a brief description of each of the commands in Fluent’s solution
mode text interface.

• Fluent Meshing Text Command List contains a brief description of each of the commands in Fluent’s
meshing mode text interface.

• Fluent Advanced Add-On Modules contains information about the usage of the different advanced
Fluent add-on modules, which are applicable for specific modeling needs.

– Part I: ANSYS Fluent Adjoint Solver contains information about the background and usage of Fluent's
Adjoint Solver Module that allows you to obtain detailed sensitivity data for the performance of a
fluid system.

– Part II: ANSYS Fluent Battery Module contains information about the background and usage of Fluent's
Battery Module that allows you to analyze the behavior of electric batteries.

– Part III: ANSYS Fluent Continuous Fiber Module contains information about the background and usage
of Fluent's Continuous Fiber Module that allows you to analyze the behavior of fiber flow, fiber
properties, and coupling between fibers and the surrounding fluid due to the strong interaction that
exists between the fibers and the surrounding gas.

– Part IV: ANSYS Fluent Fuel Cell Modules contains information about the background and the usage
of two separate add-on fuel cell models for Fluent that allow you to model polymer electrolyte
membrane fuel cells (PEMFC), solid oxide fuel cells (SOFC), and electrolysis with Fluent.

– Part V: ANSYS Fluent Magnetohydrodynamics (MHD) Module contains information about the back-
ground and usage of Fluent's Magnetohydrodynamics (MHD) Module that allows you to analyze the
behavior of electrically conducting fluid flow under the influence of constant (DC) or oscillating (AC)
electromagnetic fields.

– Part VI: ANSYS Fluent Population Balance Module contains information about the background and
usage of Fluent's Population Balance Module that allows you to analyze multiphase flows involving
size distributions where particle population (as well as momentum, mass, and energy) require a balance
equation.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.xiv

Using This Manual

http://support.ansys.com/training
http://support.ansys.com/training


• Fluent as a Server User's Guide contains information about the usage of Fluent as a Server which allows
you to connect to a Fluent session and issue commands from a remote client application.

• Running ANSYS Fluent Using a Load Manager contains information about using third-party load managers
with ANSYS Fluent.

– Part I: Running ANSYS Fluent Under LSF contains information about using Fluent with Platform
Computing’s LSF software, a distributed computing resource management tool.

– Part II: Running ANSYS Fluent Under PBS Professional contains information about using Fluent with
Altair PBS Professional, an open workload management tool for local and distributed environments.

– Part III: Running ANSYS Fluent Under SGE contains information about using Fluent with Univa Grid
Engine (formerly Sun Grid Engine) software, a distributed computing resource management tool.

3. Where to Find the Files Used in the Tutorials

Each of the tutorials uses an existing mesh file. (Tutorials for mesh generation are provided with the
mesh generator documentation.) You will find the appropriate mesh file (and any other relevant files
used in the tutorial) on the ANSYS Customer Portal. The “Preparation” step of each tutorial will tell you
where to find the necessary files. (Note that Tutorial Postprocessing (p. 879) use existing case and data
files.)

4. How To Use This Manual

Depending on your familiarity with computational fluid dynamics and the ANSYS Fluent software, you
can use this tutorial guide in a variety of ways.

4.1. For the Beginner

If you are a beginning user of ANSYS Fluent you should first read and solve Tutorial 1, in order to famil-
iarize yourself with the interface and with basic setup and solution procedures. You may then want to
try a tutorial that demonstrates features that you are going to use in your application. For example, if
you are planning to solve a problem using the non-premixed combustion model, you should look at
Using the Non-Premixed Combustion Model (p. 583).

You may want to refer to other tutorials for instructions on using specific features, such as custom field
functions, mesh scaling, and so on, even if the problem solved in the tutorial is not of particular interest
to you. To learn about postprocessing, you can look at Postprocessing (p. 879), which is devoted entirely
to postprocessing (although the other tutorials all contain some postprocessing as well).

4.2. For the Experienced User

If you are an experienced ANSYS Fluent user, you can read and/or solve the tutorial(s) that demonstrate
features that you are going to use in your application. For example, if you are planning to solve a
problem using the non-premixed combustion model, you should look at Using the Non-Premixed
Combustion Model (p. 583).

You may want to refer to other tutorials for instructions on using specific features, such as custom field
functions, mesh scaling, and so on, even if the problem solved in the tutorial is not of particular interest
to you. To learn about postprocessing, you can look at Postprocessing (p. 879), which is devoted entirely
to postprocessing (although the other tutorials all contain some postprocessing as well).
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5. Typographical Conventions Used In This Manual

Several typographical conventions are used in this manual’s text to help you find commands in the
user interface.

• Different type styles are used to indicate graphical user interface items and text interface items. For example:

Iso-Surface dialog box
surface/iso-surface text command

• The text interface type style is also used when illustrating exactly what appears on the screen to distinguish
it from the narrative text. In this context, user inputs are typically shown in boldface. For example,

solve/initialize/set-fmg-initialization

 Customize your FMG initialization:
   set the number of multigrid levels [5]

   set FMG parameters on levels ..

    residual reduction on level 1 is:  [0.001]
    number of cycles on level 1 is:  [10]  100

    residual reduction on level 2 is:  [0.001]
    number of cycles on level 2 is:  [50]  100

• Mini flow charts are used to guide you through the ribbon or the tree, leading you to a specific option, dialog
box, or task page. The following tables list the meaning of each symbol in the mini flow charts.

Table 1:  Mini Flow Chart Symbol Descriptions

Indicated ActionSymbol

Look at the ribbon

Look at the tree

Double-click to open task page

Select from task page

Right-click the preceding item

For example,

Setting Up Domain → Mesh → Transform → Translate...

indicates selecting the Setting Up Domain ribbon tab, clicking Transform (in the Mesh group box)
and selecting Translate..., as indicated in the figure below:

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.xvi

Using This Manual



And

Setup → Models → Viscous Model → Realizable k-epsilon

indicates expanding the Setup and Models branches, right-clicking Viscous, and selecting Realizable
k-epsilon from the Model sub-menu, as shown in the following figure:

And

Setup → Boundary Conditions → porous-in

indicates opening the task page as shown below:
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In this manual, mini flow charts usually accompany a description of a dialog box or command, or a
screen illustration showing how to use the dialog box or command. They show you how to quickly
access a command or dialog box without having to search the surrounding material.

• In-text references to File ribbon tab selections can be indicated using a “/”. For example File/Write/Case...
indicates clicking the File ribbon tab and selecting Case... from the Write submenu (which opens the Select
File dialog box).
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Chapter 1: Introduction to Using ANSYS Fluent in ANSYS Workbench:
Fluid Flow and Heat Transfer in a Mixing Elbow

This tutorial is divided into the following sections:
1.1. Introduction
1.2. Prerequisites
1.3. Problem Description
1.4. Setup and Solution
1.5. Summary

1.1. Introduction

This tutorial illustrates using ANSYS Fluent fluid flow systems in ANSYS Workbench to set up and solve
a three-dimensional turbulent fluid-flow and heat-transfer problem in a mixing elbow. It is designed to
introduce you to the ANSYS Workbench tool set using a simple geometry. Guided by the steps that
follow, you will create the elbow geometry and the corresponding computational mesh using the
geometry and meshing tools within ANSYS Workbench. You will use ANSYS Fluent to set up and solve
the CFD problem, then visualize the results in both ANSYS Fluent and in the CFD-Post postprocessing
tool. Some capabilities of ANSYS Workbench (for example, duplicating fluid flow systems, connecting
systems, and comparing multiple data sets) are also examined in this tutorial.

This tutorial demonstrates how to do the following:

• Launch ANSYS Workbench.

• Create a Fluent  fluid flow analysis system in ANSYS Workbench.

• Create the elbow geometry using ANSYS DesignModeler.

• Create the computational mesh for the geometry using ANSYS Meshing.

• Set up the CFD simulation in ANSYS Fluent, which includes:

– Setting material properties and boundary conditions for a turbulent forced-convection problem.

– Initiating the calculation with residual plotting.

– Calculating a solution using the pressure-based solver.

– Examining the flow and temperature fields using ANSYS Fluent and CFD-Post.

• Create a copy of the original Fluent fluid flow analysis system in ANSYS Workbench.

• Change the geometry in ANSYS DesignModeler, using the duplicated system.

• Regenerate the computational mesh.

• Recalculate a solution in ANSYS Fluent.

1
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• Compare the results of the two calculations in CFD-Post.

1.2. Prerequisites

This tutorial assumes that you have little to no experience with ANSYS Workbench, ANSYS DesignModeler,
ANSYS Meshing, ANSYS Fluent, or CFD-Post, and so each step will be explicitly described.

1.3. Problem Description

The problem to be considered is shown schematically in Figure 1.1: Problem Specification (p. 3). A
cold fluid at 293.15 K flows into the pipe through a large inlet and mixes with a warmer fluid at 313.15 K
that enters through a smaller inlet located at the elbow. The mixing elbow configuration is encountered
in piping systems in power plants and process industries. It is often important to predict the flow field
and temperature field in the area of the mixing region in order to properly design the junction.

Note

Because the geometry of the mixing elbow is symmetric, only half of the elbow must be
modeled.
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Figure 1.1:  Problem Specification

Note

The functionality to create named selections exists in both ANSYS DesignModeler and ANSYS
Meshing. For the purposes of this tutorial, named selections are created in ANSYS Meshing
since the meshing application provides more comprehensive and extensive named selection
functionality.

1.4. Setup and Solution

To help you quickly identify graphical user interface items at a glance and guide you through the steps
of setting up and running your simulation, the ANSYS Fluent Tutorial Guide uses several type styles and
mini flow charts. See Typographical Conventions Used In This Manual (p. xvi) for detailed information.

The following sections describe the setup and solution steps for this tutorial:
1.4.1. Preparation
1.4.2. Creating a Fluent Fluid Flow Analysis System in ANSYS Workbench
1.4.3. Creating the Geometry in ANSYS DesignModeler
1.4.4. Meshing the Geometry in the ANSYS Meshing Application
1.4.5. Setting Up the CFD Simulation in ANSYS Fluent
1.4.6. Solving
1.4.7. Displaying Results in ANSYS Fluent and CFD-Post
1.4.8. Duplicating the Fluent-Based Fluid Flow Analysis System
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1.4.9. Changing the Geometry in ANSYS DesignModeler
1.4.10. Updating the Mesh in the ANSYS Meshing Application
1.4.11. Calculating a New Solution in ANSYS Fluent
1.4.12. Comparing the Results of Both Systems in CFD-Post

1.4.1. Preparation

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the elbow-workbench_R180.zip link to download the input files.

7. Unzip elbow-workbench_R180.zip to your working folder. This file contains a folder,elbow-
workbench, that holds the following items:

• two geometry files,elbow_geometry.agdb and elbow_geometry.stp

• an ANSYS Workbench project archive,elbow-workbench.wbpz

Tip

The Workbench project archive contains the project as it will be once you have
completed all of the steps of the tutorial and is included for reference. If you want to
extract the project archive, start Workbench and select the File → Restore Archive...
menu item. You will be prompted with a dialog box to specify a location in which to
extract the project and its supporting files. You may choose any convenient location.

Note

ANSYS Fluent tutorials are prepared using ANSYS Fluent on a Windows system. The screen
shots and graphic images in the tutorials may be slightly different than the appearance on
your system, depending on the operating system or graphics card.
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1.4.2. Creating a Fluent Fluid Flow Analysis System in ANSYS Workbench

In this step, you will start ANSYS Workbench, create a new Fluent fluid flow analysis system, then review
the list of files generated by ANSYS Workbench.

1. From the Windows Start menu, select Start > All Programs > ANSYS 18.0 > Workbench 18.0 to start a
new ANSYS Workbench session.

This displays the ANSYS Workbench application window, which has the Toolbox on the left and the
Project Schematic to its right. Various supported applications are listed in the Toolbox and the
components of the analysis system will be displayed in the Project Schematic.

Note

Depending on which other products you have installed, the analysis systems that appear
may differ from those in the figures that follow in this tutorial.

2. Create a new Fluent fluid flow analysis system by double-clicking the Fluid Flow (Fluent) option under
Analysis Systems in the Toolbox.

Tip

You can also drag-and-drop the analysis system into the Project Schematic. A green
dotted outline indicating a potential location for the new system initially appears in the
Project Schematic. When you drag the system to one of the outlines, it turns into a red
box to indicate the chosen location of the new system.
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Figure 1.2:  Selecting the Fluid Flow (Fluent) Analysis System in ANSYS Workbench
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Figure 1.3:  ANSYS Workbench with a New Fluent-Based Fluid Flow Analysis System

3. Name the analysis.

a. Double-click the Fluid Flow (Fluent) label underneath the analysis system (if it is not already highlighted).

b. Enter elbow for the name of the analysis system.

4. Save the project.

a. In ANSYS Workbench, under the File menu, select Save.

File → Save

This displays the Save As dialog box, where you can browse to your working folder and enter
a specific name for the ANSYS Workbench project.

b. In your working directory, enter elbow-workbench as the project File name and click the Save
button to save the project. ANSYS Workbench saves the project with a .wbpj extension and also saves
supporting files for the project.

Note that the fluid flow analysis system is composed of various cells (Geometry, Mesh, etc.) that
represent the workflow for performing the analysis. ANSYS Workbench is composed of multiple
data-integrated and native applications in a single, seamless project flow, where individual cells
can obtain data from other cells and provide data to other cells. As a result of this constant flow
of data, a cell’s state can quickly change. ANSYS Workbench provides a visual indication of a
cell’s state at any given time via icons on the right side of each cell. Brief descriptions of the
various states are provided below:

• Unfulfilled ( ) indicates that required upstream data does not exist. For example, when you first
create a new Fluid Flow (Fluent) analysis system, all cells downstream of the Geometry cell appear
as Unfulfilled because you have not yet specified a geometry for the system.
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• Refresh Required ( ) indicates that upstream data has changed since the last refresh or update.
For example, after you assign a geometry to the geometry cell in your new Fluid Flow (Fluent)
analysis system, the Mesh cell appears as Refresh Required since the geometry data has not yet
been passed from the Geometry cell to the Mesh cell.

• Attention Required ( ) indicates that the current upstream data has been passed to the cell, however,
you must take some action to proceed. For example, after you launch ANSYS Fluent from the Setup
cell in a Fluid Flow (Fluent) analysis system that has a valid mesh, the Setup cell appears as Attention
Required because additional data must be entered in ANSYS Fluent before you can calculate a
solution.

• Update Required ( ) indicates that local data has changed and the output of the cell must be re-
generated. For example, after you launch ANSYS Meshing from the Mesh cell in a Fluid Flow (Fluent)
analysis system that has a valid geometry, the Mesh cell appears as Update Required because the
Mesh cell has all the data it must generate an ANSYS Fluent mesh file, but the ANSYS Fluent mesh
file has not yet been generated.

• Up To Date ( ) indicates that an update has been performed on the cell and no failures have occurred
or that an interactive calculation has been completed successfully. For example, after ANSYS Flu-
ent finishes performing the number of iterations that you request, the Solution cell appears as Up-
to-Date.

• Interrupted, Update Required ( ) indicates that you have interrupted an update (or canceled an
interactive calculation that is in progress). For example, if you select the Cancel button in ANSYS
Fluent while it is iterating, ANSYS Fluent completes the current iteration and then the Solution cell
appears as Interrupted, Update Required.

• Input Changes Pending ( ) indicates that the cell is locally up-to-date, but may change when
next updated as a result of changes made to upstream cells. For example, if you change the Mesh
in an Up-to-Date Fluid Flow (Fluent) analysis system, the Setup cell appears as Refresh Required,
and the Solution and Results cells appear as Input Changes Pending.

• Pending ( ) indicates that a batch or asynchronous solution is in progress. When a cell enters the
Pending state, you can interact with the project to exit Workbench or work with other parts of the
project. If you make changes to the project that are upstream of the updating cell, then the cell will
not be in an up-to-date state when the solution completes.

For more information about cell states, see the Workbench User's Guide.

5. View the list of files generated by ANSYS Workbench.

ANSYS Workbench allows you to easily view the files associated with your project using the Files
view. To open the Files view, select the Files option under the View menu at the top of the ANSYS
Workbench window.

View → Files
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Figure 1.4:  ANSYS Workbench Files View for the Project After Adding a Fluent-Based Fluid
Flow Analysis System

In the Files view, you will be able to see the name and type of file, the ID of the cell that the file is
associated with, the size of the file, the location of the file, and other information. For more inform-
ation about the Files view, see the Workbench User's Guide.

Note

The sizes of the files listed may differ slightly from those portrayed in Figure 1.4: ANSYS
Workbench Files View for the Project After Adding a Fluent-Based Fluid Flow Analysis
System (p. 9).

From here, you will create the geometry described in Figure 1.1: Problem Specification (p. 3), and
later create a mesh and set up a fluid flow analysis for the geometry.

1.4.3. Creating the Geometry in ANSYS DesignModeler

For the geometry of your fluid flow analysis, you can create a geometry in ANSYS DesignModeler, ANSYS
SpaceClaim Direct Modeler, or import the appropriate geometry file. In this step, you will create the
geometry in ANSYS DesignModeler, then review the list of files generated by ANSYS Workbench.

Important

Note the Attention Required icon ( ) within the Geometry cell for the system. This
indicates that the cell requires data (for example, a geometry). Once the geometry is
defined, the state of the cell will change accordingly. Likewise, the state of some of the
remaining cells in the system will change.

Note

If you would rather not create the geometry in ANSYS DesignModeler, you can import a pre-
existing geometry by right-clicking the Geometry cell and selecting the Import Geometry
option from the context menu. From there, you can browse your file system to locate the
elbow_geometry.agdb geometry file that is provided for this tutorial. If you do not have
access to ANSYS DesignModeler, you can use the elbow_geometry.stp file instead.

To learn how to create a mesh from the geometry you imported, go to Meshing the Geometry
in the ANSYS Meshing Application (p. 20).

1. Start ANSYS DesignModeler.
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In the ANSYS Workbench Project Schematic, right-click the Geometry cell in the elbow fluid flow
analysis system to display the context menu, then select New DesignModeler Geometry.... This
displays the ANSYS DesignModeler application.

2. Set the units in ANSYS DesignModeler.

When ANSYS DesignModeler first appears, you should select desired system of length units to work
from. For the purposes of this tutorial (where you will create the geometry in millimeters and perform
the CFD analysis using SI units) set the units to Millimeter.

Units → Millimeter

3. Create the geometry.

The geometry for this tutorial (Figure 1.1: Problem Specification (p. 3)) consists of a large curved
pipe accompanied by a smaller side pipe. ANSYS DesignModeler provides various geometry primitives
that can be combined to rapidly create geometries such as this one. You will perform the following
tasks to create the geometry:

• Create the bend in the main pipe by defining a segment of a torus.

• Extrude the faces of the torus segment to form the straight inlet and outlet lengths.

• Create the side pipe by adding a cylinder primitive.

• Use the symmetry tool to reduce the model to half of the pipe assembly, thus reducing computa-
tional cost.

a. Create the main pipe:

i. Create a new torus for the pipe bend by choosing the Create → Primitives → Torus menu item
from the menubar.

A preview of the torus geometry will appear in the graphics window. Note that this is a preview
and the geometry has not been created yet. First you must specify the parameters of the torus
primitive in the next step.

ii. In the Details View for the new torus (Torus1), set Base Y Component to -1 by clicking the 1 to
the right of FD10, Base Y Component, entering -1, and pressing Enter. This specifies the direction
vector from the origin to the center of the circular cross-section at the start of the torus. In the same
manner, specify Angle; Inner Radius; and Outer Radius as shown below.

Note

Enter only the value without the units of mm. They will be appended automatically
because you specified the units previously.
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iii. To create the torus segment, click the Generate button  that is located in the ANSYS
DesignModeler toolbar.
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The Torus1 item appears in the Tree Outline view. If you want to delete this item, you can
right-click it and select Delete from the context menu that opens.

iv. Ensure that the selection filter is set to Faces. This is indicated by the Faces button  appearing

depressed in the toolbar and the appearance of the Face selection cursor,  when you mouse
over the geometry.

v. Select the top face (in the positive Y direction) of the elbow and click the Extrude button 
from the 3D Features toolbar.

vi. In the Details View for the new extrusion (Extrude1), click Apply to the right of Geometry. This
accepts the face you selected as the base geometry of the extrusion.

vii. Click None (Normal) to the right of Direction Vector. Again, ensure that the selection filter is set
to Faces, select the same face on the elbow to specify that the extrusion will be normal to the face
and click Apply.
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viii.Enter 200 for FD1, Depth (>0) and click Generate.
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ix. In a similar manner, create an extrusion of the other face of the torus segment to create the 200
mm inlet extension. You will probably find it helpful to rotate the view so that you can easily select
the other face of the bend.

You can use the mouse buttons to change your view of the 3D image. The following table
describes mouse actions that are available:

Table 1.1:  DesignModeler View Manipulation Instructions

Using Graphics Toolbar Buttons and the MouseAction

After clicking the Rotate icon, , press and hold the left mouse button and
drag the mouse. Dragging side to side rotates the view about the vertical axis,
and dragging up and down rotates the view about the horizontal axis.

Rotate view
(vertical,
horizontal)

After clicking the Pan icon, , press and hold the left mouse button and
drag the object with the mouse until the view is satisfactory.

Translate or
pan view

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.14

Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat
Transfer in a Mixing Elbow



Using Graphics Toolbar Buttons and the MouseAction

After clicking the Zoom icon, , press and hold the left mouse button and
drag the mouse up and down to zoom in and out of the view.

Zoom in and
out of view

After clicking the Box Zoom icon, , press and hold the left mouse button
and drag the mouse diagonally across the screen. This action will cause a

Box zoom

rectangle to appear in the display. When you release the mouse button, a new
view will be displayed that consists entirely of the contents of the rectangle.

Clicking the Zoom to Fit icon, , will cause the object to fit exactly and be centered in
the window.

After entering the extrusion parameters and clicking Generate, the geometry should appear
as in Figure 1.5: Elbow Main Pipe Geometry (p. 16).

15
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 1.5:  Elbow Main Pipe Geometry

b. Next you will use a cylinder primitive to create the side pipe.

i. Choose Create → Primitives → Cylinder from the menubar.

ii. In the Details View, set the parameters for the cylinder as follows and click Generate:

ValueSetting

XYPlaneBasePlane

137.5FD3, Origin X Coordinate

-225FD4, Origin Y Coordinate

0FD5, Origin Z Coordinate

0FD6, Axis X Component

125FD7, Axis Y Component
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ValueSetting

0FD8, Axis Z Component

12.5FD10, Radius (>0)

The Origin Coordinates determine the starting point for the cylinder and the Axis Components determine
the length and orientation of the cylinder body.

c. The final step in creating the geometry is to split the body on its symmetry plane which will halve the
computational domain.

i. Choose Tools → Symmetry from the menu bar.

ii. Select the XYPlane in the Tree Outline.

iii. Click Apply next to Symmetry Plane 1 in the Details view.
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iv. Click Generate.

The new surface created with this operation will be assigned a symmetry boundary condition
in Fluent so that the model will accurately reflect the physics of the complete elbow geometry
even though only half of it is meshed.

d. Specify the geometry as a fluid body.

i. In the Tree Outline, open the 1 Part, 1 Body branch and select Solid.

ii. In the Details View of the body, change the name of the Body from Solid to Fluid.

iii. In the Fluid/Solid section, select Fluid from the drop-down list.
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iv. Click Generate.

Tip

In addition to the primitives you used in this tutorial, ANSYS DesignModeler offers a full
suite of 2D sketching and 3D solid modeling tools for creating arbitrary geometry. Refer
to the DesignModeler User's Guide for more information.

4. Close ANSYS DesignModeler by selecting File → Close DesignModeler or by clicking the ‘X’ icon in the
upper right-hand corner. ANSYS Workbench automatically saves the geometry and updates the Project
Schematic accordingly. The question mark in the Geometry cell is replaced by a check mark, indicating
that there is a geometry now associated with the fluid flow analysis system.

5. View the list of files generated by ANSYS Workbench by selecting View → Files.

Figure 1.6:  ANSYS Workbench Files View for the Project After Creating the Geometry

Note the addition of the geometry file (FFF.agdb, where FFF indicates a Fluent-based fluid flow
system) to the list of files. If you had imported the geometry file provided for this tutorial rather
than creating the geometry yourself, the elbow_geometry.agdb (or the elbow_geometry.stp)
file would be listed instead.
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1.4.4. Meshing the Geometry in the ANSYS Meshing Application

Now that you have created the mixing elbow geometry, you must generate a computational mesh
throughout the flow volume. For this section of the tutorial, you will use the ANSYS Meshing application
to create a mesh for your CFD analysis, then review the list of files generated by ANSYS Workbench.

Important

Note the Refresh Required icon ( ) within the Mesh cell for the system. This indicates
that the state of the cell requires a refresh and that upstream data has changed since
the last refresh or update (such as an update to the geometry). Once the mesh is defined,
the state of the Mesh cell will change accordingly, as will the state of the next cell in
the system, in this case the Setup cell.

1. Open the ANSYS Meshing application.

In the ANSYS Workbench  Project Schematic, double-click the Mesh cell in the elbow fluid flow
analysis system (cell A3). This displays the ANSYS Meshing application with the elbow geometry
already loaded. You can also right-click the Mesh cell to display the context menu where you can
select the Edit... option.
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Figure 1.7: The ANSYS Meshing Application with the Elbow Geometry Loaded

2. Create named selections for the geometry boundaries.

In order to simplify your work later on in ANSYS Fluent, you should label each boundary in the
geometry by creating named selections for the pipe inlets, the outlet, and the symmetry surface
(the outer wall boundaries are automatically detected by ANSYS Fluent).

a. Select the large inlet in the geometry that is displayed in the ANSYS Meshing application.

Tip

• Use the Graphics Toolbar buttons and the mouse to manipulate the image until you can
easily see the pipe openings and surfaces.

• To select the inlet, the Single select ( ) mode must be active.

b. Right-click and select the Create Named Selection option.
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Figure 1.8:  Selecting a Face to Name

This displays the Selection Name dialog box.
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Figure 1.9:  Applying a Name to a Selected Face

c. In the Selection Name dialog box, enter velocity-inlet-large for the name and click OK.

d. Perform the same operations for:

• The small inlet (velocity-inlet-small)

• The large outlet (pressure-outlet)

• The symmetry plane (symmetry).

The named selections that you have created appear under the Named Selections item in the
Outline view.

Important

It is important to note that by using the strings “velocity inlet” and “pressure outlet”
in the named selections (with or without hyphens or underscore characters), ANSYS
Fluent automatically detects and assigns the corresponding boundary types accordingly.

3. Create a named selection for the fluid body.

a. Change the selection filter to Body in the Graphics Toolbar ( ).

b. Click the elbow in the graphics display to select it.

c. Right-click, select the Create Named Selection option and name the body Fluid.
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By creating a named selection called Fluid for the fluid body you will ensure that ANSYS Fluent
automatically detects that the volume is a fluid zone and treats it accordingly.

4. Set basic meshing parameters for the ANSYS Meshing application.

For this analysis, you will adjust several meshing parameters to obtain a finer mesh.

a. In the Outline view, select Mesh under Project/Model to display the Details of “Mesh” view below
the Outline view.

Important

Note that because the ANSYS Meshing application automatically detects that you
are going to perform a CFD fluid flow analysis using ANSYS Fluent, the Physics
Preference is already set to CFD and the Solver Preference is already set to
Fluent.

b. Expand the Sizing node by clicking the “+” sign to the left of the word Sizing to reveal additional sizing
parameters. Change Relevance Center to Fine by clicking the default value, Coarse, and selecting
Fine from the drop-down list.

c. Expand the Quality node to reveal additional quality parameters. Change Smoothing to High.

d. Add a Body Sizing control.

i. With Mesh still selected in the Outline tree, click the elbow in the graphics display to select it.

ii. Right click in the graphics area and select Insert → Sizing from the context menu.
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A new Body Sizing entry appears under Mesh in the project Outline tree

iii. In the Outline tree, click the new Body Sizing control.

iv. Enter 6e-3 for Element Size and press Enter.

e. Click again Mesh in the Outline view and in the Details of “Mesh” view, expand the Inflation node
to reveal additional inflation parameters. Change Use Automatic Inflation to Program Controlled.

5. Generate the mesh.

Right-click Mesh in the project Outline tree, and select Update in the context menu.

25
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 1.10: The Computational Mesh for the Elbow Geometry in the ANSYS Meshing Application

Important

Using the Generate Mesh option creates the mesh, but does not actually create the
relevant mesh files for the project and is optional if you already know that the mesh
is acceptable. Using the Update option automatically generates the mesh, creates
the relevant mesh files for your project, and updates the ANSYS Workbench cell that
references this mesh.

Note

Once the mesh is generated, you can view the mesh statistics by opening the Statistics
node in the Details of “Mesh” view. This will display information such as the number of
nodes and the number of elements.
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6. Close the ANSYS Meshing application.

You can close the ANSYS Meshing application without saving it because ANSYS Workbench automat-
ically saves the mesh and updates the Project Schematic accordingly. The Refresh Required icon
in the Mesh cell has been replaced by a check mark, indicating that there is a mesh now associated
with the fluid flow analysis system.

7. View the list of files generated by ANSYS Workbench.

View → Files

Figure 1.11:  ANSYS Workbench Files View for the Project After Mesh Creation

Note the addition of the mesh files (FFF.msh and FFF.mshdb) to the list of files. The FFF.msh
file is created when you update the mesh, and the FFF.mshdb file is generated when you close
the ANSYS Meshing application.

1.4.5. Setting Up the CFD Simulation in ANSYS Fluent

Now that you have created a computational mesh for the elbow geometry, you will set up a CFD ana-
lysis using ANSYS Fluent, then review the list of files generated by ANSYS Workbench.

1.4.5.1. Starting ANSYS Fluent

1. In the ANSYS Workbench Project Schematic, double-click the Setup cell in the elbow fluid flow analysis
system. You can also right-click the Setup cell to display the context menu where you can select the Edit...
option.

When ANSYS Fluent is first started, the Fluent Launcher is displayed, enabling you to view and/or
set certain ANSYS Fluent start-up options.

Note

The Fluent Launcher allows you to decide which version of ANSYS Fluent you will use,
based on your geometry and on your processing capabilities.
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Figure 1.12:  Fluent Launcher

2. Ensure that the proper options are enabled.

Important

Note that the Dimension setting is already filled in and cannot be changed, since
ANSYS Fluent automatically sets it based on the mesh or geometry for the current
system.

a. Ensure that Serial from the Processing Options list is enabled.

b. Select Double Precision under Options.
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c. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

Note

An option is enabled when there is a check mark in the check box, and disabled when
the check box is empty. To change an option from disabled to enabled (or vice versa),
click the check box or the text.

Note

Fluent will retain your preferences for future sessions.

3. Click OK to launch ANSYS Fluent.

Note

The ANSYS Fluent settings file (FFF.set) is written as soon as ANSYS Fluent opens.

Figure 1.13: The ANSYS Fluent Application

1.4.5.2. Setting Up Domain

In this step, you will perform the mesh-related activities using the Setting Up Domain ribbon tab (Mesh
group).
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Note

These controls are also available in the General task page that can be accessed by clicking
the Setup/General tree item.

1. Change the units for length.

Because you want to specify and view values based on a unit of length in millimeters from within
ANSYS Fluent, change the units of length within ANSYS Fluent from meters (the default) to millimeters.

Important

Note that the ANSYS Meshing application automatically converts and exports meshes
for ANSYS Fluent using meters (m) as the unit of length regardless of what units
were used to create them. This is so you do not have to scale the mesh in ANSYS
Fluent under ANSYS Workbench.

Setting Up Domain → Mesh → Units...

This displays the Set Units dialog box.

a. Select length in the Quantities list.

b. Select mm in the Units list.
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c. Close the dialog box.

Note

Now, all subsequent inputs that require a value based on a unit of length can be specified
in millimeters rather than meters.

2. Check the mesh.

Setting Up Domain → Mesh → Check

Note

ANSYS Fluent will report the results of the mesh check in the console.

 Domain Extents:
   x-coordinate: min (m) = -2.000000e-01, max (m) = 2.000000e-01
   y-coordinate: min (m) = -2.250000e-01, max (m) = 2.000000e-01
   z-coordinate: min (m) = 0.000000e+00, max (m) = 5.000000e-02
 Volume statistics:
   minimum volume (m3): 1.144763e-10
   maximum volume (m3): 5.871098e-08
     total volume (m3): 2.511309e-03
 Face area statistics:
   minimum face area (m2): 2.051494e-07
   maximum face area (m2): 3.429518e-05
 Checking mesh..........................
Done.

Note

The minimum and maximum values may vary slightly when running on different platforms.
The mesh check will list the minimum and maximum x and y values from the mesh in
the default SI unit of meters. It will also report a number of other mesh features that are
checked. Any errors in the mesh will be reported at this time. Ensure that the minimum
volume is not negative as ANSYS Fluent cannot begin a calculation when this is the case.

3. Review the mesh quality.

Setting Up Domain → Mesh → Quality

Note

ANSYS Fluent will report the results of the mesh quality below the results of the mesh
check in the console.

Mesh Quality: 
Minimum Orthogonal Quality = 1.98483e-01 
(Orthogonal Quality ranges from 0 to 1, where values close to 0 correspond to low quality.) 
Maximum Ortho Skew = 7.19694e-01 
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(Ortho Skew ranges from 0 to 1, where values close to 1 correspond to low quality.) 
Maximum Aspect Ratio = 2.05643e+01 

Note

The quality of the mesh plays a significant role in the accuracy and stability of the numer-
ical computation.  Checking the quality of your mesh is, therefore, an important step in
performing a robust simulation.  Minimum cell orthogonality is an important indicator of
mesh quality. Values for orthogonality can vary between 0 and 1 with lower values indic-
ating poorer quality cells.  In general, the minimum orthogonality should not be below
0.01 with the average value significantly larger. The high aspect ratio cells in this mesh
are near the walls and are a result of the boundary layer inflation applied in the meshing
step. For more information about the importance of mesh quality refer to the Fluent
User's Guide.

1.4.5.3. Setting Up Physics

In the steps that follow, you will select a solver and specify physical models, material properties, and
zone conditions for your simulation using the Setting Up Physics ribbon tab.

1. In the Solver group of the Setting Up Physics ribbon tab, retain the default selection of the steady pressure-
based solver.

Setting Up Physics → Solver

2. Set up your models for the CFD simulation using the Models group of the Setting Up Physics ribbon tab.

Note

You can also use the Models task page that can be accessed by double-clicking the
Setup/Models tree item.

a. Enable heat transfer by activating the energy equation.

In the Setting Up Physics ribbon tab, select Energy (Models group).
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Setting Up Physics → Models → Energy

b. Enable the -  turbulence model.

i. In the Setting Up Physics ribbon tab, click Viscous... (Models group).

Setting Up Physics → Models → Viscous...
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ii. In the Viscous Model dialog box, select k-epsilon from the Model list.

Note

The Viscous Model dialog box will expand.

iii. Use the default Standard from the k-epsilon Model group.

iv. Select Enhanced Wall Treatment for the Near-Wall Treatment.

Note

The default Standard Wall Functions are generally applicable if the first cell center
adjacent to the wall has a y+ larger than 30. In contrast, the Enhanced Wall
Treatment option provides consistent solutions for all y+ values. Enhanced Wall
Treatment is recommended when using the k-epsilon model for general single-
phase fluid flow problems. For more information about Near Wall Treatments in
the k-epsilon model refer to the Fluent User's Guide.

v. Click OK to accept the model and close the Viscous Model dialog box.

Note that the Viscous... label in the ribbon is displayed in blue to indicate that the Viscous
model is enabled.

3. Set up the materials for your CFD simulation using the Materials group of the Setting Up Physics ribbon
tab.

Create a new material called water using the Create/Edit Materials dialog box (Figure 1.14: The
Create/Edit Materials Dialog Box (p. 35)).

a. In the Setting Up Physics ribbon tab, click Create/Edit... (Materials group).

Setting Up Physics → Materials → Create/Edit...

b. In the Create/Edit Materials dialog box, type water for Name.

c. In the Properties group, enter the following values:

ValueProperty

1000 [kg/m3]Density

4216 [J/kg-K] (Specific Heat)

0.677 [W/m-K]Thermal Conductivity
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ValueProperty

8e-04 [kg/m-s]Viscosity

Figure 1.14: The Create/Edit Materials Dialog Box

d. Click Change/Create.

A Question dialog box will open, asking if you want to overwrite air. Click No so that the new
material water is added to the Fluent Fluid Materials list of materials that originally contained
only air.

Extra

You could have copied the material water-liquid (h2o < l >) from the materials
database (accessed by clicking the ANSYS Fluent Database... button). If the properties
in the database are different from those you want to use, you can edit the values in
the Properties group in the Create/Edit Materials dialog box and click
Change/Create to update your local copy. The original copy will not be affected.

35
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



e. Ensure that there are now two materials (water and air) defined locally by examining the Fluent Fluid
Materials drop-down list in the Create/Edit Materials dialog box .

Note

Both the materials will also be listed under Fluid in the Materials task page and under
the Materials tree branch.

f. Close the Create/Edit Materials dialog box.

4. Set up the cell zone conditions for the CFD simulation using the Zones group of the Setting Up Physics
ribbon tab.

a. In the Setting Up Physics tab, click Cell Zones.

Setting Up Physics → Zones → Cell Zones

This opens the Cell Zone Conditions task page.
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b. Set the cell zone conditions for the fluid zone.

i. In the Cell Zone Conditions task page, in the Zone list, select fluid and click Edit... to open the
Fluid dialog box.

Note

You can also double-click fluid in the Cell Zones Conditions task page or under
the Setup/Cell Zone Conditions tree branch in order to open the corresponding
dialog box.
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ii. In the Fluid dialog box, select water from the Material Name drop-down list.

iii. Click OK to close the Fluid dialog box.

5. Set up the boundary conditions for the CFD analysis using the Zones group of the Setting Up Physics
ribbon tab.

a. In the Setting Up Physics tab, click Boundaries (Zones group).

Setting Up Physics → Zones → Boundaries

This opens the Boundary Conditions task page.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.38

Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat
Transfer in a Mixing Elbow



Note

To display boundary zones grouped by zone type (as shown above), click the Toggle
Tree View button in the upper right corner of the Boundary Conditions task page
and under the Group By category select Zone Type from the drop-down list.

b. Set the boundary conditions at the cold inlet (velocity-inlet-large).

Tip

If you are unsure of which inlet zone corresponds to the cold inlet, you can use the
mouse to probe for mesh information in the graphics window. If you click the right
mouse button with the pointer on any node in the mesh, information about the asso-
ciated zone will be displayed in the ANSYS Fluent console, including the name of the
zone. The zone you probed will be automatically selected from the Zone selection
list in the Boundary Conditions task page.
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Alternatively, you can click the probe button ( ) in the graphics toolbar and click
the left mouse button on any node. This feature is especially useful when you have
several zones of the same type and you want to distinguish between them quickly.
The information will be displayed in the console.

i. From the Zone selection list, select velocity-inlet-large and click Edit....

ii. In the Velocity Inlet dialog box, ensure that Magnitude, Normal to Boundary is selected for Ve-
locity Specification Method.

iii. Enter 0.4  for Velocity Magnitude.

iv. In the Turbulence group, from the Specification Method drop-down list, select Intensity and
Hydraulic Diameter.

v. Retain the default of 5  for Turbulent Intensity.

vi. Enter 100 mm for Hydraulic Diameter.

Note

The hydraulic diameter  is defined as:

where  is the cross-sectional area and  is the wetted perimeter.
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vii. Click the Thermal tab.

viii.Enter 293.15  for Temperature.

ix. Click OK to close the Velocity Inlet dialog box.

c. In a similar manner, set the boundary conditions at the hot inlet (velocity-inlet-small), using the values
in the following table:

ValueSetting

Magnitude, Normal to BoundaryVelocity Specification Method

1.2  [m/s]Velocity Magnitude

Intensity & Hydraulic DiameterSpecification Method

5%Turbulent Intensity

25 [mm]Hydraulic Diameter

313.15[K]Temperature

d. Double-click pressure-outlet and set the boundary conditions at the outlet, as shown in the Pressure
Outlet dialog box.
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Note

ANSYS Fluent will use the backflow conditions only if the fluid is flowing into the
computational domain through the outlet. Since backflow might occur at some point
during the solution procedure, you should set reasonable backflow conditions to
prevent convergence from being adversely affected.

1.4.6. Solving

In the steps that follow, you will set up and run the calculation using the Solving ribbon tab.

Note

You can also use the task pages listed under the Solution branch in the tree to perform
solution-related activities.

1. Set up solution parameters for the CFD simulation.

a. Change the Gradient method.

i. In the Solving ribbon tab, click Methods... (Solution group).

Solving → Solution → Methods...
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This will open the Solution Methods task page.

ii. In the Spatial Discretization group of the Solution Methods task page, change the Gradient to
Green-Gauss Node Based. This gradient method is suggested for tetrahedral meshes.

b. Enable the plotting of residuals during the calculation.

i. In the Solving ribbon tab, click Residuals... (Reports group).

Solving → Reports → Residuals...

43
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



In the Residual Monitors dialog box, ensure that Plot is enabled in the Options group.

ii. Keep the default values for the Absolute Criteria of the Residuals, as shown in the Residual
Monitors dialog box.

iii. Click OK to close the Residual Monitors dialog box.

Note

By default, all variables will be monitored and checked by ANSYS Fluent as a means
to determine the convergence of the solution.

c. Create a surface report definition at the outlet (pressure-outlet).

Solving → Reports → Definitions → New → Surface Report → Facet Maximum
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i. In the Surface Report Definition dialog box, enter temp-outlet-0 for the Name.

ii. Under the Create group, enable Report File and Report Plot.

During a solution run, ANSYS Fluent will write solution convergence data in a report file and
plot the solution convergence history in a graphics window.

It is good practice to monitor physical solution quantities in addition to equation residuals when
assessing convergence.

iii. Set Frequency to 3 by clicking the up-arrow button.

This setting instructs ANSYS Fluent to update the plot of the surface report and write data to a
file after every 3 iterations during the solution.

iv. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

v. Select pressure-outlet from the Surfaces selection list.

vi. Click OK to save the surface report definition and close the Surface Report Definition dialog box.
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The new surface report definition temp-outlet-0 appears under the Solution/Report
Definitions tree item. ANSYS Fluent also automatically creates the following items:

• temp-outlet-0-rfile (under the Solution/Monitors/Report Files tree branch)

• temp-outlet-0-rplot (under the Solution/Monitors/Report Plots tree branch)

d. In the tree, double-click the temp-outlet-0-rfile (under the Solution/Monitors/Report Files) and ex-
amine the report file settings in the Edit Report File dialog box.

The dialog box is automatically populated with data from the temp-outlet-0 report definition.
The report that will be written in a report file during a solution is listed under Selected Report
Definitions.

Retain the default output file name and click OK.

e. In the tree, double-click temp-outlet-0-rplot (under Solution/Monitors/Report Plots) and examine
the report plot settings in the Edit Report Plot dialog box.
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The dialog box is automatically populated with data from the temp-outlet-0 report definition.
As the solution progresses, the report that is listed under Selected Report Definitions will be
plotted in a graphics tab window with the title specified in Plot Title.

Retain the default names for Plot Title and Y-Axis Label and click OK.

Note

You can create report definitions for different boundaries and plot them in the same
graphics window. However, report definitions in the same Report Plot must have the
same units.

f. Initialize the flow field using the Initialization group of the Solving ribbon tab.

Solving → Initialization
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i. Keep the Method at the default of Hybrid.

ii. Click Initialize.

g. Check to see if the case conforms to best practices.

Solving → Run Calculation → Check Case

i. Click the Models and Solver tabs and examine the Recommendation in each. These recommend-
ations can be ignored for this tutorial. The issues they raise will be addressed in later tutorials.

ii. Close the Case Check dialog box.

2. Calculate a solution using the Run Calculation group of the Solving tab.

Solving → Run Calculation

a. Start the calculation by requesting 300 iterations.

i. Enter 300 for No. of Iterations.

ii. Click Calculate.

Note that while the program is calculating the solution, the states of the Setup and Solution
cells in the fluid flow ANSYS Fluent analysis system in ANSYS Workbench are changing. For ex-
ample:

• The state of the Setup cell becomes Up-to-Date and the state of the Solution cell becomes Refresh
Required after the Run Calculation task page is visited and the number of iterations is specified.
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• The state of the Solution cell is Update Required while iterations are taking place.

• The state of the Solution cell is Up-to-Date when the specified number of iterations are complete
(or if convergence is reached).

As the calculation progresses, the surface report plot will be plotted in the graphics window
(temp-outlet-0–rplot tab window) (Figure 1.15: Convergence History of the Maximum Temper-
ature at Pressure Outlet (p. 49)).

Figure 1.15:  Convergence History of the Maximum Temperature at Pressure Outlet

The residuals history will be plotted in the Scaled Residuals tab window (Figure 1.16: Residuals
for the Converged Solution (p. 50)).
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Figure 1.16:  Residuals for the Converged Solution

Note

The solution will be stopped by ANSYS Fluent when the residuals reach their specified
values or after 300 iterations. The exact number of iterations will vary depending on
the platform being used. An Information dialog box will open to alert you that the
calculation is complete. Click OK in the Information dialog box to proceed.

Because the residual values vary slightly by platform, the plot that appears on your
screen may not be exactly the same as the one shown here.

Note that the ANSYS Fluent settings file (FFF.set) is updated in the Files view of the ANSYS
Workbench before the calculation begins.

b. Examine the plots for convergence (Figure 1.16: Residuals for the Converged Solution (p. 50) and Fig-
ure 1.15: Convergence History of the Maximum Temperature at Pressure Outlet (p. 49)).

Note

There are no universal metrics for judging convergence. Residual definitions that are
useful for one class of problem are sometimes misleading for other classes of problems.
Therefore it is a good idea to judge convergence not only by examining residual
levels, but also by monitoring relevant integrated quantities and checking for mass
and energy balances.

There are three indicators that convergence has been reached:
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• The residuals have decreased to a sufficient degree.

The solution has converged when the Convergence Criterion for each variable
has been reached. The default criterion is that each residual will be reduced to a

value of less than , except the energy residual, for which the default criterion

is .

• The solution no longer changes with more iterations.

Sometimes the residuals may not fall below the convergence criterion set in the
case setup. However, monitoring the representative flow variables through iterations
may show that the residuals have stagnated and do not change with further itera-
tions. This could also be considered as convergence.

• The overall mass, momentum, energy, and scalar balances are obtained.

You can examine the overall mass, momentum, energy and scalar balances in the
Flux Reports dialog box. The net imbalance should be less than 0.2  of the net
flux through the domain when the solution has converged. In the next step you
will check to see if the mass balance indicates convergence.

3. With ANSYS Fluent still running, go back to ANSYS Workbench and view the list of generated files.

View → Files

Note the addition of the surface report definition file temp-outlet-0.out to the list of files.

The status of the Solution cell is now up-to-date.

1.4.7. Displaying Results in ANSYS Fluent and CFD-Post

In this step, you will display the results of the simulation in ANSYS Fluent, display the results in CFD-
Post, and then review the list of files generated by ANSYS Workbench.

1. Display results in ANSYS Fluent using the Postprocessing ribbon tab.

In ANSYS Fluent, you can perform a simple evaluation of the velocity and temperature contours on
the symmetry plane. Later, you will use CFD-Post (from within ANSYS Workbench) to perform the
same evaluation.
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a. Display filled contours of velocity magnitude on the symmetry plane (Figure 1.17: Velocity Distribution
Along Symmetry Plane (p. 53)).

Postprocessing → Graphics → Contours → Edit...

Note

You can also double-click the Results/Graphics/Contours tree item.

i. In the Contours dialog box, in the Options group, enable Filled.

ii. Ensure that Node Values is enabled in the Options group.

iii. From the Contours of drop-down lists, select Velocity... and Velocity Magnitude.

iv. From the Surfaces selection list, deselect all items by clicking  and then select symmetry.

v. Click Display to display the contours in the active graphics window.
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Figure 1.17: Velocity Distribution Along Symmetry Plane

Note

You may want to clear Lighting in the Viewing ribbon tab (Display group).

b. Display filled contours of temperature on the symmetry plane (Figure 1.18: Temperature Distribution
Along Symmetry Plane (p. 55)).

Postprocessing → Graphics → Contours → Edit...
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i. Select Temperature... and Static Temperature from the Contours of drop-down lists.

ii. Click Display and close the Contours dialog box.
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Figure 1.18: Temperature Distribution Along Symmetry Plane

c. Close the ANSYS Fluent application.

File → Close Fluent

Important

Note that the ANSYS Fluent case and data files are automatically saved when you exit
ANSYS Fluent and return to ANSYS Workbench.

d. View the list of files generated by ANSYS Workbench.

View → Files
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Note the addition of the compressed ANSYS Fluent case and data files to the list of files. These
will have names like FFF-1.cas.gz and FFF-1-00222.dat.gz. Note that the digit(s) fol-
lowing FFF may be different if you have had to restart the meshing or calculation steps for any
reason and that the name of the data file is based on the number of iterations. Thus your file
names may be slightly different than those shown here.

2. Display results in CFD-Post.

a. Start CFD-Post.

In the ANSYS Workbench  Project Schematic, double-click the Results cell in the elbow fluid
flow analysis system (cell A6). This displays the CFD-Post application. You can also right-click the
Results cell to display the context menu where you can select the Edit... option.

Note

The elbow geometry is already loaded and is displayed in outline mode. ANSYS Fluent
case and data files are also automatically loaded into CFD-Post.

Figure 1.19: The Elbow Geometry Loaded into CFD-Post

b. Reorient the display.

Click the blue Z axis on the axis triad in the bottom right hand corner of the graphics display to
orient the display so that the view is of the front of the elbow geometry.
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c. Ensure that Highlighting ( ) is disabled.

d. Display contours of velocity magnitude on the symmetry plane (Figure 1.20: Velocity Distribution Along
Symmetry Plane (p. 58)).

i. Insert a contour object using the Insert menu item at the top of the CFD-Post window.

Insert → Contour

This displays the Insert Contour dialog box.

ii. Keep the default name of the contour (Contour 1) and click OK to close the dialog box. This dis-
plays the Details of Contour 1 view below the Outline view in CFD-Post. This view contains all of
the settings for a contour object.

iii. In the Geometry tab, from the Domains drop-down list, select fluid.

iv. In the Locations list, select symmetry.

v. In the Variable list, select Velocity.

vi. Click Apply.
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Figure 1.20: Velocity Distribution Along Symmetry Plane

e. Display contours of temperature on the symmetry plane (Figure 1.21: Temperature Distribution Along
Symmetry Plane (p. 59)).

i. In the Outline tree view, under User Locations and Plots, clear the check box beside the Contour
1 object to disable the Contour 1 object and hide the first contour display.

ii. Insert a contour object.

Insert → Contour

This displays the Insert Contour dialog box.

iii. Keep the default name of the contour (Contour 2) and click OK to close the dialog box. This dis-
plays the Details of Contour 2 view below the Outline view.

iv. In the Geometry tab, from the Domains drop-down list, select fluid.
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v. In the Locations list, select symmetry.

vi. In the Variable list, select Temperature.

vii. Click Apply.

Figure 1.21: Temperature Distribution Along Symmetry Plane

3. Close the CFD-Post application by selecting File → Close CFD-Post or by clicking the ‘X’ in the top right
corner of the window.

Important

Note that the CFD-Post state files are automatically saved when you exit CFD-Post
and return to ANSYS Workbench.
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4. Save the elbow-workbench project in ANSYS Workbench.

5. View the list of files generated by ANSYS Workbench.

View → Files

Note the addition of the CFD-Post state file (elbow.cst) to the list of files. For more information
about CFD-Post (and the files associated with it), see the CFD-Post documentation.

1.4.8. Duplicating the Fluent-Based Fluid Flow Analysis System

At this point, you have a completely defined fluid flow system that has a geometry, a computational
mesh, a CFD setup and solution, and corresponding results. In order to study the effects upon the flow
field that may occur if you were to alter the geometry, another fluid flow analysis is required. One ap-
proach would be to use the current system and change the geometry, however you would overwrite
the data from your previous simulation. A more suitable and effective approach would be to create a
copy, or duplicate, of the current system, and then make the appropriate changes to the duplicate
system.

In this step, you will create a duplicate of the original Fluent-based fluid flow system, then review the
list of files generated by ANSYS Workbench.

1. In the Project Schematic, right-click the title cell of the Fluid Flow (Fluent) system and select Duplicate
from the context menu.

Figure 1.22:  Duplicating the Fluid Flow System
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Figure 1.23: The Original Fluid Flow System and Its Duplicate

Note

Notice that in the duplicated system, the state of the Solution cell indicates that the cell
requires a refresh while the state of the Results cell indicates that the cell requires atten-
tion. This is because when a system is duplicated, the case and data files are not copied
to the new system, therefore, the new system does not yet have solution data associated
with it.

2. Rename the duplicated system to new-elbow.

3. Save the elbow-workbench project in ANSYS Workbench.

1.4.9. Changing the Geometry in ANSYS DesignModeler

Now that you have two separate, but equivalent, Fluent-based fluid flow systems to work from, you
can make changes to the second system without impacting the original system. In this step, you will
make a slight alteration to the elbow geometry in ANSYS DesignModeler by changing the diameter of
the smaller inlet, then review the list of files generated by ANSYS Workbench.

1. Open ANSYS DesignModeler.

Right-click the Geometry cell of the new-elbow system (cell B2) and select Edit Geometry in
DesignModeler... from the context menu to display the geometry in ANSYS DesignModeler.

2. Change the diameter of the small inlet (velocity-inlet-small).

a. In the Tree Outline, select Cylinder1 to open the Details View of the small inlet pipe.

b. In the Details View, change the FD10, Radius (>0) value from 12.5 millimeters to 19 millimeters.

61
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



c. Click the Generate button to generate the geometry with your new values.
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Figure 1.24:  Changing the Diameter of the Small Inlet in ANSYS DesignModeler

3. Close ANSYS DesignModeler.

4. View the list of files generated by ANSYS Workbench.

View → Files

Note the addition of the geometry, mesh, and ANSYS Fluent settings files now associated with the
new, duplicated system.

1.4.10. Updating the Mesh in the ANSYS Meshing Application

The modified geometry now requires a new computational mesh. The mesh settings for the duplicated
system are retained in the duplicated system. In this step, you will update the mesh based on the mesh
settings from the original system, then review the list of files generated by ANSYS Workbench.
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In the Project Schematic, right-click the Mesh cell of the new-elbow system (cell B3) and select Update
from the context menu. This will update the mesh for the new geometry based on the mesh settings
you specified earlier in the ANSYS Meshing application without having to open the ANSYS Meshing
editor to regenerate the mesh.

Figure 1.25:  Updating the Mesh for the Changed Geometry

It will take a few moments to update the mesh. Once the update is complete, the state of the Mesh
cell is changed to up-to-date, symbolized by a green check mark.

For illustrative purposes of the tutorial, the new geometry and the new mesh are displayed below.
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Figure 1.26: The Updated Geometry and Mesh in the ANSYS Meshing Application

Inspecting the files generated by ANSYS Workbench reveals the updated mesh file for the duplicated
system.

View → Files

1.4.11. Calculating a New Solution in ANSYS Fluent

Now that there is an updated computational mesh for the modified geometry in the duplicated system,
a new solution must be generated using ANSYS Fluent. In this step, you will revisit the settings within
ANSYS Fluent, calculate another solution, view the new results, then review the list of files generated
by ANSYS Workbench.

1. Open ANSYS Fluent.
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In the Project Schematic, right-click the Setup cell of the new-elbow system (cell B4) and select
Edit... from the context menu. Since the mesh has been changed, you are prompted as to whether
you want to load the new mesh into ANSYS Fluent or not.

Click Yes to continue, and click OK when Fluent Launcher is displayed in order to open ANSYS Fluent.

2. Ensure that the unit of length is set to millimeters.

Setting Up Domain → Mesh → Units...

3. Check the mesh (optional).

Setting Up Domain → Mesh → Check

4. Revisit the boundary conditions for the small inlet.

Setup → Boundary Conditions → velocity-inlet-small Edit...

In the Velocity Inlet dialog box for velocity-inlet-small, you must set the hydraulic diameter to
38 mm based on the new dimensions of the small inlet.

5. Re-initialize the solution.

Solving → Initialization

Keep the Method at the default of Hybrid and click Initialize.

6. Recalculate the solution.

Solving → Run Calculation → Calculate

Keep the No. of Iterations set to 300 and click Calculate.

7. Close ANSYS Fluent.

8. Revisit the results of the calculations in CFD-Post.

Double-click the Results cell of the new-elbow fluid flow system to re-open CFD-Post where you
can review the results of the new solution.

9. Close CFD-Post.

10. Save the elbow-workbench project in ANSYS Workbench.
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11. View the list of files generated by ANSYS Workbench.

View → Files

Note the addition of the solution and state files now associated with new duplicated system.

1.4.12. Comparing the Results of Both Systems in CFD-Post

In this step, you will create a new Results system in ANSYS Workbench, use that system to compare
the solutions from each of the two Fluent-based fluid flow analysis systems in CFD-Post at the same
time, then review the list of files generated by ANSYS Workbench.

1. Create a Results system.

In ANSYS Workbench, drag a Results system from the Component Systems section of the Toolbox
and drop it into the Project Schematic, next to the fluid flow systems.

Figure 1.27: The New Results System in the Project Schematic

2. Add the solutions of each of the systems to the Results system.

a. Select the Solution cell in the first Fluid Flow analysis system (cell A5) and drag it over the Results cell
in the Results system (cell C2). This creates a transfer data connection between the two systems.

Figure 1.28:  Connecting the First Fluid Flow System to the New Results System
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b. Select the Solution cell in the second Fluid Flow analysis system (cell B5) and drag it over the Results
cell in the Results system (cell C2). This creates a transfer data connection between the two systems.

Figure 1.29:  Connecting the Second Fluid Flow System to the New Results System

3. Open CFD-Post to compare the results of the two fluid flow systems.

Now that the two fluid flow systems are connected to the Results system, double-click the Results
cell in the Results system (cell C2) to open CFD-Post. Within CFD-Post, both geometries are displayed
side by side.

Figure 1.30:  CFD-Post with Both Fluid Flow Systems Displayed

a. Re-orient the display.
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In each view, click the blue Z axis on the axis triad in the bottom right hand corner of the
graphics display to orient the display so that the view is of the front of the elbow geometry.

Important

Alternatively, you can select the synchronization tool ( ) in the 3D Viewer
Toolbar to synchronize the views, so that when you re-orient one view, the
other view is automatically updated.

b. Display contours of velocity magnitude on the symmetry plane.

i. Insert a contour object.

Insert → Contour

This displays the Insert Contour dialog box.

ii. Keep the default name of the contour (Contour 1) and click OK to close the dialog box. This dis-
plays the Details of Contour 1 view below the Outline view in CFD-Post. This view contains all of
the settings for a contour object.

iii. In the Geometry tab, from the Domains list, select fluid.

iv. In the Locations list, select symmetry.

v. In the Variable list, select Velocity.

vi. Click Apply. The velocity contours are displayed in each view.

Note

To better visualize the velocity display, you can clear the Wireframe view option under
User Locations and Plots in the Outline tree view.
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Figure 1.31:  CFD-Post Displaying Velocity Contours for Both Geometries

c. Display contours of temperature on the symmetry plane.

i. In the Outline tree view, under User Locations and Plots, deselect the Contour 1 object to hide
the first contour display in CFD-Post.

ii. Insert another contour object.

Insert → Contour

This displays the Insert Contour dialog box.

iii. Keep the default name of the contour (Contour 2) and click OK to close the dialog box. This dis-
plays the Details of Contour 2 view below the Outline view in CFD-Post.
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iv. In the Geometry tab, select fluid in the Domains list.

v. Select symmetry in the Locations list.

vi. Select Temperature in the Variable list.

vii. Click Apply. The temperature contours are displayed in each view.

Figure 1.32:  CFD-Post Displaying Temperature Contours for Both Geometries

4. Close the CFD-Post application.

5. Save the elbow-workbench project in ANSYS Workbench.

6. View the list of files associated with your project using the Files view.

View → Files
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Note the addition of the Results system and its corresponding files.

1.5. Summary

In this tutorial, portions of ANSYS Workbench were used to compare the fluid flow through two slightly
different geometries. ANSYS DesignModeler was used to create a mixing elbow geometry, ANSYS
Meshing was used to create a computational mesh, ANSYS Fluent was used to calculate the fluid flow
throughout the geometry using the computational mesh, and CFD-Post was used to analyze the results.
In addition, the geometry was altered, a new mesh was generated, and a new solution was calculated.
Finally, ANSYS Workbench was set up so that CFD-Post could directly compare the results of both cal-
culations at the same time.
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Chapter 2: Parametric Analysis in ANSYS Workbench Using ANSYS
Fluent

This tutorial is divided into the following sections:
2.1. Introduction
2.2. Prerequisites
2.3. Problem Description
2.4. Setup and Solution

2.1. Introduction

This tutorial illustrates using an ANSYS Fluent fluid flow system in ANSYS Workbench to set up and
solve a three-dimensional turbulent fluid flow and heat transfer problem in an automotive heating,
ventilation, and air conditioning (HVAC) duct system. ANSYS Workbench uses parameters and design
points to allow you to run optimization and what-if scenarios. You can define both input and output
parameters in ANSYS Fluent that can be used in your ANSYS Workbench project. You can also define
parameters in other applications including ANSYS DesignModeler and ANSYS CFD-Post. Once you have
defined parameters for your system, a Parameters cell is added to the system and the Parameter Set
bus bar is added to your project. This tutorial is designed to introduce you to the parametric analysis
utility available in ANSYS Workbench.

The tutorial starts with a Fluid Flow (Fluent) analysis system with pre-defined geometry and mesh
components. Within this tutorial, you will redefine the geometry parameters created in ANSYS Design-
Modeler by adding constraints to the input parameters. You will use ANSYS Fluent to set up and solve
the CFD problem. While defining the problem set-up, you will also learn to define input parameters in
ANSYS Fluent. The tutorial will also provide information on how to create output parameters in ANSYS
CFD-Post.

This tutorial demonstrates how to do the following:

• Add constraints to the ANSYS DesignModeler input parameters.

• Create an ANSYS Fluent fluid flow analysis system in ANSYS Workbench.

• Set up the CFD simulation in ANSYS Fluent, which includes:

– Setting material properties and boundary conditions for a turbulent forced convection problem.

– Defining input parameters in Fluent

• Define output parameters in CFD-Post

• Create additional design points in ANSYS Workbench.

• Run multiple CFD simulations by updating the design points.
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• Analyze the results of each design point project in ANSYS CFD-Post and ANSYS Workbench.

Important

The mesh and solution settings for this tutorial are designed to demonstrate a basic paramet-
erization simulation within a reasonable solution time-frame. Ordinarily, you would use addi-
tional mesh and solution settings to obtain a more accurate solution.

2.2. Prerequisites

This tutorial assumes that you are already familiar with the ANSYS Workbench interface and its project
workflow (for example, ANSYS DesignModeler, ANSYS Meshing, ANSYS Fluent, and ANSYS CFD-Post).
This tutorial also assumes that you have completed Introduction to Using ANSYS Fluent in ANSYS
Workbench: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 1), and that you are familiar with the
ANSYS Fluent graphical user interface. Some steps in the setup and solution procedure will not be
shown explicitly.

2.3. Problem Description

In the past, evaluation of vehicle air conditioning systems was performed using prototypes and testing
their performance in test labs. However, the design process of modern vehicle air conditioning (AC)
systems improved with the introduction of Computer Aided Design (CAD), Computer Aided Engineering
(CAE) and Computer Aided Manufacturing (CAM). The AC system specification will include minimum
performance requirements, temperatures, control zones, flow rates, and so on. Performance testing
using CFD may include fluid velocity (air flow), pressure values, and temperature distribution. Using
CFD enables the analysis of fluid through very complex geometry and boundary conditions.

As part of the analysis, a designer can change the geometry of the system or the boundary conditions
such as the inlet velocity, flow rate, and so on, and view the effect on fluid flow patterns. This tutorial
illustrates the AC design process on a representative automotive HVAC system consisting of both an
evaporator for cooling and a heat exchanger for heating requirements. This HVAC system is symmetric,
so the geometry has been simplified using a plane of symmetry to reduce computation time.
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Figure 2.1:  Automotive HVAC System
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Figure 2.2:  HVAC System Valve Location Details

Figure 2.1: Automotive HVAC System (p. 75) shows a representative automotive HVAC system. The system
has three valves (as shown in Figure 2.2: HVAC System Valve Location Details (p. 76)), which control the
flow in the HVAC system. The three valves control:

• Flow over the heat exchanger coils

• Flow towards the duct controlling the flow through the floor vents

• Flow towards the front vents or towards the windshield

Air enters the HVAC system at 310 K with a velocity of 0.5 m/sec through the air inlet and passes to
the evaporator and then, depending on the position of the valve controlling flow to the heat exchanger,
flows over or bypasses the heat exchanger. Depending on the cooling and heating requirements, either
the evaporator or the heat exchanger would be operational, but not both at the same time. The position
of the other two valves controls the flow towards the front panel, the windshield, or towards the floor
ducts.

The motion of the valves is constrained. The valve controlling flow over the heat exchanger varies
between 25° and 90°. The valve controlling the floor flow varies between 20° and 60°. The valve con-
trolling flow towards front panel or windshield varies between 15° and 175°.

The evaporator load is about 200 W in the cooling cycle. The heat exchanger load is about 150 W.

This tutorial illustrates the easiest way to analyze the effects of the above parameters on the flow pat-
tern/distribution and the outlet temperature of air (entering the passenger cabin). Using the parametric
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analysis capability in ANSYS Workbench, a designer can check the performance of the system at various
design points.

Figure 2.3:  Flow Pattern for the Cooling Cycle

2.4. Setup and Solution

To help you quickly identify graphical user interface items at a glance and guide you through the steps
of setting up and running your simulation, the ANSYS Fluent Tutorial Guide uses several type styles and
mini flow charts. See Typographical Conventions Used In This Manual (p. xvi) for detailed information.

The following sections describe the setup and solution steps for this tutorial:
2.4.1. Preparation
2.4.2. Adding Constraints to ANSYS DesignModeler Parameters in ANSYS Workbench
2.4.3. Setting Up the CFD Simulation in ANSYS Fluent
2.4.4. Defining Input Parameters in ANSYS Fluent
2.4.5. Solving
2.4.6. Postprocessing and Setting the Output Parameters in ANSYS CFD-Post
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2.4.7. Creating Additional Design Points in ANSYS Workbench
2.4.8. Postprocessing the New Design Points in CFD-Post
2.4.9. Summary

2.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the workbench-parameter-tutorial_R180.zip link to download the input files.

7. Unzip the workbench-parameter-tutorial_R180.zip file to your working folder.

The extracted workbench-parameter-tutorial folder contains a single archive file fluent-
workbench-param.wbpz that includes all supporting input files of the starting ANSYS Workbench
project and a folder called final_project_files that includes the archived final version of the
project. The final result files incorporate ANSYS Fluent and ANSYS CFD-Post settings and all already
defined design points (all that is required is to update the design points in the project to generate cor-
responding solutions).

Note

ANSYS Fluent tutorials are prepared using ANSYS Fluent on a Windows system. The screen
shots and graphic images in the tutorials may be slightly different than the appearance on
your system, depending on the operating system or graphics card.

2.4.2. Adding Constraints to ANSYS DesignModeler Parameters in ANSYS
Workbench

In this step, you will start ANSYS Workbench, open the project file, review existing parameters, create
new parameters, and add constraints to existing ANSYS DesignModeler parameters.
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1. From the Windows Start menu, select Start > All Programs > ANSYS 18.0 > Workbench 18.0 to start
ANSYS Workbench.

This displays the ANSYS Workbench application window, which has the Toolbox on the left and the
Project Schematic to its right. Various supported applications are listed in the Toolbox, and the
components of the analysis system are displayed in the Project Schematic.

Note

When you first start ANSYS Workbench, the Getting Started message window is displayed,
offering assistance through the online help for using the application. You can keep the
window open, or close it by clicking OK. If you need to access the online help at any
time, use the Help menu, or press the F1 key.

2. Restore the archive of the starting ANSYS Workbench project to your working directory.

File → Restore Archive...

The Select Archive to Restore dialog box appears.

a. Browse to your working directory, select the project archive file fluent-workbench-param.wbpz,
and click Open.

The Save As dialog box appears.

b. Browse, if necessary, to your working folder and click Save to restore the project file,fluent-work-
bench-param.wbpj, and a corresponding project folder,fluent-workbench-param_files,
for this tutorial.

Now that the project archive has been restored, the project will automatically open in ANSYS
Workbench.
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Figure 2.4: The Project Loaded into ANSYS Workbench

The project (fluent-workbench-param.wbpj) already has a Fluent-based fluid flow analysis
system that includes the geometry and mesh, as well as some predefined parameters. You will first
examine and edit parameters within Workbench, then later proceed to define the fluid flow model
in ANSYS Fluent.

3. Open the Files view in ANSYS Workbench so you can view the files associated with the current project and
are written during the session.

View → Files
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Figure 2.5: The Project Loaded into ANSYS Workbench Displaying Properties and Files View

Note the types of files that have been created for this project. Also note the states of the cells for the
Fluid Flow (Fluent) analysis system. Since the geometry has already been defined, the status of the Geo-
metry cell is Up-to-Date ( ). Since the mesh is not complete, the Mesh cell’s state is Refresh Required

( ), and since the ANSYS Fluent setup is incomplete and the simulation has yet to be performed, with

no corresponding results, the state for the Setup, Solution, and Results cells is Unfulfilled ( ). For more
information about cell states, see the Workbench User's Guide.

4. Review the input parameters that have already been defined in ANSYS DesignModeler.

a. Double-click the Parameter Set bus bar in the ANSYS Workbench Project Schematic to open the
Parameters Set tab.

Note

To return to viewing the Project Schematic, click the Project tab.
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b. In the Outline of All Parameters view (Figure 2.6: Parameters Defined in ANSYS DesignModeler (p. 82)),
review the following existing parameters:

• The parameter hcpos represents the valve position that controls the flow over the heat exchanger.
When the valve is at an angle of 25°, it allows the flow to pass over the heat exchanger. When the
angle is 90°, it completely blocks the flow towards the heat exchanger. Any value in between allows
some flow to pass over the heat exchanger giving a mixed flow condition.

• The parameter ftpos represents the valve position that controls flow towards the floor duct. When
the valve is at an angle of 20°, it blocks the flow towards the floor duct and when the valve angle is
60°, it unblocks the flow.

• The parameter wsfpos represents the valve position that controls flow towards the windshield and
the front panel. When the valve is at an angle of 15°, it allows the entire flow to go towards the
windshield. When the angle is 90°, it completely blocks the flow towards windshield as well as the
front panel. When the angle is 175°, it allows the flow to go towards the windshield and the front
panel.

Figure 2.6:  Parameters Defined in ANSYS DesignModeler

5. In the Outline of All Parameters view, create three new named input parameters.

a. In the row that contains New input parameter, click the parameter table cell with New name (under
the Parameter Name column) and enter input_hcpos. Note the ID of the parameter that appears
in column A of the table. For the new input parameter, the parameter ID is P4. In the Value column,
enter 15.

b. In a similar manner, create two more parameters named input_ftpos and input_wsfpos. In the
Value column, enter 25, and 90 for each new parameter (P5 and P6), respectively.
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Figure 2.7:  New Parameters Defined in ANSYS Workbench

6. Select the row (or any cell in the row) that corresponds to the hcpos parameter. In the Properties of
Outline view, change the value of the hcpos parameter in the Expression field from 90 to the expression
min(max(25,P4),90). This puts a constraint on the value of hcpos, so that the value always remains
between 25° and 90°. The redefined parameter hcpos is automatically passed to ANSYS DesignModeler.
Alternatively the same constraint can also be set using the expression max(25, min(P4,90)).

After defining this expression, the parameter becomes a derived parameter that is dependent on
the value of the parameter input_hcpos with ID P4. The derived parameters are unavailable for
editing in the Outline of All Parameters view and could be redefined only in the Properties of
Outline view.

Important

When entering expressions, you must use the list and decimal delimiters associated with
your selected language in the Workbench regional and language settings, which corres-
pond to the regional settings on your machine. The instructions in this tutorial assume
that your systems uses “.” as a decimal separator and “,” as a list separator.
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Figure 2.8:  Constrained Parameter hcpos

7. Select the row or any cell in the row that corresponds to the ftpos parameter and create a similar expression
for ftpos:min(max(20,P5),60).
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Figure 2.9:  Constrained Parameter ftpos

8. Create a similar expression for wsfpos:min(max(15,P6),175).
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Figure 2.10:  Constrained Parameter wsfpos

9. Click the X on the right side of the Parameters Set tab to close it and return to the Project Schematic.

Note the new status of the cells in the Fluid Flow (Fluent) analysis system. Since we have changed
the values of hcpos, ftpos, and wsfpos to their new expressions, the Geometry and Mesh cells

now indicates Refresh Required ( ).

10. Update the Geometry and Mesh cells.

a. Right-click the Geometry cell and select the Update option from the context menu.

b. Likewise, right-click the Mesh cell and select the Refresh option from the context menu. Once the cell
is refreshed, then right-click the Mesh cell again and select the Update option from the context menu.

11. Save the project in ANSYS Workbench.

In the main menu, select File → Save
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2.4.3. Setting Up the CFD Simulation in ANSYS Fluent

Now that you have edited the parameters for the project, you will set up a CFD analysis using ANSYS
Fluent. In this step, you will start ANSYS Fluent, and begin setting up the CFD simulation.

2.4.3.1. Starting ANSYS Fluent

In the ANSYS Workbench  Project Schematic, double-click the Setup cell in the ANSYS Fluent fluid flow
analysis system. You can also right-click the Setup cell to display the context menu where you can select
the Edit... option.

When ANSYS Fluent is first started, Fluent Launcher is displayed, allowing you to view and/or set certain
ANSYS Fluent start-up options.

Fluent Launcher allows you to decide which version of ANSYS Fluent you will use, based on your geometry
and on your processing capabilities.

Figure 2.11:  ANSYS Fluent Launcher

1. Ensure that the proper options are enabled.

Important

Note that the Dimension setting is already filled in and cannot be changed, since ANSYS
Fluent automatically sets it based on the mesh or geometry for the current system.
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a. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

Note

An option is enabled when there is a check mark in the check box, and disabled when
the check box is empty. To change an option from disabled to enabled (or vice versa),
click the check box or the text.

b. Ensure that Serial is selected from the Processing Options list.

Note

Parallel processing offers a substantial reduction in computational time. Refer to Intro-
duction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)
in this manual and the Fluent User's Guide for further information about using the
parallel processing capabilities of ANSYS Fluent.

c. Ensure that the Double Precision option is disabled.

Note

Fluent will retain your preferences for future sessions.

2. Click OK to launch ANSYS Fluent.
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Figure 2.12: The ANSYS Fluent Application

2.4.3.2. Setting Up Physics

1. In the Solver group of the Setting Up Physics ribbon tab, retain the default selection of the steady pressure-
based solver.

Setting Up Physics → Solver

2. Set up your models for the CFD simulation using the Models group of the Setting Up Physics ribbon tab.

a. Enable heat transfer by activating the energy equation.
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In the Setting Up Physics ribbon tab, select Energy (Models group).

Setting Up Physics → Models → Energy

b. Enable the -  turbulence model.

Setting Up Physics → Models → Viscous...

i. Select k-epsilon (2 eqn) from the Model group box.

ii. Select Enhanced Wall Treatment from the Near-Wall Treatment group box.
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The default Standard Wall Functions are generally applicable when the cell layer adjacent to the
wall has a y+ larger than 30.  In contrast, the Enhanced Wall Treatment option provides consistent
solutions for all y+ values.  Enhanced Wall Treatment is recommended when using the k-epsilon
model for general single-phase fluid flow problems.  For more information about Near Wall
Treatments in the k-epsilon model refer to the Fluent User's Guide.

iii. Click OK to retain the other default settings, enable the model, and close the Viscous Model dialog
box.

Note that the Viscous... label in the ribbon is displayed in blue to indicate that the Viscous
model is enabled.

3. Define a heat source cell zone condition for the evaporator volume.

Setting Up Physics → Zones → Cell Zones

Note

All cell zones defined in your simulation are listed in the Cell Zone Conditions task page
and under the Setup/Cell Zone Conditions tree branch.

a. In the Cell Zone Conditions task page, under the Zone list, select fluid-evaporator and click Edit...
to open the Fluid dialog box.

b. In the Fluid dialog box, enable Source Terms.

c. In the Source Terms tab, click the Edit... button next to Energy.
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d. In the Energy sources dialog box, change the Number of Energy sources to 1.

e. For the new energy source, select constant from the drop-down list, and enter -787401.6 W/m3 —

based on the evaporator load (200 W) divided by the evaporator volume (0.000254 m3) that was com-
puted earlier.

f. Click OK to close the Energy Source dialog box.

g. Click OK to close the Fluid dialog box.

2.4.4. Defining Input Parameters in ANSYS Fluent

You have now started setting up the CFD analysis using ANSYS Fluent. In this step, you will define
boundary conditions and input parameters for the velocity inlet.

1. Define an input parameter called in_velocity for the velocity at the inlet boundary.

a. In the Setting Up Physics tab, click Boundaries (Zones group).

Setting Up Physics → Zones → Boundaries

This opens the Boundary Conditions task page.

Note

All boundaries defined in the case are also displayed under the Setup/Boundary
Conditions tree branch.

b. In the Boundary Conditions task page, click the Toggle Tree View button (in the upper right corner),
and under the Group By category, select Zone Type. This displays boundary zones grouped by zone
type.

c. Under the Inlet zone type, double-click inlet-air.
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d. In the Velocity Inlet dialog box, from the Velocity Magnitude drop-down list, select New Input
Parameter....

This displays the Input Parameter Properties dialog box.

e. Enter in_velocity for the Name, and enter 0.5 m/s for the Current Value.

f. Click OK to close the Input Parameter Properties dialog box.

g. Under the Turbulence group box, from the Specification Method drop-down list, select Intensity
and Hydraulic Diameter.

h. Retain the value of 5  for Turbulent Intensity.
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i. Enter 0.061 for Hydraulic Diameter (m).

2. Define an input parameter called in_temp for the temperature at the inlet boundary.

a. In the Thermal tab of the Velocity Inlet dialog box, select New Input Parameter... from the
Temperature drop-down list.

b. Enter in_temp for the Name and enter 310 K for the Current Value in the Input Parameter
Properties dialog box.

c. Click OK to close the Input Parameter Properties dialog box.

d. Click OK to close the Velocity Inlet dialog box.

3. Review all of the input parameters that you have defined in ANSYS Fluent under the Parameters & Cus-
tomization/Parameters tree branch.

Parameters & Customization → Parameters → Input Parameters

Figure 2.13: The Input Parameters Sub-Branch in ANSYS Fluent
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These parameters are passed to ANSYS Fluent component system in ANSYS Workbench and are
available for editing in ANSYS Workbench (see Figure 2.14: The Parameters View in ANSYS Work-
bench (p. 95)).

Figure 2.14: The Parameters View in ANSYS Workbench

4. Set the turbulence parameters for backflow at the front outlets and foot outlets.

a. In the Boundary Conditions task page, type outlet in the Zone filter text entry field. Note that as
you type, the names of the boundary zones beginning with the characters you entered appear in the
boundary condition zone list.

Note

• The search string can include wildcards. For example, entering *let* will display all zone
names containing let, such as inlet and outlet.

• To display all zones again, click the red X icon in the Zone filter.

b. Double-click outlet-front-mid.
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c. In the Pressure Outlet dialog box, under the Turbulence group box, select Intensity and Hydraulic
Diameter from the Specification Method drop-down list.

d. Retain the value of 5 for Backflow Turbulent Intensity (%).

e. Enter 0.044 for Backflow Hydraulic Diameter (m).

These values will only be used if reversed flow occurs at the outlets. It is a good idea to set reasonable
values to prevent adverse convergence behavior if backflow occurs during the calculation.

f. Click OK to close the Pressure Outlet dialog box.

g. Copy the boundary conditions from outlet-front-mid to the other front outlet.

Setup → Boundary Conditions → outlet-front-mid Copy...
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i. Confirm that outlet-front-mid is selected in the From Boundary Zone selection list.

ii. Select outlet-front-side-left in the To Boundary Zones selection list.

iii. Click Copy to copy the boundary conditions.

Fluent will display a dialog box asking you to confirm that you want to copy the boundary con-
ditions.

iv. Click OK to confirm.

v. Close the Copy Conditions dialog box.

h. In a similar manner, set the backflow turbulence conditions for outlet-foot-left using the values in the
following table:

ValueParameter

Intensity and Hydraulic DiameterSpecification Method

5Backflow Turbulent Intensity (%)

0.052Backflow Hydraulic Diameter (m)

2.4.5. Solving

In the steps that follow, you will set up and run the calculation using the Solving ribbon tab.

Note

You can also use the task pages listed under the Solution branch in the tree to perform
solution-related activities.

1. Set the Solution Methods.

Solving → Solution → Methods...
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This will open the Solution Methods task page.

a. From the Scheme drop-down list, select Coupled.

The pressure-based coupled solver is the recommended choice for general fluid flow simulations.

b. In the Spatial Discretization group box, configure the following settings:

ValueSetting

PRESTO!Pressure

First Order UpwindMomentum

First Order UpwindEnergy
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This tutorial is primarily intended to demonstrate the use of parameterization and design points
when running Fluent from Workbench. Therefore, you will run a simplified analysis using first
order discretization, which will yield faster convergence. These settings were chosen to speed up
solution time for this tutorial. Usually, for cases like this, we would recommend higher order
discretization settings to be set for all flow equations to ensure improved results accuracy.

2. Initialize the flow field using the Initialization group of the Solving ribbon tab.

Solving → Initialization

a. Retain the default selection of Hybrid Initialization.

b. Click the Initialize button.

3. Run the simulation in ANSYS Fluent from the Run Calculation group of the Solving tab.

Solving → Run Calculation

a. For Number of Iterations, enter 1000.

b. Click the Calculate button.

The solution converges within approximately 55 iterations.

Throughout the calculation, Fluent displays a warning in the console regarding reversed flow at the
outlets. This behavior is expected in this case since air is redirected to the outlets, creating small regions
of recirculation.

Note

The warning message can be switched off by setting the solve/set/flow-warnings
text user interface (TUI) command to no in the console.

4. Close Fluent.

File → Close Fluent

5. Save the project in ANSYS Workbench.
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File → Save

2.4.6. Postprocessing and Setting the Output Parameters in ANSYS CFD-Post

In this step, you will visualize the results of your CFD simulation using ANSYS CFD-Post. You will plot
vectors that are colored by pressure, velocity, and temperature, on a plane within the geometry. In ad-
dition, you will create output parameters within ANSYS CFD-Post for later use in ANSYS Workbench.

In the ANSYS Workbench Project Schematic, double-click the Results cell in the ANSYS Fluent fluid
flow analysis system to start CFD-Post. You can also right-click the Results cell to display the context
menu where you can select the Edit... option.

The CFD-Post application appears with the automotive HVAC geometry already loaded and displayed
in outline mode. Note that ANSYS Fluent results (that is, the case and data files) are also automatically
loaded into CFD-Post.

Figure 2.15: The Automotive HVAC Geometry Loaded into CFD-Post

1. Edit some basic settings in CFD-Post (for example, changing the background color to white).

Edit → Options...

a. In the Options dialog box, select Viewer under CFD-Post in the tree view.
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b. Under the Background group, from the Color Type drop-down list, select Solid.

c. Click the Color sample bar to cycle through common color swatches until it displays white.

Tip

You can also click the ellipsis icon  to bring up a color selector dialog box from
which you can choose an arbitrary color.

d. Click OK to set the white background color for the display and close the Options dialog box.

2. Adjust the color-map legend to show the numbers in floating format.

a. In the Outline tree view, double-click Default Legend View 1 to display the Details view for
the default legend to be used for your plots.

b. In the Definition tab of the Details view, from the Title Mode drop-down list, select Variable.
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c. In the Appearance tab, set the Precision to 2 and Fixed.

d. Click Apply to set the display.

3. Plot vectors colored by pressure.

a. From the main menu, select Insert → Vector or click  in the ANSYS CFD-Post toolbar.

This displays the Insert Vector dialog box.

b. Keep the default name of Vector 1 by clicking OK.

c. In the Details view for Vector 1, under the Geometry tab, configure the following settings.
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i. Ensure All Domains is selected from the Domains drop-down list.

ii. From the Locations drop-down list, select symmetry central unit.

iii. From the Sampling drop-down list, select Equally Spaced.

iv. Set the # of Points to 10000.

v. From the Projection drop-down list, select Tangential.

d. In the Color tab, configure the following settings.

i. From the Mode drop-down list, select Variable.
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ii. From the Variable drop-down list, select Pressure.

e. In the Symbol tab, configure the following settings.

i. Set the Symbol Size to 0.05.

ii. Enable Normalize Symbols.

f. Click Apply.

Vector 1 appears under User Locations and Plots in the Outline tree view.

In the graphics display window, note that symmetry-central-unit shows the vectors colored by
pressure. Use the controls in CFD-Post to rotate the geometry (for example, clicking the dark blue
axis in the axis triad of the graphics window). Zoom into the view as shown in Figure 2.16: Vectors
Colored by Pressure (p. 105).

Note

To better visualize the vector display, you can deselect the Wireframe view option
under User Locations and Plots in the Outline tree view.
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Figure 2.16: Vectors Colored by Pressure

4. Plot vectors colored by velocity.

a. In the Details view for Vector 1, under the Color tab, configure the following settings.

i. Select Velocity from the Variable drop-down list.

ii. Click Apply.

The velocity vector plot appears on the symmetry-central-unit symmetry plane.
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Figure 2.17: Vectors Colored by Velocity

5. Plot vectors colored by temperature.

a. In the Details view for Vector 1, under the Color tab, configure the following settings.

i. Select Temperature from the Variable drop-down list.

ii. Select User Specified from the Range drop-down list.

iii. Enter 273 K for the Min temperature value.

iv. Enter 310 K for the Max temperature value.

v. Click Apply.

The user-specified range is selected much narrower than the Global and Local ranges in order
to better show the variation.
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Figure 2.18: Vectors Colored by Temperature

Note the orientation of the various valves and how they impact the flow field. Later in this tutorial, you
will change these valve angles to see how the flow field changes.

6. Create two surface groups.

Surface groups are collections of surface locations in CFD-Post. In this tutorial, two surface groups
are created in CFD-Post that will represent all of the outlets and all of the front outlets. Once created,
specific commands (or expressions) will be applied to these groups in order to calculate a particular
numerical value at that surface.

a. Create a surface group consisting of all outlets.

i. With the Outline tree view open in the CFD-Post tree view, open the Insert Surface Group dialog
box.

Insert → Location → Surface Group
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ii. Enter alloutlets for the Name of the surface group, and click OK to close the Insert Surface
Group dialog box.

iii. In the Details view for the alloutlets surface group, in the Geometry tab, click the ellipsis icon

 next to Locations to display the Location Selector dialog box.

iv. Select all of the outlet surfaces (outlet foot left,outlet front mid,outlet front
side left, and outlet windshield) in the Location Selector dialog box (hold Ctrl for
multiple selection) and click OK.

v. Click Apply in the Details view for the new surface group.

alloutlets appears under User Locations and Plots in the Outline tree view.

b. Create a surface group for the front outlets.
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Perform the same steps as described above to create a surface group called frontoutlets
with locations for the front outlets (outlet front mid and outlet front side left).

7. Create expressions in CFD-Post and mark them as ANSYS Workbench output parameters.

In this tutorial, programmatic commands or expressions are written to obtain numerical values for
the mass flow rate from all outlets, as well as at the front outlets, windshield, and foot outlets. The
surface groups you defined earlier are used to write the expressions.

a. Create an expression for the mass flow from all outlets.

i. With the Expressions tab open in the CFD-Post tree view, open the Insert Expression dialog box.

Insert → Expression

ii. Enter floutfront for the Name of the expression and click OK to close the Insert Expression
dialog box.

iii. In the Details view for the new expression, enter the following in the Definition tab.

-(massFlow()@frontoutlets)*2

The sign convention for massFlow() is such that a positive value represents flow into the domain
and a negative value represents flow out of the domain. Since you are defining an expression for
outflow from the ducts, you use the negative of the massFlow() result in the definition of the
expression.

iv. Click Apply to obtain a Value for the expression.

Note the new addition in the list of expressions in the Expressions tab in CFD-Post.

In this case, there is a small net backflow into the front ducts.
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v. Right-click the new expression and select Use as Workbench Output Parameter from the context
menu. A small “P” with a right-pointing arrow appears on the expression’s icon.

b. Create an expression for the mass flow from the wind shield.
i. Perform the same steps as described above to create an expression called floutwindshield

with the following definition:

-(massFlow()@outlet windshield)*2

ii. Right-click the new expression and select Use as Workbench Output Parameter from the context
menu.

c. Create an expression for the mass flow from the foot outlets.
i. Perform the same steps as described above to create an expression called floutfoot with the

following definition:

-(massFlow()@outlet foot left)*2

ii. Right-click the new expression and select Use as Workbench Output Parameter from the context
menu.

d. Create an expression for the mass weighted average outlet temperature.
i. Perform the same steps as described above to create an expression called outlettemp with the

following definition:

massFlowAveAbs(Temperature)@alloutlets

ii. Right-click the new expression and select Use as Workbench Output Parameter from the context
menu.

8. Close ANSYS CFD-Post.

In the main menu, select File → Close CFD-POST to return to ANSYS Workbench.

9. In the Outline of All Parameters view of the Parameter Set tab (double-click Parameter Set), review the
newly-added output parameters that you specified in ANSYS CFD-Post and when finished, click the Project
tab to return to the Project Schematic.

10. If any of the cells in the analysis system require attention, update the project by clicking the Update Project
button in the ANSYS Workbench toolbar.

11. Optionally, review the list of files generated by ANSYS Workbench. If the Files view is not open, select View
→ Files from the main menu.

You will notice additional files associated with the latest solution as well as those generated by CFD-
Post.
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Figure 2.19: The Updated Project Loaded into ANSYS Workbench Displaying the Files View

12. Save the project in ANSYS Workbench.

In the main menu, select File → Save

Note

You can also select the Save Project option from the CFD-Post File ribbon tab.

2.4.7. Creating Additional Design Points in ANSYS Workbench

Parameters and design points are tools that allow you to analyze and explore a project by giving you
the ability to run optimization and what-if scenarios. Design points are based on sets of parameter
values. When you define input and output parameters in your ANSYS Workbench project, you are es-
sentially working with a design point. To perform optimization and what-if scenarios, you create multiple
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design points based on your original project. In this step, you will create additional design points for
your project where you will be able to perform a comparison of your results by manipulating input
parameters (such as the angles of the various valves within the automotive HVAC geometry). ANSYS
Workbench provides a Table of Design Points to make creating and manipulating design points more
convenient.

1. Open the Table of Design Points.

a. In the Project Schematic, double-click the Parameter Set bus bar to open the Table of Design
Points view. If the table is not visible, select Table from the View menu in ANSYS Workbench.

View → Table

The table of design points initially contains the current project as a design point (DP0),
along with its corresponding input and output parameter values.

Figure 2.20: Table of Design Points (with DP0)

From this table, you can create new design points (or duplicate existing design points) and
edit them (by varying one or more input parameters) to create separate analyses for future
comparison of data.

2. Create a design point (DP1) by duplicating the current design point (DP0).

a. Right-click the Current design point and select Duplicate Design Point from the context menu.

The cells autofill with the values from the Current row.

b. Scroll over to the far right to expose the Retain column in the table of design points, and ensure
the check box in the row for the duplicated design point DP 1 (cell N4) is selected.

This allows the data from this new design point to be saved before it is exported for future
analysis.

3. Create another design point (DP2) by duplicating the DP1 design point.

a. Right-click the DP1 design point and select Duplicate Design Point from the context menu.

Since this is a duplicate of DP1, this design point will also have its data retained.

4. Edit values for the input parameters for DP1 and DP2.

For DP1 and DP2, edit the values for your input parameters within the Table of Design Points
as follows:

in_tempin_velocityinput_wsfposinput_ftposinput_hcpos

3000.6454545DP1

2900.7156090DP2
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Figure 2.21: Table of Design Points (with DP0, DP1, and DP2 Defined)

For demonstration purposes of this tutorial, in each design point, you are slightly changing the
angles of each of the valves, and increasing the inlet velocity and the inlet temperature. Later,
you will see how the results in each case vary.

5. Update all of your design points.

Click the Update all Design Points button in the ANSYS Workbench toolbar. Alternatively, you
can also select one or more design points, right-click, and select Update Selected Design
Points from the context menu. Click OK to acknowledge the information message notifying
you that some open editors may close during the update process. By updating the design
points, ANSYS Workbench takes the new values of the input parameters for each design point
and updates the components of the associated system (for example, the geometry, mesh, set-
tings, solution, and results), as well as any output parameters that have been defined.

Note

It may take significant time and/or computing resources to re-run the simulations
for each design point.

6. Export the design points to separate projects.

This will allow you to work with calculated data for each design point.

a. Select the three design points, DP0, DP1, and DP2 (hold Shift for multiple selection).

b. Right-click the selected design points and select Export Selected Design Points.

Note the addition of three more ANSYS Workbench project files (and their corresponding
folders) in your current working directory (fluent-workbench-param_dp0.wbpj,
fluent-workbench-param_dp1.wbpj and fluent-workbench-param_dp2.wbpj).
You can open each of these projects up separately and examine the results of each para-
meterized simulation.

Tip

You can easily access files in your project directory directly from the Files view by
right-clicking any cell in the corresponding row and selecting Open Containing
Folder from the menu that opens.

7. Inspect the output parameter values in ANSYS Workbench.
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Once all design points have been updated, you can use the table of design points to inspect
the values of the output parameters you created in CFD-Post (for example, the mass flow
parameters at the various outlets: floutfront, floutfoot, floutwindshield, and
outlettemp). These, and the rest of the output parameters are listed to the far right in the
table of design points.

Figure 2.22: Table of Design Points (Showing Output Parameters for DP0, DP1, and
DP2)

8. Click the Project tab, just above the ANSYS Workbench toolbar to return to the Project Schematic.

9. View the list of files generated by ANSYS Workbench (optional).

View → Files

The additional files for the new design points are stored with their respective project files since
you exported them.

10. Save the project in the current state in ANSYS Workbench.

In the main menu, select File → Save.

11. Quit ANSYS Workbench.

In the main menu, select File → Exit.

2.4.8. Postprocessing the New Design Points in CFD-Post

In this section, you will open the ANSYS Workbench project for each of the design points and inspect
the vector plots based on the new results of the simulations.

1. Study the results of the first design point (DP1).

a. Open the ANSYS Workbench project for the first design point (DP1).

In your current working folder, double-click the fluent-workbench-param_dp1.wbpj
file to open ANSYS Workbench.

b. Open CFD-Post by double-clicking the Results cell in the Project Schematic for the Fluid Flow
(Fluent) analysis system.

c. View the vector plot colored by temperature. Ensure that Range in the Color tab is set to User
Specified and the Min and Max temperature values are set to 273 K and 310 K, respectively.
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Figure 2.23: Vectors Colored by Temperature (DP1)

d. View the vector plot colored by pressure. Ensure that Range in the Color tab is set to Global.
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Figure 2.24: Vectors Colored by Pressure (DP1)

e. View the vector plot colored by velocity. Ensure that Range in the Color tab is set to Global.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.116

Parametric Analysis in ANSYS Workbench Using ANSYS Fluent



Figure 2.25: Vectors Colored by Velocity (DP1)

f. When you are finished viewing results of the design point DP1 in ANSYS CFD-Post, select File →
Close CFD-Post to quit ANSYS CFD-Post and return to the ANSYS Workbench Project Schematic,
and then select File → Exit to exit from ANSYS Workbench.

2. Study the results of the second design point (DP2).

a. Open the ANSYS Workbench project for the second design point (DP2).

In your current working folder, double-click the fluent-workbench-param_dp2.wbpj
file to open ANSYS Workbench.

b. Open CFD-Post by double-clicking the Results cell in the Project Schematic for the Fluid Flow
(Fluent) analysis system.
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c. View the vector plot colored by temperature. Ensure that Range in the Color tab is set to User
Specified and the Min and Max temperature values are set and the Min and Max temperature
values are set to 273 K and 310 K, respectively.

Figure 2.26: Vectors Colored by Temperature (DP2)

d. View the vector plot colored by pressure. Ensure that Range in the Color tab is set to Global.
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Figure 2.27: Vectors Colored by Pressure (DP2)

e. View the vector plot colored by velocity. Ensure that Range in the Color tab is set to Global.
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Figure 2.28: Vectors Colored by Velocity (DP2)

3. When you are finished viewing results in ANSYS CFD-Post, select File → Close CFD-Post to quit ANSYS
CFD-Post and return to the ANSYS Workbench Project Schematic, and then select File → Exit to exit
from ANSYS Workbench.

2.4.9. Summary

In this tutorial, input and output parameters were created within ANSYS Workbench, ANSYS Fluent, and
ANSYS CFD-Post in order to study the airflow in an automotive HVAC system. ANSYS Fluent was used
to calculate the fluid flow throughout the geometry using the computational mesh, and ANSYS CFD-
Post was used to analyze the results. ANSYS Workbench was used to create additional design points
based on the original settings, and the corresponding simulations were run to create separate projects
where parameterized analysis could be performed to study the effects of variable angles of the inlet
valves, velocities, and temperatures. Also, note that simplified solution settings were used in this tutorial
to speed up the solution time. For more improved solution accuracy, you would typically use denser
mesh and higher order discretization for all flow equations.
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Chapter 3: Introduction to Using ANSYS Fluent: Fluid Flow and Heat
Transfer in a Mixing Elbow

This tutorial is divided into the following sections:
3.1. Introduction
3.2. Prerequisites
3.3. Problem Description
3.4. Setup and Solution in Serial
3.5. Setup and Solution in Parallel
3.6. Summary

3.1. Introduction

This tutorial illustrates the setup and solution of a three-dimensional turbulent fluid flow and heat
transfer problem in a mixing elbow. The mixing elbow configuration is encountered in piping systems
in power plants and process industries. It is often important to predict the flow field and temperature
field in the area of the mixing region in order to properly design the junction.

This tutorial demonstrates how to do the following:

• Launch the serial version of ANSYS Fluent.

• Read an existing mesh file into ANSYS Fluent.

• Use mixed units to define the geometry and fluid properties.

• Set material properties and boundary conditions for a turbulent forced-convection problem.

• Create a surface report definition and use it as a convergence criterion.

• Calculate a solution using the pressure-based solver.

• Visually examine the flow and temperature fields using the postprocessing tools available in ANSYS Fluent.

• Change the solver method to coupled in order to increase the convergence speed.

• Adapt the mesh based on the temperature gradient to further improve the prediction of the temperature
field.

• Run the ANSYS Fluent solver in parallel.

3.2. Prerequisites

This tutorial assumes that you have little or no experience with ANSYS Fluent, and so each step will be
explicitly described.
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3.3. Problem Description

The problem to be considered is shown schematically in Figure 3.1: Problem Specification (p. 122). A
cold fluid at 20° C flows into the pipe through a large inlet, and mixes with a warmer fluid at 40° C that
enters through a smaller inlet located at the elbow. The pipe dimensions are in inches and the fluid
properties and boundary conditions are given in SI units. The Reynolds number for the flow at the larger
inlet is 50,800, so a turbulent flow model will be required.

Note

Since the geometry of the mixing elbow is symmetric, only half of the elbow must be modeled
in ANSYS Fluent.

Figure 3.1:  Problem Specification

3.4. Setup and Solution in Serial

To help you quickly identify graphical user interface items at a glance and guide you through the steps
of setting up and running your simulation, the ANSYS Fluent Tutorial Guide uses several type styles and
mini flow charts. See Typographical Conventions Used In This Manual (p. xvi) for detailed information.

The following sections describe the setup and solution steps for running this tutorial in serial:
3.4.1. Preparation
3.4.2. Launching ANSYS Fluent
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3.4.3. Reading the Mesh
3.4.4. Setting Up Domain
3.4.5. Setting Up Physics
3.4.6. Solving
3.4.7. Displaying the Preliminary Solution
3.4.8. Using the Coupled Solver
3.4.9. Adapting the Mesh

3.4.1. Preparation

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the introduction_R180.zip link to download the input files.

7. Unzip the introduction_R180.zip file you downloaded to your working folder. This file contains a
folder,introduction, that holds the file elbow.msh that you will use in this tutorial.

Note

ANSYS Fluent tutorials are prepared using ANSYS Fluent on a Windows system. The screen
shots and graphic images in the tutorials may be slightly different than the appearance on
your system, depending on the operating system and/or graphics card.

3.4.2. Launching ANSYS Fluent

1. From the Windows Start menu, select Start > All Programs > ANSYS 18.0 > Fluid Dynamics > Fluent
18.0 to start Fluent Launcher.

Fluent Launcher allows you to decide which version of ANSYS Fluent you will use, based on your
geometry and on your processing capabilities.
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2. Ensure that the proper options are enabled.

a. Select 3D from the Dimension list by clicking the radio button or the text.

b. Select Serial from the Processing Options list.

c. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

Note

An option is enabled when there is a check mark in the check box, and disabled when
the check box is empty. To change an option from disabled to enabled (or vice versa),
click the check box or the text.

d. Ensure that the Double Precision option is disabled.

Note

Fluent will retain your preferences for future sessions.

Extra

You can also restore the default settings by clicking the Default button.

3. Set the working folder to the one created when you unzipped introduction_R180.zip.
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a. Click the Show More Options button to reveal additional options.

b. Enter the path to your working folder for Working Directory by double-clicking the text box and typing.

Alternatively, you can click the browse button ( ) next to the Working Directory text box
and browse to the directory, using the Browse For Folder dialog box.

4. Click OK to launch ANSYS Fluent.
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3.4.3. Reading the Mesh

1. Read the mesh file elbow.msh.

Click the File ribbon tab, then click Read and Mesh... in the menus that open in order to open the
Select File dialog box.

File → Read → Mesh...
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a. Select the mesh file by clicking elbow.msh in the introduction folder created when you unzipped the
original file.

b. Click OK to read the file and close the Select File dialog box.

As the mesh file is read by ANSYS Fluent, messages will appear in the console reporting the progress
of the conversion. ANSYS Fluent will report that 13,852 hexahedral fluid cells have been read, along
with a number of boundary faces with different zone identifiers.

After having completed reading mesh, ANSYS Fluent displays the mesh in the graphics window.

Extra

You can use the mouse to probe for mesh information in the graphics window. If you
click the right mouse button with the pointer on any node in the mesh, information
about the associated zone will be displayed in the console, including the name of the
zone.

Alternatively, you can click the probe button ( ) in the graphics toolbar and click the
left mouse button on any node. This feature is especially useful when you have several
zones of the same type and you want to distinguish between them quickly.
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For this 3D problem, you can make it easier to probe particular nodes by changing the
view. The following table describes how to manipulate objects in the graphics window:

Table 3.1: View Manipulation Instructions

Using Graphics Toolbar Buttons and the MouseAction

After clicking the Rotate View icon, , press and hold the left mouse
button and drag the mouse. Dragging side to side rotates the view about

Rotate view
(vertical,
horizontal)

the vertical axis, and dragging up and down rotates the view about the
horizontal axis.

After clicking the Pan icon, , press and hold the left mouse button
and drag the object with the mouse until the view is satisfactory.

Translate or
pan view

After clicking the Zoom In/Out icon, , press and hold the left mouse
button and drag the mouse up and down to zoom in and out of the view.

Zoom in and
out of view

After clicking the Zoom to Area icon, , press and hold the left mouse
button and drag the mouse diagonally to the right. This action will cause

Zoom to
selected area

a rectangle to appear in the display. When you release the mouse button,
a new view will be displayed that consists entirely of the contents of the
rectangle. Note that to zoom in, you must drag the mouse to the right,
and to zoom out, you must drag the mouse to the left.

Clicking the Fit to Window icon, , will cause the object to fit exactly and be centered
in the window.

After you have clicked a button in the graphics toolbar, you can return to the default

mouse button settings by clicking .

To judge the scale of your 3D geometry, you can click the Orthographic Projection icon,

. This will display the length scale ruler near the bottom of the graphics window.

Note that you can change the default mouse button actions in the Viewing tab (in the
Mouse group box). For more information, see the Fluent User's Guide.

2. Manipulate the mesh display using the Views dialog box to obtain a front view as shown in Figure 3.2: The
Hexahedral Mesh for the Mixing Elbow (p. 130).

In the Viewing ribbon tab, locate the Display group box.
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Then click the Views... button to open the Views dialog box.

Viewing → Display → Views...

Note

You can also open the Views dialog box from the tree, by expanding Results, right-
clicking Graphics, and selecting Views....

Results → Graphics Views...

a. Select front from the Views selection list.

Note

A list item is selected if it is highlighted, and deselected if it is not highlighted.

b. Click Apply and close the Views dialog box.
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Figure 3.2: The Hexahedral Mesh for the Mixing Elbow

Extra

You can also change the orientation of the objects in the graphics window using the

axis triad  as follows:

• To orient the model in the positive/negative direction, click an axis/semi-sphere.

• To orient the model in the negative/positive direction, right-click an axis/semi-sphere.

• To set the isometric view, click the cyan iso-ball.
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• To perform in-plane clockwise or counterclockwise 90° rotations, click the white rotational
arrows .

• To perform free rotations in any direction, click and hold—in the vicinity of the triad—and
use the mouse. Release the left mouse button to stop rotating.

3.4.4. Setting Up Domain

In this step, you will perform the mesh-related activities using the Setting Up Domain ribbon tab (Mesh
group box).

1. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will report the results of the mesh check in the console.

 Domain Extents:
   x-coordinate: min (m) = -8.000000e+00, max (m) = 8.000000e+00
   y-coordinate: min (m) = -9.134633e+00, max (m) = 8.000000e+00
   z-coordinate: min (m) = 0.000000e+00, max (m) = 2.000000e+00
 Volume statistics:
   minimum volume (m3): 5.098298e-04
   maximum volume (m3): 2.330736e-02
     total volume (m3): 1.607154e+02
 Face area statistics:
   minimum face area (m2): 4.865882e-03
   maximum face area (m2): 1.017924e-01
 Checking mesh.........................
Done.

The mesh check will list the minimum and maximum x, y, and z values from the mesh in the default
SI unit of meters. It will also report a number of other mesh features that are checked. Any errors
in the mesh will be reported at this time. Ensure that the minimum volume is not negative, since
ANSYS Fluent cannot begin a calculation when this is the case.

Note

The minimum and maximum values may vary slightly when running on different platforms.

2. Scale the mesh.

Setting Up Domain → Mesh → Scale...
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a. Ensure that Convert Units is selected in the Scaling group box.

b. From the Mesh Was Created In drop-down list, select in by first clicking the down-arrow button and
then clicking the in item from the list that appears.

c. Click Scale to scale the mesh.

Warning

Be sure to click the Scale button only once.

Domain Extents will continue to be reported in the default SI unit of meters.

d. Select in from the View Length Unit In drop-down list to set inches as the working unit for length.

e. Confirm that the domain extents are as shown in the previous dialog box.

f. Close the Scale Mesh dialog box.

The mesh is now sized correctly and the working unit for length has been set to inches.

Note

Because the default SI units will be used for everything except length, there is no need
to change any other units in this problem. The choice of inches for the unit of length has
been made by the actions you have just taken. If you want a different working unit for
length, other than inches (for example, millimeters), click Units... in the Setting Up Do-
main ribbon tab (Mesh group box) and make the appropriate change in the Set Units
dialog box.
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3. Check the mesh.

Setting Up Domain → Mesh → Check

Note

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to
polyhedra, merge, separate, fuse, add zones, or smooth and swap). This will ensure that
the quality of the mesh has not been compromised.

3.4.5. Setting Up Physics

In the steps that follow, you will select a solver and specify physical models, material properties, and
zone conditions for your simulation using the Setting Up Physics ribbon tab.

1. In the Solver group box of the Setting Up Physics ribbon tab, retain the default selection of the steady
pressure-based solver.

Setting Up Physics → Solver

2. Set up your models for the CFD simulation using the Models group box of the Setting Up Physics ribbon
tab.

Note

You can also use the Models task page, which can be accessed from the tree by expanding
Setup and double-clicking the Models tree item.

a. Enable heat transfer by activating the energy equation.

In the Setting Up Physics ribbon tab, enable Energy (Models group box).
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Setting Up Physics → Models → Energy

Note

You can also double-click the Setup/Models/Energy tree item and enable the energy
equation in the Energy dialog box.

b. Enable the -  turbulence model.

Setting Up Physics → Models → Viscous...
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i. Select k-epsilon from the Model list.

The Viscous Model dialog box will expand.

ii. Retain the default selection of Standard in the k-epsilon Model group box.
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iii. Select Enhanced Wall Treatment in the Near-Wall Treatment group box.

Note

The default Standard Wall Functions are generally applicable if the first cell center
adjacent to the wall has a y+ larger than 30. In contrast, the Enhanced Wall
Treatment option provides consistent solutions for all y+ values. Enhanced Wall
Treatment is recommended when using the k-epsilon model for general single-
phase fluid flow problems. For more information about Near Wall Treatments in
the k-epsilon model, refer to the Fluent User's Guide.

iv. Click OK to accept all the other default settings and close the Viscous Model dialog box.

Note that the Viscous... label in the ribbon is displayed in blue to indicate that the Viscous
model is enabled. Also Energy and Viscous appear as enabled under the Setup/Models tree
branch.

Note

While the ribbon is the primary tool for setting up and solving your problem, the
tree is a dynamic representation of your case. The models, materials, conditions,
and other settings that you have specified in your problem will appear in the tree.
Many of the frequently used ribbon items are also available via the right-click
functionality of the tree.

3. Set up the materials for the CFD simulation using the Materials group box of the Setting Up Physics ribbon
tab.

Create a new material called water using the Create/Edit Materials dialog box.

a. In the Setting Up Physics ribbon tab, click Create/Edit... (Materials group box).

Setting Up Physics → Materials → Create/Edit...
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b. Enter water for Name.

c. Enter the following values in the Properties group box:

ValueProperty

1000 [kg/m3]Density

4216 [J/kg-K] (Specific Heat)

0.677 [W/m-K]Thermal Conductivity

8e-04 [kg/m-s]Viscosity

d. Click Change/Create.

A Question dialog box will open, asking if you want to overwrite air. Click No so that the new mater-
ial water is added to the Fluent Fluid Materials list of materials that originally contained only air.

Extra

You could have copied the material water-liquid (h2o < l >) from the materials
database (accessed by clicking the Fluent Database... button). If the properties in
the database are different from those you want to use, you can edit the values in the
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Properties group box in the Create/Edit Materials dialog box and click
Change/Create to update your local copy. The original copy will not be affected.

e. Ensure that there are now two materials (water and air) defined locally by examining the Fluent Fluid
Materials drop-down list.

Both the materials will also be listed under Fluid in the Materials task page and under the Materials
tree branch.

f. Close the Create/Edit Materials dialog box.

4. Set up the cell zone conditions for the fluid zone (fluid) using the Zones group box of the Setting Up
Physics ribbon tab.

a. In the Setting Up Physics tab, click Cell Zones (Zones group box).

Setting Up Physics → Zones → Cell Zones

This opens the Cell Zone Conditions task page.
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b. Double-click fluid in the Zone list to open the Fluid dialog box.
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Note

You can also double-click the Setup/Cell Zone Conditions/fluid tree item in order
to open the corresponding dialog box.

c. Select water from the Material Name drop-down list.

d. Click OK to close the Fluid dialog box.

5. Set up the boundary conditions for the inlets, outlet, and walls for your CFD analysis using the Zones group
box of the Setting Up Physics ribbon tab.

a. In the Setting Up Physics tab, click Boundaries (Zones group box).

Setting Up Physics → Zones → Boundaries

This opens the Boundary Conditions task page where the boundaries defined in your simulation
are displayed in the Zone selection list.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.140

Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow



Note

To display boundary zones grouped by zone type (as shown previously), click the

Toggle Tree View button ( ) in the upper right corner of the Boundary Conditions
task page and select Zone Type under Group By.

Here the zones have names with numerical identifying tags. It is good practice to give boundaries
meaningful names in a meshing application to help when you set up the model. You can also
change boundary names in Fluent by simply editing the boundary and making revisions in the
Zone Name text box.
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b. Set the boundary conditions at the cold inlet (velocity-inlet-5).

Tip

If you are unsure of which inlet zone corresponds to the cold inlet, you can probe
the mesh display using the right mouse button or the probe toolbar button

( ) as described previously in this tutorial. The information will be displayed
in the ANSYS Fluent console, and the zone you probed will be automatically se-
lected from the Zone selection list in the Boundary Conditions task page.

i. Double-click velocity-inlet-5 to open the Velocity Inlet dialog box.

ii. Retain the default selection of Magnitude, Normal to Boundary from the Velocity Specification
Method drop-down list.

iii. Enter 0.4 [m/s] for Velocity Magnitude.

iv.  In the Turbulence group box, select Intensity and Hydraulic Diameter from the Specification
Method drop-down list.

v. Retain the default value of 5 [%] for Turbulent Intensity.

vi. Enter 4 [inches] for Hydraulic Diameter.

The hydraulic diameter  is defined as:
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where  is the cross-sectional area and  is the wetted perimeter.

vii. Click the Thermal tab.

viii.Enter 293.15 [K] for Temperature.

ix. Click OK to close the Velocity Inlet dialog box.

Note

You can also access the Velocity Inlet dialog box by double-clicking the
Setup/Boundary Conditions/velocity-inlet-5 tree item.

c. In a similar manner, set the boundary conditions at the hot inlet (velocity-inlet-6), using the values in
the following table:

ValueSetting

Magnitude, Normal to BoundaryVelocity Specification Method

1.2 [m/s]Velocity Magnitude

Intensity and Hydraulic DiameterSpecification Method

5 [%]Turbulent Intensity

1 [inch]Hydraulic Diameter

313.15 [K]Temperature
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d. Double-click pressure-outlet-7 in the Zone selection list and set the boundary conditions at the outlet,
as shown in the following figure.

Note

• You do not need to set a backflow temperature in this case (in the Thermal tab) because
the material properties are not functions of temperature. If they were, a flow-weighted
average of the inlet conditions would be a good starting value.

• ANSYS Fluent will use the backflow conditions only if the fluid is flowing into the compu-
tational domain through the outlet. Since backflow might occur at some point during the
solution procedure, you should set reasonable backflow conditions to prevent convergence
from being adversely affected.

e. For the wall of the pipe (wall), retain the default value of 0 W/m2 for Heat Flux in the Thermal tab.
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3.4.6. Solving

In the steps that follow, you will set up and run the calculation using the Solving ribbon tab.

Note

You can also use the task pages listed under the Solution tree branch to perform solution-
related activities.

1. Select a solver scheme.

a. In the Solving ribbon tab, click Methods... (Solution group box).

Solving → Solution → Methods...
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b. In the Solution Methods task page, retain the default selections for the Scheme and Spatial Discret-
ization.

2. Enable the plotting of residuals during the calculation.

a. In the Solving ribbon tab, click Residuals... (Reports group box).

Solving → Reports → Residuals...
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Note

You can also access the Residual Monitors dialog box by double-clicking the Solu-
tion/Monitors/Residual tree item.

b. Ensure that Plot is enabled in the Options group box.

c. Retain the default value of 0.001 for the Absolute Criteria of continuity.

d. Click OK to close the Residual Monitors dialog box.

Note

By default, the residuals of all of the equations solved for the physical models enabled
for your case will be monitored and checked by ANSYS Fluent as a means to determine
the convergence of the solution. It is a good practice to also create and plot a surface
report definition that can help evaluate whether the solution is truly converged. You will
do this in the next step.

3. Create a surface report definition of average temperature at the outlet (pressure-outlet-7).

Solving → Reports → Definitions → New → Surface Report → Mass-Weighted Average...
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Note

You can also access the Surface Report Definition dialog box by right-clicking Report
Definitions in the tree (under Solution) and selecting New/Surface Report/Mass-
Weighted Average... from the menu that opens.

a. Enter outlet-temp-avg for the Name of the report definition.

b. Enable Report File, Report Plot, and Print to Console in the Create group box.

During a solution run, ANSYS Fluent will write solution convergence data in a report file, plot the
solution convergence history in a graphics window, and print the value of the report definition to the
console.

c. Set Frequency to 3 by clicking the up-arrow button.
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This setting instructs ANSYS Fluent to update the plot of the surface report, write data to a file, and
print data in the console after every 3 iterations during the solution.

d. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

e. Select pressure-outlet-7 from the Surfaces selection list.

f. Click OK to save the surface report definition and close the Surface Report Definition dialog box.

The new surface report definition outlet-temp-avg will appear under the Solution/Report
Definitions tree item. ANSYS Fluent also automatically creates the following items:

• outlet-temp-avg-rfile (under the Solution/Monitors/Report Files tree branch)

• outlet-temp-avg-rplot (under the Solution/Monitors/Report Plots tree branch)

4. In the tree, double-click outlet-temp-avg-rfile (under Solution/Monitors/Report Files) and examine the
report file settings in the Edit Report File dialog box.

The dialog box is automatically populated with data from the outlet-temp-avg report definition.

a. Verify that outlet-temp-avg is in the Selected Report Definitions list.

If you had created multiple report definitions, the additional ones would be listed under Available
Report Definitions, and you could use the Add>> and <<Remove buttons to manage which were
written in this particular report definition file.

b. (optional) Edit the name and location of the resulting file as necessary using the Output File Base
Name field or Browse... button.
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c. Click OK to close the Edit Report File dialog box.

5. Create a convergence condition for outlet-temp-avg.

Solving → Reports → Convergence...

a. Click the Add button.

b. Enter con-outlet-temp-avg for Conditions.

c. Select outlet-temp-avg from the Report Definition drop-down list.

d. Enter 1e-5 for Stop Criterion.

e. Enter 20 for Ignore Iterations Before.

f. Enter 15 for Use Iterations.

g. Enable Print.

h. Set Every Iteration to 3.

i. Click OK to save the convergence condition settings and close the Convergence Conditions dialog
box.

These settings will cause Fluent to consider the solution converged when the surface report definition
value for each of the previous 15 iterations is within 0.001% of the current value. Convergence of the
values will be checked every 3 iterations. The first 20 iterations will be ignored, allowing for any initial
solution dynamics to settle out. Note that the value printed to the console is the deviation between the
current and previous iteration values only.

6. Initialize the flow field using the Initialization group box of the Solving ribbon tab.
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Solving → Initialization

a. Retain the default selection of Hybrid from the Method list.

b. Click Initialize.

7. Save the case file (elbow1.cas.gz).

File → Write → Case...

a. (optional) Indicate the folder in which you would like the file to be saved.

By default, the file will be saved in the folder from which you read in elbow.msh (that is, the in-
troduction folder). You can indicate a different folder by browsing to it or by creating a new
folder.

b. Enter elbow1.cas.gz for Case File.
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Adding the extension .gz to the end of the file name extension instructs ANSYS Fluent to save
the file in a compressed format. You do not have to include .cas in the extension (for example,
if you enter elbow1.gz, ANSYS Fluent will automatically save the file as elbow1.cas.gz).
The .gz extension can also be used to save data files in a compressed format.

c. Ensure that the default Write Binary Files option is enabled, so that a binary file will be written.

d. Click OK to save the case file and close the Select File dialog box.

8. Start the calculation by requesting 150 iterations in the Solving ribbon tab (Run Calculation group box).

Solving → Run Calculation

a. Enter 150 for No. of Iterations.

b. Click Calculate.

Note

By starting the calculation, you are also starting to save the surface report data at the
rate specified in the Surface Report Definition dialog box. If a file already exists in
your working directory with the name you specified in the Edit Report File dialog
box, then a Question dialog box will open, asking if you would like to append the
new data to the existing file. Click No in the Question dialog box, and then click OK
in the Warning dialog box that follows to overwrite the existing file.

As the calculation progresses, the surface report history will be plotted in the outlet-temp-avg-
rplot tab in the graphics window (Figure 3.3: Convergence History of the Mass-Weighted Average
Temperature (p. 153)).
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Figure 3.3:  Convergence History of the Mass-Weighted Average Temperature

Similarly, the residuals history will be plotted in the Scaled Residuals tab in the graphics window
(Figure 3.4: Residuals (p. 154)).
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Figure 3.4:  Residuals

Note

You can monitor the two convergence plots simultaneously by right-clicking a tab in
the graphics window and selecting SubWindow View from the menu that opens. To
return to a tabbed graphics window view, right-click a graphics window title area and
select Tabbed View.

Since the residual values vary slightly by platform, the plot that appears on your screen may not
be exactly the same as the one shown here.

The solution will be stopped by ANSYS Fluent when any of the following occur:

• the surface report definition converges to within the tolerance specified in the Convergence
Conditions dialog box

• the residual monitors converge to within the tolerances specified in the Residual Monitors
dialog box

• the number of iterations you requested in the Run Calculation task page has been reached

In this case, the solution is stopped when the convergence criterion on outlet temperature is
satisfied, after approximately 72 iterations. The exact number of iterations for convergence will
vary, depending on the platform being used. An Information dialog box will open to alert you
that the calculation is complete. Click OK in the Information dialog box to proceed.
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9. Examine the plots for convergence (Figure 3.3: Convergence History of the Mass-Weighted Average Tem-
perature (p. 153) and Figure 3.4: Residuals (p. 154)).

Note

There are no universal metrics for judging convergence. Residual definitions that are
useful for one class of problem are sometimes misleading for other classes of problems.
Therefore it is a good idea to judge convergence not only by examining residual levels,
but also by monitoring relevant integrated quantities and checking for mass and energy
balances.

There are three indicators that convergence has been reached:

• The residuals have decreased to a sufficient degree.

The solution has converged when the Convergence Criterion for each variable has
been reached. The default criterion is that each residual will be reduced to a value of

less than 10–3, except the energy residual, for which the default criterion is 10–6.

• The solution no longer changes with more iterations.

Sometimes the residuals may not fall below the convergence criterion set in the case
setup. However, monitoring the representative flow variables through iterations may
show that the residuals have stagnated and do not change with further iterations. This
could also be considered as convergence.

• The overall mass, momentum, energy, and scalar balances are obtained.

You can examine the overall mass, momentum, energy and scalar balances in the Flux
Reports dialog box. The net imbalance should be less than 0.2 % of the net flux through
the domain when the solution has converged. In the next step you will check to see
if the mass balance indicates convergence.

10. Examine the mass flux report for convergence using the Postprocessing ribbon tab.

Postprocessing → Reports → Fluxes...
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a. Ensure that Mass Flow Rate is selected from the Options list.

b. Select pressure-outlet-7, velocity-inlet-5, and velocity-inlet-6 from the Boundaries selection list.

c. Click Compute.

The individual and net results of the computation will be displayed in the Results and Net Results
boxes, respectively, in the Flux Reports dialog box, as well as in the console.

The sum of the flux for the inlets should be very close to the sum of the flux for the outlets. The net
results show that the imbalance in this case is well below the 0.2% criterion suggested previously.

d. Close the Flux Reports dialog box.

11. Save the data file (elbow1.dat.gz).

File → Write → Data...

In later steps of this tutorial you will save additional case and data files with different suffixes.

3.4.7. Displaying the Preliminary Solution

In the steps that follow, you will visualize various aspects of the flow for the preliminary solution using
the Postprocessing ribbon tab.

1. Display filled contours of velocity magnitude on the symmetry plane (Figure 3.5: Predicted Velocity Distri-
bution after the Initial Calculation (p. 158)).

Postprocessing → Graphics → Contours → Edit...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.156

Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow



a. Enable Filled in the Options group box.

b. Ensure that Node Values is enabled in the Options group box.

c. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

d. Select symmetry from the Surfaces selection list.

e. Click Display to display the contours in the active graphics window. Clicking the Fit to Window icon

( ) will cause the object to fit exactly and be centered in the window.

Note

If you cannot see the velocity contour display, select the appropriate tab in the
graphics window.

f. Close the Contours dialog box.

g. Disable the Lighting option in the Viewing ribbon tab (in the Display group box).
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Figure 3.5:  Predicted Velocity Distribution after the Initial Calculation

Extra

When you probe a point in the displayed domain with the right mouse button or the
probe tool, the level of the corresponding contour is highlighted in the colormap in the
graphics window, and is also reported in the console.

2. Create and display a definition for temperature contours on the symmetry plane (Figure 3.6: Predicted
Temperature Distribution after the Initial Calculation (p. 160)).

Postprocessing → Graphics → Contours → New...

You can create contour definitions and save them for later use.
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a. Enter contour-temp for Contour Name.

b. Select Temperature... and Static Temperature from the Contours of drop-down lists.

c. Click Save/Display and close the Contours dialog box.

The new contour-temp definition appears under the Results/Graphics/Contours tree branch.
To edit your contour definition, right-click it and select Edit... from the menu that opens.
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Figure 3.6:  Predicted Temperature Distribution after the Initial Calculation

3. Display velocity vectors on the symmetry plane (Figure 3.9: Magnified View of Resized Velocity Vec-
tors (p. 164)).

Postprocessing → Graphics → Vectors → Edit...
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a. Select symmetry from the Surfaces selection list.

b. Click Display to plot the velocity vectors.
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Figure 3.7: Velocity Vectors Colored by Velocity Magnitude

The Auto Scale option is enabled by default in the Options group box. This scaling sometimes
creates vectors that are too small or too large in the majority of the domain. You can improve
the clarity by adjusting the Scale and Skip settings, thereby changing the size and number of
the vectors when they are displayed.

c. Enter 4 for Scale.

d. Set Skip to 2.

e. Click Display again to redisplay the vectors.
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Figure 3.8:  Resized Velocity Vectors

f. Close the Vectors dialog box.

g. Zoom in on the vectors in the display.

To manipulate the image, refer to Table 3.1: View Manipulation Instructions (p. 128). The image will
be redisplayed at a higher magnification (Figure 3.9: Magnified View of Resized Velocity Vectors (p. 164)).
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Figure 3.9:  Magnified View of Resized Velocity Vectors

h. Zoom out to the original view.

You also have the option of selecting the original view in the Views dialog box:

Viewing → Display → Views...

Select front from the Views selection list and click Apply, then close the Views dialog box.
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4. Create a line at the centerline of the outlet. For this task, you will use the Surface group box of the Post-
processing tab.

Postprocessing → Surface → Create → Iso-Surface...
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a. Select Mesh... and Z-Coordinate from the Surface of Constant drop-down lists.

b. Click Compute to obtain the extent of the mesh in the z-direction.

The range of values in the z-direction is displayed in the Min and Max fields.

c. Retain the default value of 0 inches for Iso-Values.

d. Select pressure-outlet-7 from the From Surface selection list.

e. Enter z=0_outlet for New Surface Name.

f. Click Create.

The new line surface representing the intersection of the plane z=0 and the surface pressure-
outlet-7 is created, and its name z=0_outlet appears in the From Surface selection list.

Note

• After the line surface z=0_outlet is created, a new entry will automatically be generated
for New Surface Name, in case you would like to create another surface.

• If you want to delete or otherwise manipulate any surfaces, click Manage... to open the
Surfaces dialog box.

g. Close the Iso-Surface dialog box.

5. Display and save an XY plot of the temperature profile across the centerline of the outlet for the initial
solution (Figure 3.10: Outlet Temperature Profile for the Initial Solution (p. 168)).

Postprocessing → Plots → XY Plot → Edit...
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a. Select Temperature... and Static Temperature from the Y Axis Function drop-down lists.

b. Select the z=0_outlet surface you just created from the Surfaces selection list.

c. Click Plot.

d. Enable Write to File in the Options group box.

The button that was originally labeled Plot will change to Write....

e. Click Write....

i. In the Select File dialog box, enter outlet_temp1.xy for XY File.

ii. Click OK to save the temperature data and close the Select File dialog box.

f. Close the Solution XY Plot dialog box.
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Figure 3.10:  Outlet Temperature Profile for the Initial Solution

6. Define a custom field function for the dynamic head formula ( ).

User Defined → Field Functions → Custom...

a. Select Density... and Density from the Field Functions drop-down lists, and click the Select button
to add density to the Definition field.

b. Click the X button to add the multiplication symbol to the Definition field.
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c. Select Velocity... and Velocity Magnitude from the Field Functions drop-down lists, and click the
Select button to add |V| to the Definition field.

d. Click y^x to raise the last entry in the Definition field to a power, and click 2 for the power.

e. Click the / button to add the division symbol to the Definition field, and then click 2.

f. Enter dynamic-head for New Function Name.

g. Click Define and close the Custom Field Function Calculator dialog box.

The dynamic-head tree item will appear under the Parameters & Customization/Custom Field
Functions tree branch.

7. Display filled contours of the custom field function (Figure 3.11: Contours of the Dynamic Head Custom
Field Function (p. 170)).

Postprocessing → Graphics → Contours → Edit...

a. Select Custom Field Functions... and dynamic-head from the Contours of drop-down lists.

Tip

Custom Field Functions... is at the top of the upper Contours of drop-down
list.

b. Ensure that symmetry is selected from the Surfaces selection list.
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c. Click Display and close the Contours dialog box.

Figure 3.11:  Contours of the Dynamic Head Custom Field Function

Note

You may need to change the view by zooming out after the last vector display, if you
have not already done so.

8. Save the settings for the custom field function by writing the case and data files (elbow1.cas.gz and
elbow1.dat.gz).

File → Write → Case & Data...
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a. Ensure that elbow1.cas.gz is entered for Case/Data File.

Note

When you write the case and data file at the same time, it does not matter whether
you specify the file name with a .cas or .dat extension, as both will be saved.

b. Click OK to save the files and close the Select File dialog box.

c. Click OK to overwrite the files that you had saved earlier.

3.4.8. Using the Coupled Solver

The elbow solution computed in the first part of this tutorial used the SIMPLE solver scheme for Pressure-
Velocity coupling. For many general fluid-flow problems, convergence speed can be improved by using the
Coupled solver. You will now change the Solution Method to a coupled scheme and compare the convergence
speed of the SIMPLE and Coupled solvers.

1. Change the solver settings.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list.

b. Leave the Spatial Discretization options at their default settings.

2. Re-initialize the flow field.

Solving → Initialization → Initialize

3. Run the solution for an additional 90 iterations.

Solving → Run Calculation
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a. Enter 90 for No. of Iterations.

b. Click Calculate.

A dialog box will appear stating that outlet-temp-avg-rfile.out already exists, and
asking if you want to create a new file. Click No. Another dialog box will appear asking whether
it is OK to overwrite the file. Click Yes.

The solution will converge in approximately 36 iterations (Figure 3.12: Residuals for the Coupled
Solver Calculation (p. 173)). Note that this is faster than the convergence rate using the SIMPLE
pressure-velocity coupling. The convergence history is shown in Figure 3.13: Convergence History
of Mass-Weighted Average Temperature (p. 174).

Figure 3.12:  Residuals for the Coupled Solver Calculation
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Figure 3.13:  Convergence History of Mass-Weighted Average Temperature

3.4.9. Adapting the Mesh

For the first two runs of this tutorial, you have solved the elbow problem using a fairly coarse mesh.
The elbow solution can be improved further by refining the mesh to better resolve the flow details.
ANSYS Fluent provides a built-in capability to easily adapt (locally refine) the mesh according to solution
gradients. In the following steps you will adapt the mesh based on the temperature gradients in the
current solution and compare the results with the previous results.

1. Adapt the mesh in the regions of high temperature gradient. For this task, you will use the Adapt group
box in the Setting Up Domain ribbon tab.

Setting Up Domain → Adapt → Mark/Adapt Cells → Gradient...
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a. Ensure that Refine is enabled in the Options group box.

ANSYS Fluent will not coarsen beyond the original mesh for a 3D mesh. Hence, it is not necessary to
deselect Coarsen in this instance.

b. Select Temperature... and Static Temperature from the Gradients of drop-down lists.

c. Click Compute.

ANSYS Fluent will update the Min and Max values to show the minimum and maximum temperature
gradient.

d. Enter 0.003 for Refine Threshold.

A general rule is to use 10% of the maximum gradient when setting the value for Refine Threshold.

e. Click Mark.

ANSYS Fluent will report in the console that approximately 1289 cells were marked for refinement.

f. Click Manage... to open the Manage Adaption Registers dialog box.
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i. Click Display.

ANSYS Fluent will display the cells marked for adaption in the graphics window (Figure 3.14: Cells
Marked for Adaption (p. 177)).
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Figure 3.14:  Cells Marked for Adaption

Extra You can change the way ANSYS Fluent displays cells marked for adaption (Fig-
ure 3.15: Alternative Display of Cells Marked for Adaption (p. 179)) by performing the following
steps:

A. Click Options... in the Manage Adaption Registers dialog box to open the Adaption
Display Options dialog box.
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B. Enable Wireframe in the Refine group box.

C. Enable Filled in the Options group box.

D. Enable Draw Mesh in the Options group box.

The Mesh Display dialog box will open.

E. Ensure that only the Edges option is enabled in the Options group box.

F. Select Feature from the Edge Type list.

G. Select all of the items except default-interior and z=0_outlet from the Surfaces selection
list.

H. Click Display and close the Mesh Display dialog box.

I. Click OK to close the Adaption Display Options dialog box.
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J. Click Display in the Manage Adaption Registers dialog box.

K. Rotate the view and zoom in to get the display shown in Figure 3.15: Alternative Display
of Cells Marked for Adaption (p. 179).

Figure 3.15:  Alternative Display of Cells Marked for Adaption

L. After viewing the marked cells, rotate the view back and zoom out again.

M. Click Options... in the Manage Adaption Registers dialog box to open the Adaption
Display Options dialog box again.

N. In the Adaption Display Options dialog box, disable the Draw Mesh option and click
OK to close it.

ii. In the Manage Adaption Registers dialog box, ensure that gradient-r0 is selected from the Re-
gisters selection list.
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iii. Click Adapt in the Manage Adaption Registers dialog box.

A Question dialog box will open, confirming your intention to adapt the mesh. Click Yes to pro-
ceed.

iv. Close the Manage Adaption Registers dialog box.

g. Close the Gradient Adaption dialog box.

2. Display the adapted mesh (Figure 3.16: The Adapted Mesh (p. 181)).

Setting Up Domain → Mesh → Display...

a. Select All from the Edge Type list.

b. Deselect all of the highlighted items from the Surfaces selection list except for symmetry.

Tip

To deselect all surfaces, click the Deselect All Shown button ( ) at the top of the
Surfaces selection list. Then select the desired surface from the Surfaces selection
list.
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c. Click Display and close the Mesh Display dialog box.

Figure 3.16: The Adapted Mesh

3. Request an additional 90 iterations.

Solving → Run Calculation → Calculate

The solution will converge after approximately 30 additional iterations (Figure 3.17: The Complete Residual
History (p. 182) and Figure 3.18: Convergence History of Mass-Weighted Average Temperature (p. 182)).
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Figure 3.17: The Complete Residual History

Figure 3.18:  Convergence History of Mass-Weighted Average Temperature
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4. Save the case and data files for the Coupled solver solution with an adapted mesh (elbow2.cas.gz and
elbow2.dat.gz).

File → Write → Case & Data...

a. Enter elbow2.gz for Case/Data File.

b. Click OK to save the files and close the Select File dialog box.

The files elbow2.cas.gz and elbow2.dat.gz will be saved in your default folder.

5. Display the filled temperature distribution (using node values) on the revised mesh using the temperature
contours definition that you created earlier (Figure 3.19: Filled Contours of Temperature Using the Adapted
Mesh (p. 184)).

Right-click the Results/Graphics/Contours/contour-temp tree item and select Display from the
menu that opens.

Results → Graphics → Contours → contour-temp Display
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Figure 3.19:  Filled Contours of Temperature Using the Adapted Mesh

6. Display and save an XY plot of the temperature profile across the centerline of the outlet for the adapted
solution (Figure 3.20: Outlet Temperature Profile for the Adapted Coupled Solver Solution (p. 186)).

Postprocessing → Plots → XY Plot → Edit...
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a. Ensure that the Write to File option is disabled in the Options group box.

b. Ensure that Temperature... and Static Temperature are selected from the Y Axis Function drop-down
lists.

c. Ensure that z=0_outlet is selected from the Surfaces selection list.

d. Click Plot.
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Figure 3.20:  Outlet Temperature Profile for the Adapted Coupled Solver Solution

e. Enable Write to File in the Options group box.

The button that was originally labeled Plot will change to Write....

f. Click Write....

i. In the Select File dialog box, enter outlet_temp2.xy for XY File.

ii. Click OK to save the temperature data.

g. Close the Solution XY Plot dialog box.

7. Display the outlet temperature profiles for both solutions on a single plot (Figure 3.21: Outlet Temperature
Profiles for the Two Solutions (p. 188)).

Postprocessing → Plots → File...
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a. Click the Add... button to open the Select File dialog box.

i. Click once on outlet_temp1.xy and outlet_temp2.xy.

Each of these files will be listed with their folder path in the bottom list to indicate that they have
been selected.

Tip

If you select a file by mistake, simply click the file in the bottom list and then
click Remove.
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ii. Click OK to save the files and close the Select File dialog box.

b. Select the folder path ending in outlet_temp1.xy from the Files selection list.

c. Enter Before Adaption in the lower-right text-entry box.

d. Click the Change Legend Entry button.

The item in the Legend Entries list for outlet_temp1.xy will be changed to Before Adaption. This
legend entry will be displayed in the upper-left corner of the XY plot generated in a later step.

e. In a similar manner, change the legend entry for the folder path ending in outlet_temp2.xy to be Ad-
apted Mesh.

f. Click Plot and close the File XY Plot dialog box.

Figure 3.21: Outlet Temperature Profiles for the Two Solutions (p. 188) shows the two temperature profiles
at the centerline of the outlet. It is apparent by comparing both the shape of the profiles and the predicted
outer wall temperature that the solution is highly dependent on the mesh and solution options. Specifically,
further mesh adaption should be used in order to obtain a solution that is independent of the mesh.

Figure 3.21:  Outlet Temperature Profiles for the Two Solutions

Note

When reading and writing data values, Fluent always uses SI units. Therefore, when you
read in the XY data files and plot them, the position and temperature values will be
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plotted in SI units, regardless of the settings made in the Scale Mesh dialog box earlier
in the tutorial.

Extra

You can perform additional rounds of mesh adaption based on temperature gradient
and run the calculation to see how the temperature profile changes at the outlet. For
demonstration purposes, three additional levels of mesh adaption were performed (each
time using a refinement of 10% of the new maximum gradient) and the resulting temper-
ature profiles have been plotted with outlet_temp1.xy and outlet_temp2.xy in
Figure 3.22: Outlet Temperature Profiles for Subsequent Mesh Adaption Steps (p. 189).

Figure 3.22:  Outlet Temperature Profiles for Subsequent Mesh Adaption Steps

It is evident from Figure 3.22: Outlet Temperature Profiles for Subsequent Mesh Adaption
Steps (p. 189) that as the mesh is adapted further, the profiles converge on a mesh-inde-
pendent profile. The resulting wall temperature at the outlet is predicted to be 300.4 
after mesh independence is achieved.

If computational resources allow, it is always recommended to perform successive rounds
of adaption until the solution is independent of the mesh (within an acceptable tolerance).
Typically, profiles of important variables are examined (in this case, temperature) and
compared to determine mesh independence.
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3.5. Setup and Solution in Parallel

This section explores the parallel processing capabilities of ANSYS Fluent. In order to be run in parallel,
the mesh must be divided into smaller, evenly sized partitions. Each ANSYS Fluent process, called a
compute node, will solve on a single partition, and information will be passed back and forth across all
partition interfaces. The solver of ANSYS Fluent enables parallel processing on a dedicated parallel
machine, or a network of workstations running Windows or Linux.

3.5.1. Starting the Parallel Version of ANSYS Fluent

Since the procedure for starting the parallel version of ANSYS Fluent is dependent upon the type of machine(s)
you are using, two versions of this step are provided here.

3.5.1.1. Multiprocessor Machine

Use ANSYS Fluent Launcher to start the 3D parallel version of ANSYS Fluent on a Windows or Linux
machine using 2 processes.

1. Select 3D under Dimension.

2. Enable Display Mesh After Reading under Display Options.

3. Make sure that Double Precision is disabled under Options.

4. Select Parallel under Processing Options.

5. Set Processes to 2.

To show details of the parallel settings, click Show More Options, then go to the Parallel Settings tab.
Note that your Run Types will be Shared Memory on Local Machine.

6. Click OK.
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To start ANSYS Fluent on a Linux machine, type at the command prompt

  fluent 3d -t2 

If you type fluent at the command prompt, then Fluent Launcher will appear.

For additional information about parallel command line options, see the Fluent User's Guide, available
in the help viewer or on the ANSYS Customer Portal (http://support.ansys.com/documentation).

3.5.1.2. Network of Computers

You can start the 3D parallel version of ANSYS Fluent on a network of Windows or Linux machines using
2 processes and check the network connectivity by performing the following steps:
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1. In Fluent Launcher, restore the default settings by clicking the Default button.

2. Select 3D under Dimension.

3. Enable Display Mesh After Reading under Display Options.

4. Make sure that Double Precision is disabled under Options.

5. Select Parallel under Processing Options.

6. Set the Processes to 2.

7. Click the Show More Options button and open the Parallel Settings tab.

a. Retain the selection of default in the Interconnects and MPI Types drop-down lists.

Note

On Windows platforms, default is the only available selection for Interconnects.

b. Select Distributed Memory on a Cluster under Run Types.

Note

The Fluent Root Path (in the General Options tab) should be specified as a network
path for running Fluent across multiple machines, unless Fluent is installed in the
exact same location on all of the machines that you listed for running in parallel. You

can click  to convert your Fluent Root Path to a network path.

c. Make sure that File Containing Machine Names is selected to specify the file.

d. Type the name and location of the hosts text file in the text box below File Containing Machine Names,
or browse and select it using the Browsing Machine File dialog box.

Alternatively, you can select Machine Names and type the names of the machines in the text box.

8. Click OK.

Note

If you are using a Windows platform, you will need to enter your password for MPI the
first time you run ANSYS Fluent using Distributed Memory on a Cluster.
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You can also start parallel ANSYS Fluent by typing the following at the command prompt:

fluent 3d -t2 -cnf=fluent.hosts

where -cnf indicates the location of the hosts text file. The hosts file is a text file that contains a
list of the computers on which you want to run the parallel job. If the hosts file is not located in the
directory where you are typing the startup command, you will need to supply the full pathname to
the file.

For example, the fluent.hosts file may look like the following:

 my_computer 
another_computer 
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For additional information about hosts files and parallel command line options, see the Fluent User's
Guide, available in the help viewer or on the ANSYS Customer Portal (http://support.ansys.com/
documentation).

9. Check the network connectivity information.

Although ANSYS Fluent displays a message confirming the connection to each new compute node and
summarizing the host and node processes defined, you may find it useful to review the same information
at some time during your session, especially if more compute nodes are spawned to several different
machines.

Parallel → Network → Connectivity...

a. Set Compute Node to 0.

For information about all defined compute nodes, you will select node 0, since this is the node from
which all other nodes are spawned.

b. Click Print.

------------------------------------------------------------------------------- 
ID    Hostname        Core  O.S.         PID    Vendor                     
------------------------------------------------------------------------------- 
n1    my_computer     2/32  Windows-x64  31588  Intel(R) Xeon(R) E5-2687W  
n0*   my_computer     1/32  Windows-x64  31736  Intel(R) Xeon(R) E5-2687W  
host  my_computer           Windows-x64  21192  Intel(R) Xeon(R) E5-2687W   

MPI Option Selected: ibmmpi 
Selected system interconnect: default 
-------------------------------------------------------------------------------

ID is the sequential denomination of each compute node (the host process is always host), Hostname
is the name of the machine hosting the compute node (or the host process), Core is the core num-
ber / total number of cores available, O.S. is the architecture, PID is the process ID number, and Vendor
is the vendor of the processor. Information about the selected MPI option and system interconnect
is provided at the bottom of the report.

c. Close the Parallel Connectivity dialog box.

3.5.2. Reading and Partitioning the Mesh

When you use the parallel solver, you need to subdivide (or partition) the mesh into groups of cells that can
be solved on separate processors. If you read an unpartitioned mesh into the parallel solver, ANSYS Fluent will
automatically partition it using the default partition settings. You can then check the partitions to see if you
need to modify the settings and repartition the mesh.

1. Inspect the automatic partitioning settings.
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Parallel → General → Auto Partition...

If the Case File option is enabled (the default setting), and there exists a valid partition section in the
case file (that is, one where the number of partitions in the case file divides evenly into the number of
compute nodes), then that partition information will be used rather than repartitioning the mesh. You
need to disable the Case File option only if you want to change other parameters in the Auto Partition
Mesh dialog box.

a. Make sure that Case File is enabled.

When the Case File option is enabled, ANSYS Fluent will automatically select a partitioning method
for you. This is the preferred initial approach for most problems. In the next step, you will inspect the
partitions created and be able to change them, if required.

b. Click OK to close the Auto Partition Mesh dialog box.

2. Read the case file elbow2.cas.gz.

File → Read → Case...

3. Examine the front view of the symmetry mesh zone (Figure 3.23: Mesh Along the Symmetry Plane for the
Mixing Elbow (p. 196)).
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Figure 3.23:  Mesh Along the Symmetry Plane for the Mixing Elbow

4. Check the partition information.

Parallel → General → Partition/Load Balance...
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a. Click Print Active Partitions.

ANSYS Fluent will print the active partition statistics in the console.

2 Active Partitions:
    P   Cells I-Cells Cell Ratio   Faces I-Faces Face Ratio Neighbors Load  Ext Cells
    0   11570     439      0.038   37868     633      0.017         1    1        410
    1   11305     410      0.036   37856     633      0.017         1    1        439

   ----------------------------------------------------------------------
   Collective Partition Statistics:        Minimum   Maximum   Total     
   ----------------------------------------------------------------------
   Cell count                              11305     11570     22875     
   Mean cell count deviation               -1.2%     1.2%      
   Partition boundary cell count           410       439       849       
   Partition boundary cell count ratio     3.6%      3.8%      3.7%      

   Face count                              37856     37868     75091     
   Mean face count deviation               -0.0%     0.0%      
   Partition boundary face count           633       633       633       
   Partition boundary face count ratio     1.7%      1.7%      0.8%      

   Partition neighbor count                1         1         
   ----------------------------------------------------------------------
   Partition Method                        Metis                                
   Stored Partition Count                  2

Note

ANSYS Fluent distinguishes between two cell partition schemes within a parallel
problem: the active cell partition, and the stored cell partition. Here, both are set to
the cell partition that was created upon reading the case file. If you repartition the
mesh using the Partitioning and Load Balancing dialog box, the new partition will
be referred to as the stored cell partition. To make it the active cell partition, you
need to click the Use Stored Partitions button in the Partitioning and Load Balan-
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cing dialog box. The active cell partition is used for the current calculation, while the
stored cell partition (the last partition performed) is used when you save a case file.
This distinction is made mainly to allow you to partition a case on one machine or
network of machines and solve it on a different one.

For details, see the chapter on parallel processing in the Fluent User's Guide, available in the
help viewer or on the ANSYS Customer Portal (http://support.ansys.com/documentation).

b. Review the partition statistics.

An optimal partition should produce an equal number of cells in each partition for load balancing,
a minimum number of partition interfaces to reduce interpartition communication, and a minimum
number of partition neighbors to reduce the startup time for communication. In the displayed partition
statistics, you will be looking for relatively small values of mean cell and face count deviation, and
total partition boundary cell and face count ratio. Values less than 5% are considered reasonable in
most cases. However, with very large core counts and/or especially complex cases, larger values may
be unavoidable.

c. Close the Partitioning and Load Balancing dialog box.

5. Examine the partitions graphically.

a. Initialize the solution using the default values.

Solving → Initialization → Initialize

In order to use the Contours dialog box to inspect the partition you just created, you have to initialize
the solution, even though you are not going to solve the problem at this point. The default values
are sufficient for this initialization.

b. Display the cell partitions (Figure 3.24: Cell Partitions (p. 200)).

Postprocessing → Graphics → Contours → Edit...
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i. Make sure that Filled is selected in the Options group box.

ii. Select Cell Info... and Active Cell Partition from the Contours of drop-down lists.

iii. Select symmetry from the Surfaces selection list.

iv. Set Levels to 2, which is the number of compute nodes.

v. Click Display and close the Contours dialog box.
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Figure 3.24:  Cell Partitions

As shown in Figure 3.24: Cell Partitions (p. 200), the cell partitions are acceptable for this problem. The
position of the interface reveals that the criteria mentioned earlier will be matched. If you are dissat-
isfied with the partitions, you can use the Partitioning and Load Balancing dialog box to repartition
the mesh. Recall that, if you want to use the modified partitions for a calculation, you will need to
make the stored cell partition the active cell partition by either clicking the Use Stored Partitions
button in the Partitioning and Load Balancing dialog box or saving the case file and reading it
back into ANSYS Fluent.

For details about the procedure and options for manually partitioning a mesh, see the Fluent
User's Guide, available in the help viewer or on the ANSYS Customer Portal (http://support.an-
sys.com/documentation).

6. Save the case file with the partitioned mesh (elbow4.cas.gz).

File → Write → Case...
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3.5.3. Solution

1. Initialize the flow field.

Solving → Initialization

a. Make sure that Hybrid is selected under Method (this is the default).

b. Click Initialize.

A Question dialog box will open, asking if you want to discard the data generated during the first
initialization, which was used to inspect the cell partitions.

c. Click OK in the Question dialog box to discard the data.

2. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...

3. Start the calculation by requesting 90 iterations.

Solving → Run Calculation

A Question dialog box will open, warning that outlet-temp-avg-rfile.out already exists and
asking if you want to create a new file. Click Yes.

The solution will converge in approximately 36 iterations.

4. Save the data file (elbow4.dat.gz).

File → Write → Data...

3.5.4. Checking Parallel Performance

Generally, you will use the parallel solver for large, computationally intensive problems, and you will want
to check the parallel performance to determine if any optimization is required. Although the example in this
tutorial is a simple 3D case, you will check the parallel performance as an exercise.

For details, see the chapter on parallel processing in the Fluent User's Guide, available in the help
viewer or on the ANSYS Customer Portal (http://support.ansys.com/documentation).

Parallel → Timer → Usage

Performance Timer for 36 iterations on 2 compute nodes
  Average wall-clock time per iteration:              0.097 sec
  Global reductions per iteration:                       55 ops
  Global reductions time per iteration:               0.000 sec (0.0%)
  Message count per iteration:                          637 messages
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  Data transfer per iteration:                        0.550 MB
  LE solves per iteration:                                4 solves
  LE wall-clock time per iteration:                   0.046 sec (47.7%)
  LE global solves per iteration:                         4 solves
  LE global wall-clock time per iteration:            0.000 sec (0.1%)
  LE global matrix maximum size:                        30
  AMG cycles per iteration:                           6.889 cycles
  Relaxation sweeps per iteration:                      655 sweeps
  Relaxation exchanges per iteration:                     0 exchanges

  Total wall-clock time:                              3.499 sec

The most accurate way to evaluate parallel performance is by running the same parallel problem on  CPU
and on  CPUs, and comparing the Total wall-clock time (elapsed time for the iterations) in both cases.
Ideally you would want to have the Total wall-clock time with  CPUs be  times the Total wall-clock
time with  CPU. In practice, this improvement will be reduced by the performance of the communication
subsystem of your hardware, and the overhead of the parallel process itself.

Note

The wall clock time and the ratio of iterations to convergence time may differ depending on
the type of computer you are running (for example, Windows 64, Linux 64, and so on).

3.5.5. Postprocessing

Here, two plots are generated so that you can confirm that the results obtained with the parallel solver are
the same as those obtained previously with the serial solver.

1. Display an XY plot of temperature along the centerline of the outlet (Figure 3.25: Temperature Distribution
at the Outlet (p. 203)).

Postprocessing → Plots → XY Plot → Edit...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.202

Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow



a. Select Temperature... and Static Temperature from the Y Axis Function drop-down lists.

b. Select z=0_outlet from the Surfaces selection list.

c. Click Plot and close the Solution XY Plot dialog box.

Figure 3.25: Temperature Distribution at the Outlet

Compare the plot of Temperature at the Outlet with the serial solution shown in Figure 3.20: Outlet
Temperature Profile for the Adapted Coupled Solver Solution (p. 186).

2. Display filled contours of the custom field function dynamic-head (Figure 3.26: Contours of the Custom
Field Function, Dynamic Head (p. 205)).

Postprocessing → Graphics → Contours → Edit...
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a. Select Custom Field Functions... and dynamic-head from the Contours of drop-down lists.

b. Enter 20 for Levels.

c. Select symmetry from the Surfaces selection list.

d. Click Display and close the Contours dialog box.
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Figure 3.26:  Contours of the Custom Field Function, Dynamic Head

3.6. Summary

A comparison of the convergence speed for the SIMPLE and Coupled pressure-velocity coupling schemes
indicates that the latter converges much faster. With more complex meshes, the difference in speed
between the two schemes can be significant.
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Chapter 4: Modeling Periodic Flow and Heat Transfer

This tutorial is divided into the following sections:
4.1. Introduction
4.2. Prerequisites
4.3. Problem Description
4.4. Setup and Solution
4.5. Summary
4.6. Further Improvements

4.1. Introduction

Many industrial applications, such as steam generation in a boiler or air cooling in the coil of an air
conditioner, can be modeled as two-dimensional periodic heat flow. This tutorial illustrates how to set
up and solve a periodic heat transfer problem, given a pre-generated mesh.

The system that is modeled is a bank of tubes containing a flowing fluid at one temperature that is
immersed in a second fluid in cross flow at a different temperature. Both fluids are water, and the flow
is classified as laminar and steady, with a Reynolds number of approximately 100. The mass flow rate
of the cross flow is known and the model is used to predict the flow and temperature fields that result
from convective heat transfer.

Due to symmetry of the tube bank and the periodicity of the flow inherent in the tube bank geometry,
only a portion of the geometry will be modeled in ANSYS Fluent, with symmetry applied to the outer
boundaries. The resulting mesh consists of a periodic module with symmetry. In the tutorial, the inlet
boundary will be redefined as a periodic zone, and the outflow boundary defined as its shadow.

This tutorial demonstrates how to do the following:

• Create periodic zones.

• Define a specified periodic mass flow rate.

• Model periodic heat transfer with specified temperature boundary conditions.

• Calculate a solution using the pressure-based, pseudo-transient, coupled solver.

• Plot temperature profiles on specified isosurfaces.

4.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
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• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

4.3. Problem Description

This problem considers a 2D section of a tube bank. A schematic of the problem is shown in Fig-
ure 4.1: Schematic of the Problem (p. 208). The bank consists of uniformly-spaced tubes with a diameter
of 1 cm, which are staggered across the cross-fluid flow. Their centers are separated by a distance of 2
cm in the  direction, and 1 cm in the  direction. The bank has a depth of 1 m.

Figure 4.1:  Schematic of the Problem

Because of the symmetry of the tube bank geometry, only a portion of the domain must be modeled.
The computational domain is shown in outline in Figure 4.1: Schematic of the Problem (p. 208). A mass
flow rate of 0.05 kg/s is applied to the inlet boundary of the periodic module. The temperature of the
tube wall ( ) is 400 K and the bulk temperature of the cross flow water ( ) is 300 K. The properties
of water that are used in the model are shown in Figure 4.1: Schematic of the Problem (p. 208).

4.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
4.4.1. Preparation
4.4.2. Mesh
4.4.3. General Settings
4.4.4. Models
4.4.5. Materials
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4.4.6. Cell Zone Conditions
4.4.7. Periodic Conditions
4.4.8. Boundary Conditions
4.4.9. Solution
4.4.10. Postprocessing

4.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the periodic_flow_heat_R180.zip link to download the input files.

7. Unzip periodic_flow_heat_R180.zip to your working folder.

The file tubebank.msh can be found in the periodic_flow_heat folder created after unzipping
the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that you are running in single precision (disable Double Precision).

11. Select Serial under Processing Options.

4.4.2. Mesh

1. Read the mesh file tubebank.msh.
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File → Read → Mesh...

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and report the progress in the ANSYS Fluent
console window. Ensure that the minimum volume reported is a positive number.

3. Scale the mesh.

Setting Up Domain → Mesh → Scale...

a. Select cm (centimeters) from the Mesh Was Created In drop-down list in the Scaling group box.

b. Click Scale to scale the mesh.

c. Close the Scale Mesh dialog box.

4. Check the mesh.

Setting Up Domain → Mesh → Check

Note

It is a good idea to check the mesh after you manipulate it (scale, convert to polyhedra,
merge, separate, fuse, add zones, or smooth and swap.) This will ensure that the quality
of the mesh has not been compromised.

5. Examine the mesh (Figure 4.2: Mesh for the Periodic Tube Bank (p. 211)).
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Figure 4.2:  Mesh for the Periodic Tube Bank

Quadrilateral cells are used in the regions surrounding the tube walls and triangular cells are used for
the rest of the domain, resulting in a hybrid mesh (see Figure 4.2: Mesh for the Periodic Tube Bank (p. 211)).
The quadrilateral cells provide better resolution of the viscous gradients near the tube walls. The remainder
of the computational domain is filled with triangular cells for the sake of convenience.

Tip

You can use the right mouse button to probe for mesh information in the graphics win-
dow. If you click the right mouse button on any node in the mesh, information will be
displayed in the ANSYS Fluent console about the associated zone, including the name of
the zone. This feature is especially useful when you have several zones of the same type
and you want to distinguish between them quickly.

6. Create the periodic zone.

The inlet (wall-9) and outflow (wall-12) boundaries currently defined as wall zones need to be redefined
as periodic using the text user interface. The wall-9 boundary will be redefined as a translationally peri-
odic zone and wall-12 as a periodic shadow of wall-9.

a. Press Enter in the console to get the command prompt (>).

b. Enter the text command and input the responses to the prompts as shown. Press Enter after each entry.

> mesh/modify-zones/make-periodic Enter

You will be prompted to enter the zones corresponding to the periodic boundaries and specify
the configuration of the periodicity.
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Periodic zone [()] 9 Enter

Shadow zone [()] 12 Enter

Rotational periodic? (if no, translational) [yes] no Enter
Create periodic zones? [yes] yes Enter

Auto detect translation vector? [yes] yes Enter

 zone 12 deleted

 created periodic zones.

4.4.3. General Settings

1. Retain the default settings for the solver.

Setting Up Physics → Solver

4.4.4. Models

1. Enable heat transfer.

Setting Up Physics → Models → Energy

4.4.5. Materials

The default properties for water defined in ANSYS Fluent are suitable for this problem. In this step, you will
make sure that this material is available for selecting in future steps.

1. Add water to the list of fluid materials by copying it from the ANSYS Fluent materials database.

Setup → Materials → Fluid → Create/Edit...

a. Click Fluent Database... in the Create/Edit Materials dialog box to open the Fluent Database Mater-
ials dialog box.
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i. Select water-liquid (h2o<l>) in the Fluent Fluid Materials selection list.

Scroll down the list to find water-liquid (h2o<l>). Selecting this item will display the default
properties in the dialog box.

ii. Click Copy and close the Fluent Database Materials dialog box.

The Create/Edit Materials dialog box will now display the copied properties for water-liquid.
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b. Click Change/Create and close the Create/Edit Materials dialog box.

4.4.6. Cell Zone Conditions

1. Set the cell zone conditions for the continuum fluid zone (fluid-16).

Setup → Cell Zone Conditions → fluid-16 → Edit...

a. Select water-liquid from the Material Name drop-down list.

b. Click OK to close the Fluid dialog box.
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4.4.7. Periodic Conditions

1. Define the periodic flow conditions.

Setup → Boundary Conditions → periodic-9 → Periodic Conditions...

a. Select Specify Mass Flow in the Type list.

This will allow you to specify the Mass Flow Rate.

b. Enter 0.05 kg/s for Mass Flow Rate.

c. Click OK to close the Periodic Conditions dialog box.

4.4.8. Boundary Conditions

1. Set the boundary conditions for the bottom wall of the left tube (wall-21).

Setup → Boundary Conditions → wall-21 → Edit...
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a. Enter wall-bottom for Zone Name.

b. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions list.

ii. Enter 400 K for Temperature.

These settings will specify a constant wall temperature of 400 K.

c. Click OK to close the Wall dialog box.

2. Set the boundary conditions for the top wall of the right tube (wall-3).

Setup → Boundary Conditions → wall-3 → Edit...

a. Enter wall-top for Zone Name.

b. Click the Thermal tab.

i. Select Temperature from the Thermal Conditions list.

ii. Enter 400 K for Temperature.

c. Click OK to close the Wall dialog box.

4.4.9. Solution

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default setting of Least Squares Cell Based for the Gradient in the Spatial Discretization
group box.

c. Retain the default setting of Second Order for the Pressure drop-down list.

d. Retain the default setting of Second Order Upwind in the Momentum and Energy drop-down lists.

e. Enable Pseudo Transient.

The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based
solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve
stability and convergence behavior.

2. Set the solution controls.

Solving → Controls → Controls...
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a. Retain the default values in the Pseudo Transient Explicit Relaxation Factors group box.

In some cases, the default Pseudo Transient Explicit Relaxation Factors may need to be reduced in
order to prevent oscillation of residual values or stabilization of residual values above the convergence
criteria. For additional information about setting Pseudo Transient Explicit Relaxation Factors, see
the Fluent User's Guide.

3. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...

a. Ensure Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.218

Modeling Periodic Flow and Heat Transfer



4. Initialize the solution.

You will first use the default Hybrid initialization method and then patch the fluid zone with the upstream
temperature value.

a. Initialize using the default settings.

Solving → Initialization → Initialize

b. Patch the fluid zone with the bulk upstream temperature value.

The Hybrid Initialization method computes the initial flow field based on inlet and outlet boundary
conditions. In this case we have periodic boundary conditions with a specified upstream bulk temper-
ature. You will patch the initialized solution with this temperature value in order to improve conver-
gence.

Solving → Initialization → Patch...

i. Select Temperature in the Variable selection list.

ii. Enter 300 for Value (k).

Recall that the upstream bulk temperature, , is specified as 300 K.

iii. Select fluid-16 in the Zones to Patch selection list.

iv. Click Patch and close the Patch dialog box.

5. Save the case file (tubebank.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 350 iterations.

Solving → Run Calculation
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a. Enter 350 for No. of Iterations.

b. Click Calculate.

The solution will converge in approximately 111 iterations.

7. Save the case and data files (tubebank.cas.gz and tubebank.dat.gz).

File → Write → Case & Data...

4.4.10. Postprocessing

1. Display filled contours of static pressure (Figure 4.3: Contours of Static Pressure (p. 221)).

Postprocessing → Graphics → Contours → Edit...

a. Enable Filled in the Options group box.

b. Retain the default selection of Pressure... and Static Pressure from the Contours of drop-down lists.

c. Click Display.
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Figure 4.3:  Contours of Static Pressure

d. Change the view to mirror the display across the symmetry planes (Figure 4.4: Contours of Static Pressure
with Symmetry (p. 222)).

Viewing → Display → Views...
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i. Select all of the symmetry zones (symmetry-18, symmetry-13, symmetry-11, and symmetry-24)

in the Mirror Planes selection list by clicking  in the upper right corner.

Note

There are four symmetry zones in the Mirror Planes selection list because the top
and bottom symmetry planes in the domain are each composed of two symmetry
zones, one on each side of the tube centered on the plane. It is also possible to
generate the same display shown in Figure 4.4: Contours of Static Pressure with
Symmetry (p. 222) by selecting just one of the symmetry zones on the top symmetry
plane, and one on the bottom.

ii. Click Apply and close the Views dialog box.

iii. Translate the display of symmetry contours so that it is centered in the graphics window by using
the left mouse button (Figure 4.4: Contours of Static Pressure with Symmetry (p. 222)).

Figure 4.4:  Contours of Static Pressure with Symmetry

The pressure contours displayed in Figure 4.4: Contours of Static Pressure with Symmetry (p. 222) do
not include the linear pressure gradient computed by the solver. Thus, the contours are periodic at
the inlet and outflow boundaries.

2. Display filled contours of static temperature (Figure 4.5: Contours of Static Temperature (p. 223)).

Postprocessing → Graphics → Contours → Edit...
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a. Select Temperature... and Static Temperature from the Contours of drop-down lists.

b. Click Display and close the Contours dialog box.

Figure 4.5:  Contours of Static Temperature
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The contours in Figure 4.5: Contours of Static Temperature (p. 223) reveal the temperature increase in the
fluid due to heat transfer from the tubes. The hotter fluid is confined to the near-wall and wake regions,
while a narrow stream of cooler fluid is convected through the tube bank.

3. Display the velocity vectors (Figure 4.6: Velocity Vectors (p. 225)).

Postprocessing → Graphics → Vectors → Edit...

a. Enter 2 for Scale.

This will increase the size of the displayed vectors, making it easier to view the flow patterns.

b. Retain the default selection of Velocity from the Vectors of drop-down list.

c. Retain the default selection of Velocity... and Velocity Magnitude from the Color by drop-down lists.

d. Click Display and close the Vectors dialog box.

e. Zoom in on the upper right portion of one of the left tubes to get the display shown in (Figure 4.6: Ve-
locity Vectors (p. 225)), by using the middle mouse button in the graphics window.

The magnified view of the velocity vector plot in Figure 4.6: Velocity Vectors (p. 225) clearly shows the re-
circulating flow behind the tube and the boundary layer development along the tube surface.
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Figure 4.6: Velocity Vectors

4. Create an isosurface on the periodic tube bank at  = 0.01 m (through the first column of tubes).

This isosurface and the ones created in the steps that follow will be used for the plotting of temperature
profiles.

Setting Up Domain → Surface → Create → Iso-Surface...

225
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



a. Select Mesh... and X-Coordinate from the Surface of Constant drop-down lists.

b. Enter 0.01 for Iso-Values.

c. Enter x=0.01m for New Surface Name.

d. Click Create.

5. In a similar manner, create an isosurface on the periodic tube bank at  = 0.02 m (halfway between the
two columns of tubes) named x=0.02m.

6. In a similar manner, create an isosurface on the periodic tube bank at  = 0.03 m (through the middle of
the second column of tubes) named x=0.03m, and close the Iso-Surface dialog box.

7. Create an XY plot of static temperature on the three isosurfaces (Figure 4.7: Static Temperature at x=0.01,
0.02, and 0.03 m (p. 228)).

Postprocessing → Plots → XY Plot → Edit...

a. Enter 0 for X and 1 for Y in the Plot Direction group box.

With a Plot Direction vector of (0,1), ANSYS Fluent will plot the selected variable as a function of
. Since you are plotting the temperature profile on cross sections of constant , the temperature

varies with the  direction.

b. Select Temperature... and Static Temperature from the Y-Axis Function drop-down lists.

c. Select x=0.01m, x=0.02m, and x=0.03m in the Surfaces selection list.

Scroll down to find the x=0.01m, x=0.02m, and x=0.03m surfaces.

d. Click the Curves... button to open the Curves - Solution XY Plot dialog box.
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This dialog box is used to define plot styles for the different plot curves.

i. Select  from the Symbol drop-down list.

Scroll up to find the  item.

ii. Click Apply to assign the  symbol to the  = 0.01 m curve.

iii. Set the Curve # to 1 to define the style for the  = 0.02 m curve.

iv. Select x from the Symbol drop-down list.

Scroll up to find the x item.

v. Enter 0.5 for Size.

vi. Click Apply and close the Curves - Solution XY Plot dialog box.

Since you did not change the curve style for the  = 0.03 m curve, the default symbol will be used.

e. Click Plot and close the Solution XY Plot dialog box.
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Figure 4.7:  Static Temperature at x=0.01, 0.02, and 0.03 m

4.5. Summary

In this tutorial, periodic flow and heat transfer in a staggered tube bank were modeled in ANSYS Fluent.
The model was set up assuming a known mass flow through the tube bank and constant wall temper-
atures. Due to the periodic nature of the flow and symmetry of the geometry, only a small piece of the
full geometry was modeled. In addition, the tube bank configuration lent itself to the use of a hybrid
mesh with quadrilateral cells around the tubes and triangles elsewhere.

The Periodic Conditions dialog box makes it easy to run this type of model with a variety of operating
conditions. For example, different flow rates (and hence different Reynolds numbers) can be studied,
or a different inlet bulk temperature can be imposed. The resulting solution can then be examined to
extract the pressure drop per tube row and overall Nusselt number for a range of Reynolds numbers.

For additional details about modeling periodic heat transfer, see the Fluent User's Guide.

4.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by adapting the mesh. Mesh adaption can also ensure that the solution is independent
of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat
Transfer in a Mixing Elbow (p. 121).
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Chapter 5: Modeling External Compressible Flow

This tutorial is divided into the following sections:
5.1. Introduction
5.2. Prerequisites
5.3. Problem Description
5.4. Setup and Solution
5.5. Summary
5.6. Further Improvements

5.1. Introduction

The purpose of this tutorial is to compute the turbulent flow past a transonic airfoil at a nonzero angle
of attack. You will use the Spalart-Allmaras turbulence model.

This tutorial demonstrates how to do the following:

• Model compressible flow (using the ideal gas law for density).

• Set boundary conditions for external aerodynamics.

• Use the Spalart-Allmaras turbulence model.

• Use Full Multigrid (FMG) initialization to obtain better initial field values.

• Calculate a solution using the pressure-based coupled solver with the pseudo transient option.

• Use force and surface reports to check solution convergence.

• Check the near-wall mesh resolution by plotting the distribution of .

5.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.
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5.3. Problem Description

The problem considers the flow around an airfoil at an angle of attack  and a free stream Mach
number of  ( ). The flow is transonic, and has a fairly strong shock near the mid-chord
( ) on the upper (suction) side. The chord length is 1 m. The geometry of the airfoil is shown
in Figure 5.1: Problem Specification (p. 230).

Figure 5.1:  Problem Specification

5.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
5.4.1. Preparation
5.4.2. Mesh
5.4.3. Solver
5.4.4. Models
5.4.5. Materials
5.4.6. Boundary Conditions
5.4.7. Operating Conditions
5.4.8. Solution
5.4.9. Postprocessing

5.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.
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6. Click the external_compressible_R180.zip link to download the input files.

7. Unzip external_compressible_R180.zip to your working folder.

The file airfoil.msh can be found in the external_compressible folder created after unzipping
the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Enable Double Precision.

11. Ensure Serial is selected under Processing Options.

5.4.2. Mesh

1. Read the mesh file airfoil.msh.

File → Read → Mesh...

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make
sure that the reported minimum volume is a positive number.

3. Examine the mesh (Figure 5.2: The Entire Mesh (p. 232) and Figure 5.3: Magnified View of the Mesh Around
the Airfoil (p. 233)).
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Figure 5.2: The Entire Mesh

Quadrilateral cells were used for this simple geometry because they can be stretched easily to account
for different flow gradients in different directions. In the present case, the gradients normal to the airfoil
wall are much greater than those tangent to the airfoil. Consequently, the cells near the surface have
high aspect ratios. For geometries that are more difficult to mesh, it may be easier to create a hybrid
mesh composed of quadrilateral and triangular cells.
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Figure 5.3:  Magnified View of the Mesh Around the Airfoil

A parabola was chosen to represent the far-field boundary because it has no discontinuities in slope,
enabling the construction of a smooth mesh in the interior of the domain.

Extra

You can use the right mouse button to probe for mesh information in the graphics win-
dow. If you click the right mouse button on any node in the mesh, information will be
displayed in the ANSYS Fluent console about the associated zone, including the name of
the zone. This feature is especially useful when you have several zones of the same type
and you want to distinguish between them quickly.

5.4.3. Solver

1. Set the solver settings.
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Setting Up Physics → Solver

a. Retain the default selection of Pressure-Based from the Type list.

The pressure-based solver with the Coupled option for the pressure-velocity coupling is a good altern-
ative to density-based solvers of ANSYS Fluent when dealing with applications involving high-speed
aerodynamics with shocks. Selection of the coupled algorithm is made in the Solution Methods task
page in the Solution step.

5.4.4. Models

1. Select the Spalart-Allmaras turbulence model.

Setting Up Physics → Models → Viscous...

a. Select Spalart-Allmaras (1eqn) in the Model list.

b. Select Strain/Vorticity-Based in the Spalart-Allmaras Production list.

c. Retain the default settings in the Model Constants group box.
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d. Click OK to close the Viscous Model dialog box.

Note

The Spalart-Allmaras model is a relatively simple one-equation model that solves a modeled
transport equation for the kinematic eddy (turbulent) viscosity. This embodies a relatively
new class of one-equation models in which it is not necessary to calculate a length scale
related to the local shear layer thickness. The Spalart-Allmaras model was designed spe-
cifically for aerospace applications involving wall-bounded flows and has been shown to
give good results for boundary layers subjected to adverse pressure gradients.

5.4.5. Materials

The default Fluid Material is air, which is the working fluid in this problem. The default settings need to be
modified to account for compressibility and variations of the thermophysical properties with temperature.

1. Set the properties for air, the default fluid material.

Setup → Materials → Fluids → air Edit...

a. Select ideal-gas from the Density drop-down list.

The Energy Equation will be enabled.

b. Select sutherland from the Viscosity drop-down list to open the Sutherland Law dialog box.
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Scroll down the Viscosity drop-down list to find sutherland.

i. Retain the default selection of Three Coefficient Method in the Methods list.

ii. Click OK to close the Sutherland Law dialog box.

The Sutherland law for viscosity is well suited for high-speed compressible flows.

c. Click Change/Create to save these settings.

d. Close the Create/Edit Materials dialog box.

While Density and Viscosity have been made temperature-dependent, Cp (Specific Heat) and Thermal
Conductivity have been left constant. For high-speed compressible flows, thermal dependency of the
physical properties is generally recommended. For simplicity, Thermal Conductivity and Cp (Specific
Heat) are assumed to be constant in this tutorial.

5.4.6. Boundary Conditions

Setup → Boundary Conditions
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1. Set the boundary conditions for pressure-far-field-1.

Setup → Boundary Conditions → pressure-far-field-1 → Edit...
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a. Retain the default value of 0 Pa for Gauge Pressure.

Note

The gauge pressure in ANSYS Fluent is always relative to the operating pressure, which
is defined in a separate input (see below).

b. Enter 0.8 for Mach Number.

c. Enter 0.997564 and 0.069756 for the X-Component of Flow Direction and Y-Component of Flow
Direction, respectively.

These values are determined by the  angle of attack:  and .

d. Retain Turbulent Viscosity Ratio from the Specification Method drop-down list in the Turbulence
group box.

e. Retain the default value of 10 for Turbulent Viscosity Ratio.

The viscosity ratio should be between 1 and 10 for external flows.

f. Click the Thermal tab and retain the default value of 300 K for Temperature.

i. A. Click OK to close the Pressure Far-Field dialog box.

5.4.7. Operating Conditions

1. Set the operating pressure.

Setup → Boundary Conditions → Operating Conditions...
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The Operating Conditions dialog box can also be accessed from the Cell Zone Conditions task page.

a. Retain the default value of 101325 Pa for Operating Pressure.

The operating pressure should be set to a meaningful mean value in order to avoid round-off errors.
The absolute pressure must be greater than zero for compressible flows. If you want to specify
boundary conditions in terms of absolute pressure, you can make the operating pressure zero.

b. Click OK to close the Operating Conditions dialog box.

For information about setting the operating pressure, see the Fluent User's Guide.

5.4.8. Solution

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the
Spatial Discretization group box.

c. Retain the default selection of Second Order from the Pressure drop-down list.

d. Select Second Order Upwind from the Modified Turbulent Viscosity drop-down list.

e. Enable Pseudo Transient.

The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based
solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve
stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Set the solution controls.

Solving → Controls → Controls...
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a. Enter 0.5 for Density in the Pseudo Transient Explicit Relaxation Factors group box.

Under-relaxing the density factor is recommended for high-speed compressible flows.

b. Enter 0.9 for Modified Turbulent Viscosity.

Larger under-relaxation factors (that is, closer to 1) will generally result in faster convergence. However,
instability can arise that may need to be eliminated by decreasing the under-relaxation factors.

3. Enable residual plotting during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box and click OK to close the Residual Monitors
dialog box.

4. Initialize the solution.

Solution  → Solution Initialization

a. Retain the default selection of Hybrid Initialization from the Initialization Methods group box.

b. Click Initialize to initialize the solution.
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c. Run the Full Multigrid (FMG) initialization.

FMG initialization often facilitates an easier start-up, where no CFL (Courant Friedrichs Lewy) ramping
is necessary, thereby reducing the number of iterations for convergence.

i. Press Enter  in the console to get the command prompt (>).

ii. Enter the text commands and input responses as shown in the boxes. Accept the default values by
pressing Enter  when no input response is given:

solve/initialize/set-fmg-initialization

 Customize your FMG initialization:
   set the number of multigrid levels [5]

   set FMG parameters on levels ..

    residual reduction on level 1 is:  [0.001]
    number of cycles on level 1 is:  [10]  100

    residual reduction on level 2 is:  [0.001]
    number of cycles on level 2 is:  [50]  100

    residual reduction on level 3 is:  [0.001]
    number of cycles on level 3 is:  [100]

    residual reduction on level 4 is:  [0.001]
    number of cycles on level 4 is:  [500]

    residual reduction on level 5 [coarsest grid] is:  [0.001]
    number of cycles on level 5 is:  [500]

 * FMG customization complete

   set FMG courant-number [0.75]

   enable FMG verbose? [no] yes

solve/initialize/fmg-initialization
Enable FMG initialization? [no] yes

Note

Whenever FMG initialization is performed, it is important to inspect the FMG initialized
flow field using the postprocessing tools of ANSYS Fluent. Monitoring the normalized
residuals, which are plotted in the console window, will give you an idea of the conver-
gence of the FMG solver. You should notice that the value of the normalized residuals
decreases. For information about FMG initialization, including convergence strategies,
see the Fluent User's Guide.

5. Save the case and data files (airfoil.cas.gz and airfoil.dat.gz).

File → Write → Case & Data...

It is good practice to save the case and data files during several stages of your case setup.

6. Start the calculation by requesting 50 iterations.

Solving → Run Calculation
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a. Enter 50 for No. of Iterations.

b. Click Calculate.

By performing some iterations before setting up the force reports, you will avoid large initial transients
in the report plots. This will reduce the axes range and make it easier to judge the convergence.

7. Set the reference values that are used to compute the lift, drag, and moment coefficients.

Setup  → Reference Values

The reference values are used to non-dimensionalize the forces and moments acting on the airfoil. The
dimensionless forces and moments are the lift, drag, and moment coefficients.

a. Select pressure-far-field-1 from the Compute from drop-down list.

ANSYS Fluent will update the Reference Values based on the boundary conditions at the far-field
boundary.

8. Create a force report definition to plot and write the drag coefficient for the walls of the airfoil.

Solving → Reports → Definitions → New → Force Report → Drag...
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a. Enter cd-1 for Name.

b. Make sure that Drag Coefficient is selected in the Report Output Type group box.

c. In the Create group box, enable Report Plot.

d. Enable Report File to save the report history to a file.

Note

If you do not enable the Report File option, the history information will be lost when
you exit ANSYS Fluent.

e. Select wall-bottom and wall-top in the Wall Zones selection list.

f. Enter 0.9976 for X and 0.06976 for Y in the Force Vector group box.

These X and Y values ensure that the drag coefficient is calculated parallel to the free-stream flow,

which is  off of the global coordinates.
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g. Click OK to close the Drag Report Definition dialog box.

9. Similarly, create a force report definition for the lift coefficient.

Solving → Reports → Definitions → New → Force Report → Lift...

Enter the values for X and Y shown in the Lift Report Definition dialog box.

The X and Y values shown ensure that the lift coefficient is calculated normal to the free-stream flow,

which is  off of the global coordinates.

10. In a similar manner, create a force report definition for the moment coefficient.

Solving → Reports → Definitions → New → Force Report → Moment...
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Enter the values for the Moment Center and Moment Axis shown in the Moment Report Definition
dialog box.

11. Display filled contours of pressure overlaid with the mesh in preparation for creating a surface report
definition (Figure 5.4: Pressure Contours After 50 Iterations (p. 249) and Figure 5.5: Magnified View of Pressure
Contours Showing Wall-Adjacent Cells (p. 250)).

Postprocessing → Graphics → Contours → Edit...
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a. Enable Filled in the Options group box.

b. Enable Draw Mesh to open the Mesh Display dialog box.

i. Retain the default settings.

ii. Close the Mesh Display dialog box.

c. Click Display and close the Contours dialog box.
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Figure 5.4:  Pressure Contours After 50 Iterations

The shock is clearly visible on the upper surface of the airfoil, where the pressure jumps to a higher
value downstream of the low pressure area.

Note

The color indicating a high pressure area near the leading edge of the airfoil is ob-
scured by the overlaid green mesh. To view this contour, simply disable the Draw
Mesh option in the Contours dialog box and click Display.

d. Zoom in on the shock wave, until individual cells adjacent to the upper surface (wall-top boundary)
are visible, as shown in Figure 5.5: Magnified View of Pressure Contours Showing Wall-Adjacent
Cells (p. 250).
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Figure 5.5:  Magnified View of Pressure Contours Showing Wall-Adjacent Cells

The magnified region contains cells that are just downstream of the shock and adjacent to the upper
surface of the airfoil. In the following step, you will create a point surface inside a wall-adjacent cell,
which you will use to create a surface report definition.

12. Create a point surface just downstream of the shock wave.

Postprocessing → Surface → Create → Point...
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a. Enter 0.53 m for x0 and 0.051 m for y0 in the Coordinates group box.

b. Retain the default entry of point-4 for New Surface Name.

c. Click Create and close the Point Surface dialog box.

Note

You have entered the exact coordinates of the point surface so that your convergence
history will match the plots and description in this tutorial. In general, however, you will
not know the exact coordinates in advance, so you will need to select the desired location
in the graphics window. You do not have to apply the following instructions at this point
in the tutorial; they are added here for your information:

a. In the Point Surface dialog box, click the Select Point with Mouse button. A Working
dialog box will open telling you to “Click on a location in the graphics window with the
MOUSE-PROBE mouse button.”

b. Position the mouse pointer at a point located inside one of the cells adjacent to the upper
surface (wall-top boundary), downstream of the shock (see Figure 5.6: Pressure Contours
after Creating a Point with the Mouse (p. 252)).

c. Click the right mouse button.

d. Click Create to create the point surface and then close the Point Surface dialog box.
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Figure 5.6:  Pressure Contours after Creating a Point with the Mouse

13. Enable residual plotting during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Select none from the Convergence Criterion drop-down list so that automatic convergence checking
does not occur.

c. Click OK to close the Residual Monitors dialog box.

14. Create a surface report definition for tracking the velocity magnitude value at the point created in the
previous step.

Since the drag, lift, and moment coefficients are global variables, indicating certain overall conditions,
they may converge while local conditions at specific points are still varying from one iteration to the
next. To account for this, create a report definition at a point (just downstream of the shock) where there
is likely to be significant variation, and monitor the value of the velocity magnitude.

Solving → Reports → Definitions → New → Surface Report → Vertex Average...
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a. Enter surf-mon-1 for Name.

b. Select Velocity... and Velocity Magnitude from the Field Variable drop-down list.

c. Select point-4 in the Surfaces selection list.

d. In the Create group box, enable Report File, Report Plot and Print to Console.

e. Click OK to close the Surface Report Definition dialog box.

15. Save the case and data files (airfoil-1.cas.gz and airfoil-1.dat.gz).

File → Write → Case & Data...

16. Continue the calculation for 200 more iterations.

Solving → Run Calculation → Calculate
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The force reports (Figure 5.8: Drag Coefficient Convergence History (p. 256) and Figure 5.9: Lift Coefficient
Convergence History (p. 257)) show that the case is converged after approximately 200 iterations.

Figure 5.7: Velocity Magnitude History
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Figure 5.8:  Drag Coefficient Convergence History
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Figure 5.9:  Lift Coefficient Convergence History
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Figure 5.10:  Moment Coefficient Convergence History

17. Save the case and data files (airfoil-2.cas.gz and airfoil-2.dat.gz).

File → Write → Case & Data...

5.4.9. Postprocessing

1. Plot the  distribution on the airfoil (Figure 5.11: XY Plot of y+ Distribution (p. 260)).

Postprocessing → Plots → XY Plot → Edit...
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a. Disable Node Values in the Options group box.

b. Select Turbulence... and Wall Yplus from the Y Axis Function drop-down list.

Wall Yplus is available only for cell values.

c. Select wall-bottom and wall-top in the Surfaces selection list.

d. Click Plot and close the Solution XY Plot dialog box.

Note

The values of  are dependent on the resolution of the mesh and the Reynolds number
of the flow, and are defined only in wall-adjacent cells. The value of  in the wall-adjacent
cells dictates how wall shear stress is calculated. When you use the Spalart-Allmaras
model, you should check that  of the wall-adjacent cells is either very small (on the
order of ), or approximately 30 or greater. Otherwise, you should modify your mesh.

The equation for  is

(5.1)

where  is the distance from the wall to the cell center,  is the molecular viscosity,  is
the density of the air, and  is the wall shear stress.

Figure 5.11: XY Plot of y+ Distribution (p. 260) indicates that, except for a few small regions
(notably at the shock and the trailing edge),  and for much of these regions it does
not drop significantly below 30. Therefore, you can conclude that the near-wall mesh
resolution is acceptable.
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Figure 5.11:  XY Plot of y+ Distribution

2. Display filled contours of Mach number (Figure 5.12: Contour Plot of Mach Number (p. 261)).

Postprocessing → Graphics → Contours → Edit...

a. Ensure Filled is enabled in the Options group box.

b. Select Velocity... and Mach Number from the Contours of drop-down list.

c. Click Display and close the Contours dialog box.

d. Zoom in on the region around the airfoil, as shown in Figure 5.12: Contour Plot of Mach Number (p. 261).
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Figure 5.12:  Contour Plot of Mach Number

Note the discontinuity, in this case a shock, on the upper surface of the airfoil in Figure 5.12: Contour
Plot of Mach Number (p. 261) at about .

3. Plot the pressure distribution on the airfoil (Figure 5.13: XY Plot of Pressure (p. 262)).

Postprocessing → Plots → XY Plot → Edit...

a. Enable Node Values.

b. Select Pressure... and Pressure Coefficient from the Y Axis Function drop-down lists.

c. Click Plot.

261
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 5.13:  XY Plot of Pressure

Notice the effect of the shock wave on the upper surface in Figure 5.13: XY Plot of Pressure (p. 262).

4. Plot the  component of wall shear stress on the airfoil surface (Figure 5.14: XY Plot of x Wall Shear
Stress (p. 263)).

a. Disable Node Values.

b. Select Wall Fluxes... and X-Wall Shear Stress from the Y Axis Function drop-down lists.

c. Click Plot and close the Solution XY Plot dialog box.

As shown in Figure 5.14: XY Plot of x Wall Shear Stress (p. 263), the large, adverse pressure gradient induced
by the shock causes the boundary layer to separate. The point of separation is where the wall shear stress
vanishes. Flow reversal is indicated here by negative values of the x component of the wall shear stress.
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Figure 5.14:  XY Plot of x Wall Shear Stress

5. Display filled contours of the  component of velocity (Figure 5.15: Contour Plot of x Component of Velo-
city (p. 264)).

Postprocessing → Graphics → Contours → Edit...

a. Ensure Filled is enabled in the Options group box.

b. Select Velocity... and X Velocity from the Contours of drop-down lists.

c. Click Display and close the Contours dialog box.

Note the flow reversal downstream of the shock in Figure 5.15: Contour Plot of x Component of Velo-
city (p. 264).
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Figure 5.15:  Contour Plot of x Component of Velocity

6. Plot velocity vectors (Figure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 265)).

Postprocessing → Graphics → Vectors → Edit...

a. Enter 15 for Scale.

b. Click Display and close the Vectors dialog box.

c. Zoom in on the flow above the upper surface at a point downstream of the shock, as shown in Fig-
ure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 265).
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Figure 5.16:  Plot of Velocity Vectors Downstream of the Shock

Flow reversal is clearly visible in Figure 5.16: Plot of Velocity Vectors Downstream of the Shock (p. 265).

5.5. Summary

This tutorial demonstrated how to set up and solve an external aerodynamics problem using the pressure-
based coupled solver with pseudo transient under-relaxation and the Spalart-Allmaras turbulence
model. It showed how to monitor convergence using force and surface report definitions, and demon-
strated the use of several postprocessing tools to examine the flow phenomena associated with a shock
wave.

5.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 6: Modeling Transient Compressible Flow

This tutorial is divided into the following sections:
6.1. Introduction
6.2. Prerequisites
6.3. Problem Description
6.4. Setup and Solution
6.5. Summary
6.6. Further Improvements

6.1. Introduction

In this tutorial, ANSYS Fluent’s density-based implicit solver is used to predict the time-dependent flow
through a two-dimensional nozzle. As an initial condition for the transient problem, a steady-state
solution is generated to provide the initial values for the mass flow rate at the nozzle exit.

This tutorial demonstrates how to do the following:

• Calculate a steady-state solution (using the density-based implicit solver) as an initial condition for a transient
flow prediction.

• Define a transient boundary condition using a user-defined function (UDF).

• Use dynamic mesh adaption for both steady-state and transient flows.

• Calculate a transient solution using the second-order implicit transient formulation and the density-based
implicit solver.

• Create an animation of the transient flow using ANSYS Fluent’s transient solution animation feature.

6.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.
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6.3. Problem Description

The geometry to be considered in this tutorial is shown in Figure 6.1: Problem Specification (p. 268).
Flow through a simple nozzle is simulated as a 2D planar model. The nozzle has an inlet height of 0.2 m,
and the nozzle contours have a sinusoidal shape that produces a 20% reduction in flow area. Symmetry
allows only half of the nozzle to be modeled.

Figure 6.1:  Problem Specification

6.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
6.4.1. Preparation
6.4.2. Reading and Checking the Mesh
6.4.3. Solver and Analysis Type
6.4.4. Models
6.4.5. Materials
6.4.6. Operating Conditions
6.4.7. Boundary Conditions
6.4.8. Solution: Steady Flow
6.4.9. Enabling Time Dependence and Setting Transient Conditions
6.4.10. Specifying Solution Parameters for Transient Flow and Solving
6.4.11. Saving and Postprocessing Time-Dependent Data Sets

6.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.
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a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the unsteady_compressible_R180.zip link to download the input files.

7. Unzip the unsteady_compressible_R180.zip file you downloaded to your working folder.

The files nozzle.msh and pexit.c can be found in the unsteady_compressible folder created
after unzipping the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent
Launcher in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that Serial is selected under Processing Options.

11. Disable the Double Precision option.

6.4.2. Reading and Checking the Mesh

1. Read the mesh file nozzle.msh.

File → Read → Mesh...

The mesh for the half of the geometry is displayed in the graphics window.

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure
that the reported minimum volume is a positive number.

3. Verify that the mesh size is correct.

Setting Up Domain → Mesh → Scale
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Close the Scale Mesh dialog box.

4. Mirror the mesh across the centerline (Figure 6.2: 2D Nozzle Mesh Display with Mirroring (p. 271)).

Viewing → Display → Views...

a. Select symmetry in the Mirror Planes selection list.

b. Click Apply to refresh the display.

c. Close the Views dialog box.
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Figure 6.2:  2D Nozzle Mesh Display with Mirroring

6.4.3. Solver and Analysis Type

1. Select the solver settings.

Setting Up Physics → Solver → Density-Based

a. In the Solver group of the Setting Up Physics tab, select Density-Based from the Type list.

The density-based implicit solver is the solver of choice for compressible, transonic flows without
significant regions of low-speed flow. In cases with significant low-speed flow regions, the pressure-
based solver is preferred. Also, for transient cases with traveling shocks, the density-based explicit
solver with explicit time stepping may be the most efficient.
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b. Retain the default selection of Steady from the Time list.

Note

You will solve for the steady flow through the nozzle initially. In later steps, you will
use these initial results as a starting point for a transient calculation.

2. For convenience, change the unit of measurement for pressure.

The pressure for this problem is specified in atm, which is not the default unit in ANSYS Fluent. You must
redefine the pressure unit as atm.

Setting Up Domain → Mesh → Units...

a. Select pressure in the Quantities selection list.

Scroll down the list to find pressure.

b. Select atm in the Units selection list.

c. Close the Set Units dialog box.

6.4.4. Models

1. Enable the energy equation.

Setup → Models → Energy Model → On
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2. Select the k-omega SST turbulence model.

Setup → Models → Viscous Model → SST k-omega

6.4.5. Materials

1. Define the settings for air, the default fluid material.

Setup → Materials → air → Create/Edit...
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a. Select ideal-gas from the Density drop-down list in the Properties group box, so that the ideal gas
law is used to calculate density.

Note

ANSYS Fluent automatically enables the solution of the energy equation when the
ideal gas law is used, in case you did not already enable it manually in the Energy
dialog box.

b. Retain the default values for all other properties.

c. Click the Change/Create button to save your change.

d. Close the Create/Edit Materials dialog box.

6.4.6. Operating Conditions

1. Define the operating pressure.

Setting Up Physics → Solver → Operating Conditions...
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a. Enter 0 atm for Operating Pressure.

b. Click OK to close the Operating Conditions dialog box.

Since you have set the operating pressure to zero, you will specify the boundary condition inputs for
pressure in terms of absolute pressures when you define them in the next step. Boundary condition inputs
for pressure should always be relative to the value used for operating pressure.

6.4.7. Boundary Conditions

1. Define the boundary conditions for the nozzle inlet (inlet).

Setup → Boundary Conditions → inlet (pressure-inlet) Edit...
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a. Enter 0.9 atm for Gauge Total Pressure.

b. Enter 0.7369 atm for Supersonic/Initial Gauge Pressure.

The inlet static pressure estimate is the mean pressure at the nozzle exit. This value will be used during
the solution initialization phase to provide a guess for the nozzle velocity.

c. Retain Intensity and Viscosity Ratio from the Specification Method drop-down list in the Turbulence
group box.

d. Enter 1.5% for Turbulent Intensity.

e. Retain the setting of 10 for Turbulent Viscosity Ratio.

f. Click OK to close the Pressure Inlet dialog box.

2. Define the boundary conditions for the nozzle exit (outlet).

Setup → Boundary Conditions → outlet (pressure-outlet) Edit...
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a. Enter 0.7369 atm for Gauge Pressure.

b. Retain Intensity and Viscosity Ratio from the Specification Method drop-down list in the Turbulence
group box.

c. Enter 1.5% for Backflow Turbulent Intensity.

d. Retain the setting of 10 for Backflow Turbulent Viscosity Ratio.

If substantial backflow occurs at the outlet, you may need to adjust the backflow values to levels
close to the actual exit conditions.

e. Click OK to close the Pressure Outlet dialog box.

6.4.8. Solution: Steady Flow

In this step, you will generate a steady-state flow solution that will be used as an initial condition for the
time-dependent solution.

1. Define the solution parameters.

Solving → Solution → Methods...
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a. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the
Spatial Discretization group box.

b. Select Second Order Upwind from the Turbulent Kinetic Energy and Specific Dissipation Rate drop-
down lists.

Second-order discretization provides optimum accuracy.

2. Modify the Courant Number.

Solving → Controls → Controls...
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a. Enter 50 for the Courant Number.

Note

The default Courant number for the density-based implicit formulation is 5. For relat-
ively simple problems, setting the Courant number to 10, 20, 100, or even higher
value may be suitable and produce fast and stable convergence. However, if you en-
counter convergence difficulties at the startup of the simulation of a properly set up
problem, then you should consider setting the Courant number to its default value
of 5. As the solution progresses, you can start to gradually increase the Courant
number until the final convergence is reached.

b. Retain the default values for the Under-Relaxation Factors.

3. Enable the plotting of residuals.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Select none from the Convergence Criterion drop-down list.

c. Click OK to close the Residual Monitors dialog box.

4. Create the surface report definition for mass flow rate at the flow exit.

Solving → Reports → Definitions → New → Surface Report → Mass Flow Rate...
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a. Enter mass_flowrate_out for Name.

b. Select outlet in the Surfaces selection list.

c. In the Create group box, enable Report File, Report Plot and Print to Console.

Note

When Report File is enabled in the Surface Report Definition dialog box, the mass
flow rate history will be written to a file. If you do not enable this option, the history
information will be lost when you exit ANSYS Fluent.

d. Click OK to close the Surface Report Definition dialog box.
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mass_flowrate_out-rplot and mass_flowrate_out-rfile are automatically generated by Fluent
and appear in the tree (under Solution/Monitors/Report Plots and Solution/Monitors/Report
Files, respectively).

e. Modify the output file name.

Solution → Monitors → Report Files → mass_flowrate_out-rfile Edit...

i. Enter noz_ss.out for Output File Base Name.

ii. Click OK to close the Edit Report File dialog box.

5. Save the case file (noz_ss.cas.gz).

File → Write → Case...

6. Initialize the solution.

Solving → Initialization
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a. Keep the Method at the default of Hybrid.

b. Click Initialize.

7. Set up gradient adaption for dynamic mesh refinement.

You will enable dynamic adaption so that the solver periodically refines the mesh in the vicinity of the
shocks as the iterations progress. The shocks are identified by their large pressure gradients.

Setting Up Domain → Adapt → Mark/Adapt Cells → Gradient...

a. Select Gradient from the Method group box.

The mesh adaption criterion can either be the gradient or the curvature (second gradient). Because
strong shocks occur inside the nozzle, the gradient is used as the adaption criterion.

b. Select Scale from the Normalization group box.

Mesh adaption can be controlled by the raw (or standard) value of the gradient, the scaled value (by
its average in the domain), or the normalized value (by its maximum in the domain). For dynamic
mesh adaption, it is recommended that you use either the scaled or normalized value because the
raw values will probably change strongly during the computation, which would necessitate a read-
justment of the coarsen and refine thresholds. In this case, the scaled gradient is used.

c. Enable Dynamic in the Dynamic group box.

d. Enter 100 for the Interval.

For steady-state flows, it is sufficient to only seldomly adapt the mesh—in this case an interval of
100 iterations is chosen. For time-dependent flows, a considerably smaller interval must be used.

e. Retain the default selection of Pressure... and Static Pressure from the Gradients of drop-down lists.

f. Enter 0.3 for Coarsen Threshold.
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g. Enter 0.7 for Refine Threshold.

As the refined regions of the mesh get larger, the coarsen and refine thresholds should get smaller.
A coarsen threshold of 0.3 and a refine threshold of 0.7 result in a “medium” to “strong” mesh refine-
ment in combination with the scaled gradient.

h. Click Apply to store the information.

i. Click the Controls... button to open the Mesh Adaption Controls dialog box.

i. Retain the default selection of fluid in the Zones selection list.

ii. Enter 20000 for Max # of Cells.

To restrict the mesh adaption, the maximum number of cells can be limited. If this limit is violated
during the adaption, the coarsen and refine thresholds are adjusted to respect the maximum
number of cells. Additional restrictions can be placed on the minimum cell volume, minimum
number of cells, and maximum level of refinement.

iii. Click OK to save your settings and close the Mesh Adaption Controls dialog box.

j. Click Close to close the Gradient Adaption dialog box.

8. Start the calculation by requesting 500 iterations.

Solving → Run Calculation → Advanced...
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a. Enter 500 for Number of Iterations.

b. Click Calculate to start the steady flow simulation.

Figure 6.3:  Mass Flow Rate History

9. Save the case and data files (noz_ss.cas.gz and noz_ss.dat.gz).
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File → Write → Case & Data...

Note

When you write the case and data files at the same time, it does not matter whether you
specify the file name with a .cas or .dat extension, as both will be saved.

10. Click OK in the Question dialog box to overwrite the existing file.

11. Review a mesh that resulted from the dynamic adaption performed during the computation.

Results → Graphics → Mesh Edit...

a. Ensure that only the Edges option is enabled in the Options group box.

b. Select Feature from the Edge Type list.

c. Ensure that all of the items are selected from the Surfaces selection list.

d. Click Display and close the Mesh Display dialog box.

The mesh after adaption is displayed in the graphics window (Figure 6.4: 2D Nozzle Mesh after
Adaption (p. 287))

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.286

Modeling Transient Compressible Flow



Figure 6.4:  2D Nozzle Mesh after Adaption

e. Zoom in using the middle mouse button to view aspects of your mesh.

Notice that the cells in the regions of high pressure gradients have been refined.

12. Display the steady flow contours of static pressure (Figure 6.5: Contours of Static Pressure (Steady
Flow) (p. 288)).

Postprocessing → Graphics → Contours → Edit...
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a. Enable Filled in the Options group box.

b. Click Display and close the Contours dialog box.

Figure 6.5:  Contours of Static Pressure (Steady Flow)
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The steady flow prediction in Figure 6.5: Contours of Static Pressure (Steady Flow) (p. 288) shows the ex-
pected pressure distribution, with low pressure near the nozzle throat.

13. Display the steady-flow velocity vectors (Figure 6.6: Velocity Vectors Showing Recirculation (Steady
Flow) (p. 290)).

Postprocessing → Graphics → Vectors → Edit...

a. Enter 50 under Scale.

b. Click Display and close the Vectors dialog box.

The steady flow prediction shows the expected form, with a peak velocity of approximately 300 m/s
through the nozzle.

You can zoom in on the wall in the expansion region of the nozzle to view the recirculation of the
flow as shown in Figure 6.6: Velocity Vectors Showing Recirculation (Steady Flow) (p. 290) .
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Figure 6.6: Velocity Vectors Showing Recirculation (Steady Flow)

14. Check the mass flux balance.

Important

Although the mass flow rate history indicates that the solution is converged, you should
also check the mass flux throughout the domain to ensure that mass is being conserved.

Postprocessing → Reports → Fluxes...
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a. Retain the default selection of Mass Flow Rate.

b. Select inlet and outlet in the Boundaries selection list.

c. Click Compute and examine the values displayed in the dialog box.

Important

The net mass imbalance should be a small fraction (for example, 0.1%) of the
total flux through the system. The imbalance is displayed in the lower right field
under Net Results. If a significant imbalance occurs, you should decrease your
residual tolerances by at least an order of magnitude and continue iterating.

d. Close the Flux Reports dialog box.

6.4.9. Enabling Time Dependence and Setting Transient Conditions

In this step you will define a transient flow by specifying a transient pressure condition for the nozzle.

1. Enable a time-dependent flow calculation.

Setting Up Physics → Solver → Transient

2. Read the user-defined function (pexit.c), in preparation for defining the transient condition for the
nozzle exit.

The pressure at the outlet is defined as a wave-shaped profile, and is described by the following equation:

(6.1)

where
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= circular frequency of transient pressure (rad/s)

= mean exit pressure (atm)

In this case,  rad/s, and  atm.

A user-defined function ( pexit.c ) has been written to define the equation (Equation 6.1 (p. 291)) required
for the pressure profile.

Note

To input the value of Equation 6.1 (p. 291) in the correct units, the function pexit.c has
to be written in SI units.

More details about user-defined functions can be found in the Fluent Customization Manual.

User Defined → User Defined → Functions → Interpreted...

a. Enter pexit.c for Source File Name.

If the UDF source file is not in your working directory, then you must enter the entire directory path
for Source File Name instead of just entering the file name.

b. Click Interpret.

The user-defined function has already been defined, but it must be compiled within ANSYS Fluent before
it can be used in the solver.

c. Close the Interpreted UDFs dialog box.

3. Define the transient boundary conditions at the nozzle exit (outlet).

Setup → Boundary Conditions → outlet Edit...
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a. Select udf transient_pressure (the user-defined function) from the Gauge Pressure drop-down list.

b. Click OK to close the Pressure Outlet dialog box.

4. Update the gradient adaption parameters for the transient case.

Setting Up Domain → Adapt → Mark/Adapt Cells → Gradient...

a. Enter 10 for Interval in the Dynamic group box.

For the transient case, the mesh adaption will be done every 10 time steps.

b. Enter 0.3 for Coarsen Threshold.

c. Enter 0.7 for Refine Threshold.

The refine and coarsen thresholds have been changed during the steady-state computation to meet
the limit of 20000 cells. Therefore, you must reset these parameters to their original values.

d. Click Apply to store the values.

e. Click Controls... to open the Mesh Adaption Controls dialog box.

i. Enter 8000 for Min # of Cells.

ii. Enter 30000 for Max # of Cells.
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You must increase the maximum number of cells to try to avoid readjustment of the coarsen and
refine thresholds. Additionally, you must limit the minimum number of cells to 8000, because you
should not have a coarse mesh during the computation (the current mesh has approximately
20000 cells).

iii. Click OK to close the Mesh Adaption Controls dialog box.

f. Close the Gradient Adaption dialog box.

6.4.10. Specifying Solution Parameters for Transient Flow and Solving

1. Modify the mass_flowrate_out-rfile report file definition.

Solution → Monitors → Report Files → mass_flowrate_out-rfile Edit...

a. Enter noz_uns.out for Output File Base Name.

b. Select time-step from the Get Data Every drop-down list.

c. Click OK to close the Edit Report File dialog box.

2. Modify the mass_flowrate_out-rplot report plot definition.

Solution → Monitors → Report Plots → mass_flowrate_out-rplot Edit...
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a. For Get Data Every, retain the value of 1 and select time-step from the drop-down list.

Because each time step requires 10 iterations, a smoother plot will be generated by plotting at every
time step.

b. Select time-step from the X-Axis Label drop-down list.

c. Click OK to close the Edit Report File dialog box.

3. Save the transient solution case file (noz_uns.cas.gz).

File → Write → Case...

4. Modify the plotting of residuals.

Solving → Reports → Residuals...

a. Ensure that Plot is enabled in the Options group box.

b. Ensure none is selected from the Convergence Criterion drop-down list.

c. Set the Iterations to Plot to 100.

d. Click OK to close the Residual Monitors dialog box.

5. Define the time step parameters.
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The selection of the time step is critical for accurate time-dependent flow predictions. Using a time step

of 2.85596 x 10-5 seconds, 100 time steps are required for one pressure cycle. The pressure cycle begins
and ends with the initial pressure at the nozzle exit.

Solving → Run Calculation → Advanced

a. Enter 2.85596e-5 s for Time Step Size.

b. Enter 600 for Number of Time Steps.

c. Enter 10 for Max Iterations/Time Step.

d. Click Calculate to start the transient simulation.

By requesting 600 time steps, you are asking ANSYS Fluent to compute six pressure cycles. The mass flow
rate history is shown in Figure 6.7: Mass Flow Rate History (Transient Flow) (p. 297).
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Figure 6.7:  Mass Flow Rate History (Transient Flow)

6. Optionally, you can review the effect of dynamic mesh adaption performed during transient flow compu-
tation as you did in steady-state flow case.

7. Save the transient case and data files (noz_uns.cas.gz and noz_uns.dat.gz).

File → Write → Case & Data...

6.4.11. Saving and Postprocessing Time-Dependent Data Sets

At this point, the solution has reached a time-periodic state. To study how the flow changes within a single
pressure cycle, you will now continue the solution for 100 more time steps. You will use ANSYS Fluent’s
solution animation feature to save contour plots of pressure and Mach number at each time step, and the
autosave feature to save case and data files every 10 time steps. After the calculation is complete, you will
use the solution animation playback feature to view the animated pressure and Mach number plots over
time.

1. Request the saving of case and data files every 10 time steps.

Solving → Activities → Autosave...
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a. Enter 10 for Save Data File Every.

b. Select Each Time for Save Associated Case Files.

c. Retain the default selection of time-step from the Append File Name with drop-down list.

d. Enter noz_anim.gz for File Name.

When ANSYS Fluent saves a file, it will append the time step value to the file name prefix (
noz_anim ). The standard extensions ( .cas and .dat ) will also be appended. By adding the
optional extension .gz to the end of the file name, you instruct ANSYS Fluent to save the case and
data files in compressed format. This will yield file names of the form noz_anim-1-00640.cas.gz
and noz_anim-1-00640.dat.gz , where 00640 is the time step number.

e. Click OK to close the Autosave dialog box.

Tip

If you have constraints on disk space, you can restrict the number of files saved by
ANSYS Fluent by enabling the Retain Only the Most Recent Files option and setting
the Maximum Number of Data Files to a nonzero number.

2. Create an animation definition for the nozzle pressure contour plot.

Solving → Activities → Create → Solution Animations...
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a. Enter pressure for the Name.

b. Select Time Step for Record after every.

The default value of 1 in the integer number entry box instructs ANSYS Fluent to update the animation
sequence at every time step.

c. Select In Memory from the Storage Type drop-down.

The In Memory option is acceptable for a small 2D case such as this. For larger 2D or 3D cases,
saving animation files with either the Metafile or PPM Image option is preferable, to avoid using
too much of your machine’s memory.

d. Enter 3 for the Window Id.

e. Click New Object and select Contours... from the drop-down list to open the associated dialog box.
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i. Select Pressure... and Static Pressure from the Contours of drop-down lists.

ii. Ensure that Filled is enabled in the Options group box.

iii. Disable Auto Range.

iv. Enter 0.25 atm for Min and 1.25 atm for Max.

v. Click Save/Display and close the Contours dialog box.
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vi. Figure 6.8:  Pressure Contours at t=0.017136 s

f. Ensure contour-1 is selected in the Animation Object group box.

g. Click Save and close the Animation Definition dialog box.

3. Create an animation definition for the Mach number contour plot.

Solving → Activities → Create → Solution Animations...
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a. Enter mach-number for the Name.

b. Select Time Step for Record after every.

The default value of 1 in the integer number entry box instructs ANSYS Fluent to update the animation
sequence at every time step.

c. Ensure that In Memory is selected from the Storage Type drop-down.

d. Enter 4 for the Window Id.

e. Click New Object and select Contours... from the drop-down list to open the associated dialog box.

i. Select Velocity... and Mach Number from the Contours of drop-down lists.

ii. Ensure that Filled is enabled in the Options group box.

iii. Disable Auto Range.

iv. Enter 0.00 for Min and 1.30 for Max.

v. Click Save/Display and close the Contours dialog box.
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vi. Figure 6.9:  Mach Number Contours at t=0.017136 s

f. Ensure contour-2 is selected in the Animation Object group box.

g. Click Save and close the Animation Definition dialog box.

4. Continue the calculation by requesting 100 time steps.

By requesting 100 time steps, you will march the solution through an additional 0.0028 seconds, or
roughly one pressure cycle.

With the autosave and animation features active (as defined previously), the case and data files will be
saved approximately every 0.00028 seconds of the solution time; animation files will be saved every
0.000028 seconds of the solution time.

Solving → Run Calculation → Advanced...
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Enter 100 for Number of Time Steps and click Calculate.

When the calculation finishes, you will have ten pairs of case and data files and there will be 100 pairs
of contour plots stored in memory. In the next few steps, you will play back the animation sequences
and examine the results at several time steps after reading in pairs of newly saved case and data files.

5. Play the animation of the pressure contours.

Results → Animations → Solution Animation Playback Edit...
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a. Retain the default selection of pressure in the Sequences selection list.

Ensure that tab window 4 is open in the graphics window.

b. Click the play button (the second from the right in the group of buttons in the Playback group box).

c. Close the Playback dialog box.

Examples of pressure contours at  s (the 630th time step) and  s (the 670th time
step) are shown in Figure 6.10: Pressure Contours at t=0.017993 s (p. 306) and Figure 6.11: Pressure Contours
at t=0.019135 s (p. 306).
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Figure 6.10:  Pressure Contours at t=0.017993 s

Figure 6.11:  Pressure Contours at t=0.019135 s
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6. In a similar manner to steps 4 and 5, select the appropriate active window and animation sequence name
for the Mach number contours.

Examples of Mach number contours at  s and  s are shown in Figure 6.12: Mach
Number Contours at t=0.017993 s (p. 307) and Figure 6.13: Mach Number Contours at t=0.019135 s (p. 308).

Figure 6.12:  Mach Number Contours at t=0.017993 s

307
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 6.13:  Mach Number Contours at t=0.019135 s

Tip

ANSYS Fluent gives you the option of exporting an animation as an MPEG file or as a
series of files in any of the hardcopy formats available in the Save Picture dialog box
(including TIFF and PostScript).

To save an MPEG file, select MPEG from the Write/Record Format drop-down list in the
Playback dialog box and then click the Write button. The MPEG file will be saved in your
working folder. You can view the MPEG movie using an MPEG player (for example, Win-
dows Media Player or another MPEG movie player).

To save a series of TIFF, PostScript, or other hardcopy files, select Picture Frames in the
Write/Record Format drop-down list in the Playback dialog box. Click the Picture Op-
tions... button to open the Save Picture dialog box and set the appropriate parameters
for saving the hardcopy files. Click Apply in the Save Picture dialog box to save your
modified settings. Click Save... to select a directory in which to save the files. In the
Playback dialog box, click the Write button. ANSYS Fluent will replay the animation,
saving each frame to a separate file in your working folder.

If you want to view the solution animation in a later ANSYS Fluent session, you can select
Animation Frames as the Write/Record Format and click Write.

Warning

Because the solution animation was stored in memory, it will be lost if you exit
ANSYS Fluent without saving it in one of the formats described previously. Note
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that only the animation-frame format can be read back into the Playback dialog
box for display in a later ANSYS Fluent session.

7. Read the case and data files for the 660th time step (noz_anim–1–00660.cas.gz and noz_an-
im–1–00660.dat.gz) into ANSYS Fluent.

8. Plot vectors at  s (Figure 6.14: Velocity Vectors at t=0.018849 s (p. 310)).

Postprocessing → Graphics → Vectors → Edit...

a. Ensure Auto Scale is enabled under Options.

b. Enter 50 under Scale.

c. Enter 50 under Skip.

d. Click Display and close the Vectors dialog box.
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Figure 6.14: Velocity Vectors at t=0.018849 s

The transient flow prediction in Figure 6.14: Velocity Vectors at t=0.018849 s (p. 310) shows the expected
form, with peak velocity of approximately 260 m/s through the nozzle at  seconds.

9. In a similar manner to steps 7 and 8, read the case and data files saved for other time steps of interest and
display the vectors.

6.5. Summary

In this tutorial, you modeled the transient flow of air through a nozzle. In doing so, you learned how
to:

• generate a steady-state solution as an initial condition for the transient case.

• set solution parameters for implicit time-stepping and apply a user-defined transient pressure profile
at the outlet.

• use mesh adaption to refine the mesh in areas with high pressure gradients to better capture the shocks.

• automatically save solution information as the transient calculation proceeds.

• create and view solution animations of the transient flow.

6.6. Further Improvements

This tutorial guides you through the steps to generate a second-order solution. You may be able to
increase the accuracy of the solution even further by using an appropriate higher-order discretization
scheme and by adapting the mesh further. Mesh adaption can also ensure that the solution is independ-
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ent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and
Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 7: Modeling Radiation and Natural Convection

This tutorial is divided into the following sections:
7.1. Introduction
7.2. Prerequisites
7.3. Problem Description
7.4. Setup and Solution
7.5. Summary
7.6. Further Improvements

7.1. Introduction

In this tutorial, combined radiation and natural convection are solved in a three-dimensional square
box on a mesh consisting of hexahedral elements.

This tutorial demonstrates how to do the following:

• Use the surface-to-surface (S2S) radiation model in ANSYS Fluent.

• Set the boundary conditions for a heat transfer problem involving natural convection and radiation.

• Calculate a solution using the pressure-based solver.

• Display velocity vectors and contours of wall temperature, surface cluster ID, and radiation heat flux.

7.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

7.3. Problem Description

The problem to be considered is shown schematically in Figure 7.1: Schematic of the Problem (p. 314).

A three-dimensional box  has a hot wall of aluminum at 473.15 K. All other
walls are made of an insulation material and are subject to radiative and convective heat transfer to
the surroundings, which are at 293.15 K. Gravity acts downwards. The medium contained in the box is
assumed not to emit, absorb, or scatter radiation. All walls are gray. The objective is to compute the
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flow and temperature patterns in the box, as well as the wall heat flux, using the surface-to-surface
(S2S) model available in ANSYS Fluent.

The working fluid has a Prandtl number of approximately 0.71, and the Rayleigh number based on 

(0.25) is . This means the flow is most likely laminar. The Planck number  is 0.006,
and measures the relative importance of conduction to radiation.

Figure 7.1:  Schematic of the Problem

7.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
7.4.1. Preparation
7.4.2. Reading and Checking the Mesh
7.4.3. Solver and Analysis Type
7.4.4. Models
7.4.5. Defining the Materials
7.4.6. Operating Conditions
7.4.7. Boundary Conditions
7.4.8. Obtaining the Solution
7.4.9. Postprocessing
7.4.10. Comparing the Contour Plots after Varying Radiating Surfaces
7.4.11. S2S Definition, Solution, and Postprocessing with Partial Enclosure

7.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
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2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the radiation_natural_convection_R180.zip link to download the input files.

7. Unzip radiation_natural_convection_R180.zip to your working folder.

The mesh file rad.msh.gz can be found in the radiation_natural_convection folder created
after unzipping the file.

8. Use Fluent Launcher to start the 3D, single precision (disable Double Precision) version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that Serial is selected under Processing Options.

7.4.2. Reading and Checking the Mesh

1. Read the mesh file rad.msh.gz.

File → Read → Mesh...

As the mesh is read, messages will appear in the console reporting the progress of the reading and the
mesh statistics. The mesh size will be reported as 64,000 cells. Once reading is complete, the mesh will
be displayed in the graphics window.
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Figure 7.2:  Graphics Display of Mesh

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure
that the reported minimum volume is a positive number.

7.4.3. Solver and Analysis Type

1. Confirm the solver settings and enable gravity.

Setup → General
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a. Retain the default settings of pressure-based steady-state solver in the Solver group box.

b. Enable the Gravity option.

c. Enter -9.81 m/s2 for Y in the Gravitational Acceleration group box.

7.4.4. Models

1. Enable the energy equation.

Setup → Models → Energy On

2. Set up the Surface to Surface (S2S) radiation model.
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Setup → Models → Radiation Model → Surface to Surface (S2S)

The surface-to-surface (S2S) radiation model can be used to account for the radiation exchange in an
enclosure of gray-diffuse surfaces. The energy exchange between two surfaces depends in part on their
size, separation distance, and orientation. These parameters are accounted for by a geometric function
called a “view factor”.

The S2S model assumes that all surfaces are gray and diffuse. Thus according to the gray-body model,
if a certain amount of radiation is incident on a surface, then a fraction is reflected, a fraction is absorbed,
and a fraction is transmitted. The main assumption of the S2S model is that any absorption, emission,
or scattering of radiation by the medium can be ignored. Therefore only “surface-to-surface” radiation
is considered for analysis.

For most applications the surfaces in question are opaque to thermal radiation (in the infrared spectrum),
so the surfaces can be considered opaque. For gray, diffuse, and opaque surfaces it is valid to assume
that the emissivity is equal to the absorptivity and that reflectivity is equal to 1 minus the emissivity.

When the S2S model is used, you also have the option to define a “partial enclosure”. This option allows
you to disable the view factor calculation for walls with negligible emission/absorption or walls that
have uniform temperature. The main advantage of this option is to speed up the view factor calculation
and the radiosity calculation.

a. Click the Settings... button to open the View Factors and Clustering dialog box.

You will define the view factor and cluster parameters.
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i. Retain the value of 1 for Faces per Surface Cluster for Flow Boundary Zones in the Manual group
box.

ii. Click Apply to All Walls.

The S2S radiation model is computationally very expensive when there are a large number of
radiating surfaces. The number of radiating surfaces is reduced by clustering surfaces into surface
“clusters”. The surface clusters are made by starting from a face and adding its neighbors and
their neighbors until a specified number of faces per surface cluster is collected.

For a small problem, the default value of 1 for Faces per Surface Cluster for Flow Boundary
Zones is acceptable. For a large problem you can increase this number to reduce the memory
requirement for the view factor file that is saved in a later step. This may also lead to some reduc-
tion in the computational expense. However, this is at the cost of some accuracy. This tutorial il-
lustrates the influence of clusters.

iii. Ensure Ray Tracing is selected from the Method list in the View Factors group box.

iv. Click OK to close the View Factors and Clustering dialog box.

b. Click the Compute/Write/Read... button in the View Factors and Clustering group box to open the
Select File dialog box and to compute the view factors.
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The file created in this step will store the cluster and view factor parameters.

i. Enter rad_1.s2s.gz as the file name for S2S File.

ii. Click OK in the Select File dialog box.

Note

The size of the view factor file can be very large if not compressed. It is highly
recommended to compress the view factor file by providing .gz or .Z extension
after the name (that is, rad_1.gz or rad_1.Z). For small files, you can provide
the .s2s extension after the name.

ANSYS Fluent will print an informational message describing the progress of the view factor cal-
culation in the console.

c. Click OK to close the Radiation Model dialog box.

7.4.5. Defining the Materials

1. Set the properties for air.

Setup → Materials → Fluids → air Edit...

a. Select ideal-gas from the Density drop-down list.

b. Enter 1021 J/kg-K for Cp (Specific Heat).
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c. Enter 0.0371 W/m-K for Thermal Conductivity.

d. Enter 2.485e-05 kg/m-s for Viscosity.

e. Retain the default value of 28.966 kg/kmol for Molecular Weight.

f. Click Change/Create and close the Create/Edit Materials dialog box.

2. Define the new material, insulation.

Setup → Materials → Solid → aluminum Edit...

a. Enter insulation for Name.

b. Delete the entry in the Chemical Formula field.

c. Enter 50 kg/m3 for Density.

d. Enter 800 J/kg-K for Cp (Specific Heat).

e. Enter 0.09 W/m-K for Thermal Conductivity.

f. Click Change/Create.

g. Click No when the Question dialog box appears, asking if you want to overwrite aluminum.

The Create/Edit Materials dialog box will be updated to show the new material, insulation, in the
Fluent Solid Materials drop-down list.

h. Close the Create/Edit Materials dialog box.

7.4.6. Operating Conditions

Specify operating density.
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Setting Up Physics → Solver → Operating Conditions...

1. In the Operating Conditions dialog box, select the Specified Operating Density check box.

2. Enter 0 for Operating Density and click OK to close the Operating Conditions dialog box.

7.4.7. Boundary Conditions

1. Set the boundary conditions for the front wall (w-high-x).

Setup → Boundary Conditions → w-high-x Edit...

The Wall dialog box opens.
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a. Click the Thermal tab and select Mixed from the Thermal Conditions list.

b. Select insulation from the Material Name drop-down list.

c. Enter 5 W/m2-K for Heat Transfer Coefficient.

d. Enter 293.15 K for Free Stream Temperature.

e. Enter 0.75 for External Emissivity.

f. Enter 293.15 K for External Radiation Temperature.

g. Enter 0.95 for Internal Emissivity.

h. Enter 0.05 m for Wall Thickness.

i. Click OK to close the Wall dialog box.

2. Copy boundary conditions to define the side walls w-high-z and w-low-z.

Setup → Boundary Conditions → w-high-x Copy...
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a. Ensure w-high-x is selected in the From Boundary Zone selection list.

b. Select w-high-z and w-low-z from the To Boundary Zones selection list.

c. Click Copy.

d. Click OK when the Question dialog box opens asking whether you want to copy the boundary conditions
of w-high-x to all the selected zones.

e. Close the Copy Conditions dialog box.

3. Set the boundary conditions for the heated wall (w-low-x).

Setup → Boundary Conditions → w-low-x Edit...
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a. Click the Thermal tab and select Temperature from the Thermal Conditions list.

b. Retain the default selection of aluminum from the Material Name drop-down list.

c. Enter 473.15 K for Temperature.

d. Enter 0.95 for Internal Emissivity.

e. Click OK to close the Wall dialog box.

4. Set the boundary conditions for the top wall (w-high-y).

Setup → Boundary Conditions → w-high-y Edit...

a. Click the Thermal tab and select Mixed from the Thermal Conditions list.

b. Select insulation from the Material Name drop-down list.

c. Enter 3 W/m2-K for Heat Transfer Coefficient.

d. Enter 293.15 K for Free Stream Temperature.

e. Enter 0.75 for External Emissivity.

f. Enter 293.15 K for External Radiation Temperature.

g. Enter 0.95 for Internal Emissivity.

h. Enter 0.05 m for Wall Thickness.

i. Click OK to close the Wall dialog box.
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5. Copy boundary conditions to define the bottom wall (w-low-y) as previously done in this tutorial.

Setup → Boundary Conditions → w-high-y Copy...

a. Ensure w-high-y is selected in the From Boundary Zone selection list.

b. Select w-low-y from the To Boundary Zones selection list.

c. Click Copy.

d. Click OK when the Question dialog box opens asking whether you want to copy the boundary conditions
of w-high-y to all the selected zones.

e. Close the Copy Conditions dialog box.

7.4.8. Obtaining the Solution

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Select Body Force Weighted from the Pressure drop-down list in the Spatial Discretization group
box.

c. Retain the default selection of Second Order Upwind from the Momentum and Energy drop-down
lists.

d. Enable the Pseudo Transient option.

2. Set the convergence criteria for you simulation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Enter 0.0001 for the Absolute Criteria of continuity, x-, y-, and z-velocity.

c. Enter 1e-7 for the Absolute Criteria of energy.

Decreasing the criteria for these residuals will improve the accuracy of the solution.

d. Click OK

3. Initialize the solution.

Solving → Initialization

a. Retain the default selection of Hybrid Initialization from the Initialization Methods list.

b. Click Initialize.

4. Create a surface report definition to aid in judging convergence.

It is good practice to use reports of physical solution quantities together with residual monitors when
determining whether a solution is converged. In this step you will create a surface report definition for
the average temperature on the z=0 plane.

a. Create the new surface, zz_center_z.
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Setting Up Domain → Surface → Create → Iso-Surface...

i. Select Mesh... and Z-Coordinate from the Surface of Constant drop-down lists.

ii. Click Compute and retain the default value of 0 for Iso-Values.

iii. Enter zz_center_z for New Surface Name.

Note

If you want to delete or otherwise manipulate any surfaces, click Manage... to
open the Surfaces dialog box.

iv. Click Create and close the Iso-Surface dialog box.

b. Create the surface report definition.

Solving → Reports → Definitions → New → Surface Report → Area-Weighted Average...
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i. Enter surf-mon-1 for the Name of the surface report definition.

ii. In the Create group box, enable Report Plot and Print to Console.

Note

Unlike residual values, data from other reports is not saved as part of the solution
set when the ANSYS Fluent data file is saved. If you want to access the surface
report data in future ANSYS Fluent sessions, you can enable the Report File option.
The report file will be saved in your working directory.

iii. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

iv. Select zz_center_z from the Surfaces selection list.

v. Click OK to save the surface report definition settings and close the Surface Report Definition
dialog box.
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5. Save the case file (rad_a_1.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 400 iterations.

Solving → Run Calculation→Advanced...

a. Select User Specified from the Time Step Method list.

b. Retain the default value of 1 for Pseudo Time Step.

c. Enter 400 for Number of Iterations.

d. Click Calculate.
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Figure 7.3: Temperature Surface Report

The surface report history shows that the average temperature on zz_center_z has stabilized, thus con-
firming that the solution has indeed reached convergence. You can view the behavior of the residuals
(Figure 7.4: Scaled Residuals (p. 333)) in the Scaled Residuals graphics window tab.
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Figure 7.4:  Scaled Residuals

7. Save the case and data files (rad_a_1.cas.gz,rad_a_1.dat.gz).

File → Write → Case & Data...

7.4.9. Postprocessing

1. Enable the postprocessing view by clicking  in the objects toolbar and selecting Post Processing.

2. Disable lighting.

Results → Graphics Lights...

a. Disable Light On and click Apply.

b. Close the Lights dialog box.

3. Create a new surface, zz_x_side, which will be used later to plot wall temperature.

Postprocessing → Surface → Create → Line/Rake...
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a. Enter (-0.125,0,0.125) for (x0, y0, z0), respectively.

b. Enter (0.125,0,0.125) for (x1, y1, z1), respectively.

c. Enter zz_x_side for New Surface Name.

Note

If you want to delete or otherwise manipulate any surfaces, click Manage... to open
the Surfaces dialog box.

d. Click Create and close the Line/Rake Surface dialog box.

4. Display contours of static temperature.

Postprocessing → Graphics → Contours → Edit...
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a. Enable the Filled option in the Options group box.

b. Select Temperature... and Static Temperature from the Contours of drop-down lists.

c. Select zz_center_z from the Surfaces selection list.

d. Enable the Draw Mesh option in the Options group box to open the Mesh Display dialog box.

i. Ensure Outline is selected in the Edge Type group box.

ii. Close the Mesh Display dialog box.

e. Disable the Auto Range option.

f. Enter 421 K for Min and 473.15 K for Max.

g. Click Display, rotate the view as shown in Figure 7.5: Contours of Static Temperature (p. 336), and close
the Contours dialog box.
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Figure 7.5:  Contours of Static Temperature

A regular check for most buoyant cases is to look for evidence of stratification in the temperature field.
This is observed as nearly horizontal bands of similar temperature. These may be broken or disturbed by
buoyant plumes. For this case you can expect reasonable stratification with some disturbance at the
vertical walls where the air is driven around. Inspection of the temperature contours in Figure 7.5: Contours
of Static Temperature (p. 336) reveals that the solution appears as expected.

5. Create and display a contour definition for wall temperature (surfaces in contact with the fluid).

Postprocessing → Graphics → Contours → New...
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a. Enter wall-temperature for Contour Name.

b. Ensure that the Filled option is enabled in the Options group box.

c. Disable the Node Values option.

d. Select Temperature... and Wall Temperature from the Contours of drop-down lists.

e. Select all surfaces except default-interior and zz_x_side in the Surfaces selection list.

f. Enter 413 K for Min and 473.15 K for Max.

g. Click Save/Display, and rotate the view as shown in Figure 7.6: Contours of Wall Temperature (p. 338).
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Figure 7.6:  Contours of Wall Temperature

6. Display contours of radiation heat flux.

Postprocessing → Graphics → Contours → Edit...
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a. Ensure that the Filled option is enabled in the Options group box.

b. Enable Auto Range.

c. Select Wall Fluxes... and Radiation Heat Flux from the Contours of drop-down list.

d. Make sure that all surfaces except default-interior and zz_x_side are selected in the Surfaces selection
list.

e. Click Display.

f. Close the Contours dialog box.

Figure 7.7: Contours of Radiation Heat Flux (p. 340) shows the radiating wall (w-low-x) with positive
heat flux and all other walls with negative heat flux.
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Figure 7.7:  Contours of Radiation Heat Flux

7. Display vectors of velocity magnitude.

Postprocessing → Graphics → Vectors → Edit...
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a. Retain the default selection of Velocity from the Vectors of drop-down list.

b. Retain the default selection of Velocity... and Velocity Magnitude from the Color by drop-down lists.

c. Select zz_center_z from the Surfaces selection list.

d. Enable the Draw Mesh option in the Options group box to open the Mesh Display dialog box.

i. Ensure that Outline is selected from the Edge Type list.

ii. Click Display and close the Mesh Display dialog box.

e. Enter 7 for Scale.

f. Click Display and rotate the view as shown in Figure 7.8: Vectors of Velocity Magnitude (p. 342).

g. Close the Vectors dialog box.
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Figure 7.8: Vectors of Velocity Magnitude

8. Compute view factors and radiation emitted from the front wall (w-high-x) to all other walls.

In the Postprocessing tab, click S2S Information... (Model Specific group box).

Postprocessing → Model Specific → S2S Information...

a. Ensure that the View Factors option is enabled in the Report Options group box.

b. Enable the Incident Radiation option.
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c. Select w-high-x from the From selection list.

d. Select all zones except w-high-x from the To selection list.

e. Click Compute and close the S2S Information dialog box.

The computed values of the view factors and incident radiation are displayed in the console. A view
factor of approximately 0.2 for each wall is a good value for the square box.

9. Compute the total heat transfer rate.

Postprocessing → Reports → Fluxes...

a. Select Total Heat Transfer Rate from the Options list.

b. Select all boundary zones except default-interior from the Boundaries selection list.

c. Click Compute.

Note

The energy imbalance is approximately 0.004%.

10. Compute the total heat transfer rate for w-low-x.

Postprocessing → Reports → Fluxes...
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a. Retain the selection of Total Heat Transfer Rate from the Options list.

b. Deselect all boundary zones and select w-low-x from the Boundaries selection list.

c. Click Compute.

Note

The net heat load is approximately 63 W.

11. Compute the radiation heat transfer rate.

Postprocessing → Reports → Fluxes...
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a. Select Radiation Heat Transfer Rate from the Options list.

b. Select all boundary zones except default-interior from the Boundaries selection list.

c. Click Compute.

Note

The heat imbalance is approximately -0.007 W.

12. Compute the radiation heat transfer rate for w-low-x.

Postprocessing → Reports → Fluxes...
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a. Retain the selection of Radiation Heat Transfer Rate from the Options list.

b. Deselect all boundary zones and select w-low-x from the Boundaries selection list.

c. Click Compute and close the Flux Reports dialog box.

The net heat load is approximately 51 W. After comparing the total heat transfer rate and radiation heat
transfer rate, it can be concluded that radiation is the dominant mode of heat transfer.

13. Display the temperature profile for the side wall.

Postprocessing → Plots → XY Plot → Edit...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.346

Modeling Radiation and Natural Convection



a. Select Temperature... and Wall Temperature from the Y Axis Function drop-down lists.

b. Retain the default selection of Direction Vector from the X Axis Function drop-down list.

c. Select zz_x_side from the Surfaces selection list.

d. Click Plot (Figure 7.9: Temperature Profile Along the Outer Surface of the Box (p. 348)).

e. Enable the Write to File option and click the Write... button to open the Select File dialog box.

i. Enter tp_1.xy for XY File.

ii. Click OK in the Select File dialog box.

f. Disable the Write to File option.

g. Close the Solution XY Plot dialog box.
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Figure 7.9: Temperature Profile Along the Outer Surface of the Box

14. Save the case and data files (rad_b_1.cas.gz and rad_b_1.dat.gz).

File → Write → Case & Data...

7.4.10. Comparing the Contour Plots after Varying Radiating Surfaces

1. Increase the number of faces per cluster to 10.

Setup → Models → Radiation Edit...

a. Click the Settings... button to open the View Factors and Clustering dialog box.

i. Enter 10 for Faces per Surface Cluster for Flow Boundary Zones in the Manual group box.

ii. Click Apply to All Walls.

iii. Click OK to close the View Factors and Clustering dialog box.

b. Click the Compute/Write/Read... button to open the Select File dialog box and to compute the view
factors.

Specify a name for the S2S file that will store the cluster and view factor parameters.

i. Enter rad_10.s2s.gz for S2S File.

ii. Click OK in the Select File dialog box.
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c. Click OK to close the Radiation Model dialog box.

2. Right-click Solution Initialization and select Initialize.

Solution → Solution Initialization Initialize

3. Start the calculation by requesting 400 iterations.

Solution → Run Calculation Calculate

The solution will converge in approximately 309 iterations.

4. Save the case and data files (rad_10.cas.gz and rad_10.dat.gz).

File → Write → Case & Data...

5. In a similar manner described in the steps 13.a – 13.g of Postprocessing (p. 333), display the temperature
profile for the side wall and write it to a file named tp_10.xy.

6. Repeat the procedure, outlined in steps 1 – 5 of this section, for 100, 400, 800, and 1600 faces per surface
cluster and save the respective S2S files (for example,rad_100.s2s.gz), case and data files (for example,
rad_100.cas.gz), and temperature profile files (for example,tp_100.xy).

7. Display contours of wall temperature for all six cases using the wall-temperature definition you created
earlier.

Results → Graphics → Contours → wall-temperature Display
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Figure 7.10:  Contours of Wall Temperature: 1 Face per Surface Cluster

Figure 7.11:  Contours of Wall Temperature: 10 Faces per Surface Cluster
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Figure 7.12:  Contours of Wall Temperature: 100 Faces per Surface Cluster

Figure 7.13:  Contours of Wall Temperature: 400 Faces per Surface Cluster
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Figure 7.14:  Contours of Wall Temperature: 800 Faces per Surface Cluster

Figure 7.15:  Contours of Wall Temperature: 1600 Faces per Surface Cluster
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8. Display contours of surface cluster ID for 1600 faces per surface cluster (Figure 7.16: Contours of Surface
Cluster ID—1600 Faces per Surface Cluster (FPSC) (p. 354)).

Postprocessing → Graphics → Contours → Edit...

a. Ensure that the Filled option is enabled in the Options group box.

b. Ensure that the Node Values option is disabled.

c. Enable the Auto Range option.

d. Select Radiation... and Surface Cluster ID from the Contours of drop-down lists.

e. Ensure that all surfaces except default-interior and zz_x_side are selected in the Surfaces selection
list.

f. Click Display and rotate the view as shown in Figure 7.16: Contours of Surface Cluster ID—1600 Faces
per Surface Cluster (FPSC) (p. 354).

g. Close the Contours dialog box.
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Figure 7.16:  Contours of Surface Cluster ID—1600 Faces per Surface Cluster (FPSC)

9. Read rad_400.cas.gz and rad_400.dat.gz and, in a similar manner to the previous step, display
contours of surface cluster ID (Figure 7.17: Contours of Surface Cluster ID—400 FPSC (p. 355)).
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Figure 7.17:  Contours of Surface Cluster ID—400 FPSC

Figure 7.17: Contours of Surface Cluster ID—400 FPSC (p. 355) shows contours of Surface Cluster ID for
400 FPSC. This case shows better clustering compared to all of the other cases.

10. Create a plot that compares the temperature profile plots for 1, 10, 100, 400, 800, and 1600 FPSC.

Postprocessing → Plots → File...

a. Click the Add... button to open the Select File dialog box.

i. Select the file tp_1.xy that you created in step 11 of Postprocessing (p. 333).

ii. Click OK to close the Select File dialog box.

b. Change the legend entry for the data series.
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i. Enter Faces/Cluster in the Legend Title text box.

ii. Enter 1 in the text box to the left of the Change Legend Entry button.

iii. Click Change Legend Entry.

ANSYS Fluent will update the Legend Entry text for the file tp_1.xy.

c. Load the files tp_10.xy,tp_100.xy,tp_400.xy,tp_800.xy, and tp_1600.xy and change
their legend entries accordingly, in a manner similar to the previous two steps (a and b).

d. Click the Axes... button to open the Axes dialog box.

i. Ensure X is selected from the Axis list.

ii. Enter 3 for Precision in the Number Format group box and click Apply.

iii. Select Y from the Axis list.

iv. Enter 2 for Precision and click Apply.
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v. Close the Axes dialog box.

e. Click Plot (Figure 7.18: A Comparison of Temperature Profiles along the Outer Surface of the Box (p. 357))
and close the File XY Plot dialog box.

Figure 7.18:  A Comparison of Temperature Profiles along the Outer Surface of the Box

7.4.11. S2S Definition, Solution, and Postprocessing with Partial Enclosure

As mentioned previously, when the S2S model is used, you also have the option to define a “partial enclosure”;
that is, you can disable the view factor calculation for walls with negligible emission/absorption, or walls
that have uniform temperature. Even though the view factor will not be computed for these walls, they will
still emit radiation at a fixed temperature called the “partial enclosure temperature”. The main advantage
of this is to speed up the view factor and the radiosity calculation.

In the steps that follow, you will specify the radiating wall (w-low-x) as a boundary zone that is not particip-
ating in the S2S radiation model. Consequently, you will specify the partial enclosure temperature for the
wall. Note that the partial enclosure option may not yield accurate results in cases that have multiple wall
boundaries that are not participating in S2S radiation and that each have different temperatures. This is
because a single partial enclosure temperature is applied to all of the non-participating walls.

1. Read the case file saved previously for the S2S model (rad_b_1.cas.gz).

File → Read → Case...

2. Set the partial enclosure parameters for the S2S model.

Setup → Boundary Conditions → w-low-x Edit...
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a. Click the Radiation tab.

b. Disable the Participates in View Factor Calculation option in the S2S Parameters group box.

c. Click OK to close the Wall dialog box.

Click OK to close the dialog box informing you that you must recompute viewfactors.

3. Compute the view factors for the S2S model.

Setup → Models → Radiation Edit...

a. Click the Settings... button to open the View Factors and Clustering dialog box.

b. Click the Select... button to open the Participating Boundary Zones dialog box.
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i. Enter 473.15 K for Non-Participating Boundary Zones Temperature.

ii. Click OK to close the Participating Boundary Zones dialog box.

Click OK to close the dialog box informing you that you must recompute viewfactors.

c. Click OK to close the View Factors and Clustering dialog box.

d. Click the Compute/Write/Read... button to open the Select File dialog box and to compute the view
factors.

The view factor file will store the view factors for the radiating surfaces only. This may help you control
the size of the view factor file as well as the memory required to store view factors in ANSYS Fluent.
Furthermore, the time required to compute the view factors will be reduced, as only the view factors
for radiating surfaces will be calculated.

i. Enter rad_partial.s2s.gz for S2S File.

ii. Click OK in the Select File dialog box.

e. Click OK to close the Radiation Model dialog box.

4. Right-click Solution Initialization and select Initialize.

Solution → Solution Initialization Initialize

5. Start the calculation by requesting 400 iterations.

Solution → Run Calculation Calculate

The solution will converge in approximately 300 iterations.

6. Save the case and data files (rad_partial.cas.gz and rad_partial.dat.gz).

File → Write → Case & Data...
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7. Compute the radiation heat transfer rate.

Postprocessing → Reports → Fluxes...

a. Ensure that Radiation Heat Transfer Rate is selected from the Options list.

b. Select all boundary zones except default-interior from the Boundaries selection list.

c. Click Compute and close the Flux Reports dialog box.

The Flux Reports dialog box does not report any heat transfer rate for the radiating wall (w-low-x),
because you specified that it not participate in the view factor calculation. The remaining walls report
similar rates to those obtained in step 9 of Postprocessing (p. 333), indicating that in this case the use of
a partial enclosure saved computation time without significantly affecting the results.

8. Compare the temperature profile for the side wall to the profile saved in tp_1.xy.

Postprocessing → Plots → XY Plot → Edit...

a. Display the temperature profile for the side wall, zz_x_side, and write it to a file named tp_par-
tial.xy, in a manner similar to the instructions shown in step 13 of Postprocessing (p. 333).

b. Click Load File... to open the Select File dialog box.

i. Select tp_1.xy.

ii. Click OK to close the Select File dialog box.

c. Click Plot.

d. Close the Solution XY Plot dialog box.
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Figure 7.19: Wall Temperature Profile Comparison

Figure 7.19: Wall Temperature Profile Comparison (p. 361) further confirms that the use of a partial enclosure
did not significantly affect the results.

7.5. Summary

In this tutorial you studied combined natural convection and radiation in a three-dimensional square
box and compared how varying the settings of the surface-to-surface (S2S) radiation model affected
the results. The S2S radiation model is appropriate for modeling the enclosure radiative transfer without
participating media, whereas the methods for participating radiation may not always be efficient.

For more information about the surface-to-surface (S2S) radiation model, see the Fluent User's Guide.

7.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 8: Modeling Flow Through Porous Media

This tutorial is divided into the following sections:
8.1. Introduction
8.2. Prerequisites
8.3. Problem Description
8.4. Setup and Solution
8.5. Summary
8.6. Further Improvements

8.1. Introduction

Many industrial applications such as filters, catalyst beds, and packing, involve modeling the flow through
porous media. This tutorial illustrates how to set up and solve a problem involving gas flow through
porous media.

The industrial problem solved here involves gas flow through a catalytic converter. Catalytic converters
are commonly used to purify emissions from gasoline and diesel engines by converting environmentally
hazardous exhaust emissions to acceptable substances. Examples of such emissions include carbon
monoxide (CO), nitrogen oxides (NOx), and unburned hydrocarbon fuels. These exhaust gas emissions
are forced through a substrate, which is a ceramic structure coated with a metal catalyst such as platinum
or palladium.

The nature of the exhaust gas flow is a very important factor in determining the performance of the
catalytic converter. Of particular importance is the pressure gradient and velocity distribution through
the substrate. Hence, CFD analysis is useful for designing efficient catalytic converters. By modeling the
exhaust gas flow, the pressure drop and the uniformity of flow through the substrate can be determined.
In this tutorial, ANSYS Fluent is used to model the flow of nitrogen gas through a catalytic converter
geometry, so that the flow field structure may be analyzed.

This tutorial demonstrates how to do the following:

• Set up a porous zone for the substrate with appropriate resistances.

• Calculate a solution for gas flow through the catalytic converter using the pressure-based solver.

• Plot pressure and velocity distribution on specified planes of the geometry.

• Determine the pressure drop through the substrate and the degree of non-uniformity of flow through cross
sections of the geometry using X-Y plots and numerical reports.

8.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)
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• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

8.3. Problem Description

The catalytic converter modeled here is shown in Figure 8.1: Catalytic Converter Geometry for Flow
Modeling (p. 364). The nitrogen flows through the inlet with a uniform velocity of 22.6 m/s, passes
through a ceramic monolith substrate with square-shaped channels, and then exits through the outlet.

Figure 8.1:  Catalytic Converter Geometry for Flow Modeling

While the flow in the inlet and outlet sections is turbulent, the flow through the substrate is laminar
and is characterized by inertial and viscous loss coefficients along the inlet axis. The substrate is imper-
meable in other directions. This characteristic is modeled using loss coefficients that are three orders
of magnitude higher than in the main flow direction.

8.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
8.4.1. Preparation
8.4.2. Mesh
8.4.3. General Settings
8.4.4. Models
8.4.5. Materials
8.4.6. Cell Zone Conditions
8.4.7. Boundary Conditions
8.4.8. Solution
8.4.9. Postprocessing
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8.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the porous_R180.zip link to download the input files.

7. Unzip porous_R180.zip to your working folder.

The mesh file catalytic_converter.msh can be found in the porous directory created after
unzipping the file.

8. Use Fluent Launcher to start the 3D version of ANSYS Fluent, with the Double Precision and Display
Mesh After Reading options enabled.

For more information about starting ANSYS Fluent using the Fluent Launcher, see the Fluent Getting
Started Guide, available in the help viewer or on the ANSYS Customer Portal (http://support.an-
sys.com/documentation).

8.4.2. Mesh

1. Read the mesh file (catalytic_converter.msh).

File → Read → Mesh...

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure
that the reported minimum volume is a positive number.

3. Scale the mesh.
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Setting Up Domain → Mesh → Scale...

a. Select mm from the Mesh Was Created In drop-down list.

b. Click Scale.

c. Select mm from the View Length Unit In drop-down list.

All dimensions will now be shown in millimeters.

d. Close the Scale Mesh dialog box.

4. Check the mesh.

Setting Up Domain → Mesh → Check

Note

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to
polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that
the quality of the mesh has not been compromised.

5. Examine the mesh.

Rotate the view and zoom in to get the display shown in Figure 8.2: Mesh for the Catalytic Converter
Geometry (p. 367). The hex mesh on the geometry contains a total of 34,580 cells.
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Figure 8.2:  Mesh for the Catalytic Converter Geometry

8.4.3. General Settings

Setting Up Physics → Solver

1. Retain the default solver settings.

8.4.4. Models

1. Select the standard -  turbulence model.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2eqn) in the Model list.

The original Viscous Model dialog box will now expand.

b. Retain the default settings for k-epsilon Model and Near-Wall Treatment and click OK to close the
Viscous Model dialog box.

8.4.5. Materials

1. Add nitrogen to the list of fluid materials by copying it from the Fluent Database of materials.

Setting Up Physics → Materials → Create/Edit...
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a. Click the Fluent Database... button to open the Fluent Database Materials dialog box.

i. Select nitrogen (n2) in the Fluent Fluid Materials selection list.

ii. Click Copy to copy the information for nitrogen to your list of fluid materials.
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iii. Close the Fluent Database Materials dialog box.

b. Click Change/Create and close the Create/Edit Materials dialog box.

8.4.6. Cell Zone Conditions

Setup → Cell Zone Conditions → fluid Edit...

1. Set the cell zone conditions for the fluid (fluid).

a. Select nitrogen from the Material Name drop-down list.

b. Click OK to close the Fluid dialog box.
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2. Set the cell zone conditions for the substrate (substrate).

Setup → Cell Zone Conditions → substrate Edit...

a. Select nitrogen from the Material Name drop-down list.

b. Enable Porous Zone to activate the porous zone model.

c. Enable Laminar Zone to solve the flow in the porous zone without turbulence.

d. Click the Porous Zone tab.

i. Make sure that the principal direction vectors are set as shown in Table 8.1: Values for the Principle
Direction Vectors (p. 371).

ANSYS Fluent automatically calculates the third (Z direction) vector based on your inputs for the
first two vectors. The direction vectors determine which axis the viscous and inertial resistance
coefficients act upon.

Table 8.1: Values for the Principle Direction Vectors

Direction-2 VectorDirection-1 VectorAxis

01X

10Y

00Z

ii. For the viscous and inertial resistance directions, enter the values in Table 8.2: Values for the Viscous
and Inertial Resistance (p. 372) Viscous Resistance and Inertial Resistance.
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Direction-2 and Direction-3 are set to arbitrary large numbers. These values are several orders
of magnitude greater than that of the Direction-1 flow and will make any radial flow insignificant.

Scroll down to access the fields that are not initially visible.

Table 8.2: Values for the Viscous and Inertial Resistance

Inertial Resistance (1/m)Viscous Resistance (1/m2)Direction

20.4143.846e+07Direction-1

204143.846e+10Direction-2

204143.846e+10Direction-3

e. Click OK to close the Fluid dialog box.

8.4.7. Boundary Conditions

Setup → Boundary Conditions → inlet Edit...

1. Set the velocity and turbulence boundary conditions at the inlet (inlet).
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a. Enter 22.6 m/s for Velocity Magnitude.

b. In the Turbulence group box, select Intensity and Hydraulic Diameter from the Specification
Method drop-down list.

c. Enter 10% for the Turbulent Intensity.

d. Enter 42 mm for the Hydraulic Diameter.

e. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions at the outlet (outlet).

Setup → Boundary Conditions → outlet Edit...
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a. Retain the default setting of 0 for Gauge Pressure.

b. In the Turbulence group box, select Intensity and Hydraulic Diameter from the Specification
Method drop-down list.

c. Retain the default value of 5% for the Backflow Turbulent Intensity.

d. Enter 42 mm for the Backflow Hydraulic Diameter.

e. Click OK to close the Pressure Outlet dialog box.

3. Retain the default boundary conditions for the walls (substrate-wall and wall).

8.4.8. Solution

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list.

b. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the
Spatial Discretization group box.

c. Retain the default selection of Second Order Upwind from the Momentum drop-down list.

d. Enable Pseudo Transient.

2. Enable the plotting of the mass flow rate at the outlet.

Solving → Reports → Definitions → New → Surface Report → Mass Flow Rate
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a. Enter surf-mon-1 for the Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console.

c. Select outlet in the Surfaces selection list.

d. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

3. Initialize the solution from the inlet.

Solving → Initialization
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a. Select Standard under Method.

Warning

Standard is the recommended initialization method for porous media simulations.
The default Hybrid method does not account for the porous media properties, and
depending on boundary conditions, may produce an unrealistic initial velocity field.
For porous media simulations, the Hybrid method should only be used when the
Maintain Constant Velocity Magnitude option is enabled in the Hybrid Initialization
dialog box.

b. Click Options... to open the Solution Initialization task page, which provides access to further settings.

i. Select inlet from the Compute from drop-down list in the Solution Initialization task page.

ii. Retain the default settings for standard initialization method.
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iii. Click Initialize.

4. Save the case file (catalytic_converter.cas.gz).

File → Write → Case...

5. Run the calculation by requesting 100 iterations.

Solving → Run Calculation

a. Enter 100 for No. of Iterations.

b. Click Calculate to begin the iterations.

The solution will converge in approximately 65 iterations. The mass flow rate graph flattens out, as
seen in Figure 8.3: Mass Flow Rate History (p. 378).

Figure 8.3:  Mass Flow Rate History

6. Save the case and data files (catalytic_converter.cas.gz and catalytic_converter.dat.gz).

File → Write → Case & Data...

Note

If you choose a filename that already exists in the current folder, ANSYS Fluent will prompt
you for confirmation to overwrite the file.
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8.4.9. Postprocessing

1. Create a surface passing through the centerline for postprocessing purposes.

Postprocessing → Surface → Create → Iso-Surface...

a. Select Mesh... and Y-Coordinate from the Surface of Constant drop-down lists.

b. Click Compute to calculate the Min and Max values.

c. Retain the default value of 0 for Iso-Values.

d. Enter y=0 for New Surface Name.

e. Click Create.

Note

To interactively place the surface on your mesh, use the slider bar in the Iso-Surface
dialog box.

2. Create cross-sectional surfaces at locations on either side of the substrate, as well as at its center.

Postprocessing → Surface → Create → Iso-Surface...
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a. Select Mesh... and X-Coordinate from the Surface of Constant drop-down lists.

b. Click Compute to calculate the Min and Max values.

c. Enter 95 for Iso-Values.

d. Enter x=95 for the New Surface Name.

e. Click Create.

f. In a similar manner, create surfaces named x=130 and x=165 with Iso-Values of 130 and 165, re-
spectively.

g. Close the Iso-Surface dialog box after all the surfaces have been created.

3. Create a line surface for the centerline of the porous media.

Postprocessing → Surface → Create → Line/Rake...
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a. Enter the coordinates of the end points of the line in the End Points group box as shown.

b. Enter porous-cl for the New Surface Name.

c. Click Create to create the surface.

d. Close the Line/Rake Surface dialog box.

4. Display the two wall zones (substrate-wall and wall).

Postprocessing → Graphics → Mesh...

a. Disable Edges and make sure Faces is enabled in the Options group box.

381
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



b. Deselect inlet and outlet in the Surfaces selection list, and make sure that only substrate-wall and
wall are selected.

c. Click Display and close the Mesh Display dialog box.

5. Set the lighting for the display.

Viewing → Display → Options...

a. Disable Double Buffering in the Rendering group box.

b. Make sure Lights On is enabled in the Lighting Attributes group box.

c. Select Gouraud from the Lighting drop-down list.

d. Click Apply and close the Display Options dialog box.

6. Set the transparency parameter for the wall zones (substrate-wall and wall).

Viewing → Graphics → Compose...
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a. Select substrate-wall and wall in the Names selection list.

b. Click the Display... button in the Geometry Attributes group box to open the Display Properties
dialog box.

i. Make sure that the Red, Green, and Blue sliders are set to the maximum position (that is, 255).

ii. Set the Transparency slider to 70.

iii. Click Apply and close the Display Properties dialog box.

383
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



c. Click Apply and close the Scene Description dialog box.

7. Display velocity vectors on the y=0 surface (Figure 8.4: Velocity Vectors on the y=0 Plane (p. 385)).

Postprocessing → Graphics → Vectors → Edit...

a. Enable Draw Mesh in the Options group box to open the Mesh Display dialog box.

i. Make sure that substrate-wall and wall are selected in the Surfaces selection list.
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ii. Click Display and close the Mesh Display dialog box.

b. Enter 5 for Scale.

c. Set Skip to 1.

d. Select y=0 in the Surfaces selection list.

e. Click Display and close the Vectors dialog box.

f. Rotate the view and adjust the magnification to get the display shown in Figure 8.4: Velocity Vectors
on the y=0 Plane (p. 385).

Figure 8.4: Velocity Vectors on the y=0 Plane

The flow pattern shows that the flow enters the catalytic converter as a jet, with recirculation on either
side of the jet. As it passes through the porous substrate, it decelerates and straightens out, and exhibits
a more uniform velocity distribution. This allows the metal catalyst present in the substrate to be more
effective.

8. Display filled contours of static pressure on the y=0 plane (Figure 8.5: Contours of Static Pressure on the
y=0 plane (p. 387)).

Postprocessing → Graphics → Contours → Edit...
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a. Enable Filled in the Options group box.

b. Enable Draw Mesh to open the Mesh Display dialog box.

i. Make sure that substrate-wall and wall are selected in the Surfaces selection list.

ii. Click Display and close the Mesh Display dialog box.

c. Make sure that Pressure... and Static Pressure are selected from the Contours of drop-down lists.

d. Select y=0 in the Surfaces selection list.

e. Click Display and close the Contours dialog box.

The pressure changes rapidly in the middle section, where the fluid velocity changes as it passes through
the porous substrate. The pressure drop can be high, due to the inertial and viscous resistance of the
porous media. Determining this pressure drop is one of the goals of the CFD analysis. In the next step,
you will learn how to plot the pressure drop along the centerline of the substrate.
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Figure 8.5:  Contours of Static Pressure on the y=0 plane

9. Plot the static pressure across the line surface porous-cl (Figure 8.6: Plot of Static Pressure on the porous-
cl Line Surface (p. 388)).

Postprocessing → Plots → XY Plot...
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a. Make sure that Pressure... and Static Pressure are selected from the Y Axis Function drop-down lists.

b. Select porous-cl in the Surfaces selection list.

c. Click Plot and close the Solution XY Plot dialog box.

Figure 8.6:  Plot of Static Pressure on the porous-cl Line Surface

As seen in Figure 8.6: Plot of Static Pressure on the porous-cl Line Surface (p. 388), the pressure drop
across the porous substrate is approximately 300 Pa.

10. Display filled contours of the velocity in the X direction on the x=95, x=130, and x=165 surfaces (Fig-
ure 8.7: Contours of the X Velocity on the x=95, x=130, and x=165 Surfaces (p. 390)).

Postprocessing → Graphics → Contours → Edit...
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a. Make sure that Filled and Draw Mesh are enabled in the Options group box.

b. Disable Global Range in the Options group box.

c. Select Velocity... and X Velocity from the Contours of drop-down lists.

d. Select x=130, x=165, and x=95 in the Surfaces selection list, and deselect y=0.

e. Click Display and close the Contours dialog box.
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Figure 8.7:  Contours of the X Velocity on the x=95, x=130, and x=165 Surfaces

The velocity profile becomes more uniform as the fluid passes through the porous media. The velocity is
very high at the center (the area in red) just before the nitrogen enters the substrate and then decreases
as it passes through and exits the substrate. The area in green, which corresponds to a moderate velocity,
increases in extent.

11. Use numerical reports to determine the average, minimum, and maximum of the velocity distribution before
and after the porous substrate.

Postprocessing → Reports → Surface Integrals...
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a. Select Mass-Weighted Average from the Report Type drop-down list.

b. Select Velocity and X Velocity from the Field Variable drop-down lists.

c. Select x=165 and x=95 in the Surfaces selection list.

d. Click Compute.

e. Select Facet Minimum from the Report Type drop-down list and click Compute.

f. Select Facet Maximum from the Report Type drop-down list and click Compute.

The numerical report of average, maximum and minimum velocity can be seen in the main ANSYS
Fluent console.

g. Close the Surface Integrals dialog box.

The spread between the average, maximum, and minimum values for X velocity gives the degree to which
the velocity distribution is non-uniform. You can also use these numbers to calculate the velocity ratio (that
is, the maximum velocity divided by the mean velocity) and the space velocity (that is, the product of the
mean velocity and the substrate length).

Custom field functions and UDFs can be also used to calculate more complex measures of non-uniformity,
such as the standard deviation and the gamma uniformity index.

           Mass-Weighted Average
                      X Velocity                (m/s)
-------------------------------- --------------------
                            x=95            5.3014566
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                           x=165            4.0395238
                ---------------- --------------------
                             Net            4.6774315

         Minimum of Facet Values
                      X Velocity                (m/s)
-------------------------------- --------------------
                            x=95            0.8805235
                           x=165            2.3446729
                ---------------- --------------------
                             Net            0.8805235

         Maximum of Facet Values
                      X Velocity                (m/s)
-------------------------------- --------------------
                            x=95            8.0334597
                           x=165            6.3715858
                ---------------- --------------------
                             Net            8.0334597

8.5. Summary

In this tutorial, you learned how to set up and solve a problem involving gas flow through porous media
in ANSYS Fluent. You also learned how to perform appropriate postprocessing. Flow non-uniformities
were easily identified through images of velocity vectors and pressure contours. Surface integrals and
X-Y plots provided purely numeric data.

For additional details about modeling flow through porous media (including heat transfer and reaction
modeling), see the Fluent User's Guide, available in the help viewer or on the ANSYS Customer Portal
(http://support.ansys.com/documentation).

8.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 9: Using a Single Rotating Reference Frame

This tutorial is divided into the following sections:
9.1. Introduction
9.2. Prerequisites
9.3. Problem Description
9.4. Setup and Solution
9.5. Summary
9.6. Further Improvements
9.7. References

9.1. Introduction

This tutorial considers the flow within a 2D, axisymmetric, co-rotating disk cavity system. Understanding
the behavior of such flows is important in the design of secondary air passages for turbine disk cooling.

This tutorial demonstrates how to do the following:

• Set up a 2D axisymmetric model with swirl, using a rotating reference frame.

• Use the standard -  and RNG -  turbulence models.

• Calculate a solution using the pressure-based solver.

• Display velocity vectors and contours of pressure.

• Set up and display XY plots of radial velocity and wall  distribution.

• Restart the solver from an existing solution.

9.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent  tree and ribbon structure. Some steps in the setup
and solution procedure will not be shown explicitly.
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9.3. Problem Description

The problem to be considered is shown schematically in Figure 9.1: Problem Specification (p. 394). This
case is similar to a disk cavity configuration that was extensively studied by Pincombe [1].

Air enters the cavity between two co-rotating disks. The disks are 88.6 cm in diameter and the air enters
at 1.146 m/s through a circular bore 8.86 cm in diameter. The disks, which are 6.2 cm apart, are spinning
at 71.08 rpm, and the air enters with no swirl. As the flow is diverted radially, the rotation of the disk
has a significant effect on the viscous flow developing along the surface of the disk.

Figure 9.1:  Problem Specification

As noted by Pincombe [1], there are two nondimensional parameters that characterize this type of disk
cavity flow: the volume flow rate coefficient, , and the rotational Reynolds number, . These
parameters are defined as follows:

(9.1)

(9.2)

where  is the volumetric flow rate,  is the rotational speed,  is the kinematic viscosity, and  is

the outer radius of the disks. Here, you will consider a case for which  = 1092 and  = .
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9.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
9.4.1. Preparation
9.4.2. Mesh
9.4.3. General Settings
9.4.4. Models
9.4.5. Materials
9.4.6. Cell Zone Conditions
9.4.7. Boundary Conditions
9.4.8. Solution Using the Standard k- ε Model
9.4.9. Postprocessing for the Standard k- ε Solution
9.4.10. Solution Using the RNG k- ε Model
9.4.11. Postprocessing for the RNG k- ε Solution

9.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the single_rotating_R180.zip link to download the input files.

7. Unzip single_rotating_R180.zip to your working folder.

The file disk.msh can be found in the single_rotating folder created after unzipping the file.

8. Use Fluent Launcher to start the 2D single precision (disable Double Precision) version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher in
the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.
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10. Run in Serial under Processing Options.

9.4.2. Mesh

1. Read the mesh file (disk.msh).

File → Read → Mesh...

As ANSYS Fluent reads the mesh file, it will report its progress in the console.

Note

The Fluent console will display a warning that the current setup for the boundary condi-
tions is not appropriate for a 2D/3D flow problem.

You will resolve this issue when you modify the solver settings in a subsequent step.

9.4.3. General Settings

1. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure
that the reported minimum volume is a positive number.

2. Examine the mesh (Figure 9.2: Mesh Display for the Disk Cavity (p. 397)).
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Figure 9.2:  Mesh Display for the Disk Cavity

Extra

You can use the right mouse button to check which zone number corresponds to each
boundary. If you click the right mouse button on one of the boundaries in the graphics
window, information will be displayed in the ANSYS Fluent console about the associated
zone, including the name of the zone. This feature is especially useful when you have
several zones of the same type and you want to distinguish between them quickly.

3. Define new units for angular velocity and length.

Setting Up Domain → Mesh → Units...

In the problem description, angular velocity and length are specified in rpm and cm, respectively, which
is more convenient in this case. These are not the default units for these quantities.
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a. Select angular-velocity from the Quantities list, and rpm in the Units list.

b. Select length from the Quantities list, and cm in the Units list.

c. Close the Set Units dialog box.

4. Specify the solver formulation to be used for the model calculation and enable the modeling of axisymmetric
swirl.

Setting Up Physics → Solver

a. Retain the default selection of Pressure-Based in the Type list.

b. Retain the default selection of Absolute in the Velocity Formulation list.

For a rotating reference frame, the absolute velocity formulation has some numerical advantages.

c. Select Axisymmetric Swirl from the drop-down list in the Solver group box (below Reference Values...).

9.4.4. Models

1. Enable the standard -  turbulence model with the enhanced near-wall treatment.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2 eqn) in the Model list.

The Viscous Model dialog box will expand.

b. Retain the default selection of Standard in the k-epsilon Model list.

c. Select Enhanced Wall Treatment in the Near-Wall Treatment list.

d. Click OK to close the Viscous Model dialog box.

The ability to calculate a swirl velocity permits the use of a 2D mesh, so the calculation is simpler
and more economical to run. This is especially important for problems where the enhanced wall
treatment is used. The near-wall flow field is resolved through the viscous sublayer and buffer zones
(that is, the first mesh point away from the wall is placed at a  of the order of 1).

For details, see enhanced wall treatment in the Fluent Theory Guide.
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9.4.5. Materials

For the present analysis, you will model air as an incompressible fluid with a density of 1.225 kg/  and a

dynamic viscosity of 1.7894  kg/m-s. Since these are the default values, no change is required in the
Create/Edit Materials dialog box.

1. Retain the default properties for air.

Setting Up Physics → Materials → Create/Edit...

Extra

You can modify the fluid properties for air at any time or copy another material from the
database.

2. Click Close to close the Create/Edit Materials dialog box.

For details, see physical properties in the Fluent User's Guide.

9.4.6. Cell Zone Conditions

Set up the present problem using a rotating reference frame for the fluid. Then define the disk walls to rotate
with the moving frame.

Setup → Cell Zone Conditions → fluid-7 Edit...
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1. Define the rotating reference frame for the fluid zone (fluid-7).

a. Enable Frame Motion.

b. Enter 71.08 rpm for Speed in the Rotational Velocity group box.

c. Click OK to close the Fluid dialog box.

9.4.7. Boundary Conditions

Setup → Boundary Conditions → velocity-inlet-2 Edit...
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1. Set the following conditions at the flow inlet (velocity-inlet-2).

a. Select Components from the Velocity Specification Method drop-down list.

b. Enter 1.146 m/s for Axial-Velocity.

c. Retain the default selection of Intensity and Viscosity Ratio from the Specification Method drop-
down list in the Turbulence group box.

d. Retain the default value of 5 % for Turbulent Intensity.

e. Enter 5 for Turbulent Viscosity Ratio.

f. Click OK to close the Velocity Inlet dialog box.
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2. Set the following conditions at the flow outlet (pressure-outlet-3).

Setup → Boundary Conditions → pressure-outlet-3 Edit...

a. Select From Neighboring Cell from the Backflow Direction Specification Method drop-down list.

b. Click OK to close the Pressure Outlet dialog box.

Note

ANSYS Fluent will use the backflow conditions only if the fluid is flowing into the
computational domain through the outlet. Since backflow might occur at some point
during the solution procedure, you should set reasonable backflow conditions to
prevent convergence from being adversely affected.

3. Confirm that the wall boundary condition settings for the disk walls (wall-6) are as shown below.

Setup → Boundary Conditions → wall-6 Edit...
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Note

A Stationary Wall condition implies that the wall is stationary with respect to the adjacent
cell zone. Hence, in the case of a rotating reference frame a Stationary Wall is actually
rotating with respect to the absolute reference frame. To specify a non-rotating wall in
this case you would select Moving Wall (that is, moving with respect to the rotating ref-
erence frame). Then you would specify an absolute rotational speed of 0 in the Motion
group box.

a. Click OK to close the Wall dialog box.

9.4.8. Solution Using the Standard k- ε Model

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default selection of Least Squares Cell Based from the Gradient list in the Spatial Discret-
ization group box.

c. Select PRESTO! from the Pressure drop-down list in the Spatial Discretization group box.

The PRESTO! scheme is well suited for steep pressure gradients involved in rotating flows. It provides
improved pressure interpolation in situations where large body forces or strong pressure variations
are present as in swirling flows.

d. Select Second Order Upwind from the Turbulent Kinetic Energy and Turbulent Dissipation Rate
drop-down lists.

Use the scroll bar to access the discretization schemes that are not initially visible in the task page.

e. Enable Pseudo Transient.

The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based
solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve
stability and convergence behavior. Use of this option is recommended for general fluid flow problems.
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2. Set the solution controls.

Solving → Controls → Controls...

a. Retain the default values in the Pseudo Transient Explicit Relaxation Factors group box.

Note

For this problem, the default explicit relaxation factors are satisfactory. However, if
the solution diverges or the residuals display large oscillations, you may need to reduce
the relaxation factors from their default values.

For tips on how to adjust the explicit relaxation parameters for different situations, see the Fluent
User's Guide.

3. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

Note

For this calculation, the convergence tolerance on the continuity equation is kept at
0.001. Depending on the behavior of the solution, you can reduce this value if necessary.

4. Enable the plotting of mass flow rate at the flow exit.

Solving → Reports → Definitions → New → Surface Report → Mass Flow Rate
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a. Enter surf-mon-1 for the Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console for surf-mon-1.

Note

When the Report File option is selected in the Surface Report Definition dialog box,
the mass flow rate history will be written to a file. If you do not enable the Report
File option, the history information will be lost when you exit ANSYS Fluent.

c. Select pressure-outlet-3 from the Surfaces selection list.

d. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

5. Initialize the solution.

Solving → Initialization
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a. Retain the default selection of the Hybrid initialization method.

b. Click Initialize.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity
and pressure fields than standard initialization. This in general will help in improving
the convergence behavior of the solver.

6. Save the case file (disk-ke.cas.gz).

File → Write → Case...

7. Start the calculation by requesting 600 iterations.

Run Calculation

a. Enter 600 for the Number of Iterations.

b. Click Calculate.

Throughout the calculation, ANSYS Fluent will report reversed flow at the exit. This is reasonable for
the current case. The solution should be sufficiently converged after approximately 550 iterations.
The mass flow rate history is shown in Figure 9.3: Mass Flow Rate History (k- ε Turbulence Mod-
el) (p. 410).
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Figure 9.3:  Mass Flow Rate History (k- ε Turbulence Model)

Extra

Here we have retained the default Timescale Factor of 1 in the Run Calculation panel.
When performing a Pseudo Transient calculation, larger values of Timescale Factor may
speed up convergence of the solution. However, setting Timescale Factor too large may
cause the solution to diverge and fail to complete. As an optional activity, you can re-
initialize the solution and try running the calculation with Timescale Factor set to 2.
Observe the convergence behavior and the number of iterations before convergence.
Then try the same again with Timescale Factor set to 4. For more information on setting
Timescale Factor and the Pseudo Transient solver settings, refer to the Fluent User's Guide.

8. Check the mass flux balance.

Postprocessing → Reports → Fluxes...

Warning

Although the mass flow rate history indicates that the solution is converged, you
should also check the net mass fluxes through the domain to ensure that mass is
being conserved.
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a. Select velocity-inlet-2 and pressure-outlet-3 from the Boundaries selection list.

b. Retain the default Mass Flow Rate option.

c. Click Compute and close the Flux Reports dialog box.

Warning

The net mass imbalance should be a small fraction (for example, 0.5%) of the total
flux through the system. If a significant imbalance occurs, you should decrease the
residual tolerances by at least an order of magnitude and continue iterating.

9. Save the case and data files (disk-ke.cas.gz and disk-ke.dat.gz).

File → Write → Case & Data...

Click OK to overwrite disk-ke.cas.gz.

Note

It is always prudent to save both case and data files in case anything has changed.

9.4.9. Postprocessing for the Standard k- ε Solution

1. Display the velocity vectors.

Postprocessing → Graphics → Vectors → Edit...
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a. Enter 50 for Scale

b. Set Skip to 1.

c. Click the Vector Options... button to open the Vector Options dialog box.

i. Disable Z Component.

This allows you to examine only the non-swirling components.

ii. Click Apply and close the Vector Options dialog box.

d. Click Display in the Vectors dialog box to plot the velocity vectors.
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A magnified view of the velocity field displaying a counter-clockwise circulation of the flow is shown
in Figure 9.4: Magnified View of Velocity Vectors within the Disk Cavity (p. 413).

Figure 9.4:  Magnified View of Velocity Vectors within the Disk Cavity

e. Close the Vectors dialog box.

2. Display filled contours of static pressure.

Postprocessing → Graphics → Contours → Edit...
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a. Enable Filled in the Options group box.

b. Retain the selection of Pressure... and Static Pressure from the Contours of drop-down lists.

c. Click Display and close the Contours dialog box.

The pressure contours are displayed in Figure 9.5: Contours of Static Pressure for the Entire Disk Cav-
ity (p. 415). Notice the high pressure that occurs on the right disk near the hub due to the stagnation of
the flow entering from the bore.
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Figure 9.5:  Contours of Static Pressure for the Entire Disk Cavity

3. Create a constant -coordinate line for postprocessing.

Postprocessing → Surface → Create → Iso-Surface...

a. Select Mesh... and Y-Coordinate from the Surface of Constant drop-down lists.

b. Click Compute to update the minimum and maximum values.
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c. Enter 37 in the Iso-Values field.

This is the radial position along which you will plot the radial velocity profile.

d. Enter aaa_y=37cm for the New Surface Name.

Using a prefix such as aaa or zzz allows you to keep all postprocessing surfaces together.

e. Click Create to create the isosurface.

Note

The name you use for an isosurface can be any continuous string of characters (without
spaces).

f. Close the Iso-Surface dialog box.

4. Plot the radial velocity distribution on the surface aaa_y=37cm.

Postprocessing → Plots → XY Plot → Edit...

a. Select Velocity... and Radial Velocity from the Y Axis Function drop-down lists.

b. Select the y-coordinate line aaa_y=37cm from the Surfaces selection list.

c. Click Plot.

Figure 9.6: Radial Velocity Distribution—Standard k- ε Solution (p. 417) shows a plot of the radial ve-
locity distribution along .
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Figure 9.6:  Radial Velocity Distribution—Standard k- ε Solution

d. Enable Write to File in the Options group box to save the radial velocity profile.

e. Click the Write... button to open the Select File dialog box.

i. Enter ke-data.xy in the XY File text entry box and click OK.

Be sure to double check the location where the files are being saved to ensure they will be saved
where you intend.

5. Plot the wall y+ distribution on the rotating disk wall along the radial direction (Figure 9.7: Wall Yplus Dis-
tribution on wall-6— Standard k- ε Solution (p. 420)).

Postprocessing → Plots → XY Plot → Edit...
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a. Disable Write to File in the Options group box.

b. Select Turbulence... and Wall Yplus from the Y Axis Function drop-down lists.

c. Deselect aaa_y=37cm and select wall-6 from the Surfaces selection list.

d. Enter 0 and 1 for X and Y respectively in the Plot Direction group box.

Note

The change in Plot Direction is required because we are plotting y+ along the radial
dimension of the disk, which is oriented with Y axis.

e. Click the Axes... button to open the Axes - Solution XY Plot dialog box.
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i. Retain the default selection of X from the Axis group box.

ii. Disable Auto Range in the Options group box.

iii. Retain the default value of 0 for Minimum and enter 43 for Maximum in the Range group box.

iv. Click Apply and close the Axes - Solution XY Plot dialog box.

f. Click Plot in the Solution XY Plot dialog box.

Figure 9.7: Wall Yplus Distribution on wall-6— Standard k- ε Solution (p. 420) shows a plot of wall y+
distribution along wall-6.
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Figure 9.7:  Wall Yplus Distribution on wall-6— Standard k- ε Solution

g. Enable Write to File in the Options group box to save the wall y+ profile.

h. Click the Write... button to open the Select File dialog box.

i. Enter ke-yplus.xy in the XY File text entry box and click OK.

Note

Ideally, while using enhanced wall treatment, the wall y+ should be in the order of 1
(at least less than 5) to resolve the viscous sublayer. The plot justifies the applicability
of enhanced wall treatment to the given mesh.

i. Close the Solution XY Plot dialog box.

9.4.10. Solution Using the RNG k- ε Model

Recalculate the solution using the RNG -  turbulence model.

1. Enable the RNG -  turbulence model with the enhanced near-wall treatment.

Setting Up Physics → Models → Viscous...
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a. Select RNG in the k-epsilon Model list.

b. Enable Differential Viscosity Model and Swirl Dominated Flow in the RNG Options group box.

The differential viscosity model and swirl modification can provide better accuracy for swirling flows
such as the disk cavity.

For more information, see RNG swirl modification in the Fluent Theory Guide.

c. Retain Enhanced Wall Treatment as the Near-Wall Treatment.

d. Click OK to close the Viscous Model dialog box.

421
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



2. Continue the calculation by requesting 300 iterations.

Solving → Run Calculation

The solution converges after approximately 245 additional iterations.

3. Save the case and data files (disk-rng.cas.gz and disk-rng.dat.gz).

File → Write → Case & Data...

9.4.11. Postprocessing for the RNG k- ε Solution

1. Plot the radial velocity distribution for the RNG -  solution and compare it with the distribution for the
standard -  solution.

Postprocessing → Plots → XY Plot → Edit...

a. Enter 1 and 0 for X and Y respectively in the Plot Direction group box.

b. Select Velocity... and Radial Velocity from the Y Axis Function drop-down lists.

c. Select aaa_y=37cm and deselect wall-6 from the Surfaces selection list.

d. Disable the Write to File option.

e. Click the Load File... button to load the -  data.

i. Select the file ke-data.xy in the Select File dialog box.
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ii. Click OK.

f. Click the Axes... button to open the Axes - Solution XY Plot dialog box.

i. Enable Auto Range in the Options group box.

ii. Click Apply and close the Axes - Solution XY Plot dialog box.

g. Click the Curves... button to open the Curves - Solution XY Plot dialog box, where you will define a
different curve symbol for the RNG -  data.

i. Retain 0 for the Curve #.

ii. Select x from the Symbol drop-down list.

iii. Click Apply and close the Curves - Solution XY Plot dialog box.

h. Click Plot in the Solution XY Plot dialog box (Figure 9.8: Radial Velocity Distribution — RNG k- ε and
Standard k- ε Solutions (p. 424)).
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Figure 9.8:  Radial Velocity Distribution — RNG k- ε and Standard k- ε Solutions

The peak velocity predicted by the RNG -  solution is higher than that predicted by the standard
-  solution. This is due to the less diffusive character of the RNG -  model. Adjust the range of

the  axis to magnify the region of the peaks.

i. Click the Axes... button to open the Axes - Solution XY Plot dialog box, where you will specify the
-axis range.

i. Disable Auto Range in the Options group box.
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ii. Retain the value of 0 for Minimum and enter 1 for Maximum in the Range dialog box.

iii. Click Apply and close the Axes - Solution XY Plot dialog box.

j. Click Plot.

The difference between the peak values calculated by the two models is now more apparent.

Figure 9.9:  RNG k- ε and Standard k- ε Solutions (x=0 cm to x=1 cm)

2. Plot the wall y+ distribution on the rotating disk wall along the radial direction Figure 9.10: wall-6 — RNG
k- ε and Standard k- ε Solutions (x=0 cm to x=43 cm) (p. 427).

Postprocessing → Plots → XY Plot → Edit...
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a. Select Turbulence... and Wall Yplus from the Y Axis Function drop-down lists.

b. Deselect aaa_y=37cm and select wall-6 from the Surfaces selection list.

c. Enter 0 and 1 for X and Y respectively in the Plot Direction group box.

d. Select any existing files that appear in the File Data selection list and click the Free Data button to
remove the file.

e. Click the Load File... button to load the RNG -  data.

i. Select the file ke-yplus.xy in the Select File dialog box.

ii. Click OK.

f. Click the Axes... button to open the Axes - Solution XY Plot dialog box.

i. Retain the default selection of X from the Axis group box.

ii. Retain the default value of 0 for Minimum and enter 43 for Maximum in the Range group box.

iii. Click Apply and close the Axes - Solution XY Plot dialog box.

g. Click Plot in the Solution XY Plot dialog box.
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Figure 9.10:  wall-6 — RNG k- ε and Standard k- ε Solutions (x=0 cm to x=43 cm)

9.5. Summary

This tutorial illustrated the setup and solution of a 2D, axisymmetric disk cavity problem in ANSYS Fluent.
The ability to calculate a swirl velocity permits the use of a 2D mesh, thereby making the calculation
simpler and more economical to run than a 3D model. This can be important for problems where the
enhanced wall treatment is used, and the near-wall flow field is resolved using a fine mesh (the first
mesh point away from the wall being placed at a y+ on the order of 1).

For more information about mesh considerations for turbulence modeling, see the Fluent User's Guide.

9.6. Further Improvements

The case modeled in this tutorial lends itself to parametric study due to its relatively small size. Here
are some things you may want to try:

• Separate wall-6 into two walls.

Setting Up Domain → Zones → Separate → Faces...

Specify one wall to be stationary, and rerun the calculation.

• Use adaption to see if resolving the high velocity and pressure-gradient region of the flow has a significant
effect on the solution.
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• Introduce a nonzero swirl at the inlet or use a velocity profile for fully-developed pipe flow. This is probably
more realistic than the constant axial velocity used here, since the flow at the inlet is typically being supplied
by a pipe.

• Model compressible flow (using the ideal gas law for density) rather than assuming incompressible flow
text.

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).

9.7. References

1. Pincombe, J.R.,“Velocity Measurements in the Mk II - Rotating Cavity Rig with a Radial Outflow”, Thermo-
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Chapter 10: Using Multiple Reference Frames

This tutorial is divided into the following sections:
10.1. Introduction
10.2. Prerequisites
10.3. Problem Description
10.4. Setup and Solution
10.5. Summary
10.6. Further Improvements

10.1. Introduction

Many engineering problems involve rotating flow domains. One example is the centrifugal blower unit
that is typically used in automotive climate control systems. For problems where all the moving parts
(fan blades, hub and shaft surfaces, and so on) are rotating at a prescribed angular velocity, and the
stationary walls (for example, shrouds, duct walls) are surfaces of revolution with respect to the axis of
rotation, the entire domain can be referred to as a single rotating frame of reference. However, when
each of the several parts is rotating about a different axis of rotation, or about the same axis at different
speeds, or when the stationary walls are not surfaces of revolution (such as the volute around a centri-
fugal blower wheel), a single rotating coordinate system is not sufficient to “immobilize" the computa-
tional domain so as to predict a steady-state flow field. In such cases, the problem must be formulated
using multiple reference frames.

In ANSYS Fluent, the flow features associated with one or more rotating parts can be analyzed using
the multiple reference frame (MRF) capability. This model is powerful in that multiple rotating reference
frames can be included in a single domain. The resulting flow field is representative of a snapshot of
the transient flow field in which the rotating parts are moving. However, in many cases the interface
can be chosen in such a way that the flow field at this location is independent of the orientation of the
moving parts. That is, if an interface can be drawn on which there is little or no angular dependence,
the model can be a reliable tool for simulating time-averaged flow fields. It is therefore very useful in
complicated situations where one or more rotating parts are present.

This tutorial illustrates the procedure for setting up and solving a problem using the MRF capability. As
an example, the flow field on a 2D section of a centrifugal blower will be calculated. Although this is a
general methodology that can be applied to cases where more than one reference frame is moving,
this example will be limited to a single rotating reference frame.

This tutorial demonstrates how to do the following:

• Create mesh interfaces from interface-zones defined during meshing.

• Specify different frames of reference for different fluid zones.

• Set the relative velocity of each wall.

• Calculate a solution using the pressure-based solver.
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10.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

This tutorial also assumes that you are familiar with the ANSYS Fluent tree and ribbon structure. Some
steps in the setup and solution procedure will not be shown explicitly.

In general, to solve problems using the MRF feature, you should be familiar with the concept of creating
multiple fluid zones in your mesh generator.

10.3. Problem Description

This problem considers a 2D section of a generic centrifugal blower. A schematic of the problem is
shown in Figure 10.1: Schematic of the Problem (p. 430). The blower consists of 32 blades, each with a
chord length of 13.5 mm. The blades are located approximately 56.5 mm (measured from the leading
edge) from the center of rotation. The radius of the outer wall varies logarithmically from 80 mm to
146.5 mm. You will simulate the flow under no load, or free-delivery conditions when inlet and outlet
pressures are at ambient conditions (0 Pa gauge). This corresponds to the maximum flow-rate of the
blower when sitting in free air. The blades are rotating with an angular velocity of 2500 rpm. The flow
is assumed to be turbulent.

Figure 10.1:  Schematic of the Problem
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10.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
10.4.1. Preparation
10.4.2. Reading and Checking the Mesh and Setting the Units
10.4.3. Specifying Solver and Analysis Type
10.4.4. Specifying the Models
10.4.5. Specifying Materials
10.4.6. Specifying Cell Zone Conditions
10.4.7. Setting Boundary Conditions
10.4.8. Defining Mesh Interfaces
10.4.9. Obtaining the Solution
10.4.10. Step 9: Postprocessing

10.4.1. Preparation

To access tutorials and their input files on the ANSYS Customer Portal, go to http://support.ansys.com/
training.

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the multiple_rotating_R180.zip link to download the input files.

7. Unzip the multiple_rotating_R180.zip file you have downloaded to your working folder.

The file, blower-2d.msh can be found in the multiple_rotating directory created after unzipping
the file.

8. Use Fluent Launcher to start the 2D Double Precision version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.
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For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher in
the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

10.4.2. Reading and Checking the Mesh and Setting the Units

1. Read the mesh file (blower-2d.msh).

File → Read → Mesh...

The geometry and mesh are displayed in graphics window (Figure 10.2: Mesh of the 2D Centrifugal
Blower (p. 433))

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make
sure that the reported minimum volume is a positive number. It will also issue warnings about unassigned
interface zones. You do not need to take any action now. You will set up the mesh interfaces in a later
step.

3. Examine the mesh.

The mesh consists of three fluid zones, fluid-casing, fluid-inlet, and fluid-rotor. These are reported in
the console when the mesh is read. In the Mesh Display dialog box, the fluid zones are reported as in-
terior zones default-interior, default-interior:013, and default-interior:015 respectively. The fluid zone
containing the blades will be solved in a rotational reference frame.
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Figure 10.2:  Mesh of the 2D Centrifugal Blower

The fluid zones are bounded by interface zones that appear in the mesh display in yellow. These interface
boundaries were used in the mesh generator to separate the fluid zones, and will be used to create mesh
interfaces between adjacent fluid zones when the boundary conditions are set later in this tutorial.

4. Set the units for angular velocity.

Setting Up Domain → Mesh → Units...

In the problem description, angular velocity is specified in rpm rather than in the default unit of rad/s.
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a. Select angular-velocity from the Quantities list and rpm in the Units list.

b. Close the Set Units dialog box.

10.4.3. Specifying Solver and Analysis Type

1. Retain the default settings of the pressure-based steady-state solver in the Solver group.

Setting Up Physics → Solver

10.4.4. Specifying the Models

1. Enable the standard -  turbulence model.

Setup → Models → Viscous Edit...
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a. Select k-epsilon (2eqn) in the Model list.

b. Select Enhanced Wall Treatment in the Near-Wall Treatment list.

c. Click OK to close the Viscous Model dialog box.

10.4.5. Specifying Materials

1. Retain the default properties for air.

Setup → Materials → air → Create/Edit...
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Tip

If needed, you could modify the fluid properties for air or copy another material from
the database.

2. Click Close to close the Create/Edit Materials dialog box.

For details, see physical properties in the Fluent User's Guide.

10.4.6. Specifying Cell Zone Conditions

1. Define the boundary conditions for the rotational reference frame (fluid-rotor).

Setup → Cell Zone Conditions → fluid-rotor Edit...
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a. Enable Frame Motion.

The dialog box will expand to show the relevant inputs.

b. Under the Reference Frame tab, retain the Rotation-Axis Origin default setting of (0,0).

This is the center of curvature for the circular boundaries of the rotating zone.

c. Enter -2500 rpm for Speed in the Rotational Velocity group box.

Note

The speed is entered as a negative value because the rotor is rotating clockwise, which
is in the negative sense about the Z axis.

d. Click OK to close the Fluid dialog box.

Note

Since the other fluid zones are stationary, you do not need to set any boundary conditions
for them. If one or more of the remaining fluid zones were also rotating, you would need
to set the appropriate rotational speed for them.

Tip

In this example, the names of the fluid-zones in the mesh file leave no ambiguity as to
which is the rotating fluid zone. In the event that you have a mesh without clear names,
you may have difficulty identifying the various fluid-zones. Unlike interior zones, the fluid-
zones cannot be individually selected and displayed from the Mesh Display dialog box.
However, you can use commands in the text interface to display them.
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Setting Up Domain → Display

i. Deselect all surfaces except, default-interior, default-interior:013, and default-interior:015
in the Surfaces selection list to deselect them.

ii. Click Display.

Only the domain boundaries and interface zones will be displayed.

iii. Press Enter to get the > prompt.

iv. Type the commands, in the console, as shown.

>  display

/display>  zone-mesh
()
zone id/name(1) [()]  4
zone id/name(2) [()]  <Enter>

The resulting display shows that the zone with ID 4 (in this case fluid-rotor) corresponds
to the rotating region.

v. Close the Mesh Display dialog box.

10.4.7. Setting Boundary Conditions

1. Set the boundary conditions for the flow inlet (inlet) as specified in the problem description (see Fig-
ure 10.1: Schematic of the Problem (p. 430)).

Setup → Boundary Conditions → inlet Edit...
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a. Review the boundary condition definition for the pressure-inlet type. Leave the settings at their defaults.

b. Click OK to close the Pressure Inlet dialog box.

Note

All pressures that you specify in ANSYS Fluent are gauge pressures, relative to the oper-
ating pressure specified in the Operating Conditions dialog box. By default, the operating
pressure is 101325 Pa.

For details, see operating pressure in the Fluent User's Guide.

2. Review and retain the default values for the boundary conditions for the flow outlet (outlet) so that the
backflow turbulence parameters for the flow outlet (outlet) are set to the same values used for inlet.

Note

The backflow values are used only if reversed flow occurs at the outlet, but it is a good
idea to use reasonable values, even if you do not expect any backflow to occur.

3. Define the velocity of the wall zone representing the blades (blades) relative to the moving fluid zone.

Setup → Boundary Conditions → blades Edit...
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With fluid-rotor set to a rotating reference frame, blades becomes a moving wall.

a. Select Moving Wall in the Wall Motion group box.

The Wall dialog box will expand to show the wall motion parameters.

b. Retain the default selection of Relative to Adjacent Cell Zone and select Rotational in the Motion
group box.

c. Retain the default value of 0 rpm for (relative) Speed.

d. Click OK to close the Wall dialog box.

The Rotation-Axis Origin should be located at  = 0 m and  = 0 m. With these settings, the blades
will move at the same speed as the surrounding fluid.

10.4.8. Defining Mesh Interfaces

Recall that the fluid domain is defined as three distinct fluid zones. You must define mesh interfaces between
the adjacent fluid zones so that ANSYS Fluent can solve the flow equations across the interfaces.

1. Set up the mesh interface between fluid-inlet and fluid-rotor.

Setup → Mesh Interfaces New...
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a. Enter int1 under Mesh Interface to name this interface definition.

b. Select interface-1 for Interface Zone 1 and interface-2 for Interface Zone 2.

You can use the Draw button to help identify the interface-zones.

c. Click Create in order to create the mesh interface,int1.

d. In a similar manner, define a mesh interface called int2 between interface-3 and interface-
4.

e. Close the Create/Edit Mesh Interfaces dialog box.

10.4.9. Obtaining the Solution

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Select Second Order Upwind for Turbulent Kinetic Energy and Turbulent Dissipation Rate in the
Spatial Discretization group box.

The second-order scheme will provide a more accurate solution.

2. Enable that plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Enter 5e-5 under Absolute Criteria for the continuity equation.

For this problem, the default value of 0.001 is insufficient for the flow rate in the blower to fully
converge. All other settings should remain at their default values.

c. Click OK to close the Residual Monitors dialog box.

3. Create a surface report definition and plot the volume flow rate at the flow outlet.

Solving → Reports → Definitions → New → Surface Report → Volume Flow Rate
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a. Enter surf-mon-1 for the Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console.

c. Note

When the Report File option is selected in the Surface Report Definition dialog box,
the volume flow rate history will be written to a file. If you do not enable the Report
File option, the history information will be lost when you exit ANSYS Fluent.

d. Select outlet from the Surfaces selection list.

e. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

4. Initialize the solution.

Solving → Initialization
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a. Retain the Method at the default of Hybrid in the Initialization Methods group.

b. Click Initialize to initialize the solution.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity
and pressure fields than standard initialization. This in general will help in improving
the convergence behavior of the solver.

5. Save the case file (blower.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 150 iterations.

Solving → Run Calculation

a. Enter 150 for No. of Iterations.

b. Click Calculate.

Early in the calculation, ANSYS Fluent will report that there is reversed flow occurring at the exit. This
is due to the sudden expansion, which results in a recirculating flow near the exit.

The solution will converge in approximately 120 iterations (when all residuals have dropped
below their respective criteria).
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Figure 10.3:  History of Volume Flow Rate the Outlet

The surface report history indicates that the flow rate at the outlet has ceased changing significantly,

further indicating that the solution has converged. The volume flow rate is approximately 3.49 m3/s.

Note

You can examine the residuals history in an appropriate graphics tab window.

7. Save the case and data files (blower2.cas.gz and blower2.dat.gz).

File → Write → Case & Data...

Note

It is good practice to save the case file whenever you are saving the data. This will ensure
that the relevant parameters corresponding to the current solution data are saved accord-
ingly.

10.4.10. Step 9: Postprocessing

1. Display filled contours of static pressure (Figure 10.4: Contours of Static Pressure (p. 448)).

Postprocessing → Graphics → Contours → Edit...
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a. Enable Filled in the Options group box.

b. Ensure Pressure... and Static Pressure are selected from the Contours of drop-down lists.

c. Click Display and close the Contours dialog box (see Figure 10.4: Contours of Static Pressure (p. 448)).

Pressure distribution in the flow domain is plotted in graphics window.
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Figure 10.4:  Contours of Static Pressure

2. Display absolute velocity vectors (Figure 10.5: Velocity Vectors (p. 450)).

Postprocessing → Graphics → Vectors → Edit...
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a. Enter 10 for Scale.

By default, Auto Scale is chosen. This will automatically scale the length of velocity vectors relative
to the size of the smallest cell in the mesh. To increase the length of the “scaled" vectors, set the Scale
factor to a value greater than 1.

b. Retain the default selection of Velocity from the Vectors of drop-down list.

c. Retain the default selection of Velocity... and Velocity Magnitude from the Color by drop-down list.

d. Click Display and close the Vectors dialog box (see Figure 10.5: Velocity Vectors (p. 450)).
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Figure 10.5: Velocity Vectors

The velocity vectors show an area of flow separation near the bottom of the outlet duct. You can zoom
in on this area and see the flow recirculation.

3. Display relative velocity vectors with respect to the rotational reference frame (fluid-rotor).

a. In the Reference Values task page, select fluid-rotor from the Reference Zone drop-down list.

Setup → Reference Values

b. Open the Vectors dialog box.

Postprocessing → Graphics → Vectors → Edit...
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i. Select Relative Velocity from the Vectors of drop-down list.

ii. Select Velocity... and Relative Velocity Magnitude from the Color by drop-down list.

iii. Set Scale to 2.

iv. Click Display and close the Vectors dialog box.

The relative air velocity vectors viewed in the frame of reference rotating with the rotor are
displayed.

v. Zoom in on the rotor blade region as shown in Figure 10.6: Relative Velocity Vectors (p. 452) and
examine the air flow through the rotor blade passages.

451
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 10.6:  Relative Velocity Vectors

4. Report the mass flux at inlet and outlet.

Postprocessing → Reports → Fluxes...
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a. Retain the selection of Mass Flow Rate in the Options group box.

b. Select inlet and outlet in the Boundaries selection list.

c. Click Compute.

The net mass imbalance should be no more than a small fraction (say, 0.5%) of the total flux through
the system. If a significant imbalance occurs, you should decrease your residual tolerances by at least
an order of magnitude and continue iterating.

The flux report will compute fluxes only for boundary zones.

d. Close the Flux Reports dialog box.

Note

You can use the Surface Integrals option to report fluxes on surfaces or planes.

Results → Reports → Surface Integrals Edit...

10.5. Summary

This tutorial illustrates the procedure for setting up and solving problems with multiple reference frames
using ANSYS Fluent. Although this tutorial considers only one rotating fluid zone, extension to multiple
rotating fluid zones is straightforward as long as you delineate each fluid zone.
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Note that this tutorial was solved using the default absolute velocity formulation. For some problems
involving rotating reference frames, you may want to use the relative velocity formulation. See the
 Fluent User's Guide for details.

10.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 11: Using Sliding Meshes

This tutorial is divided into the following sections:
11.1. Introduction
11.2. Prerequisites
11.3. Problem Description
11.4. Setup and Solution
11.5. Summary
11.6. Further Improvements

11.1. Introduction

The analysis of turbomachinery often involves the examination of the transient effects due to flow in-
teraction between the stationary components and the rotating blades. In this tutorial, the sliding mesh
capability of ANSYS Fluent is used to analyze the transient flow in an axial compressor stage. The rotor-
stator interaction is modeled by allowing the mesh associated with the rotor blade row to rotate relative
to the stationary mesh associated with the stator blade row.

This tutorial demonstrates how to do the following:

• Create periodic zones.

• Set up the transient solver and cell zone and boundary conditions for a sliding mesh simulation.

• Set up the mesh interfaces for a periodic sliding mesh model.

• Sample the time-dependent data and view the mean value.

11.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

11.3. Problem Description

The model represents a single-stage axial compressor composed of two blade rows. The first row is the
rotor with 16 blades, which is operating at a rotational speed of 37,500 rpm. The second row is the
stator with 32 blades. The blade counts are such that the domain is rotationally periodic, with a periodic
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angle of 22.5 degrees. This enables you to model only a portion of the geometry, namely, one rotor
blade and two stator blades. Due to the high Reynolds number of the flow and the relative coarseness
of the mesh (both blade rows are composed of only 13,856 cells total), the analysis will employ the in-
viscid model, so that ANSYS Fluent is solving the Euler equations.

Figure 11.1:  Rotor-Stator Problem Description

11.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
11.4.1. Preparation
11.4.2. Mesh
11.4.3. General Settings
11.4.4. Models
11.4.5. Materials
11.4.6. Cell Zone Conditions
11.4.7. Boundary Conditions
11.4.8. Operating Conditions
11.4.9. Mesh Interfaces
11.4.10. Solution
11.4.11. Postprocessing

11.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
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2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the sliding_mesh_R180.zip link to download the input files.

7. Unzip sliding_mesh_R180.zip to your working folder.

The mesh file axial_comp.msh can be found in the sliding_mesh directory created after unzipping
the file.

8. Use Fluent Launcher to start the 3D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Enable single precision (disable Double Precision).

11. Do not enable Meshing Mode.

12. Run in Serial under Processing Options.

11.4.2. Mesh

1. Read in the mesh file axial_comp.msh.

File → Read → Mesh...

11.4.3. General Settings

1. Check the mesh.

Setting Up Domain → Mesh → Check
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ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure
that the reported minimum volume is a positive number.

Warnings will be displayed regarding unassigned interface zones, resulting in the failure of the mesh
check. You do not need to take any action at this point, as this issue will be rectified when you define
the mesh interfaces in a later step.

2. Examine the mesh (Figure 11.2: Rotor-Stator Display (p. 458)).

Orient the view to display the mesh as shown in Figure 11.2: Rotor-Stator Display (p. 458). The inlet of the
rotor mesh is colored blue, the interface between the rotor and stator meshes is colored yellow, and the
outlet of the stator mesh is colored red.

Figure 11.2:  Rotor-Stator Display

3. Use the text user interface to change zones rotor-per-1 and rotor-per-3 from wall zones to peri-
odic zones.
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a. Press Enter in the console to get the command prompt (>).

b. Type the commands as shown below in the console:

> mesh/modify-zones/list-zones
  id  name                       type                material              kind
----  -------------------------  ------------------  --------------------  ----
  13  fluid-rotor                fluid               air                   cell
  28  fluid-stator               fluid               air                   cell
   2  default-interior:0         interior                                  face
  15  default-interior           interior                                  face
   3  rotor-hub                  wall                air                   face
   4  rotor-shroud               wall                air                   face
   7  rotor-blade-1              wall                air                   face
   8  rotor-blade-2              wall                air                   face
  16  stator-hub                 wall                air                   face
  17  stator-shroud              wall                air                   face
  20  stator-blade-1             wall                air                   face
  21  stator-blade-2             wall                air                   face
  22  stator-blade-3             wall                air                   face
  23  stator-blade-4             wall                air                   face
   5  rotor-inlet                pressure-inlet                            face
  19  stator-outlet              pressure-outlet                           face
  10  rotor-per-1                wall                air                   face
  12  rotor-per-2                wall                air                   face
  24  stator-per-2               wall                air                   face
  26  stator-per-1               wall                air                   face
   6  rotor-interface            interface                                 face
  18  stator-interface           interface                                 face
  11  rotor-per-4                wall                air                   face
   9  rotor-per-3                wall                air                   face
  25  stator-per-4               wall                air                   face
  27  stator-per-3               wall                air                   face

 /mesh/modify-zones> make-periodic
 Periodic zone [()] 10
 Shadow zone [()] 9
 Rotational periodic? (if no, translational) [yes] yes
 Create periodic zones? [yes] yes

     zone 9 deleted

      created periodic zones.

4. Similarly, change the following wall zone pairs to periodic zones:

Respective Zone IDsZone Pairs

12 and 11rotor-per-2 and rotor-per-4

26 and 27stator-per-1 and stator-per-3

24 and 25stator-per-2 and stator-per-4

5. Define the solver settings.

Setup → General
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a. Retain the default selection of Pressure-Based in the Type list.

b. Select Transient in the Time list.

6. Define the units for the model.

Setup → General → Units...

a. Select angular-velocity from the Quantities selection list.

b. Select rpm from the Units selection list.

c. Select pressure from the Quantities selection list.

Scroll down the Quantities list to find pressure.
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d. Select atm from the Units selection list.

e. Close the Set Units dialog box.

11.4.4. Models

1. Enable the inviscid model.

Setup → Models → Viscous Edit...

a. Select Inviscid in the Model list.

b. Click OK to close the Viscous Model dialog box.

11.4.5. Materials

1. Specify air (the default material) as the fluid material, using the ideal gas law to compute density.

Setup → Materials → Fluids → air → Edit...

461
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



a. Retain the default entry of air in the Name text entry field.

b. Select ideal-gas from the Density drop-down list  in the Properties group box.

c. Retain the default values for all other properties.

d. Click Change/Create and close the Create/Edit Materials dialog box.

As reported in the console, ANSYS Fluent will automatically enable the energy equation, since this is re-
quired when using the ideal gas law to compute the density of the fluid.

11.4.6. Cell Zone Conditions

Setup → Cell Zone Conditions
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1. Set the cell zone conditions for the fluid in the rotor (fluid-rotor).

Setup → Cell Zone Conditions → fluid-rotor → Edit...
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a. Enable Mesh Motion.

b. Click the Mesh Motion tab.

c. Retain the default values of (0, 0, 1) for X, Y, and Z in the Rotation-Axis Direction group box.

d. Enter 37500 rpm for Speed in the Rotational Velocity group box.

e. Click OK to close the Fluid dialog box.

2. Set the cell zone conditions for the fluid in the stator (fluid-stator).

Setup → Cell Zone Conditions → fluid-stator → Edit...
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a. Retain the default values of (0, 0, 1) for X, Y, and Z in the Rotation-Axis Direction group box.

b. Click OK to close the Fluid dialog box.

11.4.7. Boundary Conditions

Setup → Boundary Conditions
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1. Enter rotor-inlet into the Zone field to filter the zone list.

Setup → Boundary Conditions → rotor-inlet → Edit...
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a. Enter 1.0 atm for Gauge Total Pressure.

b. Enter 0.9 atm for Supersonic/Initial Gauge Pressure.

For information about the Supersonic/Initial Gauge Pressure, see the Fluent User's Guide.

c. Click the Thermal tab and enter 288 K for Total Temperature.
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d. Click OK to close the Pressure Inlet dialog box.

2. Enter stator-outlet into the Zone field to filter the zone list.

Setup → Boundary Conditions → stator-outlet → Edit...

a. Enter 1.08 atm for Gauge Pressure.

b. Enable Radial Equilibrium Pressure Distribution.

c. Click the Thermal tab and enter 288 K for Backflow Total Temperature.
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d. Click OK to close the Pressure Outlet dialog box.

Note

The momentum settings and temperature you input at the pressure outlet will be used
only if flow enters the domain through this boundary. It is important to set reasonable
values for these downstream scalar values, in case flow reversal occurs at some point
during the calculation.

3. Retain the default boundary conditions for all wall zones.

Setup → Boundary Conditions → rotor-blade-1 → Edit...
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Note

For wall zones, ANSYS Fluent always imposes zero velocity for the normal velocity com-
ponent, which is required whether or not the fluid zone is moving. This condition is all
that is required for an inviscid flow, as the tangential velocity is computed as part of the
solution.

11.4.8. Operating Conditions

1. Set the operating pressure.

Setup → Boundary Conditions → Operating Conditions...

a. Enter 0 atm for Operating Pressure.

b. Click OK to close the Operating Conditions dialog box.

Since you have specified the boundary condition inputs for pressure in terms of absolute pressures, you
have to set the operating pressure to zero. Boundary condition inputs for pressure should always be rel-
ative to the value used for operating pressure.
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11.4.9. Mesh Interfaces

1. Create a periodic mesh interface between the rotor and stator mesh regions.

Setup → Mesh Interfaces New...

a. Enter int for Mesh Interface.

b. Enable Periodic Repeats in the Interface Options group box.

Enabling this option, allows ANSYS Fluent to treat the interface between the sliding and non-sliding
zones as periodic where the two zones do not overlap.

c. Select rotor-interface from the Interface Zones Side 1 selection list.

Note

In general, when one interface zone is smaller than the other, it is recommended that
you choose the smaller zone as Interface Zone 1. In this case, since both zones are
approximately the same size, the order is not significant.

d. Select stator-interface from the Interface Zones Side 2 selection list.
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e. Click Create and close the Create/Edit Mesh Interfaces dialog box.

2. Check the mesh again to verify that the warnings displayed earlier have been resolved.

Setting Up Domain → Mesh → Check

11.4.10. Solution

1. Set the solution parameters.

Solving → Solution → Methods...

a. Select Coupled from the Pressure-Velocity Coupling group box.

For many general fluid-flow problems, convergence speed can be improved by using the coupled
solver.

2. Change the Solution Controls

Solving → Controls → Controls...
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a. Enter 0.5 for Momentum and Pressure in the Explicit Relaxation Factors group box.

b. Enter 0.9 for Temperature in the Under-Relaxation Factors group box.

3. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that the Plot is selected in the Options group box.

b. Select relative from the Convergence Criterion drop-down list.

c. Enter 0.01 for Relative Criteria for each Residual (continuity, x-velocity, y-velocity, z-velocity, and
energy).

d. Click OK to close the Residual Monitors dialog box.

4. Enable the plotting of mass flow rate at the inlet (rotor-inlet).

Solving → Reports → Definitions → New → Surface Report → Mass Flow Rate...
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a. Enter surf-mon-1 for the Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console.

c. Enter rotor-inlet in the Surfaces field to filter the list.

d. Select rotor-inlet from the Surfaces selection list.

e. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

surf-mon-1-rplot and surf-mon-1-rfile that are automatically generated by Fluent appear in
the tree (under Solution/Monitors/Report Plots and Solution/Monitors/Report Files, respect-
ively).

5. Enable the plotting of mass flow rate at the outlet (stator-outlet).

Solving → Reports → Definitions → New → Surface Report → Mass Flow Rate...
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a. Enter surf-mon-2 for the Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console.

c. Enter stator-outlet in the Surfaces field to filter the list.

d. Select stator-outlet from the Surfaces selection list.

e. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

surf-mon-2-rplot and surf-mon-2-rfile that are automatically generated by Fluent appear in
the tree (under Solution/Monitors/Report Plots and Solution/Monitors/Report Files, respect-
ively).

6. Enable the plotting of the area-weighted average of the static pressure at the interface (stator-interface).

Solving → Reports → Definitions → New → Surface Report → Area-Weighted Average...
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a. Enter surf-mon-3 for the Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console.

c. Retain the default selection of Pressure... and Static Pressure from the Field Variable drop-down
lists.

d. Enter stator-interface in the Surfaces field to filter the list.

e. Select stator-interface from the Surfaces selection list.

f. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

surf-mon-3-rplot and surf-mon-3-rfile that are automatically generated by Fluent appear in
the tree (under Solution/Monitors/Report Plots and Solution/Monitors/Report Files, respect-
ively).
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7. Initialize the solution using the values at the inlet (rotor-inlet).

Solving → Initialization → Options...

a. Select rotor-inlet from the Compute from drop-down list.

b. Select Absolute in the Reference Frame list.

c. Click Initialize.

8. Save the initial case file (axial_comp.cas.gz).

File → Write → Case...

9. Run the calculation for one revolution of the rotor.

Solving → Run Calculation → Advanced...
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a. Enter 6.6667e-6 s for Time Step Size.

The time step is set such that the passing of a single rotor blade is divided into 15 time steps. There
are 16 blades on the rotor. Therefore, in each time step the rotor rotates 360/16/15=1.5 degrees. With
a rotational speed of 37,500 rpm (225,000 deg/sec), 1.5 degrees of rotation takes 1.5 / 2.25e5 =
6.6667e-6 sec.

b. Enter 240 for Number of Time Steps.

There are 16 blades on the rotor, and each rotor blade period corresponds to 15 time steps (see
above). Therefore, a complete revolution of the rotor will take 16*15=240 time steps.

c. Retain the default setting of 20 for Max Iterations/Time Step.

d. Click Calculate.

The calculation will run for approximately 4,200 iterations.

The residuals jump at the beginning of each time step and then fall at least two to three orders of mag-
nitude. Also, the relative convergence criteria is achieved before reaching the maximum iteration limit
(20) for each time step, indicating the limit does not need to be increased.
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Figure 11.3:  Residual History for the First Revolution of the Rotor

10. Examine the flow variable histories for the first revolution of the rotor (Figure 11.4: Mass Flow Rate at the
Inlet During the First Revolution (p. 481), Figure 11.5: Mass Flow Rate at the Outlet During the First Revolu-
tion (p. 481), and Figure 11.6: Static Pressure at the Interface During the First Revolution (p. 482)).
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Figure 11.4:  Mass Flow Rate at the Inlet During the First Revolution

Figure 11.5:  Mass Flow Rate at the Outlet During the First Revolution
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Figure 11.6:  Static Pressure at the Interface During the First Revolution

The flow variable histories show that the large variations in flow rate and interface pressure that occur
early in the calculation are greatly reduced as time-periodicity is approached.

11. Save the case and data files (axial_comp-0240.cas.gz and axial_comp-0240.dat.gz).

File → Write → Case & Data...

Note

It is a good practice to save the case file whenever you are saving the data file espe-
cially for sliding mesh model. This is because the case file contains the mesh inform-
ation, which is changing with time.

Note

For transient-state calculations, you can add the character string %t to the file name so
that the iteration number is automatically appended to the name (for example, by entering
axial_comp-%t for the File Name in the Select File dialog box, ANSYS Fluent will save
files with the names axial_comp-0240.cas and axial_comp-0240.dat).

12. Rename the report output file in preparation for further iterations.

Solution → Monitors → Report Files → surf-mon-1-rfile Edit...
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a. Enter surf-mon-1b.out for Output File Base Name.

b. Click OK to close the Edit Report File dialog box.

13. Similarly, change the output file names for the surf-mon-2-rfile and surf-mon-3-rfile report file definitions
to surf-mon-2b.out and surf-mon-3b.out, respectively.

14. Continue the calculation for 720 more time steps to simulate three more revolutions of the rotor.

Solving → Run Calculation → Advanced...
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Note

Calculating three more revolutions will require some additional CPU time. If you choose,
instead of calculating the solution, you can read a data file (axial_comp-0960.dat.gz)
with the precalculated solution for this tutorial. This data file can be found in the slid-
ing_mesh directory.

The calculation will run for approximately 11,600 more iterations.

15. Examine the flow variable histories for the next three revolutions of the rotor to verify that the solution is
time-periodic (Figure 11.7: Mass Flow Rate at the Inlet During the Next 3 Revolutions (p. 485) Figure 11.8: Mass
Flow Rate at the Outlet During the Next 3 Revolutions (p. 486), and Figure 11.9: Static Pressure at the Interface
During the Next 3 Revolutions (p. 486)).

Note

If you read the provided data file instead of iterating the solution for three revolutions,
the flow variable histories can be displayed by using the File XY Plot dialog box.

Results  → Plots → File Edit...
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Click the Add button in the File XY Plot dialog box to select one of the flow variable
histories from the Select File dialog box, click OK, and then click Plot. To obtain a better
view of the data, you may want to manually change the ranges of the axes.

Figure 11.7:  Mass Flow Rate at the Inlet During the Next 3 Revolutions
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Figure 11.8:  Mass Flow Rate at the Outlet During the Next 3 Revolutions

Figure 11.9:  Static Pressure at the Interface During the Next 3 Revolutions

16. Save the case and data files (axial_comp-0960.cas.gz and axial_comp-0960.dat.gz).
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File → Write → Case & Data...

17. Change the file names for surf-mon-1b.out, surf-mon-2b.out, and surf-mon-3b.out to surf-mon-
1c.out,surf-mon-2c.out, and surf-mon-3c.out, respectively (as described in a previous step),
in preparation for further iterations.

18. Add a point at the interface of the stator.

Postprocessing → Surface → Create → Point...

a. Enter -0.02 for x0,-0.08 for y0, and -0.036 for z0 in the Point Surface dialog box.

b. Retain the default,point-1 for New Surface Name.

c. Click Create and close the Point Surface dialog box.

19. Enable plotting of the static pressure at a point on the stator interface (point-1).

Solving → Reports → Definitions → New → Surface Report → Vertex Average...
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a. Enter surf-mon-4 for the Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console.

c. Retain the defaults of Pressure and Static Pressure for Field Variable.

d. Enter point-1 in the Surfaces field to filter the list.

e. Select point-1 from the Surfaces selection list.

f. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

20. Continue the calculation for one final revolution of the rotor, while saving data samples for the postpro-
cessing of the time statistics.

Solving → Run Calculation → Advanced...
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a. Enter 240 for Number of Time Steps.

b. Enable Data Sampling for Time Statistics in the Options group box.

Enabling Data Sampling for Time Statistics causes ANSYS Fluent to calculate and store mean and
root-mean-square (RMS) values of various quantities and field functions over the calculation interval.

c. Click Calculate.

The calculation will run for approximately 3,800 more iterations.

21. Save the case and data files (axial_comp-1200.cas.gz and axial_comp-1200.dat.gz).

File → Write → Case & Data...
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Figure 11.10:  Static Pressure at a Point on The Stator Interface During the Final Revolution

11.4.11. Postprocessing

In the next three steps you will examine the time-averaged values for the mass flow rates at the inlet and
the outlet during the final revolution of the rotor. By comparing these values, you will verify the conservation
of mass on a time-averaged basis for the system over the course of one revolution.

1. Examine the time-averaged mass flow rate at the inlet during the final revolution of the rotor (as calculated
from surf-mon-1c.out).

Postprocessing → Plots → FFT...
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a. Click the Load Input File... button to open the Select File dialog box.
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i. Select All Files from the files of type: drop-down list.

ii. Select surf-mon-1c.out from the list of files.

iii. Click OK to close the Select File dialog box.

b. Click the Plot/Modify Input Signal... button to open the Plot/Modify Input Signal dialog box.

i. Examine the values for Min, Max, Mean, and Variance in the Signal Statistics group box.

ii. Close the Plot/Modify Input Signal dialog box.

c. Select the directory path ending in surf-mon-1c.out from the Files selection list.

d. Click the Free File Data button.

2. Examine the time-averaged mass flow rate at the outlet during the final revolution of the rotor (as calculated
from surf-mon-2c.out), and plot the data.

Postprocessing → Plots → FFT...

a. Click the Load Input File... button to open the Select File dialog box.

i. Select All Files from the files of type: drop-down list.

ii. Select surf-mon-2c.out from the list of files.
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iii. Click OK to close the Select File dialog box.

b. Click the Plot/Modify Input Signal... button to open the Plot/Modify Input Signal dialog box.

i. Examine the values for Min, Max, and Variance in the Signal Statistics group box.

ii. Click Set Defaults.

iii. Click Apply/Plot to display the area-weighted average of mass flow rate at the outlet (Fig-
ure 11.11: Area-Weighted Average Mass Flow Rate at the Outlet During the Final Revolution (p. 494)).
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Figure 11.11:  Area-Weighted Average Mass Flow Rate at the Outlet During the Final
Revolution

iv. Close the Plot/Modify Input Signal dialog box.

3. Examine the vertex-averaged static pressure at the stator during the final revolution of the rotor (as calculated
from surf-mon-4.out), and plot the data.

Postprocessing → Plots → FFT...

a. Click the Load Input File... button to open the Select File dialog box.

i. Select All Files from the Files of type: drop-down list.

ii. Select surf-mon-4-rfile.out from the list of files.

iii. Click OK to close the Select File dialog box.

b. Click the Plot/Modify Input Signal... button to open the Plot/Modify Input Signal dialog box.
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i. Enable Subtract Mean Value in the Options group box.

ii. Click Apply/Plot.

iii. Close the Plot/Modify Input Signal dialog box.

c. Click Plot FFT in the Fourier Transform dialog box.

d. Click Axes... to open the Axes - Fourier Transform dialog box.
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e. Select exponential from the Type drop-down list, and set Precision to 1 in the Number Format group
box.

f. Click Apply and close the Axes - Fourier Transform dialog box.

g. Click Plot FFT and close the Fourier Transform dialog box.

Figure 11.12:  FFT of Static Pressure at the Stator
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The FFT plot clearly shows that the pressure fluctuations due to interaction at the interface are
dominated by the rotor and stator blade passing frequencies (which are 10 kHz and 20 kHz, respect-
ively) and their higher harmonics.

4. Display contours of the mean static pressure on the walls of the axial compressor.

Postprocessing → Graphics → Contours → Edit

a. Enable Filled in the Options group box.

b. Select Unsteady Statistics... and Mean Static Pressure from the Contours of drop-down lists.

c. Select wall from the Surface Types selection list.

Scroll down the Surfaces selection list to find wall.

d. Click Display and close the Contours dialog box.

e. Rotate the view to get the display as shown in Figure 11.13: Mean Static Pressure on the Outer Shroud
of the Axial Compressor (p. 498).

Shock waves are clearly visible in the flow near the outlets of the rotor and stator, as seen in the areas
of rapid pressure change on the outer shroud of the axial compressor.
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Figure 11.13:  Mean Static Pressure on the Outer Shroud of the Axial Compressor

11.5. Summary

This tutorial has demonstrated the use of the sliding mesh model for analyzing transient rotor-stator
interaction in an axial compressor stage. The model utilized the coupled pressure-based solver in con-
junction with the transient algorithm to compute the inviscid flow through the compressor stage. The
solution was calculated over time until the reported variables displayed time-periodicity (which required
several revolutions of the rotor), after which time-averaged data was collected while running the case
for the equivalent of one additional rotor revolution (240 time steps).

The Fast Fourier Transform (FFT) utility in ANSYS Fluent was employed to determine the time averages
from stored flow variable report data. You also used the FFT utility to examine the frequency content
of the transient report data. The observed peak corresponds to the passing frequency and the higher
harmonics of the passing frequency, which occurred at approximately 10,000 Hz.
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11.6. Further Improvements

This tutorial guides you through the steps to reach a second-order solution. You may be able to obtain
a more accurate solution by adapting the mesh. Adapting the mesh can also ensure that your solution
is independent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid
Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 12: Using Dynamic Meshes

This tutorial is divided into the following sections:
12.1. Introduction
12.2. Prerequisites
12.3. Problem Description
12.4. Setup and Solution
12.5. Summary
12.6. Further Improvements

12.1. Introduction

In ANSYS Fluent, the dynamic mesh capability is used to simulate problems with boundary motion,
such as check valves and store separations. The building blocks for dynamic mesh capabilities within
ANSYS Fluent are three dynamic mesh schemes, namely, smoothing, layering, and remeshing. A com-
bination of these three schemes is used to tackle the most challenging dynamic mesh problems. However,
for simple dynamic mesh problems involving linear boundary motion, the layering scheme is often
sufficient. For example, flow around a check valve can be simulated using only the layering scheme, as
is demonstrated in this tutorial.

Check valves are commonly used to allow unidirectional flow. For instance, they are often used to act
as a pressure-relieving device by only allowing fluid to leave the domain when the pressure is higher
than a certain level. In such a case, a ball is connected to a spring that acts to push the ball to the valve
seat and to shut the flow. But when the pressure force on the ball is greater than the spring force, the
ball will move away from the valve seat and allow fluid to leave, thus reducing the pressure upstream.
Gravity could be another factor in the force balance, and can be considered in ANSYS Fluent. The de-
formation of the ball is typically neglected, thus allowing for a rigid body Fluid Structure Interaction
(FSI) calculation, which can be handled by Fluent's six degrees of freedom (six DOF) solver.

This tutorial provides information for performing basic dynamic mesh calculations by demonstrating
how to do the following:

• Use the dynamic mesh capability of ANSYS Fluent to solve a simple flow-driven rigid-body motion problem.

• Set boundary conditions for internal flow.

• Set up the rigid-body motion of the ball, by specifying a set of six DOF properties that define the translation,
spring loading, and range.

• Calculate a solution using the pressure-based solver.

12.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)
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• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

12.3. Problem Description

The check valve problem to be considered is shown schematically in Figure 12.1: Problem Specifica-
tion (p. 502). A 2D axisymmetric valve geometry is used, consisting of a mass-flow inlet on the left, and
a pressure outlet on the right, affecting the motion of a valve ball. In this case, the transient motion of
the valve ball due to spring force and hydrodynamic force is studied.

Figure 12.1:  Problem Specification

12.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
12.4.1. Preparation
12.4.2. Mesh
12.4.3. General Settings
12.4.4. Models
12.4.5. Materials
12.4.6. Boundary Conditions
12.4.7. Solution: Steady Flow
12.4.8.Time-Dependent Solution Setup
12.4.9. Mesh Motion
12.4.10.Time-Dependent Solution
12.4.11. Postprocessing

12.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.
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4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the dynamic_mesh_R180.zip link to download the input files.

7. Unzip dynamic_mesh_R180.zip to your working folder.

The mesh file valve.msh can be found in the dynamic_mesh folder created after unzipping the
file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that Double Precision is disabled if you want to match the tutorial setup exactly.

11. Select Serial under Processing Options.

If you decide to instead run this tutorial in parallel, make sure to use Principal Axes as the partitioning
method.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

12.4.2. Mesh

1. Read the mesh file valve.msh.

File → Read → Mesh...

12.4.3. General Settings

1. Check the mesh.

Setting Up Domain → Mesh → Check

Note

You should always make sure that the cell minimum volume is not negative, since ANSYS
Fluent cannot begin a calculation if this is the case.

2. Change the display units for length to millimeters in the Set Units dialog box.

Setting Up Domain → Mesh → Units...
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a. Select length under Quantities and mm under Units.

b. Close the Set Units dialog box.

3. Display the mesh (Figure 12.2: Initial Mesh for the Valve (p. 505)).

Setting Up Domain → Mesh → Display...

a. Deselect axis-inlet, axis-move, inlet, and outlet from the Surfaces selection list.

b. Click Display.
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Figure 12.2:  Initial Mesh for the Valve

c. Close the Mesh Display dialog box.

4. Enable an axisymmetric steady-state calculation.

Setting Up Physics → Solver

Select Axisymmetric from the drop-down list in the Solver group box (below Reference Values...).

12.4.4. Models

1. Enable the standard -  turbulence model.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2 eqn) from the Model list and retain the default selection of Standard in the k-ep-
silon Model group box.

b. Select Enhanced Wall Treatment for the Near-Wall Treatment.

c. Click OK to close the Viscous Model dialog box.

12.4.5. Materials

1. Apply the ideal gas law for the incoming air stream.

Setting Up Physics → Materials → Create/Edit...
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a. Ensure air is selected from the Fluent Fluid Materials drop-down list.

b. Select ideal-gas from the Density drop-down list.

c. Click Change/Create.

d. Close the Create/Edit Materials dialog box.

Note that the energy equation is automatically enabled based on your change to the material density
method.

12.4.6. Boundary Conditions

Dynamic mesh motion and all related parameters are specified using the items in the Dynamic Mesh task
page, not through the Boundary Conditions task page. You will set these conditions in a later step.

1. Set the conditions for the mass-flow inlet (inlet).

Since the inlet boundary is assigned to a wall boundary type in the original mesh, you will need to ex-
plicitly assign the inlet boundary to a mass-flow inlet boundary type in ANSYS Fluent.
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Setup → Boundary Conditions → inlet Type → mass-flow-inlet

a. Enter 0.0116 kg/s for Mass Flow Rate.

b. Select Normal to Boundary from the Direction Specification Method drop-down list.

c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-
bulence group box.

d. Retain 5% for Turbulent Intensity.

e. Enter 20 mm for the Hydraulic Diameter.

f. Click OK to close the Mass-Flow Inlet dialog box.

2. Set the conditions for the exit boundary (outlet).

Since the outlet boundary is assigned to a wall boundary type in the original mesh, you will need to
explicitly assign the outlet boundary to a pressure outlet boundary type in ANSYS Fluent.

Setup → Boundary Conditions → outlet Type → pressure-outlet
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a. Select From Neighboring Cell from the Backflow Direction Specification Method drop-down list.

b. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-
bulence group box.

c. Retain 5% for Backflow Turbulent Intensity.

d. Enter 50 mm for Backflow Hydraulic Diameter.

e. Click OK to close the Pressure Outlet dialog box.

3. Set the boundary type to axis for the axis-inlet boundary.

Since the axis-inlet boundary is assigned to a wall boundary type in the original mesh, you will need
to explicitly assign this boundary to an axis boundary type in ANSYS Fluent.

Setup → Boundary Conditions → axis-inlet Type → axis

4. Set the boundary type to axis for the axis-move boundary.

Setup → Boundary Conditions → axis-move Type → axis

12.4.7. Solution: Steady Flow

In this step, you will generate a steady-state flow solution that will be used as an initial condition for the
time-dependent solution.
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1. Set the solution parameters.

Solving → Solution → Methods...

a. Select Coupled from the Scheme drop-down list.

b. Select PRESTO! from the Pressure drop-down list.

c. Retain the default of Second Order Upwind in the Density drop-down list.

d. Retain the default of Second Order Upwind in the Momentum drop-down list.

e. Retain the defaults of First Order Upwind in the Turbulent Kinetic Energy and Turbulent Dissipation
Rate drop-down lists.

f. Retain the default of Second Order Upwind in the Energy drop-down list.

2. Set the relaxation factors.

Solving → Controls → Controls...
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Retain the default values for Under-Relaxation Factors in the Solution Controls task page.

3. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

4. Initialize the solution.

Solving → Initialization

a. Retain the default selection of Hybrid from the Method list.

b. Click Initialize.

Note

A warning is displayed in the console stating that the convergence tolerance of
1.000000e-06 was not reached during hybrid initialization. This means that the default
number of iterations is not enough. You will increase the number of iterations and
re-initialize the flow. For more information refer to hybrid initialization in the Fluent
User's Guide.

c. Click More Settings....
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i. Increase the Number of Iterations to 20.

ii. Click OK to close the Hybrid Initialization dialog box.

d. Click Initialize again.

Note

Click OK in the Question dialog box that asks if it is OK to discard the current data. The
console will then display that hybrid initialization is done.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity
and pressure fields than standard initialization. This will help to improve the convergence
behavior of the solver.

5. Save the case file (valve_init.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 150 iterations.

Solving → Run Calculation

a. Enter 150 for No. of Iterations.

b. Click Calculate to start the steady flow simulation.

The solution converges in approximately 132 iterations.

7. Save the case and data files (valve_init.cas.gz and valve_init.dat.gz).

File → Write → Case & Data...

12.4.8. Time-Dependent Solution Setup

1. Enable a time-dependent calculation.

Setting Up Physics → Solver
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Select Transient from the Time list.

12.4.9. Mesh Motion

1. Enable dynamic mesh motion and define the layering settings.

Setting Up Domain → Mesh Models → Dynamic Mesh...

a. Enable Dynamic Mesh in the Dynamic Mesh task page.
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For more information on the available models for moving and deforming zones, see the Fluent
User's Guide.

b. Disable Smoothing and enable Layering in the Mesh Methods group box.

Note

ANSYS Fluent will automatically flag the existing mesh zones for use of the different
dynamic mesh methods where applicable.

c. Click the Settings... button in the Mesh Methods group box to open the Mesh Method Settings
dialog box.

i. Select Ratio Based in the Options group box.

ii. Retain the default settings of 0.4 and 0.2 for Split Factor and Collapse Factor, respectively.

iii. Click OK to close the Mesh Method Settings dialog box.

2. Enable the six degrees of freedom (six DOF) solver and define a set of motion properties.

The six DOF solver computes external forces and moments (such as hydrodynamic forces) on objects that
undergo rigid body motion. These forces are computed by numerical integration of pressure and shear
stress over the object’s surfaces. Additional load forces can be added, such as those produced by a spring.

a. Enable Six DOF in the Options group box of the Dynamic Mesh task page.

b. Click the Settings... button in the Options group box to open the Options dialog box.
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i. Click the Create/Edit... button in the Six DOF tab of the Options dialog box, in order to open the
Six DOF Properties group box.

Here you will define a set of properties for the motion of the valve ball using the ANSYS Fluent
graphical user interface. Note that you could instead define it through a user-defined function;
this is not as easy to do, but may be necessary for more complex motion.
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ii. Enter 1dof for Name.

iii. Enter 0.2 for Mass.

This represents the total mass of the valve ball.

iv. Enable the One DOF Translation option to ensure the valve ball only translates in a single direction
without rotation.

v. Enter 1 for X and 0 for Y in the Direction group box.

vi. Enter -21 for Preload and 1000 for Constant in the Spring group box, in order to define a Hooke's
law spring that exerts loads on the valve ball.

The Preload field allows you to specify that the spring is deformed (that is, extended or com-
pressed) with the current position of the valve ball. A negative value is used in this case in accord-
ance with the defined Direction, that is, to specify that the initial force of the spring acts to move
the valve ball toward the valve seat.
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vii. Enable the Constrained option, so that you can prevent the valve ball from contacting the valve
seat.

The valve cannot be allowed to completely close: because dynamic mesh problems require that
at least one layer of cells remains in order to maintain the topology, a small gap must be main-
tained between the valve ball and the valve seat.

viii.Enter the following values in the Reference Point group box.

ValueProperty

10 mmLocation

1 mmMinimum

185 mmMaximum

The Location assigns a coordinate value to a point located on the dynamic object (the valve
ball) in its initial position. The value of the Location is arbitrary, and allows you to define the
range using values that are most convenient for your problem. In this case, the surface of the
valve ball is initially 10 mm away from the valve seat; the Minimum is defined relative to the
Location and the values you entered here allow the valve ball to move only 9 mm in the direction
opposite to the Direction.

ix. Click Create to save your settings.

x. Close the Six DOF Properties dialog box.

xi. Enable the Write Motion History option in the Options dialog box, and enter motion for the File
Name.

This ensures that a file is created during the simulation that lists the location and orientation of
the dynamic object at every time step, which could be used for postprocessing.

xii. Click OK to close the Options dialog box.

3. Specify the dynamic mesh zone motion for the fluid cell zone in which the valve ball moves (fluid-move).

a. Click Create/Edit... in the Dynamic Mesh task page, to open the Dynamic Mesh Zones dialog box.
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b. Select fluid-move from the Zone Names drop-down list.

c. Retain the default selection of Rigid Body from the Type list.

d. Ensure that the On option is enabled in the Six DOF group box of the Motion Attributes tab.

e. Enable the Passive option in the Six DOF group box.

The only reason you are having this cell zone move is to preserve the mesh that surrounds the moving
valve ball. Enabling the Passive option ensures that the forces on this zone do not affect the motion
of the valve ball.

f. Ensure that 1dof is selected from the Six DOF UDF/Properties drop-down list, to apply the motion
properties you defined previously.

g. Enter 61 mm for X and 0 mm for Y in the Center of Gravity Location.
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These coordinates correspond to the center of the valve ball in the initial position. These fields will
be updated by ANSYS Fluent during the simulation, allowing you to track the location of this zone
from within the Dynamic Mesh Zones dialog box.

h. Retain the default settings of 0 for the fields in the Center of Gravity Velocity, Rigid Body Orientation,
and Rigid Body Angular Velocity group boxes.

i. Click Create.

4. Specify the meshing options for the boundary zone named int-layering in the Dynamic Mesh Zones
dialog box. This boundary zone acts as a layering interface between the stationary inlet cell zone and the
cell zone in which the valve ball moves.

a. Select int-layering from the Zone Names drop-down list.

b. Select Stationary from the Type list.

c. Enter 0.5 mm for the Cell Height of the fluid-move Adjacent Zone.
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d. Retain the default value of 0 mm for the Cell Height of the fluid-inlet Adjacent Zone.

e. Click Create.

5. Specify the meshing options for the boundary zone named outlet in the Dynamic Mesh Zones dialog
box. This boundary zone acts as a stationary outlet for the cell zone in which the valve ball moves.

a. Select outlet from the Zone Names drop-down list.

b. Retain the previous selection of Stationary from the Type list.

c. Enter 1.9 mm for the Cell Height of the fluid-move Adjacent Zone.

d. Click Create.

6. Specify the meshing options for the boundary zone named seat-valve in the Dynamic Mesh Zones dialog
box. This boundary zone acts as the stationary valve seat.

a. Select seat-valve from the Zone Names drop-down list.

b. Retain the previous selection of Stationary from the Type list.

c. Enter 0.5 mm for the Cell Height of the fluid-move Adjacent Zone.

d. Click Create.

7. Specify the motion of the boundary zone named valve in the Dynamic Mesh Zones dialog box. This
boundary zone surrounds the valve ball that moves relative to the valve seat.

a. Select valve from the Zone Names drop-down list.

b. Select Rigid Body from the Type list.

c. Click the Motion Attributes tab.

i. Enable the On option in the Six DOF group box.

ii. Ensure that the Passive option is disabled in the Six DOF group box.

This ensures that the forces on this zone affect the motion of the valve ball.

iii. Select 1dof from the Six DOF UDF/Properties drop-down list to apply the motion properties you
defined previously.

iv. Enter 61 mm for X and 0 mm for Y in the Center of Gravity Location.

Again, these coordinates correspond to the center of the valve ball in the initial position.

v. Retain the default settings of 0 for the fields in the Center of Gravity Velocity, Rigid Body Orient-
ation, and Rigid Body Angular Velocity group boxes.

d. Click the Meshing Options tab and enter 0 mm for the Cell Height of the fluid-move Adjacent
Zone.

e. Click Create and close the Dynamic Mesh Zones dialog box.
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In many moving / deforming mesh (MDM) problems, you may want to preview the mesh motion before
proceeding. In this problem, the mesh motion is affected by the pressure exerted by the fluid on the valve
ball and acting against the inertia of the valve ball. Hence, for this problem, mesh motion in the absence of
a flow field solution is meaningless, and you will not use this feature here.

12.4.10. Time-Dependent Solution

1. Set the solution parameters.

Solving → Solution → Methods...

a. Select PISO from the Scheme drop-down list in Pressure-Velocity Coupling group box.
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b. Enter 0 for Skewness Correction.

c. Retain all of the other previously set schemes and defaults.

2. Set the relaxation factors.

Solving → Controls → Controls...

a. Enter 0.6 for Pressure in the Under-Relaxation Factors group box.

b. Enter 0.4 for Turbulent Kinetic Energy.

c. Scroll down and enter 0.4 for Turbulent Dissipation Rate.

3. Request that case and data files are automatically saved every 50 time steps.

Solving → Activities → Autosave...
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a. Enter 50 for Save Data File Every (Time Steps).

b. Enter valve_tran.gz in the File Name field.

c. Select flow-time from the Append File Name with drop-down list.

When ANSYS Fluent saves a file, it will append the flow time value to the file name prefix
(valve_tran). The gzipped standard extensions (.cas.gz and .dat.gz) will also be appended.

d. Click OK to close the Autosave dialog box.

4. Create an animation sequence for the static pressure contour plots for the valve.

Use the solution animation feature to save pressure contour plots every five time steps. After the calculation
is complete, you will use the solution animation playback feature to view the animated plots over time.

Solving → Activities → Create → Solution Animations...
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a. Enter pressure for Name in the Animation Definition dialog box.

b. Set Record after every to 5 and select Time Step from the neighboring drop-down list.

The default value of 1 instructs ANSYS Fluent to update the animation sequence at every time step.
For this case, this would generate a large number of files.

c. Retain the default value of 2 for Window Id.

This is where the animation frames will be displayed during the calculation.

d. Click the New Object drop-down list and select Contours... from the menu that opens.
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i. Enter contour-pressure for Contour Name in the Contours dialog box.

ii. Enable Filled in the Options group box.

iii. Retain the default selection of Pressure... and Static Pressure from the Contours of drop-down
lists.

iv. Click Save/Display (Figure 12.3: Contours of Static Pressure at t=0 s (p. 527)).

v. Close the Contours dialog box.
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Figure 12.3:  Contours of Static Pressure at t=0 s

e. Select contour-pressure from the Animation Object selection list.

f. Click Save and close the Animation Definition dialog box.

5. Create an animation sequence for the velocity vectors plots for the valve.

Solving → Activities → Create → Solution Animations...
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a. Enter vv for Name.

b. Set Record after every to 5 and select Time Step from the neighboring drop-down list.

c. Retain the default value of 3 for Window Id.

d. Click the New Object drop-down list and select Vectors... from the menu that opens.
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i. Enter vector-vv for Name.

ii. Retain all the other default settings.

iii. Click Save/Display (Figure 12.4: Vectors of Velocity at t=0 s (p. 530)).

iv. Close the Vectors dialog box.
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Figure 12.4: Vectors of Velocity at t=0 s

e. Select vector-vv from the Animation Object selection list.

f. Click Save and close the Animation Definition dialog box.

Note that the new animation definitions appear under the Solution/Calculation Activities/Solution
Animations tree branch. To edit an animation definition, right-click it and select Edit... from the menu
that opens.

6. Set the time step parameters for the calculation.

Solving → Run Calculation → Advanced...
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a. Enter 0.0001 s for Time Step Size.

b. Enter 150 for Number of Time Steps.

c. Retain 20 for Max Iterations/Time Step.

In the accurate solution of a real-life time-dependent CFD problem, it is important to make sure that
the solution converges at every time step to within the desired accuracy. Here, the first few time steps
will only come to a reasonably converged solution.

7. Save the initial case and data files for this transient problem (valve_tran-0.000000.cas.gz and
valve_tran-0.000000.dat.gz).

File → Write → Case & Data...

8. Calculate a solution by clicking Calculate in the Run Calculation task page.
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12.4.11. Postprocessing

1. Inspect the solution at the final time step.

a. Inspect the contours of static pressure in the valve, by clicking the Contours of Static Pressure tab in
the graphics window (Figure 12.5: Contours of Static Pressure After 150 Time Steps (p. 532)).

Figure 12.5:  Contours of Static Pressure After 150 Time Steps

b. Inspect the velocity vectors near the point where the valve ball meets the valve seat, by clicking the
Velocity Vectors Colored By Velocity Magnitude tab in the graphics window (Figure 12.6: Velocity
Vectors After 150 Time Steps (p. 533)).
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Figure 12.6: Velocity Vectors After 150 Time Steps

2. Play the animation of the pressure contours.

Postprocessing → Animation → Solution Playback...
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a. Select pressure from the Animation Sequences list in the Playback dialog box.

If the Animation Sequences list is empty, click Read... to select the pressure.cxa sequence
file from your working folder.

The playback control buttons will become active.

b. Set the slider bar above Replay Speed about halfway between Slow and Fast.

c. Retain the default settings in the rest of the dialog box and click the  button.

You may have to change the window to see the animation. Click the second tab in the graphics
window, which corresponds to the Window Id that you set for pressure in the Animation
Definition dialog box.

3. Play the animation of the velocity vectors.

a. Select vv from the Animation Sequences list in the Playback dialog box.

If the Animation Sequences list does not contain vv, click Read... to select the vv.cxa sequence
file from your working folder.

b. Retain the settings in the rest of the dialog box and click the  button.

You may have to change the window to see the animation. Click the third tab in the graphics window,
which corresponds to the Window Id that you set for vv in the Animation Definition dialog box.

For additional information on animating the solution, see Modeling Transient Compressible
Flow (p. 267) and see the Fluent User's Guide.

c. Close the Playback dialog box.
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4. You can also inspect the solution at different intermediate time steps.

a. Read the corresponding case and data files (for example,valve_tran-1-0.010000.cas.gz and
valve_tran-1-0.010000.dat.gz).

File → Read → Case & Data...

b. Display the desired contours and vectors.

12.5. Summary

In this tutorial, a check valve is used to demonstrate the dynamic layering capability within ANSYS
Fluent, using one of the three dynamic mesh schemes available. You were also shown how to perform
a one degree of freedom (one DOF) rigid body FSI by means of the six DOF solver.

12.6. Further Improvements

This tutorial guides you through the steps to generate an initial first-order solution. You may be able
to increase the accuracy of the solution further by using an appropriate higher-order discretization
scheme. For a more accurate solution, you can increase the number of layers across the valve seat area.
This can be achieved either by using a finer mesh at the valve seat area and/or using a non-constant
layer height instead of a constant layer height, as demonstrated in this tutorial.
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Chapter 13: Modeling Species Transport and Gaseous Combustion

This tutorial is divided into the following sections:
13.1. Introduction
13.2. Prerequisites
13.3. Problem Description
13.4. Background
13.5. Setup and Solution
13.6. Summary
13.7. Further Improvements

13.1. Introduction

This tutorial examines the mixing of chemical species and the combustion of a gaseous fuel.

A cylindrical combustor burning methane ( ) in air is studied using the eddy-dissipation model in
ANSYS Fluent.

This tutorial demonstrates how to do the following:

• Enable physical models, select material properties, and define boundary conditions for a turbulent flow with
chemical species mixing and reaction.

• Initiate and solve the combustion simulation using the pressure-based solver.

• Examine the reacting flow results using graphics.

• Predict thermal and prompt NOx production.

• Use custom field functions to compute NO parts per million.

13.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

To learn more about chemical reaction modeling, see the Fluent User's Guide and the Fluent Theory
Guide. Otherwise, no previous experience with chemical reaction or combustion modeling is assumed.
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13.3. Problem Description

The cylindrical combustor considered in this tutorial is shown in Figure 13.1: Combustion of Methane
Gas in a Turbulent Diffusion Flame Furnace (p. 538). The flame considered is a turbulent diffusion flame.
A small nozzle in the center of the combustor introduces methane at 80  . Ambient air enters the
combustor coaxially at 0.5  . The overall equivalence ratio is approximately 0.76 (approximately 28

 excess air). The high-speed methane jet initially expands with little interference from the outer wall,
and entrains and mixes with the low-speed air. The Reynolds number based on the methane jet diameter

is approximately .

Figure 13.1:  Combustion of Methane Gas in a Turbulent Diffusion Flame Furnace

13.4. Background

In this tutorial, you will use the generalized eddy-dissipation model to analyze the methane-air combus-
tion system. The combustion will be modeled using a global one-step reaction mechanism, assuming
complete conversion of the fuel to  and . The reaction equation is

(13.1)

This reaction will be defined in terms of stoichiometric coefficients, formation enthalpies, and parameters
that control the reaction rate. The reaction rate will be determined assuming that turbulent mixing is
the rate-limiting process, with the turbulence-chemistry interaction modeled using the eddy-dissipation
model.

13.5. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
13.5.1. Preparation
13.5.2. Mesh
13.5.3. General Settings
13.5.4. Models
13.5.5. Materials
13.5.6. Boundary Conditions
13.5.7. Initial Reaction Solution
13.5.8. Postprocessing
13.5.9. NOx Prediction

13.5.1. Preparation

To prepare for running this tutorial:
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1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the species_transport_R180.zip link to download the input files.

7. Unzip species_transport_R180.zip to your working folder.

The file gascomb.msh can be found in the species_transport folder created after unzipping
the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher in
the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Enable Double-Precision.

11. Ensure Serial is selected under Processing Options.

13.5.2. Mesh

1. Read the mesh file gascomb.msh.

File → Read → Mesh...

After reading the mesh file, ANSYS Fluent will report that 1615 quadrilateral fluid cells have been read,
along with a number of boundary faces with different zone identifiers.

13.5.3. General Settings

1. Check the mesh.
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Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure
that the reported minimum volume reported is a positive number.

2. Scale the mesh.

Setting Up Domain → Mesh → Scale...

Since this mesh was created in units of millimeters, you will need to scale the mesh into meters.

a. Select mm from the Mesh Was Created In drop-down list in the Scaling group box.

b. Click Scale.

c. Ensure that m is selected from the View Length Unit In drop-down list.

d. Ensure that Xmax and Ymax are reset to 1.8 m and 0.225 m respectively.

The default SI units will be used in this tutorial, hence there is no need to change any units in this
problem.

e. Close the Scale Mesh dialog box.

3. Check the mesh.

Setting Up Domain → Mesh → Check

Note

You should check the mesh after you manipulate it (scale, convert to polyhedra, merge,
separate, fuse, add zones, or smooth and swap). This will ensure that the quality of the
mesh has not been compromised.
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4. Examine the mesh with the default settings.

Figure 13.2: The Quadrilateral Mesh for the Combustor Model

Extra

You can use the right mouse button to probe for mesh information in the graphics win-
dow. If you click the right mouse button on any node in the mesh, information will be
displayed in the ANSYS Fluent console about the associated zone, including the name of
the zone. This feature is especially useful when you have several zones of the same type
and you want to distinguish between them quickly.

5. Select Axisymmetric in the 2D Space list.

Setup → General
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13.5.4. Models

1. Enable heat transfer by enabling the energy equation.

Setting Up Physics → Models → Energy

2. Select the standard -  turbulence model.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2 eqn) in the Model list.

The Viscous Model dialog box will expand to provide further options for the k-epsilon model.

b. Retain the default settings for the k-epsilon model.

c. Click OK to close the Viscous Model dialog box.

3. Enable chemical species transport and reaction.

Setting Up Physics → Models → Species...
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a. Select Species Transport in the Model list.

The Species Model dialog box will expand to provide further options for the Species Transport
model.

b. Enable Volumetric in the Reactions group box.

c. Select methane-air from the Mixture Material drop-down list.

Scroll down the list to find methane-air.

Note

The Mixture Material list contains the set of chemical mixtures that exist in the ANSYS
Fluent database. You can select one of the predefined mixtures to access a complete
description of the reacting system. The chemical species in the system and their
physical and thermodynamic properties are defined by your selection of the mixture
material. You can alter the mixture material selection or modify the mixture material
properties using the Create/Edit Materials dialog box (see Materials (p. 545)).

d. Select Eddy-Dissipation in the Turbulence-Chemistry Interaction group box.
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The eddy-dissipation model computes the rate of reaction under the assumption that chemical kinetics
are fast compared to the rate at which reactants are mixed by turbulent fluctuations (eddies).

e. Click OK to close the Species Model dialog box.

Prior to listing the properties that are required for the models you have enabled, ANSYS Fluent will display
a warning about the symmetry zone in the console. You may have to scroll up to see this warning.

Warning: It appears that symmetry zone 5 should actually be an axis
          (it has faces with zero area projections).
          Unless you change the zone type from symmetry to axis,
          you may not be able to continue the solution without
          encountering floating point errors.

In the axisymmetric model, the boundary conditions should be such that the centerline is an axis type
instead of a symmetry type. You will change the symmetry zone to an axis boundary in Boundary Condi-
tions (p. 548).

13.5.5. Materials

In this step, you will examine the default settings for the mixture material. This tutorial uses mixture properties
copied from the Fluent Database. In general, you can modify these or create your own mixture properties
for your specific problem as necessary.

1. Confirm the properties for the mixture materials.

Setup → Materials → Mixture → methane-air Edit...

The Create/Edit Materials dialog box will display the mixture material (methane-air) that was selected
in the Species Model dialog box. The properties for this mixture material have been copied from the
Fluent Database... and will be modified in the following steps.

a. Click the Edit... button to the right of the Mixture Species drop-down list to open the Species dialog
box.
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You can add or remove species from the mixture material as necessary using the Species dialog box.

i. Retain the default selections from the Selected Species selection list.

The species that make up the methane-air mixture are predefined and require no modification.

ii. Click OK to close the Species dialog box.

b. Click the Edit... button to the right of the Reaction drop-down list to open the Reactions dialog box.
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The eddy-dissipation reaction model ignores chemical kinetics (the Arrhenius rate) and uses only the
parameters in the Mixing Rate group box in the Reactions dialog box. The Arrhenius Rate group
box will therefore be inactive. The values for Rate Exponent and Arrhenius Rate parameters are
included in the database and are employed when the alternate finite-rate/eddy-dissipation model is
used.

i. Retain the default values in the Mixing Rate group box.

ii. Click OK to close the Reactions dialog box.

c. Retain the selection of incompressible-ideal-gas from the Density drop-down list.

d. Retain the selection of mixing-law from the Cp (Specific Heat) drop-down list.

e. Retain the default values for Thermal Conductivity, Viscosity, and Mass Diffusivity.
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f. Click Change/Create to accept the material property settings.

g. Close the Create/Edit Materials dialog box.

The calculation will be performed assuming that all properties except density and specific heat are con-
stant. The use of constant transport properties (viscosity, thermal conductivity, and mass diffusivity
coefficients) is acceptable because the flow is fully turbulent. The molecular transport properties will play
a minor role compared to turbulent transport.

13.5.6. Boundary Conditions

Setup → Boundary Conditions
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1. Convert the symmetry zone to the axis type.

Setup → Boundary Conditions → symmetry-5

The symmetry zone must be converted to an axis to prevent numerical difficulties where the radius reduces
to zero.

a. Select axis from the Type drop-down list.

2. Set the boundary conditions for the air inlet (velocity-inlet-8).

Setup → Boundary Conditions → velocity-inlet-8 Edit...

To determine the zone for the air inlet, display the mesh without the fluid zone to see the boundaries.
Use the right mouse button to probe the air inlet. ANSYS Fluent will report the zone name (velocity-inlet-
8) in the console.
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a. Enter air-inlet for Zone Name.

This name is more descriptive for the zone than velocity-inlet-8.

b. Enter 0.5  for Velocity Magnitude.

c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-
bulence group box.

d. Enter 10  for Turbulent Intensity.

e. Enter 0.44  for Hydraulic Diameter.

f. Click the Thermal tab and retain the default value of 300  for Temperature.

g. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.
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h. Click OK to close the Velocity Inlet dialog box.

3. Set the boundary conditions for the fuel inlet (velocity-inlet-6).

Setup → Boundary Conditions → velocity-inlet-6 Edit...

a. Enter fuel-inlet for Zone Name.
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This name is more descriptive for the zone than velocity-inlet-6.

b. Enter 80  for the Velocity Magnitude.

c. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-
bulence group box.

d. Enter 10  for Turbulent Intensity.

e. Enter 0.01  for Hydraulic Diameter.

f. Click the Thermal tab and retain the default value of 300  for Temperature.

g. Click the Species tab and enter 1 for ch4 in the Species Mass Fractions group box.

h. Click OK to close the Velocity Inlet dialog box.

4. Set the boundary conditions for the exit boundary (pressure-outlet-9).

Setup → Boundary Conditions → pressure-outlet-9 Edit...

a. Retain the default value of 0  for Gauge Pressure.

b. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list in the Tur-
bulence group box.

c. Enter 10  for Backflow Turbulent Intensity.

d. Enter 0.45  for Backflow Hydraulic Diameter.
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e. Click the Thermal tab and retain the default value of 300  for Backflow Total Temperature.

f. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.

g. Click OK to close the Pressure Outlet dialog box.

The Backflow values in the Pressure Outlet dialog box are utilized only when backflow occurs at the
pressure outlet. Always assign reasonable values because backflow may occur during intermediate itera-
tions and could affect the solution stability.

5. Set the boundary conditions for the outer wall (wall-7).

Setup → Boundary Conditions → wall-7 Edit...

Use the mouse-probe method described for the air inlet to determine the zone corresponding to the
outer wall.

a. Enter outer-wall for Zone Name.

This name is more descriptive for the zone than wall-7.

b. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions list.

ii. Retain the default value of 300  for Temperature.

c. Click OK to close the Wall dialog box.
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6. Set the boundary conditions for the fuel inlet nozzle (wall-2).

Setup → Boundary Conditions → wall-2 Edit...

a. Enter nozzle for Zone Name.

This name is more descriptive for the zone than wall-2.

b. Click the Thermal tab.

i. Retain the default selection of Heat Flux in the Thermal Conditions list.

ii. Retain the default value of 0  for Heat Flux, so that the wall is adiabatic.

c. Click OK to close the Wall dialog box.

13.5.7. Initial Reaction Solution

You will first calculate a solution for the basic reacting flow neglecting pollutant formation. In a later step,
you will perform an additional analysis to simulate NOx.

1. Select the Coupled Pseudo Transient solution method.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default selections in the Spatial Discretization group box.

c. Enable Pseudo Transient.

The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based
solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve
stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Modify the solution controls.

Solving → Controls → Controls...
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a. Enter 0.25 under Density in the Pseudo Transient Explicit Relaxation Factors group box.

The default explicit relaxation parameters in ANSYS Fluent are appropriate for a wide range of general
fluid flow problems. However, in some cases it may be necessary to reduce the relaxation factors to
stabilize the solution. Some experimentation is typically necessary to establish the optimal values.
For this tutorial, it is sufficient to reduce the density explicit relaxation factor to 0.25 for stability.

b. Click Advanced... to open the Advanced Solution Controls dialog box and select the Expert tab.

The Expert tab in the Advanced Solution Controls dialog box allows you to individually specify the
solution method and Pseudo Transient Time Scale Factors for each equation, except for the flow
equations. When using the Pseudo Transient method for general reacting flow cases, increasing the
species and energy time scales is recommended.
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i. Enable the pseudo-transient method for ch4, o2, co2, h2o, and Energy in the Expert tab, by selecting
each one under On/Off.

ii. Enter 10 for the Time Scale Factor for ch4, o2, co2, h2o, and Energy.

iii. Click OK to close the Advanced Solution Controls dialog box.

3. Ensure the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

4. Initialize the field variables.

Solving → Initialization

a. Retain the default Hybrid initialization method and click Initialize to initialize the variables.

5. Save the case file (gascomb1.cas.gz).

File → Write → Case...

a. Enter gascomb1.cas.gz for Case File.

b. Ensure that Write Binary Files is enabled to produce a smaller, unformatted binary file.

c. Click OK to close the Select File dialog box.

6. Run the calculation by requesting 200 iterations.

Solving → Run Calculation → Advanced...
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a. Select Aggressive from the Length Scale Method drop-down list.

When using the Automatic Time Step Method ANSYS Fluent computes the Pseudo Transient time step
based on characteristic length and velocity scales of the problem. The Conservative Length Scale
Method uses the smaller of two computed length scales emphasizing solution stability. The Aggressive
Length Scale Method uses the larger of the two which may provide faster convergence in some cases.

b. Enter 5 for the Timescale Factor.

The Timescale Factor allows you to further manipulate the computed Time Step calculated by ANSYS
Fluent. Larger time steps can lead to faster convergence. However, if the time step is too large it can
lead to solution instability.

c. Enter 200 for Number of Iterations.

d. Click Calculate.

The solution will converge after approximately 160 iterations.

7. Save the case and data files (gascomb1.cas.gz and gascomb1.dat.gz).
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File → Write → Case & Data...

Note

If you choose a file name that already exists in the current folder, ANSYS Fluent will ask
you to confirm that the previous file is to be overwritten.

13.5.8. Postprocessing

Review the solution by examining graphical displays of the results and performing surface integrations at
the combustor exit.

1. Report the total sensible heat flux.

Postprocessing → Reports → Fluxes...

a. Select Total Sensible Heat Transfer Rate in the Options list.

b. Select all the boundaries from the Boundaries selection list (you can click the select-all button ( ).

c. Click Compute and close the Flux Reports dialog box.

Note

The energy balance is good because the net result is small compared to the heat of
reaction.
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2. Display filled contours of temperature (Figure 13.3: Contours of Temperature (p. 561)).

Postprocessing → Graphics → Contours → Edit...

a. Ensure that Filled is enabled in the Options group box.

b. Select Temperature... and Static Temperature in the Contours of drop-down lists.

c. Click Display.

Figure 13.3:  Contours of Temperature

The peak temperature is approximately 2310  .

3. Display velocity vectors (Figure 13.4: Velocity Vectors (p. 563)).

Postprocessing → Graphics → Vectors → Edit...
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a. Enter 0.01 for Scale.

b. Click the Vector Options... button to open the Vector Options dialog box.

i. Enable Fixed Length.

The fixed length option is useful when the vector magnitude varies dramatically. With fixed length
vectors, the velocity magnitude is described only by color instead of by both vector length and
color.

ii. Click Apply and close the Vector Options dialog box.

c. Click Display and close the Vectors dialog box.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.562

Modeling Species Transport and Gaseous Combustion



Figure 13.4: Velocity Vectors

4. Display filled contours of stream function (Figure 13.5: Contours of Stream Function (p. 564)).

Postprocessing → Graphics → Contours → Edit...

a. Select Velocity... and Stream Function from the Contours of drop-down lists.

b. Click Display.
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Figure 13.5:  Contours of Stream Function

The entrainment of air into the high-velocity methane jet is clearly visible in the streamline display.

5. Display filled contours of mass fraction for  (Figure 13.6: Contours of CH4 Mass Fraction (p. 565)).

Postprocessing → Graphics → Contours → Edit...

a. Select Species... and Mass fraction of ch4 from the Contours of drop-down lists.

b. Click Display.
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Figure 13.6:  Contours of CH4 Mass Fraction

6. In a similar manner, display the contours of mass fraction for the remaining species , , and  (Fig-
ure 13.7: Contours of O2 Mass Fraction (p. 566), Figure 13.8: Contours of CO2 Mass Fraction (p. 566), and
Figure 13.9: Contours of H2O Mass Fraction (p. 567)) Close the Contours dialog box when all of the species
have been displayed.
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Figure 13.7:  Contours of O2 Mass Fraction

Figure 13.8:  Contours of CO2 Mass Fraction
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Figure 13.9:  Contours of H2O Mass Fraction

7. Determine the average exit temperature.

Postprocessing → Reports → Surface Integrals...
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a. Select Mass-Weighted Average from the Report Type drop-down list.

b. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

The mass-averaged temperature will be computed as:

(13.2)

c. Select pressure-outlet-9 from the Surfaces selection list, so that the integration is performed over this
surface.

d. Click Compute.

The Mass-Weighted Average field will show that the exit temperature is approximately 1840  .

8. Determine the average exit velocity.

Postprocessing → Reports → Surface Integrals...
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a. Select Area-Weighted Average from the Report Type drop-down list.

b. Select Velocity... and Velocity Magnitude from the Field Variable drop-down lists.

The area-weighted velocity-magnitude average will be computed as:

(13.3)

c. Click Compute.

The Area-Weighted Average field will show that the exit velocity is approximately 3.30  .

d. Close the Surface Integrals dialog box.

13.5.9. NOx Prediction

In this section you will extend the ANSYS Fluent model to include the prediction of NOx. You will first calculate
the formation of both thermal and prompt NOx, then calculate each separately to determine the contribution
of each mechanism.

1. Enable the NOx model.

Setup → Models → Species → NOx Edit...
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a. Enable Thermal NOx and Prompt NOx in the Pathways group box.

b. Select ch4 from the Fuel Species selection list.

c. Click the Turbulence Interaction Mode tab.
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i. Select temperature from the PDF Mode drop-down list.

This will enable the turbulence-chemistry interaction. If turbulence interaction is not enabled, you
will be computing NOx formation without considering the important influence of turbulent fluc-
tuations on the time-averaged reaction rates.

ii. Retain the default selection of beta from the PDF Type drop-down list and enter 20 for PDF Points.

The value for PDF Points is increased from 10 to 20 to obtain a more accurate NOx prediction.

iii. Select transported from the Temperature Variance drop-down list.

d. Select partial-equilibrium from the [O] Model drop-down list in the Formation Model Parameters
group box in the Thermal tab.

The partial-equilibrium model is used to predict the O radical concentration required for thermal
NOx prediction.

e. Click the Prompt tab.

571
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



i. Retain the default value of 1 for Fuel Carbon Number.

ii. Enter 0.76 for Equivalence Ratio.

All of the parameters in the Prompt tab are used in the calculation of prompt NOx formation.
The Fuel Carbon Number is the number of carbon atoms per molecule of fuel. The Equivalence
Ratio defines the fuel-air ratio (relative to stoichiometric conditions).

f. Click Apply to accept these changes and close the NOx Model dialog box.

2. Enable the calculation of NO species only and temperature variance.

Solving → Controls → Equations...
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a. Deselect all variables except Pollutant no and Temperature Variance from the Equations selection
list.

b. Click OK to close the Equations dialog box.

You will predict NOx formation in a “postprocessing” mode, with the flow field, temperature, and
hydrocarbon combustion species concentrations fixed. Hence, only the NO equation will be computed.
Prediction of NO in this mode is justified on the grounds that the NO concentrations are very low
and have negligible impact on the hydrocarbon combustion prediction.

3. Modify the solution controls for Pollutant no and Temperature Variance.

Solving → Controls → Controls...
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a. Click Advanced... to open the Advanced Solution Controls dialog box.

i. In the Expert tab, enable the pseudo-transient method for Pollutant no and Temperature
Variance, by selecting them under On/Off.

ii. Enter 10 for Time Scale Factor for Pollutant no and Temperature Variance.

iii. Click OK to close the Advanced Solution Controls dialog box.

b. Enter 1 for Pollutant no and Temperature Variance in the Pseudo Transient Explicit Relaxation
Factors group box.

4. Confirm the convergence criterion for the NO species equation.

Solving → Reports → Residuals...

a. Ensure that the Absolute Criteria for pollut_no is set to 1e-06.

b. Click OK to close the Residual Monitors dialog box.

5. Request 25 more iterations.

Solution → Run Calculation

The solution will converge in approximately 10 iterations.

6. Save the new case and data files (gascomb2.cas.gz and gascomb2.dat.gz).

File → Write → Case & Data...

7. Review the solution by creating and displaying a contour definition for NO mass fraction (Figure 13.10: Con-
tours of NO Mass Fraction — Prompt and Thermal NOx Formation (p. 575)).

Postprocessing → Graphics → Contours → New...
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a. Enter contour-no-mass-fraction for Contour Name.

b. Disable Filled in the Options group box.

c. Select NOx... and Mass fraction of Pollutant no from the Contours of drop-down lists.

d. Click Save/Display and close the Contours dialog box.

Figure 13.10:  Contours of NO Mass Fraction — Prompt and Thermal NOx Formation

8. Calculate the average exit NO mass fraction.

Postprocessing → Reports → Surface Integrals...
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a. Select Mass-Weighted Average from the Report Type drop-down list.

b. Select NOx... and Mass fraction of Pollutant no from the Field Variable drop-down lists.

c. Ensure that pressure-outlet-9 is selected from the Surfaces selection list.

d. Click Compute.

The Mass-Weighted Average field will show that the exit NO mass fraction is approximately 0.00421.

e. Close the Surface Integrals dialog box.

9. Disable the prompt NOx mechanism in preparation for solving for thermal NOx only.

Setup → Models → Species → NOx Edit...

a. In the Formation tab, disable Prompt NOx.

b. Click Apply and close the NOx Model dialog box.

10. Request 25 iterations.

Solution → Run Calculation

The solution will converge in approximately 6 iterations.
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11. Review the thermal NOx solution by displaying the contour-no-mass-fraction contour definition for NO
mass fraction (under the Results/Graphics/Contours tree branch) you created earlier (Figure 13.11: Contours
of NO Mass Fraction—Thermal NOx Formation (p. 577)).

Results → Graphics → Contours → contour-no-mass-fraction Display

Figure 13.11:  Contours of NO Mass Fraction—Thermal NOx Formation

Note that the concentration of NO is slightly lower without the prompt NOx mechanism.

12. Compute the average exit NO mass fraction with only thermal NOx formation.

Postprocessing → Reports → Surface Integrals...

Tip

Follow the same procedure you used earlier for the calculation with both thermal
and prompt NOx formation.

The Mass-Weighted Average field will show that the exit NO mass fraction with only thermal
NOx formation (without prompt NOx formation) is approximately 0.004174.

13. Solve for prompt NOx production only.

Setup → Models → Species → NOx Edit...

a. Disable Thermal NOx in the Pathways group box.
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b. Enable Prompt NOx.

c. Click Apply and close the NOx Model dialog box.

14. Request 25 iterations.

Solution → Run Calculation

The solution will converge in approximately 13 iterations.

15. Review the prompt NOx solution by displaying the contour-no-mass-fraction contour definition for NO
mass fraction (under the Results/Graphics/Contours tree branch) (Figure 13.12: Contours of NO Mass
Fraction—Prompt NOx Formation (p. 578)).

Results → Graphics → Contours → contour-no-mass-fraction Display

Figure 13.12:  Contours of NO Mass Fraction—Prompt NOx Formation

The prompt NOx mechanism is most significant in fuel-rich flames. In this case the flame is lean and
prompt NO production is low.

16. Compute the average exit NO mass fraction only with prompt NOx formation.
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Postprocessing → Reports → Surface Integrals...

Tip

Follow the same procedure you used earlier for the calculation with both thermal
and prompt NOx formation.

The Mass-Weighted Average field will show that the exit NO mass fraction with only prompt
NOx formation is approximately 9.975e-05.

Note

The individual thermal and prompt NO mass fractions do not add up to the levels predicted
with the two models combined. This is because reversible reactions are involved. NO
produced in one reaction can be destroyed in another reaction.

17. Use a custom field function to compute NO parts per million (ppm).

The NOppm will be computed from the following equation:

(13.4)

Note

This is the dry ppm. Therefore, the value is normalized by removing the water mole
fraction in the denominator.

User Defined → Field Functions → Custom...

a. Select NOx... and Mole fraction of Pollutant no from the Field Functions drop-down lists, and click
the Select button to enter molef-pollut-pollutant-0 in the Definition field.

b. Click the appropriate calculator buttons to enter
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*10ˆ6/(1-

in the Definition field, as shown in the previous dialog box.

Tip

If you make a mistake, click the DEL button on the calculator pad to delete the
last item you added to the function definition.

For more explicit instructions on using the Custom Field Function calculator buttons, see Intro-
duction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).

c. Select Species... and Mole fraction of h2o from the Field Functions drop-down lists, and click the
Select button to enter molef-h2o in the Definition field.

d. Click the ) button to complete the field function.

e. Enter no-ppm for New Function Name.

f. Click Define to add the new field function to the variable list and close the Custom Field Function
Calculator dialog box.

18. Display contours of NO ppm (Figure 13.13: Contours of NO ppm — Prompt NOx Formation (p. 581)).

Postprocessing → Graphics → Contours → Edit...

a. Select Custom Field Functions... and no-ppm from the Contours of drop-down lists.

Scroll up the list to find Custom Field Functions....

b. Click Display and close the Contours dialog box.
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Figure 13.13:  Contours of NO ppm — Prompt NOx Formation

The contours closely resemble the mass fraction contours (Figure 13.12: Contours of NO Mass Frac-
tion—Prompt NOx Formation (p. 578)), as expected.

13.6. Summary

In this tutorial you used ANSYS Fluent to model the transport, mixing, and reaction of chemical species.
The reaction system was defined by using a mixture-material entry in the ANSYS Fluent database. The
procedures used here for simulation of hydrocarbon combustion can be applied to other reacting flow
systems.

The NOx production in this case was dominated by the thermal NO mechanism. This mechanism is very
sensitive to temperature. Every effort should be made to ensure that the temperature solution is not
overpredicted, since this will lead to unrealistically high predicted levels of NO.

13.7. Further Improvements

Further improvements can be expected by including the effects of intermediate species and radiation,
both of which will result in lower predicted combustion temperatures.

The single-step reaction process used in this tutorial cannot account for the moderating effects of inter-
mediate reaction products, such as CO and . Multiple-step reactions can be used to address these
species. If a multi-step Magnussen model is used, considerably more computational effort is required
to solve for the additional species. Where applicable, the nonpremixed combustion model can be used
to account for intermediate species at a reduced computational cost.

For more details on the nonpremixed combustion model, see the Fluent User's Guide.
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Radiation heat transfer tends to make the temperature distribution more uniform, thereby lowering the
peak temperature. In addition, radiation heat transfer to the wall can be very significant (especially here,
with the wall temperature set at 300  ). The large influence of radiation can be anticipated by computing
the Boltzmann number for the flow:

where  is the Boltzmann constant (5.729 ) and  is the adiabatic flame temperature.

For a quick estimate, assume , , and  (the majority of the
inflow is air). Assume . The resulting Boltzmann number is Bo = 1.09, which shows that
radiation is of approximately equal importance to convection for this problem.

For details on radiation modeling, see the Fluent User's Guide.

This tutorial guides you through the steps to reach an initial set of solutions. You may be able to obtain
a more accurate solution by using an appropriate higher-order discretization scheme and by adapting
the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps
are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 121).
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Chapter 14: Using the Non-Premixed Combustion Model

This tutorial is divided into the following sections:
14.1. Introduction
14.2. Prerequisites
14.3. Problem Description
14.4. Setup and Solution
14.5. Summary
14.6. References
14.7. Further Improvements

14.1. Introduction

The goal of this tutorial is to accurately model the combustion processes in a 300 KW BERL combustor.
The reaction can be modeled using either the species transport model or the non-premixed combustion
model. In this tutorial you will set up and solve a natural gas combustion problem using the non-premixed
combustion model for the reaction chemistry.

This tutorial demonstrates how to do the following:

• Define inputs for modeling non-premixed combustion chemistry.

• Prepare the PDF table in ANSYS Fluent.

• Solve a natural gas combustion simulation problem.

• Use the Discrete Ordinates (DO) radiation model for combustion applications.

• Use the -  turbulence model.

The non-premixed combustion model uses a modeling approach that solves transport equations for
one or two conserved scalars (mixture fractions). Multiple chemical species, including radicals and inter-
mediate species, may be included in the problem definition. Their concentrations will be derived from
the predicted mixture fraction distribution.

Property data for the species are accessed through a chemical database, and turbulence-chemistry in-
teraction is modeled using a -function for the PDF. For details on the non-premixed combustion
modeling approach, the Fluent User's Guide.

14.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
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• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

14.3. Problem Description

The flow considered is an unstaged natural gas flame in a 300 kW swirl-stabilized burner. The furnace
is vertically-fired and of octagonal cross-section with a conical furnace hood and a cylindrical exhaust
duct. The furnace walls are capable of being refractory-lined or water-cooled. The burner features 24
radial fuel ports and a bluff centerbody. Air is introduced through an annular inlet and movable swirl
blocks are used to impart swirl. The combustor dimensions are described in Figure 14.1: Problem De-
scription (p. 584), and Figure 14.2: Close-Up of the Burner (p. 585) shows a close-up of the burner assuming
2D axisymmetry. The boundary condition profiles, velocity inlet boundary conditions of the gas, and
temperature boundary conditions are based on experimental data [1].

Figure 14.1:  Problem Description
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Figure 14.2:  Close-Up of the Burner

14.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
14.4.1. Preparation
14.4.2. Reading and Checking the Mesh
14.4.3. Specifying Solver and Analysis Type
14.4.4. Specifying the Models
14.4.5. Defining Materials and Properties
14.4.6. Specifying Boundary Conditions
14.4.7. Specifying Operating Conditions
14.4.8. Obtaining Solution
14.4.9. Postprocessing
14.4.10. Energy Balances Reporting

14.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
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2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the non_premix_combustion_R180.zip link to download the input files.

7. Unzip non_premix_combustion_R180.zip to your working folder.

The files, berl.msh and berl.prof, can be found in the non_premix_combustion folder,
which will be created after unzipping the file.

The mesh file, berl.msh, is a quadrilateral mesh describing the system geometry shown in Fig-
ure 14.1: Problem Description (p. 584) and Figure 14.2: Close-Up of the Burner (p. 585).

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Enable Double-Precision.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

11. Ensure that the Serial processing option is selected.

14.4.2. Reading and Checking the Mesh

1. Read the mesh file berl.msh.

File → Read → Mesh...

The ANSYS Fluent console will report that the mesh contains 9784 quadrilateral cells. A warning will be
generated informing you to consider making changes to the zone type, or to change the problem defin-
ition to axisymmetric. You will change the problem to axisymmetric swirl in Specifying Solver and Ana-
lysis Type (p. 590).

2. Check the mesh.
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Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure
that the reported minimum volume is a positive number.

3. Scale the mesh.

Setting Up Domain → Mesh → Scale...

a. Select mm from the View Length Unit In drop-down list.

All dimensions will now be shown in millimeters.

b. Select mm from the Mesh Was Created In drop-down list in the Scaling group box.

c. Click Scale and verify that the domain extents are as shown in the Scale Mesh dialog box.

d. Close the Scale Mesh dialog box.

4. Check the mesh.

Setting Up Domain → Mesh → Check

Note

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to
polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that
the quality of the mesh has not been compromised.

5. Examine the mesh (Figure 14.3: 2D BERL Combustor Mesh Display (p. 588)).
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Figure 14.3:  2D BERL Combustor Mesh Display

Due to the mesh resolution and the size of the domain, you may find it more useful to display just the
outline, or to zoom in on various portions of the mesh display.

Extra

You can use the mouse zoom button (middle button, by default) to zoom in to the display
and the mouse probe button (right button, by default) to find out the boundary zone
labels. The zone labels will be displayed in the console.

6. Mirror the display about the symmetry plane.

Results → Graphics Views...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.588

Using the Non-Premixed Combustion Model



a. Select axis-2 from the Mirror Planes selection list.

b. Click Apply and close the Views dialog box.

The full geometry is displayed, as shown in Figure 14.4: 2D BERL Combustor Mesh Display Including the
Symmetry Plane (p. 589)

Figure 14.4:  2D BERL Combustor Mesh Display Including the Symmetry Plane
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14.4.3. Specifying Solver and Analysis Type

1. Retain the default settings of pressure-based steady-state solver in the Solver group box.

Setup → General

The non-premixed combustion model is available only with the pressure-based solver.

2. Change the spatial definition to axisymmetric swirl by selecting Axisymmetric Swirl in the 2D Space list.

14.4.4. Specifying the Models

1. Enable the Energy Equation.

Setting Up Physics → Models → Energy

Since heat transfer occurs in the system considered here, you will have to solve the energy equation.

2. Select the standard k-epsilon turbulence model.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2eqn) in the Model list.

For axisymmetric swirling flow, the RNG k-epsilon model can also be used, but for this case you will
retain the default Standard, k-epsilon model.

b. Retain the default Standard Wall Functions in the Near-Wall Treatment group box.

c. Click OK to accept all other default settings and close the Viscous Model dialog box.

3. Select the Discrete Ordinates (DO) radiation model.

The DO radiation model provides a high degree of accuracy, but it can be CPU intensive. In cases where
the computational expense of the DO model is deemed too great, the P1 model may provide an acceptable
solution more quickly.

For details on the different radiation models available in ANSYS Fluent, see the Fluent User's Guide.

Setting Up Physics → Models → Radiation...
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a. Select Discrete Ordinates (DO) in the Model list.

The dialog box will expand to show related inputs.

b. Enter 1 for Energy Iterations per Radiation Iteration.

c. Click OK to accept all other default settings and close the Radiation Model dialog box.

The ANSYS Fluent console lists the properties that are required for the model you have enabled. An
Information dialog box opens, reminding you to confirm the property values.

d. Click OK to close the Information dialog box.

4. Select the Non-Premixed Combustion model.

Setting Up Physics → Models → Species...
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a. Select Non-Premixed Combustion in the Model list.

The dialog box will expand to show the related inputs. You will use this dialog box to create the PDF
table.

When you use the non-premixed combustion model, you need to create a PDF table. This table contains
information on the thermo-chemistry and its interaction with turbulence. ANSYS Fluent interpolates
the PDF during the solution of the non-premixed combustion model.

b. Enable Inlet Diffusion in the PDF Options group box.

The Inlet Diffusion option enables the mixture fraction to diffuse out of the domain through inlets
and outlets.

c. Define chemistry models.

i. Retain the default selection of the Chemical Equilibrium state relation and the Non-Adiabatic
energy treatment.

In most non-premixed combustion simulations, the Chemical Equilibrium model is recommended.
The Steady Diffusion Flamelet option can model local chemical non-equilibrium due to turbulent
strain.

ii. Retain the default value for Operating Pressure.

iii. Enter 0.064 for Fuel Stream Rich Flammability Limit.

The Fuel Stream Rich Flammability Limit enables you to perform a “partial equilibrium” calcu-
lation, suspending equilibrium calculations when the mixture fraction exceeds the specified rich
limit. This increases the efficiency of the PDF calculation, allowing you to bypass the complex
equilibrium calculations in the fuel-rich region. This is also more physically realistic than the as-
sumption of full equilibrium.
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For combustion cases, a value 10% – 50% larger than the stoichiometric mixture fraction can be
used for the rich flammability limit of the fuel stream. In this case, the stoichiometric fraction is
0.058, therefore a value that is 10% greater is 0.064.

d. Click the Boundary tab to add and define the boundary species.

i. Enter c2h6 in the Boundary Species text-entry field and click Add.

The c2h6 species appears at the bottom of the table.

ii. Similarly, add c3h8,c4h10, and co2.

All the added species will appear in the table.

iii. Select Mole Fraction in the Specify Species in list.

iv. Retain the default values for n2 and o2 for Oxid.

The oxidizer (air) consists of 21%  and 79%  by volume.

v. Specify the fuel composition by entering the following values for Fuel:

The fuel composition is entered in mole fractions of the species, c2h6, c3h8, c4h10, and co2.

Mole FractionSpecies

0.965ch4

0.013n2
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Mole FractionSpecies

0.017c2h6

0.001c3h8

0.001c4h10

0.003co2

Tip

Scroll down to see all the species.

Note

All boundary species with a mass or mole fraction of zero will be ignored.

vi. Enter 315 K for Fuel and Oxid in the Temperature group box.

e. Click the Control tab and retain default species to be excluded from the equilibrium calculation.

f. Click the Table tab to specify the table parameters and calculate the PDF table.

i. Ensure that Automated Grid Refinement is enabled.

ii. Retain the default values for all the parameters in the Table Parameters group box.

The maximum number of species determines the number of most preponderant species to consider
after the equilibrium calculation is performed.

iii. Click Calculate PDF Table to compute the non-adiabatic PDF table.

iv. Click the Display PDF Table... button.
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A. In the PDF Table dialog box, retain the default parameters and click Display (Figure 14.5: Non-
Adiabatic Temperature Look-Up Table on the Adiabatic Enthalpy Slice (p. 596)).

B. Close the PDF Table dialog box.

Figure 14.5:  Non-Adiabatic Temperature Look-Up Table on the Adiabatic Enthalpy
Slice

The 3D look-up tables are reviewed on a slice-by-slice basis. By default, the slice selected corresponds
to the adiabatic enthalpy values. You can also select other slices of constant enthalpy for display.
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The maximum and minimum values for mean temperature and the corresponding mean mixture
fraction is also reported in the console. The maximum mean temperature is reported as 2246 K at a
mean mixture fraction of 0.058.

g. Save the PDF output file (berl.pdf).

File → Write → PDF...

i. Retain berl.pdf for PDF File name.

ii. Click OK to write the file.

By default, the file will be saved as formatted (ASCII, or text). To save a binary (unformatted) file,
enable the Write Binary Files option in the Select File dialog box.

h. Click OK to close the Species Model dialog box.

14.4.5. Defining Materials and Properties

1. Specify the continuous phase (pdf-mixture) material.

Setup  → Materials → pdf-mixture → Create/Edit...

All thermodynamic data for the continuous phase, including density, specific heat, and formation enthal-
pies are extracted from the chemical database when the non-premixed combustion model is used. These
properties are transferred to the pdf-mixture material, for which only transport properties, such as vis-
cosity and thermal conductivity, need to be defined. The Density and Cp (Specific Heat) laws cannot
be altered: these properties are stored in the non-premixed combustion look-up tables.

Under Properties, you can click the View... button next to Mixture Species to view the species included
in the pdf-mixture material. These are the species included during the system chemistry setup.
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a. Under Properties, from the Absorption Coefficient drop-down list, select wsggm-domain-based.

Tip

Scroll down to view the Absorption Coefficient option.

This specifies a composition-dependent absorption coefficient, using the weighted-sum-of-gray-gases
model. WSGGM-domain-based is a variable coefficient that uses a length scale, based on the geometry
of the model.

For more details, see radiation in combusting flows in the Fluent Theory Guide.

b. Click Change/Create and close the Create/Edit Materials dialog box.

ANSYS Fluent uses the gas law to compute the mixture density and a mass-weighted mixing law to
compute the mixture . When the non-premixed combustion model is used, do not alter the properties
of the individual species. This will create an inconsistency with the PDF look-up table.

14.4.6. Specifying Boundary Conditions

1. Read the boundary conditions profile file.

File → Read → Profile...

a. Select berl.prof from the Select File dialog box.

b. Click OK.

The CFD solution for reacting flows can be sensitive to the boundary conditions, in particular the incoming
velocity field and the heat transfer through the walls. Here, you will use profiles to specify the velocity at
air-inlet-4, and the wall temperature for wall-9. The latter approach of fixing the wall temperature to
measurements is common in furnace simulations, to avoid modeling the wall convective and radiative
heat transfer. The data used for the boundary conditions was obtained from experimental data [1].

2. Set the boundary conditions for the pressure outlet (poutlet-3).

Setup → Boundary Conditions → poutlet-3 → Edit...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.598

Using the Non-Premixed Combustion Model



a. In the Turbulence group, from the Specification Method drop-down list, select Intensity and Hydraulic
Diameter.

b. Retain 5% for Backflow Turbulent Intensity.

c. Enter 600 mm for Backflow Hydraulic Diameter.

d. Click the Thermal tab and enter 1300 K for Backflow Total Temperature.

e. Click OK to close the Pressure Outlet dialog box.

The exit gauge pressure of zero defines the system pressure at the exit to be the operating pressure. The
backflow conditions for scalars (temperature, mixture fraction, turbulence parameters) will be used only
if flow is entrained into the domain through the exit. It is a good idea to use reasonable values in case
flow reversal occurs at the exit at some point during the solution process.

3. Set the boundary conditions for the velocity inlet (air-inlet-4).

Setup → Boundary Conditions → air-inlet-4 → Edit...
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a. From the Velocity Specification Method drop-down list, select Components.

b. From the Axial-Velocity drop-down list, select vel-prof u.

c. From the Swirl-Velocity drop-down list, select vel-prof w.

d. In the Turbulence group, from the Specification Method drop-down list, select Intensity and Hydraulic
Diameter.

e. Enter 17% for Turbulent Intensity.

f. Enter 29 mm for Hydraulic Diameter.

Turbulence parameters are defined based on intensity and length scale. The relatively large turbulence
intensity of 17% may be typical for combustion air flows.

g. Click the Thermal tab and enter 312 K for Temperature.

h. Click the Species tab. For the non-premixed combustion calculation, you have to define the inlet Mean
Mixture Fraction and Mixture Fraction Variance. In this case, the gas phase air inlet has a zero mixture
fraction. Therefore, you can retain the zero default settings.

i. Click OK to close the Velocity Inlet dialog box.

4. Set the boundary conditions for the velocity inlet (fuel-inlet-5).

Setup → Boundary Conditions → fuel-inlet-5 → Edit...
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a. From the Velocity Specification Method drop-down list, select Components.

b. Enter 157.25 m/s for Radial-Velocity.

c. In the Turbulence group, from the Specification Method drop-down list, select Intensity and Hydraulic
Diameter.

d. Retain 5% for Turbulent Intensity.

e. Enter 1.8 mm for Hydraulic Diameter.

The hydraulic diameter has been set to twice the height of the 2D inlet stream.

f. Click the Thermal tab and enter 308 K for Temperature.

g. Click the Species tab and enter 1 for Mean Mixture Fraction for the fuel inlet.

h. Click OK to close the Velocity Inlet dialog box.

5. Set the boundary conditions for wall-6.

Setup → Boundary Conditions → wall-6 → Edit...
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a. Click the Thermal tab.

i. In the Thermal Conditions list, select Temperature.

ii. Enter 1370 K for Temperature.

iii. Enter 0.5 for Internal Emissivity.

b. Click OK to close the Wall dialog box.

6. Similarly, set the boundary conditions for wall-7 through wall-13 using the following values:

Internal EmissivityTemperatureZone Name

0.5312wall-7

0.51305wall-8

0.5temp-prof t (from the drop-down list)wall-9

0.51100wall-10

0.51273wall-11

0.51173wall-12

0.51173wall-13

7. Plot the profile of temperature for the wall furnace (wall-9).

Postprocessing → Plots → Profile Data...
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a. From the Profile selection list, select temp-prof.

b. Retain the selection of  t and x from the Y Axis Function and X Axis Function selection lists, respectively.

c. Click Plot (Figure 14.6: Profile Plot of Temperature for wall-9 (p. 603)).

Figure 14.6:  Profile Plot of Temperature for wall-9

8. Plot the profiles of velocity for the swirling air inlet (air-inlet-4).

a. Plot the profile of axial-velocity for the swirling air inlet.
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Postprocessing → Plots → Profile Data...

i. From the Profile selection list, select vel-prof.

ii. From the Y Axis Function selection list, retain the selection of u.

iii. From the X Axis Function selection list, select y.

iv. Click Plot (Figure 14.7: Profile Plot of Axial-Velocity for the Swirling Air Inlet (air-inlet-4) (p. 604)).

Figure 14.7:  Profile Plot of Axial-Velocity for the Swirling Air Inlet (air-inlet-4)
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b. Plot the profile of swirl-velocity for swirling air inlet.

Postprocessing → Plots → Profile Data...

i. From the Profile selection list, retain the selection of vel-prof.

ii. From the Y Axis Function selection list, select w.

iii. From the X Axis Function selection list, retain the selection of y.

iv. Click Plot (Figure 14.8: Profile Plot of Swirl-Velocity for the Swirling Air Inlet (air-inlet-4) (p. 606)) and
close the Plot Profile Data dialog box.
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Figure 14.8:  Profile Plot of Swirl-Velocity for the Swirling Air Inlet (air-inlet-4)

14.4.7. Specifying Operating Conditions

1. Retain the default operating conditions.

Setup → Boundary Conditions → Operating Conditions...

The Operating Pressure was already set in the PDF table generation in Specifying the Models (p. 590).
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14.4.8. Obtaining Solution

1. Set the solution parameters.

Solving → Solution → Methods...

a. In the Pressure-Velocity Coupling group, from the Scheme drop-down list, select Coupled.

b. In the Spatial Discretization group, from the Pressure drop-down list, select PRESTO!.

c. Retain the other default selections and settings.

2. Set the solution controls.

Solving → Controls → Controls...
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a. Enter 70 for Flow Courant Number.

b. Set the following parameters in the Under-Relaxation Factors group box:

ValueUnder-Relaxation Factor

0.2Density

0.8Body Forces

The default under-relaxation factors are considered to be too aggressive for reacting flow cases with
high swirl velocity.

3. Enable the display of residuals during the solution process.

Solving → Reports → Residuals...
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a. Ensure that the Plot is enabled in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

4. Initialize the flow field.

Solving → Initialization

a. Retain the Method at the default of Hybrid in the Initialization group.

b. Click Initialize.

5. Save the case file (berl-1.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 1500 iterations.

Solving → Run Calculation →
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The solution will converge in approximately 1060 iterations.

7. Save the converged solution (berl-1.dat.gz).

File → Write → Data...

14.4.9. Postprocessing

1. Display the predicted temperature field (Figure 14.9: Temperature Contours (p. 611)).

Postprocessing → Graphics → Contours → Edit...

a. Enable Filled in the Options group box.

b. Select Temperature... and Static Temperature from the Contours of drop-down lists.

c. Click Display.

The peak temperature in the system is 1981 K.
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Figure 14.9: Temperature Contours

2. Display contours of velocity (Figure 14.10: Velocity Contours (p. 612)).

Postprocessing → Graphics → Contours → Edit...

a. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

b. Click Display.

611
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 14.10: Velocity Contours

3. Display the contours of mass fraction of O2 (Figure 14.11: Contours of Mass Fraction of o2 (p. 613)).

Postprocessing → Graphics → Contours → Edit...

a. Select Species... and Mass fraction of o2 from the Contours of drop-down lists.

b. Click Display and close the Contours dialog box.
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Figure 14.11:  Contours of Mass Fraction of o2

14.4.10. Energy Balances Reporting

ANSYS Fluent can report the overall energy balance and details of the heat and mass transfer.

1. Compute the gas phase mass fluxes through the domain boundaries.

Postprocessing → Reports → Fluxes...
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a. Retain the default selection of Mass Flow Rate in the Options group box.

b. Select air-inlet-4, fuel-inlet-5, and poutlet-3 from the Boundaries selection list.

c. Click Compute.

The net mass imbalance should be a small fraction of the total flux through the system. If a significant
imbalance occurs, you should decrease your residual tolerances by at least an order of magnitude and
continue iterating.

2. Compute the fluxes of heat through the domain boundaries.

Postprocessing → Reports → Fluxes...

a. Select Total Heat Transfer Rate in the Options group box.

b. Select all the zones from the Boundaries selection list.

c. Click Compute, examine the resulting values, and close the Flux Reports dialog box.

The value will be displayed in the console. Positive flux reports indicate heat addition to the domain.
Negative values indicate heat leaving the domain. Again, the net heat imbalance should be a small
fraction (for example, 0.5% or less) of the total energy flux through the system. The reported value
may change for different runs.

3. Compute the mass weighted average of the temperature at the pressure outlet.

Postprocessing → Reports → Surface Integrals...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.614

Using the Non-Premixed Combustion Model



a. Select Mass-Weighted Average from the Report Type drop-down list.

b. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

c. Select poutlet-3 from the Surfaces selection list.

d. Click Compute.

A value of approximately 1464 K will be displayed in the console.

e. Close the Surface Integrals dialog box.

14.5. Summary

In this tutorial you learned how to use the non-premixed combustion model to represent the gas phase
combustion chemistry. In this approach the fuel composition was defined and assumed to react according
to the equilibrium system data. This equilibrium chemistry model can be applied to other turbulent,
diffusion-reaction systems. You can also model gas combustion using the finite-rate chemistry model.

You also learned how to set up and solve a gas phase combustion problem using the Discrete Ordinates
radiation model, and applying the appropriate absorption coefficient.

14.6. References
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14.7. Further Improvements

This tutorial guides you through the steps to first generate an initial solution, and then to reach a more
accurate second-order solution. You may be able to increase the accuracy of the solution even further
by using an appropriate higher-order discretization scheme and by adapting the mesh. Mesh adaption
can also ensure that your solution is independent of the mesh. These steps are demonstrated in Intro-
duction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 15: Modeling Surface Chemistry

This tutorial is divided into the following sections:
15.1. Introduction
15.2. Prerequisites
15.3. Problem Description
15.4. Setup and Solution
15.5. Summary
15.6. Further Improvements

15.1. Introduction

In chemically reacting laminar flows, such as those encountered in chemical vapor deposition (CVD)
applications, accurate modeling of time-dependent hydrodynamics, heat and mass transfer, and
chemical reactions (including wall surface reactions) is important.

In this tutorial, surface reactions are considered. Modeling the reactions taking place at gas-solid interfaces
is complex and involves several elementary physicochemical processes like adsorption of gas-phase
species on the surface, chemical reactions occurring on the surface, and desorption of gases from the
surface back to the gas phase.

This tutorial demonstrates how to do the following:

• Create new materials and set the mixture properties.

• Model surface reactions involving site species.

• Enable physical models and define boundary conditions for a chemically reacting laminar flow involving
wall surface reactions.

• Calculate the deposition solution using the pressure-based solver.

• Examine the flow results using graphics.

15.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.
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Before beginning with this tutorial, see the Fluent User's Guide  for more information about species
transport, chemically reacting flows, wall surface reaction modeling, and chemical vapor deposition. In
particular, you should be familiar with the Arrhenius rate equation, as this equation is used for the
surface reactions modeled in this tutorial.

15.3. Problem Description

A rotating disk CVD reactor for the growth of Gallium Arsenide (GaAs) shown in Figure 15.1: Schematic
of the Reactor Configuration (p. 618) will be modeled.

Figure 15.1:  Schematic of the Reactor Configuration

The process gases, Trimethyl Gallium ( ) and Arsine ( ) enter the reactor at 293 K through

the inlet at the top. These gases flow over the hot, spinning disk depositing thin layers of gallium and
arsenide on it in a uniform, repeatable manner. The disk rotation generates a radially pumping effect,
which forces the gases to flow in a laminar manner down to the growth surface, outward across the
disk, and finally to be discharged from the reactor.

The semiconductor materials Ga(s) and As(s) are deposited on the heated surface governed by the fol-
lowing surface reactions.

(15.1)

(15.2)

The inlet gas is a mixture of Trimethyl Gallium, which has a mass fraction of 0.15, and Arsine, which has
a mass fraction of 0.4, the remainder is hydrogen. The mixture velocity at the inlet is 0.02189 m/s. The
disk rotates at 80 rad/sec. The top wall (wall-1) is heated to 473 K and the sidewalls (wall-2) of the reactor
are maintained at 343 K. The susceptor (wall-4) is heated to a uniform temperature of 1023 K and the
bottom wall (wall-6) is at 303 K. These CVD reactors are typically known as cold-wall reactors, where
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only the wafer surface is heated to higher temperatures, while the remaining reactor walls are maintained
at low temperatures.

In this tutorial, simultaneous deposition of Ga and As is simulated and examined. The mixture properties
and the mass diffusivity are determined based on kinetic theory. Detailed surface reactions with multiple
sites and site species, and full multi-component/thermal diffusion effects are also included in the simu-
lation.

The purpose of this tutorial is to demonstrate surface reaction capabilities in ANSYS Fluent. Convective
heat transfer is considered to be the dominant mechanism compared to radiative heat transfer, thus
radiation effects are ignored.

15.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
15.4.1. Preparation
15.4.2. Reading and Checking the Mesh
15.4.3. Solver and Analysis Type
15.4.4. Specifying the Models
15.4.5. Defining Materials and Properties
15.4.6. Specifying Boundary Conditions
15.4.7. Setting the Operating Conditions
15.4.8. Simulating Non-Reacting Flow
15.4.9. Simulating Reacting Flow
15.4.10. Postprocessing the Solution Results

15.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the surface_chem_R180.zip link to download the input files.

7. Unzip the surface_chem_R180.zip file you have downloaded to your working folder.
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The file surface.msh can be found in the surface_chem folder created after unzipping the file.

8. Use Fluent Launcher to start the 3D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent
Launcher in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

11. Enable Double Precision.

15.4.2. Reading and Checking the Mesh

1. Read in the mesh file surface.msh.

File → Read → Mesh...

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure
that the reported minimum volume is a positive number.

3. Scale the mesh.

Setting Up Domain → Mesh → Scale...

Scale the mesh to meters as it was created in centimeters.
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a. Select cm (centimeters) from the Mesh Was Created In drop-down list in the Scaling group box.

b. Click Scale and verify that the domain extents are as shown in the Scale Mesh dialog box.

The default SI units will be used in this tutorial, hence there is no need to change any units.

c. Close the Scale Mesh dialog box.

4. Check the mesh.

Setting Up Domain → Mesh → Check

Note

It is a good practice to check the mesh after manipulating it (scale, convert to polyhedra,
merge, separate, fuse, add zones, or smooth and swap). This will ensure that the quality
of the mesh has not been compromised.

5. Examine the mesh (Figure 15.2: Mesh Display (p. 622)).
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Figure 15.2:  Mesh Display

Extra

You can use the left mouse button to rotate the image and view it from different angles.
Use the right mouse button to check which zone number corresponds to each boundary.
If you click the right mouse button on one of the boundaries in the graphics window, its
name and type will be printed in the ANSYS Fluent console. This feature is especially
useful when you have several zones of the same type and you want to distinguish between
them quickly. Use the middle mouse button to zoom the image.

15.4.3. Solver and Analysis Type

Retain the default solver settings of pressure-based steady-state solver in the Setting Up Physics tab
(Solver group).
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Setting Up Physics → Solver

15.4.4. Specifying the Models

In this problem, the energy equation and the species conservation equations will be solved, along with the
momentum and continuity equations.

1. Enable heat transfer by turning on the energy equation.

Setting Up Physics → Models → Energy

2. Enable chemical species transport.

Setting Up Physics → Models → Species...
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a. Select Species Transport in the Model list.

The Species Model dialog box will expand to show relevant input options.

b. Retain the selection of mixture-template from the Mixture Material drop-down list.

You will modify the mixture material later in this tutorial.

c. Retain the default setting for Diffusion Energy Source.

This includes the effect of enthalpy transport due to species diffusion in the energy equation, which
contributes to the energy balance, especially for the case of Lewis numbers far from unity.

d. Enable Full Multicomponent Diffusion and Thermal Diffusion.

The Full Multicomponent Diffusion activates Stefan-Maxwell’s equations and computes the diffusive
fluxes of all species in the mixture to all concentration gradients. The Thermal Diffusion effects cause
heavy molecules to diffuse less rapidly, and light molecules to diffuse more rapidly, toward heated
surfaces.

e. Click OK to close the Species Model dialog box.

15.4.5. Defining Materials and Properties

In the following steps you will copy the gas-phase species (AsH3 , Ga(CH3)3 , CH3 , and H2 ) from the ANSYS

Fluent database, specify the mixture materials, setup the reactions, and modify the material properties. You
will also create the site species (Ga_s and As_s) and the solid species (Ga and As).

1. Copy arsenic-trihydride, hydrogen, methyl-radical, and trimethyl-gallium from the ANSYS Fluent material
database to the list of fluid materials and modify their properties.

Setup → Materials → Fluid → air Edit...

a. Click Fluent Database... in the Create/Edit Materials dialog box to open the Fluent Database Mater-
ials dialog box.

b. In the Fluent Database Materials dialog box, select fluid from the Material Type drop-down list.

c. From the Fluent Fluid Materials selection list, select arsenic-trihydride (ash3), hydrogen (h2), methyl-
radical (ch3), and trimethyl-gallium (game3) by clicking each species once.

Scroll down the Fluent Fluid Materials list to locate each species.
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d. Click Copy to copy the selected species to your model.

e. Click Close to close the Fluent Database Materials dialog box.

The Create/Edit Materials dialog box is updated to show the new materials, arsenic-trihydride
(ash3), hydrogen (h2), methyl-radical (ch3), and trimethyl-gallium (game3), in the Fluent
Fluid Materials drop-down list. The species are also listed under Fluid in the Materials task page
and the Setup/Materials/Fluid tree branch.

2. Create the site species (Ga_s and As_s) and the solid species (Ga and As).

a. In the Create/Edit Materials dialog box, select air from the Fluent Fluid Materials drop-down list.

b. Enter ga_s for the Name text entry field.

c. Enter ga_s for the Chemical Formula text entry field.

d. Click Change/Create to create the new material.

e. Click No in the Question dialog box when asked if you want to overwrite air.

The new material ga_s is added to your model and listed under Fluid in the Materials task page
and under the Setup/Materials/Fluid tree branch.
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f. Create As_s, Ga, and As following the same procedure as for Ga_s and close the Create/Edit Materials
dialog box.

Extra

To enter complex formulae such as Ga(CH3)3 in the text entry box, use ‘<’ and ‘>’ instead

of ‘(’ and ‘ )’, respectively.

3. Set the mixture species.

Setup → Materials → Mixture → mixture-template Edit...

a. Enter gaas_deposition for Name.

b. Click Change/Create.

c. Click Yes in the Question dialog box to overwrite the mixture-template.

d. Set the Selected Species.

i. In Properties group box, click the Edit... button to the right of the names drop-down list for Mixture
Species to open the Species dialog box.
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ii. Set the Selected Species from the Available Materials selection list as shown in Table 15.1: Selected
Species (p. 627) .

Table 15.1:  Selected Species

Selected Species

ash3

game3

ch3

h2

Important

• Add arsenic-trihydride (ash3), trimethyl-gallium (game3), methyl-radical (ch3),
and hydrogen (h2) to the Selected Species list before removing h2o, o2, and n2.

• Ensure that h2 is at the bottom in the Selected Species selection list as shown in
Table 15.1: Selected Species (p. 627). ANSYS Fluent will interpret the last species in the
list as the bulk species.

Note

To add/remove the species:

• To add a particular species to the list, select the required species from the Available
Materials selection list and click Add in the corresponding species selection list (Se-
lected Species, Selected Site Species, or Selected Solid Species). The species will
be added to the end of the relevant list and removed from the Available Materials
list.

• To remove an unwanted species from the selection list, select the species from the
selection list (Selected Species, Selected Site Species, or Selected Solid Species)
and click Remove in the corresponding selection list. The species will be removed
from the list and added to the Available Materials list.

iii. Click OK to close the Species dialog box.

iv. Click Change/Create and close the Creat/Edit Materials dialog box.

4. Enable chemical species transport reaction.

Setting Up Physics → Models → Species...

Although you enable reactions, you still run a non-reacting flow to produce an initial solution. You will
run a reacting flow in Simulating Reacting Flow (p. 644).
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a. Enable Volumetric and Wall Surface in the Reactions group box.

b. Retain the selection of gass_deposition from the Mixture Material drop-down list.

c. Disable Heat of Surface Reactions and enable Mass Deposition Source.

d. Click OK to close the Species Model dialog box.

5. Set the site and solid species and the mixture reactions in a similar manner to the mixture species.

Setup → Materials → Mixture → gaas_deposition Edit...

a. Click the Edit... button to the right of the names drop-down list for Mixture Species in the Properties
group box.
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Specify the Selected Site Species and the Selected Solid Species as shown in Table 15.2: Selected
Site and Solid Species (p. 629).

Table 15.2:  Selected Site and Solid Species

Selected Solid SpeciesSelected Site Species

gaga_s

asas_s

Once you set the site and solid species, the Species dialog box should look like this:

b. Click OK to close the Species dialog box.

c. Click the Edit... button to the right of the Reaction drop-down list to open the Reactions dialog box.
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d. Increase the Total Number of Reactions to 2, and define the following reactions using the parameters
in Table 15.3: Reaction Parameters (p. 630) :

(15.3)

(15.4)

Table 15.3:  Reaction Parameters

For Equation 15.4 (p. 630)For Equation 15.3 (p. 630)Parameter

2 a1Reaction ID

arsenic-depgallium-depReaction Name

Wall SurfaceWall SurfaceReaction Type

22Number of Reactants

game3, as_sash3, ga_sSpecies

game3= 1, as_s= 1ash3= 1, ga_s= 1Stoich. Coefficient

game3= 1, as_s= 1ash3= 1, ga_s= 1Rate Exponent

PEF= 1e+12, AE= 0, TE= 0.5PEF= 1e+06, AE= 0, TE= 0.5 bArrhenius Rate
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For Equation 15.4 (p. 630)For Equation 15.3 (p. 630)Parameter

33Number of Products

as, ga_s, ch3ga, as_s, h2Species

as= 1, ga_s= 1, ch3= 3ga= 1, as_s= 1, h2= 1.5Stoich. Coefficient

ga_s= 0, ch3= 0as_s= 0, h2= 0Rate Exponent
aSet the ID to 2 in order to set the parameters for the second reaction.
bHere, PEF = Pre-Exponential Factor, AE = Activation Energy, and TE = Temperature Exponent.

e. Click OK to save the data and close the Reactions dialog box.

f. Set the reaction mechanisms for the mixture.

i. Click the Edit... button to the right of the Mechanism drop-down list to open the Reaction Mech-
anisms dialog box.

ii. Retain Number of Mechanisms as 1.

iii. Enter gaas-ald for Name.

iv. Select Wall Surface in the Reaction Type group box.

v. Select gallium-dep and arsenic-dep from the Reactions selection list.

vi. Set Number of Sites to 1.

vii. Enter 1e-08 kgmol/m2 for Site Density for site-1.
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viii.Click the Define... button to the right of site-1 to open the Site Parameters dialog box.

A. Set Total Number of Site Species to 2.

B. Select ga_s as the first site species and enter 0.7 for Initial Site Coverage.

C. Select as_s as the second site species and enter 0.3 for Initial Site Coverage.

D. Click Apply and close the Site Parameters dialog box.

ix. Click OK to close the Reaction Mechanisms dialog box.

g. Retain the default selection of incompressible-ideal-gas from the Density drop-down list.

h. Retain the default selection of mixing-law from the Cp (Specific Heat) drop-down list.

i. Select mass-weighted-mixing-law from the Thermal Conductivity drop-down list.

j. Select mass-weighted-mixing-law from the Viscosity drop-down list.

k. Retain the default selection of kinetic-theory from the Mass Diffusivity drop-down list.

l. Retain the default selection of kinetic-theory from the Thermal Diffusion Coefficient drop-down list.

m. Click Change/Create and close the Create/Edit Materials dialog box.

6. Specify the material properties for arsenic-trihydride, hydrogen, methyl-radical, trimethyl-gallium, site
species (Ga_s and As_s), and solid species (Ga and As).

Setup → Materials → Mixture → gaas_deposition →  arsenic-trihydride Edit...
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a. In the Properties group box, modify the arsenic-trihydride properties as shown in Table 15.4: Properties
of Species (p. 633).

Important

Ensure Mixture is set to gaas_deposition

Tip

Scroll down in the Properties group box to see all the parameters.

Table 15.4:  Properties of Species

H_2CH_3Ga(CH_3)_3AsH_3Parameter

hydrogenmethyl-radic-
al

trimethyl-
gallium

arsenic-tri-
hydride

Name

h2ch3game3ash3Chemical Formula

piecewise-poly-
nomial

piecewise-poly-
nomial

piecewise-poly-
nomial

piecewise-
polynomial

Cp (Specific Heat)

kinetic-theorykinetic-theorykinetic-theorykinetic-theoryThermal Conductiv-
ity
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H_2CH_3Ga(CH_3)_3AsH_3Parameter

kinetic-theorykinetic-theorykinetic-theorykinetic-theoryViscosity

2.0215114.8377.95Molecular Weight

02.044e+0700Standard State En-
thalpy

130579.1257367.6130579.1130579.1Standard State En-
tropy

298.15298.15298.15298.15Reference Temper-
ature

2.8273.7585.684.145L-J Characteristic
Length

59.7148.6398259.8L-J Energy Paramet-
er

b. When finished, click Change/Create to update your local copy of the species material.

Note

When you modify the properties of the material local copy, the original copy in Fluent
material database stays intact.

c. In a similar way, modify the properties of trimethyl-gallium (game3), methyl-radical (ch3), and hy-
drogen (h2).

Note

Make sure to click Change/Create each time you modify the properties for the mater-
ial to apply the changes to the local copy.

d. Select ga_s from the Fluent Fluid Materials drop-down list.

e. Enter the parameter values for the ga_s species as shown in Table 15.5: Properties of Species (p. 634).

Table 15.5:  Properties of Species

AsGaAs_sGa_sParameter

asgaas_sga_sName

asgaas_sga_sChemical Formula

1006.431006.43520.64520.64Cp (Specific Heat)

kinetic-theorykinetic-theory0.01580.0158Thermal Conduct-
ivity

kinetic-theorykinetic-theory2.125e-052.125e-05Viscosity

74.9269.7274.9269.72Molecular Weight
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AsGaAs_sGa_sParameter

00-3117.71-3117.71Standard State
Enthalpy

00154719.3154719.3Standard State
Entropy

298.15298.15298.15298.15Reference Temper-
ature

0000L-J Characteristic
Length

0000L-J Energy Para-
meter

f. Modify the material properties for As_s, Ga, and As as shown in Table 15.5: Properties of Species (p. 634).

g. Close the Create/Edit Materials dialog box.

15.4.6. Specifying Boundary Conditions

1. Set the conditions for velocity-inlet.

Setup → Boundary Conditions → velocity-inlet Edit...
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a. Retain the default selection of Magnitude, Normal to Boundary from the Velocity Specification
Method drop-down list.

b. Retain the default selection of Absolute from the Reference Frame drop-down list.

c. Enter 0.02189 m/s for Velocity Magnitude.

d. Click the Thermal tab and enter 293 K for Temperature.

e. Under the Species tab, set the Species Mass Fractions for ash3 to 0.4, game3 to 0.15, and ch3 to
0.

The mass fraction of hydrogen is 0.45, but there is no need to specify this since it is the last species
in the mixture.

f. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions for outlet.

Setup → Boundary Conditions → outlet Edit...

a. Retain the default settings under the Momentum tab.
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b. Under the Thermal tab, enter 400 K for Temperature.

c. Under the Species tab, set the Species Mass Fractions for ash3 to 0.32, game3 to 0.018, and ch3
to 0.06.

Since a certain amount of backflow is expected in the flow regions around the rotating shaft,
you should set the realistic backflow species mass fractions to minimize convergence difficulties.

d. Click OK to accept the remaining default settings.
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3. Set the boundary conditions for wall-1.

Setup → Boundary Conditions → wall-1 Edit...

a. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions group box.

ii. Enter 473 K for Temperature.

b. Click OK to close the Wall dialog box.

4. Set the boundary conditions for wall-2.

Setup → Boundary Conditions → wall-2 Edit...

a. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions group box.

ii. Enter 343 K for Temperature.

b. Click OK to close the Wall dialog box.

5. Set the boundary conditions for wall-4.

Setup → Boundary Conditions → wall-4 Edit...
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a. Select Moving Wall in the Wall Motion group box.

The Wall dialog box will expand to wall motion inputs and options.

b. Select Absolute and Rotational in the Motion group box.

c. Enter 80 rad/s for Speed.

d. Retain the other default settings.

e. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions group box.

ii. Enter 1023 K for Temperature.

f. Click the Species tab.
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i. Enable Reaction.

ii. Retain the selection of gaas-ald from the Reaction Mechanisms drop-down list.

g. Click OK to close the Wall dialog box.

6. Set the boundary conditions for wall-5.

Setup → Boundary Conditions → wall-5 Edit...

a. Select Moving Wall in the Wall Motion group box.

b. Select Absolute and Rotational in the Motion group box.

c. Enter 80 rad/s for Speed.

d. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions group box.

ii. Enter 720 K for Temperature.

e. Click OK to close the Wall dialog box.

7. Set the boundary conditions for wall-6.

Setup → Boundary Conditions → wall-6 Edit...
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a. Click the Thermal tab.

i. Select Temperature in the Thermal Conditions group box.

ii. Enter 303 K for Temperature.

b. Click OK to close the Wall dialog box.

15.4.7. Setting the Operating Conditions

1. Setting Up Physics → Solver → Operating Conditions...

a. Enter 10000 Pa for Operating Pressure.

b. Enable Gravity.

The dialog box will expand to show related gravitational inputs.

c. Enter 9.81 m/s2 for Gravitational Acceleration in the Z direction.

d. Enter 303 K for Operating Temperature.

e. Click OK to close the Operating Conditions dialog box.

The Operating Conditions dialog box can be accessed from the Cell Zone Conditions task page.
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15.4.8. Simulating Non-Reacting Flow

1. Disable Volumetric for solving non-reacting flow.

Setting Up Physics → Models → Species...

a. Disable Volumetric in the Reactions group box.

b. Click OK to close the Species Model dialog box.

You will first run a non-reacting solution to establish the flow.

2. Select the Coupled solver method.

Solution → Solution Methods

a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the default selections in the Spatial Discretization group box.
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3. Examine Solution Controls and retain the default settings.

Solution → Solution Controls

4. Enable residual plotting during the calculation.

Solving → Reports → Residuals...

a. Retain the default settings and close the Residual Monitors dialog box.

5. Initialize the flow field.

Solution → Solution Initialization
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a. Retain the default selection of Hybrid Initialization from the Initialization Methods group box.

b. Click Initialize.

6. Save the case file (surface-non-react.cas.gz).

File → Write → Case...

7. Start the calculation by requesting 200 iterations.

Solving → Run Calculation

a. Enter 200 for No. of Iterations and click Calculate.

The solution will converge in approximately 50 iterations.

15.4.9. Simulating Reacting Flow

1. Enable Volumetric for the reacting flow solution.

Setting Up Physics → Models → Species...
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a. Enable Volumetric and Wall Surface in the Reactions group box.

b. Ensure that Mass Deposition Source is enabled in the Wall Surface Reaction Options group box.

c. Click OK to close the Species Model dialog box.

2. Retain the default convergence criteria for calculation.

Solving → Reports → Residuals...
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3. Request 200 more iterations.

Solving → Run Calculation → Calculate

The solution will converge in approximately 60 additional iterations.

4. Compute the mass fluxes.

Postprocessing → Reports → Fluxes...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.646

Modeling Surface Chemistry



a. Retain the default selection of Mass Flow Rate in the Options group box.

b. Select outlet, velocity-inlet, and wall-4 from the Boundaries selection list.

In order to properly assess the mass balance, you must account for the mass deposition on the spinning
disk. Hence you select wall-4 in addition to the inlet and outlet boundaries.

c. Click Compute, examine the values displayed in the Results and Net Results boxes, and close the Flux
Reports dialog box.

The net mass imbalance should be a small fraction (for example, 0.5% or less) of the total flux
through the system. If a significant imbalance occurs, you should decrease your residual tolerances
by at least an order of magnitude and continue iterating.

5. Display contours of surface deposition rate of ga (Figure 15.3: Contours of Surface Deposition Rate of
Ga (p. 648)).

Postprocessing → Graphics → Contours → Edit...

a. Enable Filled in the Options group box.

b. Select Species... and Surface Deposition Rate of ga from the Contours of drop-down lists.

c. Select wall-4 from the Surfaces selection list.

d. Click Display and close the Contours dialog box.

Rotate the display with the mouse to obtain the view as shown in (Figure 15.3: Contours of Surface De-
position Rate of Ga (p. 648)).
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Figure 15.3:  Contours of Surface Deposition Rate of Ga

6. Reduce the convergence criteria.

Solving → Reports → Residuals...

a. Enter 5e-06 for Absolute Criteria for continuity.
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b. Click OK to close the Residual Monitors dialog box.

7. Request 200 more iterations.

Solving → Run Calculation → Calculate

The solution will converge in approximately 175 additional iterations.

Figure 15.4:  Scaled Residuals

8. Check the mass fluxes.

Postprocessing → Reports → Fluxes...
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a. Retain the default selection of Mass Flow Rate in the Options group box.

b. Retain the selection of outlet and velocity-inlet and, wall-4 from the Boundaries selection list.

c. Click Compute, examine the values displayed in the Results and Net Results boxes, and close the Flux
Reports dialog box.

Again, the net mass imbalance should be a small fraction (for example, 0.5% or less) of the total
flux through the system.

9. Save the case and data files (surface-react1.cas.gz and surface-react1.dat.gz).

File → Write → Case & Data...

15.4.10. Postprocessing the Solution Results

1. Create an iso-surface near wall-4.

Postprocessing → Surface → Create → Iso-Surface...
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a. Select Mesh... and Z-Coordinate from the Surface of Constant drop-down lists.

b. Click Compute.

The Min and Max fields display the z-extent of the domain.

c. Enter 0.075438 m for Iso-Values.

d. Enter z=0.07 for New Surface Name.

Note

If you want to delete or otherwise manipulate any surfaces, click Manage... to open
the Surfaces dialog box.

e. Click Create and close the Iso-Surface dialog box.

The new surface z=0.07 is added to the surfaces selection list.

2. Display contours of temperature on the plane surface created. (Figure 15.5: Temperature Contours Near
wall-4 (p. 653)).

Postprocessing → Graphics → Contours → Edit...
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a. Ensure that Filled is enabled in the Options group box.

b. Select Temperature... and Static Temperature from the Contours of drop-down lists.

c. Deselect wall-4 from the Surfaces selection list.

d. Select z=0.07 from the Surfaces selection list.

e. Click Display.
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Figure 15.5: Temperature Contours Near wall-4

Figure 15.5: Temperature Contours Near wall-4 (p. 653) shows the temperature distribution across a plane
just above the rotating disk. You can see that the disk has a temperature of 1023 K.

3. Display contours of surface deposition rates of ga (Figure 15.6: Contours of Surface Deposition Rate of
ga (p. 654)).

Postprocessing → Graphics → Contours → Edit...

a. Select Species... and Surface Deposition Rate of ga from the Contours of drop-down lists.

b. Select wall-4 from the Surfaces selection list.

c. Deselect z=0.07 from the Surfaces selection list.

d. Click Display.

You may need to use the left mouse button to rotate the image so that you can see the contours on the
top side of wall-4 where the deposition takes place.

Figure 15.6: Contours of Surface Deposition Rate of ga (p. 654) shows the gradient of surface deposition
rate of ga. The maximum deposition is seen at the center of the disk.
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Figure 15.6:  Contours of Surface Deposition Rate of ga

4. Display contours of surface coverage of ga_s (Figure 15.7: Contours of Surface Coverage of ga_s (p. 655)).

Postprocessing → Graphics → Contours → Edit...

a. Select Species... and Surface Coverage of ga_s from the Contours of drop-down lists.

b. Retain the selection of wall-4 in the Surfaces selection list.

c. Click Display and close the Contours dialog box.
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Figure 15.7:  Contours of Surface Coverage of ga_s

Figure 15.7: Contours of Surface Coverage of ga_s (p. 655) shows the rate of surface coverage of the site
species ga_s.

5. Create a line surface from the center of wall-4 to the edge.

Postsprocessing → Surface → Create → Line/Rake...
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a. Enter the values for x0, x1, y0, y1, z0, and z1 as follows:

ValueEnd Points

-0.01040954x0

-0.004949478y0

0.0762001z0

0.1428x1

0.1386585y1

0.07620001z1

You can also select the points by clicking Select Points with Mouse. Then, in the graphic display,
click at the center of wall-4 and at the edge using the right mouse button.

b. Click Create to accept the default name of line-9 for the New Surface Name.

Note

If you want to delete or otherwise manipulate any surfaces, click Manage... to open
the Surfaces dialog box

c. Close the Line/Rake Surface dialog box.

6. Plot the surface deposition rate of Ga versus radial distance (Figure 15.8: Plot of Surface Deposition Rate
of Ga (p. 657)).

Postprocessing → Plots → XY Plot → Edit...
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a. Disable Node Values in the Options group box.

b. Select Species... and Surface Deposition Rate of ga from the Y Axis Function drop-down lists.

The source/sink terms due to the surface reaction are deposited in the cell adjacent to the wall cells,
so it is necessary to plot the cell values and not the node values.

c. Select line-9 you just created from the Surfaces selection list.

d. Click Plot and close the Solution XY Plot dialog box.

The peak surface deposition rate occurs at the center of wall-4 (where the concentration of the mixture
is highest).

Figure 15.8:  Plot of Surface Deposition Rate of Ga

Extra

You can also perform all the postprocessing steps to analyze the deposition of As.

7. Save the case and data files (surface-react2.cas.gz and surface-react2.dat.gz).

File → Write → Case & Data...

15.5. Summary

The main focus of this tutorial is the accurate modeling of macroscopic gas flow, heat and mass transfer,
species diffusion, and chemical reactions (including surface reactions) in a rotating disk CVD reactor. In
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this tutorial, you learned how to use the two-step surface reactions involving site species, and computed
simultaneous deposition of gallium and arsenide from a mixture of precursor gases on a rotating sus-
ceptor. Note that the same approach is valid if you are simulating multi-step reactions with multiple
sites/site species.

15.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.658

Modeling Surface Chemistry



Chapter 16: Modeling Evaporating Liquid Spray

This tutorial is divided into the following sections:
16.1. Introduction
16.2. Prerequisites
16.3. Problem Description
16.4. Setup and Solution
16.5. Summary
16.6. Further Improvements

16.1. Introduction

In this tutorial, the air-blast atomizer model in ANSYS Fluent is used to predict the behavior of an
evaporating methanol spray. Initially, the air flow is modeled without droplets. To predict the behavior
of the spray, the discrete phase model is used, including a secondary model for breakup.

This tutorial demonstrates how to do the following:

• Define a spray injection for an air-blast atomizer.

• Calculate a solution using the discrete phase model in ANSYS Fluent.

16.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

16.3. Problem Description

The geometry to be considered in this tutorial is shown in Figure 16.1: Problem Specification (p. 660).

Methanol is cooled to C before being introduced into an air-blast atomizer. The atomizer contains
an inner air stream surrounded by a swirling annular stream. To make use of the periodicity of the

problem, only a  section of the atomizer will be modeled.
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Figure 16.1:  Problem Specification

16.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
16.4.1. Preparation
16.4.2. Mesh
16.4.3. Solver
16.4.4. Models
16.4.5. Materials
16.4.6. Boundary Conditions
16.4.7. Initial Solution Without Droplets
16.4.8. Creating a Spray Injection
16.4.9. Solution
16.4.10. Postprocessing

16.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.
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2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the evaporate_liquid_R180.zip link to download the input files.

7. Unzip evaporate_liquid_R180.zip to your working folder.

The mesh file sector.msh can be found in the evaporate_liquid directory created after unzipping
the file.

8. Use the ANSYS Fluent Launcher to start the 3D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about the ANSYS Fluent Launcher, see starting ANSYS Fluent using the Fluent
Launcher in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

11. Enable Double Precision.

12. Ensure that Meshing Mode is disabled.

16.4.2. Mesh

1. Read in the mesh file sector.msh.

File → Read → Mesh...

2. Change the periodic type of periodic-a to rotational.

Setup → Boundary Conditions → periodic-a → Edit...
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a. Select Rotational in the Periodic Type group box.

b. Click OK to close the Periodic dialog box.

3. In a similar manner, change the periodic type of periodic-b to rotational.

4. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Ensure
that the reported minimum volume is a positive number.

5. Display the mesh.

Setting Up Domain → Mesh → Display...

a. Ensure that Faces is enabled in the Options group box.
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b. Select only atomizer-wall, central_air, and swirling_air from the Surfaces selection list.

Tip

To deselect all surfaces click the far-right button  at the top of the Surfaces selec-
tion list, and then select the desired surfaces from the Surfaces selection list.

c. Click the Colors... button to open the Mesh Colors dialog box.

i. Select wall from the Types selection list.

ii. Select pink from the Colors selection list.

iii. Close the Mesh Colors dialog box.

d. Click Display and close the Mesh Display dialog box.

The graphics display will be updated to show the mesh. Zoom in with the mouse to obtain the view
shown in Figure 16.2: Air-Blast Atomizer Mesh Display (p. 664).
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Figure 16.2:  Air-Blast Atomizer Mesh Display

16.4.3. Solver

Retain the default solver settings of pressure-based steady-state solver in the Solver group of the Setting
Up Physics tab.

Setting Up Physics → Solver
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16.4.4. Models

1. Enable heat transfer by enabling the energy equation.

Setting Up Physics → Models → Energy

2. Enable the Realizable -  turbulence model.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2 eqn) in the Model list.

b. Select Realizable in the k-epsilon Model list.

The Realizable -  model gives a more accurate prediction of the spreading rate of both planar and
round jets than the standard -  model.

c. Retain the default selection of Standard Wall Functions in the Near-Wall Treatment list.

d. Click OK to close the Viscous Model dialog box.

3. Enable chemical species transport and reaction.

Setting Up Physics → Models → Species...
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a. Select Species Transport in the Model list.

b. Select methyl-alcohol-air from the Mixture Material drop-down list.

The Mixture Material list contains the set of chemical mixtures that exist in the ANSYS Fluent database.
When selecting an appropriate mixture for your case, you can review the constituent species and the
reactions of the predefined mixture by clicking View... next to the Mixture Material drop-down list.
The chemical species and their physical and thermodynamic properties are defined by the selection
of the mixture material. After enabling the Species Transport model, you can alter the mixture ma-
terial selection or modify the mixture material properties using the Create/Edit Materials dialog
box. You will modify your local copy of the mixture material later in this tutorial.

c. Click OK to close the Species Model dialog box.

16.4.5. Materials

Define materials using the Materials task page.

Setup → Materials
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1. Remove water vapor and carbon dioxide from the Mixture Species list.

Setup → Materials → Mixture → Create/Edit...
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a. Click the Edit button next to the Mixture Species drop-down list to open the Species dialog box.

i. Select carbon dioxide (co2) from the Selected Species selection list.

ii. Click Remove to remove carbon dioxide from the Selected Species list.
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iii. In a similar manner, remove water vapor (h2o) from the Selected Species list.

iv. Click OK to close the Species dialog box.

b. Click Change/Create and close the Create/Edit Materials dialog box.

Note

It is good practice to click the Change/Create button whenever changes are made
to material properties even though it is not necessary in this case.

16.4.6. Boundary Conditions

Specify boundary conditions using the Boundary Conditions task page.

Setup → Boundary Conditions

1. Set the boundary conditions for the inner air stream (central_air).
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Setup → Boundary Conditions → central_air → Edit...

a. Enter 9.167e-5 kg/s for Mass Flow Rate.

b. Enter 0 for X-Component of Flow Direction.

c. Retain the default value of 0 for Y-Component of Flow Direction.

d. Enter 1 for Z-Component of Flow Direction.

e. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list.

f. Enter 10 for Turbulent Intensity.

g. Enter 0.0037 m for Hydraulic Diameter.

h. Click the Thermal tab and enter 293 K for Total Temperature.

i. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.

j. Click OK to close the Mass-Flow Inlet dialog box.

2. Set the boundary conditions for the air stream surrounding the atomizer (co-flow-air).
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Setup → Boundary Conditions → co-flow-air → Edit...

a. Enter 1 m/s for Velocity Magnitude.

b. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list.

c. Retain the default value of 5 for Turbulent Intensity.

d. Enter 0.0726 m for Hydraulic Diameter.

e. Click the Thermal tab and enter 293 K for Temperature.

f. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.

g. Click OK to close the Velocity Inlet dialog box.

3. Set the boundary conditions for the exit boundary (outlet).

Setup → Boundary Conditions → outlet → Edit...
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a. Select From Neighboring Cell from the Backflow Direction Specification Method drop-down list.

b. Retain Intensity and Viscosity Ratio from the Specification Method drop-down list.

c. Retain the default value of 5 for Backflow Turbulent Intensity (%).

d. Enter 5 for Backflow Turbulent Viscosity Ratio.

e. Click the Thermal tab and enter 293 K for Backflow Total Temperature.

f. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.

g. Click OK to close the Pressure Outlet dialog box.

4. Set the boundary conditions for the swirling annular stream (swirling_air).

Setup → Boundary Conditions → swirling_air → Edit...
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a. Select Magnitude and Direction from the Velocity Specification Method drop-down list.

b. Enter 19 m/s for Velocity Magnitude.

c. Select Cylindrical (Radial, Tangential, Axial) from the Coordinate System drop-down list.

d. Enter 0 for Radial-Component of Flow Direction.

e. Enter 0.7071 for Tangential-Component of Flow Direction.

f. Enter 0.7071 for Axial-Component of Flow Direction.

g. Select Intensity and Hydraulic Diameter from the Specification Method drop-down list.

h. Retain the default value of 5 for Turbulent Intensity.

i. Enter 0.0043 m for Hydraulic Diameter.

j. Click the Thermal tab and enter 293 K for Temperature.

k. Click the Species tab and enter 0.23 for o2 in the Species Mass Fractions group box.

l. Click OK to close the Velocity Inlet dialog box.

5. Set the boundary conditions for the outer wall of the atomizer (outer-wall).
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Setup → Boundary Conditions → outer-wall → Edit...

a. Select Specified Shear in the Shear Condition list.

b. Retain the default values for the remaining parameters.

c. Click OK to close the Wall dialog box.

16.4.7. Initial Solution Without Droplets

The airflow will first be solved and analyzed without droplets.

1. Set the solution method.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Enable Pseudo Transient.

The message appears in the console informing you of changing AMG cycle type for Volume Fraction,
Turbulent Kinetic Energy, and Turbulent Dissipation Rate to F-cycle.

2. Retain the default under-relaxation factors.

Solving → Controls → Controls...
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3. Enable residual plotting during the calculation.

Solving → Reports → Residuals...

a. Ensure that Plot is enabled in the Options group box.
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b. Click OK to close the Residual Monitors dialog box.

4. Initialize the flow field.

Solving → Initialization

a. Retain the Method at the default of Hybrid.

b. Click Initialize to initialize the variables.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity
and pressure fields than standard initialization. This will help to improve the convergence
behavior of the solver.

5. Save the case file (spray1.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 150 iterations.

Solution → Run Calculation

a. Select User Specified from the Time Step Method group box.

b. Retain 1 s for Pseudo Time Step.

c. Enter 150 for Number of Iterations.

d. Click Calculate.

The solution will converge in approximately 105 iterations.
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Figure 16.3:  Scaled Residuals

7. Save the case and data files (spray1.cas.gz and spray1.dat.gz).

File → Write → Case & Data...

Note

ANSYS Fluent will ask you to confirm that the previous case file is to be overwritten.

8. Create a clip plane to examine the flow field at the midpoint of the atomizer section.

Postprocessing → Surface → Create → Iso-Surface...
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a. Select Mesh... and Angular Coordinate from the Surface of Constant drop-down lists.

b. Click Compute to obtain the minimum and maximum values of the angular coordinate.

c. Enter 15 for Iso-Values.

d. Enter angle=15 for New Surface Name.

e. Click Create to create the isosurface.

f. Close the Iso-Surface dialog box.

9. Review the current state of the solution by examining contours of velocity magnitude (Figure 16.4: Velocity
Magnitude at Mid-Point of Atomizer Section (p. 682)).

Postprocessing → Graphics → Contours → Edit...
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a. Enable Filled in the Options group box

b. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

c. Enable Draw Mesh.

The Mesh Display dialog box will open.

i. Retain the current mesh display settings.

ii. Close the Mesh Display dialog box.

d. Select angle=15 from the Surfaces selection list.

e. Click Display and close the Contours dialog box.

f. Use the mouse to obtain the view shown in Figure 16.4: Velocity Magnitude at Mid-Point of Atomizer
Section (p. 682).
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Figure 16.4: Velocity Magnitude at Mid-Point of Atomizer Section

10. Modify the view to include the entire atomizer.

Viewing → Display → Views...
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a. Click the Define... button to open the Graphics Periodicity dialog box.

i. Select fluid from the Cell Zones selection list.

ii. Retain the selection of Rotational in the Periodic Type list.

iii. Retain the value of 12 for Number of Repeats.

iv. Click Set and close the Graphics Periodicity dialog box.

The graphics display will be updated to show the entire atomizer.

b. Click Apply and close the Views dialog box.
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11. Display pathlines of the air in the swirling annular stream (Figure 16.5: Pathlines of Air in the Swirling An-
nular Stream (p. 685)).

Postprocessing → Graphics → Pathlines → Edit...

a. Increase the Path Skip value to 5.

b. In the Release from Surfaces filter, type s to display the surface names that begin with s and select
swirling_air from the selection list.

c. Enable Draw Mesh in the Options group box.

The Mesh Display dialog box will open.

i. Retain the current mesh display settings.

ii. Close the Mesh Display dialog box.

d. Click Display and close the Pathlines dialog box.

e. Use the mouse to obtain the view shown in Figure 16.5: Pathlines of Air in the Swirling Annular
Stream (p. 685).
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Figure 16.5:  Pathlines of Air in the Swirling Annular Stream

16.4.8. Creating a Spray Injection

1. Define the discrete phase modeling parameters.

Setting Up Physics → Models → Discrete Phase...
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a. Select Interaction with Continuous Phase in the Interaction group box.

This will include the effects of the discrete phase trajectories on the continuous phase.

b. Retain the value of 10 for DPM Iteration Interval.

c. Select Mean Values in the Contour Plots for DPM Variables group box.

This will make the cell-averaged variables available for postprocessing activities.

d. Select the Unsteady Particle Tracking option in the Particle Treatment group box.

e. Enter 0.0001 for Particle Time Step Size.

f. Enter 10 for Number of Time Steps.

g. Under the Physical Models tab, select the Temperature Dependent Latent Heat and Breakup (Options
group).
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h. Under the Numerics tab, select Linearize Source Terms (Source Terms group).

Enabling this option will allow you to run the simulation with more aggressive setting for the
Discrete Phase Sources under-relaxation factor to speed up the solution convergence.

i. Click Injections... to open the Injections dialog box.

In this step, you will define the characteristics of the atomizer.
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An Information dialog box appears indicating that the Max. Number of Steps has been changed
from 50000 to 500. Click OK in the Information dialog box to continue.

j. Click the Create button to create the spray injection.

k. In the Set Injection Properties dialog box, select air-blast-atomizer from the Injection Type drop-
down list.

l. Enter 600 for Number of Streams.
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This option controls the number of droplet parcels that are introduced into the domain at every time
step.

m. Select Droplet in the Particle Type group box.

n. Select methyl-alcohol-liquid from the Material drop-down list.

o. In the Point Properties tab, specify point properties for particle injections.

i. Retain the default values of 0 and 0 for X-Position and Y-Position.

ii. Enter 0.0015 for Z-Position.

iii. Retain the default values of 0,0, and 1 for X-Axis, Y-Axis, and Z-Axis, respectively.

iv. Enter 263 K for Temperature.

Scroll down the list to see the remaining point properties.

v. Enter 8.5e-5 kg/s for Flow Rate.

This is the methanol flow rate for a 30-degree section of the atomizer. The actual atomizer flow
rate is 12 times this value.

vi. Retain the default Start Time of 0 s and enter 100 s for the Stop Time.

For this problem, the injection should begin at  and not stop until long after the time period
of interest. A large value for the stop time (for example, 100 s) will ensure that the injection will
essentially never stop.

vii. Enter 0.0035 m for the Injector Inner Diameter and 0.0045 m for the Injector Outer Diameter.

viii.Enter 45 degrees for Spray Half Angle.

The spray angle is the angle between the liquid sheet trajectory and the injector centerline.

ix. Enter 82.6 m/s for the Relative Velocity.

The relative velocity is the expected relative velocity between the atomizing air and the liquid
sheet.

x. Retain the default Azimuthal Start Angle of 0 degrees and enter 30 degrees for the Azimuthal
Stop Angle.

This will restrict the injection to the 30-degree section of the atomizer that is being modeled.

p. In the Physical Models tab, specify the breakup model and drag parameters.
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i. In the Breakup group, ensure that Enable Breakup is selected and TAB is selected from the
Breakup Model drop-down list.

ii. Retain the default values of 0 for y0 and 2 for Breakup Parcels.

iii. In the Drag Parameters group box, select dynamic-drag from the Drag Law drop-down list.

The dynamic-drag law is available only when the Breakup model is used.

q. In the Turbulent Dispersion tab, define the turbulent dispersion.
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i. Enable Discrete Random Walk Model and Random Eddy Lifetime in the Stochastic Tracking
group box.

These models will account for the turbulent dispersion of the droplets.

ii. Click OK to close the Set Injection Properties dialog box.

Note

To modify the existing injection, select its name in the Injections list and click
Set..., or simply double-click the injection of interest.

r. Close the Injections dialog box.

Note

In the case that the spray injection would be striking a wall, you should specify the
wall boundary conditions for the droplets. Though this tutorial does have wall zones,
they are a part of the atomizer apparatus. You need not change the wall boundary
conditions any further because these walls are not in the path of the spray droplets.

s. Click OK to close the Discrete Phase Model dialog box.

2. Specify the droplet material properties.

Setup → Materials → methyl-alcohol-liquid → Create/Edit...
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When secondary atomization models (such as Breakup) are used, several droplet properties need to be
specified.

a. Ensure droplet-particle is selected in the Material Type drop-down list.

b. Enter 0.0056 kg/m-s for Viscosity in the Properties group box.

c. Ensure that piecewise-linear is selected from the Saturation Vapor Pressure drop-down list.

Scroll down to find the Saturation Vapor Pressure drop-down list.

d. Click the Edit... button next to Saturation Vapor Pressure to open the Piecewise-Linear Profile dialog
box.

e. Retain the default values and click OK to close the Piecewise-Linear Profile dialog box.

f. Select convection/diffusion-controlled from the Vaporization Model drop-down list.

g. Click OK to close the Convection/Diffusion Model dialog box.

h. Click Change/Create to accept the change in properties for the methanol droplet material and close
the Create/Edit Materials dialog box.

16.4.9. Solution

1. Increase the under-relaxation factor for Discrete Phase Sources.

Solving → Controls → Controls...
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In the Pseudo Transient Explicit Relaxation Factors group box, change the under-relaxation factor
for Discrete Phase Sources to 0.9.

2. Remove the convergence criteria.

Solving → Reports → Residuals...
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a. Select none from the Convergence Criterion drop-down list.

b. Click OK to close the Residual Monitors dialog box.

3. Enable the plotting of mass fraction of ch3oh.

Solving → Reports → Definitions → New → Surface Report → Mass-Weighted Average...

a. Enter ch3oh_outlet for Name of the surface report definition.

b. In the Create group box, enable Report Plot and Print to Console.

c. Select Species... and Mass fraction of ch3oh from the Field Variable drop-down lists.

d. Select outlet from the Surfaces selection list.

e. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

Fluent automatically generates the ch3oh_outlet-rplot report plot under the Solution/Monit-
ors/Report Plots tree branch.
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4. Enable the plotting of the sum of the DPM Mass Source.

Solving → Reports → Definitions → New → Volume Report → Sum...

a. Enter dpm-mass-source for Name.

b. In the Create group box, enable Report Plot and Print to Console.

c. Select Discrete Phase Sources... and DPM Mass Source from the Field Variable drop-down lists.

d. Select fluid from the Cell Zones selection list.

e. Click OK to save the volume report definition settings and close the Volume Report Definition dialog
box.

Fluent automatically generates the dpm-mass-source-rplot report plot under Solution/Monit-
ors/Report Plots tree branch.
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f. Modify the attributes of the dpm-mass-source-rplot report plot axes.

Solution → Monitors → Report Plots → dpm-mass-source-rplot Edit...

i. In the Plot Window group box, click the Axes... button to open the Axes dialog box.
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ii. Select Y in the Axis list.

iii. Select exponential from the Type drop-down list.

iv. Set Precision to 2.

v. Click Apply and close the Axes dialog box.

vi. Click OK to close the Edit Report Plot dialog box.

5. Create a DPM report definition for tracking the total mass present in the domain.

Solving → Reports → Definitions → New → DPM Report → Mass in Domain...

a. Enter dpm-mass-in-domain for Name.

b. In the Create group box, enable Report Plot and Print to Console.

c. Select injection-0 from the Injections selection list.

d. Clear Show Mass Flow / Change Rate.

e. Click OK to save the volume report definition settings and close the DPM Report Definition dialog
box.
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Fluent automatically generates the dpm-mass-in-domain-rplot report plot under Solution/Mon-
itors/Report Plots tree branch.

f. Modify the attributes of the dpm-mass-in-domain-rplot report plot axes (in a manner similar to that
for the dpm-mass-source-rplot plot).

Solution → Monitors → Report Plots → dpm-mass-in-domain-rplot Edit...

i. In the Plot Window group box, click the Axes... button to open the Axes dialog box.

ii. Select Y in the Axis list.

iii. Select exponential from the Type drop-down list.

iv. Set Precision to 2.

v. Click Apply and close the Axes dialog box.

vi. Click OK to close the Edit Report Plot dialog box.

6. Create a DPM report definition for tracking the mass of the evaporated particles.

Solving → Reports → Definitions → New → DPM Report → Evaporated Mass...
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a. Enter dpm-evaporated-mass for Name.

b. In the Create group box, enable Report Plot and Print to Console.

c. Select injection-0 from the Injections selection list.

d. Ensure that the Show Mass Flow / Change Rate option is selected.

e. Click OK to save the volume report definition settings and close the DPM Report Definition dialog
box.

Fluent automatically generates the dpm-evaporated-mass-rplot report plot under Solution/Mon-
itors/Report Plots tree branch.

f. Modify the attributes of the dpm-evaporated-mass-rplot report plot axes in a manner similar to that
for the dpm-mass-source-rplot plot.

7. Request 300 more iterations (Figure 16.6: Convergence History of Mass Fraction of ch3oh on Fluid (p. 699),
Figure 16.7: Convergence History of DPM Mass Source on Fluid (p. 700), Figure 16.8: Convergence History
of Total Mass in Domain (p. 700), and Figure 16.9: Convergence History of Evaporated Particle Mass (p. 701)).

Solving → Run Calculation

It can be concluded that the solution is converged because the number of particle tracks are constant
and the flow variable plots are flat.

Figure 16.6:  Convergence History of Mass Fraction of ch3oh on Fluid
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Figure 16.7:  Convergence History of DPM Mass Source on Fluid

Figure 16.8:  Convergence History of Total Mass in Domain
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Figure 16.9:  Convergence History of Evaporated Particle Mass

8. Save the case and data files (spray2.cas.gz and spray2.dat.gz).

File → Write → Case & Data...

16.4.10. Postprocessing

1. Display the trajectories of the droplets in the spray injection (Figure 16.10: Particle Tracks for the Spray In-
jection (p. 703)).

This will allow you to review the location of the droplets.

Postprocessing → Graphics → Particle Tracks → Edit...
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a. Enable Draw Mesh in the Options group box.

The Mesh Display dialog box will open.

i. Retain the current display settings.

ii. Close the Mesh Display dialog box.

b. Retain the default selection of point from the Track Style drop-down list.

c. Select Particle Variables... and Particle Diameter from the Color by drop-down lists.

This will display the location of the droplets colored by their diameters.

d. Select injection-0 from the Release from Injections selection list.

e. Click Display. As an optional exercise, you can increase the particle size by clicking the Attributes... button
in the Particle Tracks dialog box and adjusting the Marker Size value in the Track Style Attributes dialog
box.

f. Close the Particle Tracks dialog box.

g. Restore the 30–degree section to obtain the view as shown in Figure 16.10: Particle Tracks for the Spray
Injection (p. 703).

Viewing → Display → Views...

i. Click the Define... button to open the Graphics Periodicity dialog box.

ii. Click Reset and close the Graphics Periodicity dialog box.
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iii. Close the Views dialog box.

h. Use the mouse to obtain the view shown in Figure 16.10: Particle Tracks for the Spray Injection (p. 703).

Figure 16.10:  Particle Tracks for the Spray Injection

The air-blast atomizer model assumes that a cylindrical liquid sheet exits the atomizer, which then disin-
tegrates into ligaments and droplets. Appropriately, the model determines that the droplets should be
input into the domain in a ring. The radius of this disk is determined from the inner and outer radii of
the injector.

Note

The maximum diameter of the droplets is about 10–4  m or 0.1 mm. This is slightly smaller
than the film height. The inner diameter and outer diameter of the injector are 3.5 mm
and 4.5 mm, respectively. Hence the film height is 0.5 mm. The range in the droplet sizes
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is due to the fact that the air-blast atomizer automatically uses a distribution of droplet
sizes.

Also note that the droplets are placed a slight distance away from the injector. Once the
droplets are injected into the domain, their behavior will be determined by secondary
models. For instance, they may collide/coalesce with other droplets depending on the
secondary models employed. However, once a droplet has been introduced into the do-
main, the air-blast atomizer model no longer affects the droplet.

2. Display the mean particle temperature field (Figure 16.11: Contours of DPM Temperature (p. 705)).

Postprocessing → Graphics → Contours → Edit...

a. Ensure that Filled is enabled in the Options group box

b. Disable Draw Mesh.

c. Select Discrete Phase Variables... and DPM Temperature from the Contours of drop-down lists.

d. Disable Auto Range.

The Clip to Range option will automatically be enabled.

e. Click Compute to update the Min and Max fields.

f. Enter 260 for Min.

g. Select angle=15 from the Surfaces selection list.
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h. Click Display and close the Contours dialog box.

i. Use the mouse to obtain the view shown in Figure 16.11: Contours of DPM Temperature (p. 705).

Figure 16.11:  Contours of DPM Temperature

3. Display the mean Sauter diameter (Figure 16.12: Contours of DPM Sauter Diameter (p. 706)).

Postprocessing → Graphics → Contours → Edit...

a. Enable Autorange in the Options group box.

b. Select Discrete Phase Variables... and DPM D32 from the Contours of drop-down lists.

c. Select angle=15 from the Surfaces selection list.

d. Click Display and close the Contours dialog box.
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Figure 16.12:  Contours of DPM Sauter Diameter

4. Display vectors of DPM mean velocity colored by DPM velocity magnitude (Figure 16.13: Vectors of DPM
Mean Velocity Colored by DPM Velocity Magnitude (p. 708)).

Postprocessing → Graphics → Vectors → Edit...
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a. Select dpm-mean-velocity from the Vectors of drop-down lists.

b. Select Discrete Phase Variables... and DPM Velocity Magnitude from the Color by drop-down lists.

c. Enter 7 for Scale.

d. Select angle=15 from the Surfaces selection list.

e. Click Display and close the Contours dialog box.
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Figure 16.13: Vectors of DPM Mean Velocity Colored by DPM Velocity Magnitude

5. Create an isosurface of the methanol mass fraction.

Postprocessing → Surface → Create → Iso-Surface...
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a. Select Species... and Mass fraction of ch3oh from the Surface of Constant drop-down lists.

b. Click Compute to update the minimum and maximum values.

c. Enter 0.002 for Iso-Values.

d. Enter methanol-mf=0.002 for the New Surface Name.

e. Click Create and then close the Iso-Surface dialog box.

6. Display the isosurface you just created (methanol-mf=0.002).

Postprocessing → Graphics → Mesh → Edit...

a. Deselect atomizer-wall and select methanol-mf=0.002 in the Surfaces selection list.
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b. Click the Colors... button to open the Mesh Colors dialog box.

i. Select surface in the Types list and green in the Colors list.

Scroll down the Types list to locate surface. The isosurface will now be displayed in green, which
contrasts better with the rest of the mesh.

ii. Close the Mesh Colors dialog box.

c. Click Display in the Mesh Display dialog box.

The graphics display will be updated to show the isosurface.

7. Modify the view to include the entire atomizer.

Viewing → Display → Views...

a. Click Define... to open the Graphics Periodicity dialog box.
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i. Select fluid from the Cell Zones list.

ii. Ensure that Rotational is selected from the Periodic Type list and the Number of Repeats is set
to 12.

iii. Click Set and close the Graphics Periodicity dialog box.

b. Click Apply and close the Views dialog box.

c. Click Display and close the Mesh Display dialog box.

d. Use the mouse to obtain the view shown in Figure 16.14: Full Atomizer Display with Surface of Constant
Methanol Mass Fraction (p. 711).

Figure 16.14:  Full Atomizer Display with Surface of Constant Methanol Mass Fraction

e. This view can be improved to resemble Figure 16.15: Atomizer Display with Surface of Constant Meth-
anol Mass Fraction Enhanced (p. 712) by changing some of the following variables:
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• Disable Edges in the Mesh Display dialog box

• Select only atomizer-wall and methanol-mf=0.002 in the Surfaces list of the Mesh Display
dialog box

• Change the Number of Repeats to 6 in the Graphics Periodicity dialog box

• Enable Lighting and change it to Flat in the Viewing tab (Display group)

• Enable Headlight check in the Viewing tab (Display group)

Figure 16.15:  Atomizer Display with Surface of Constant Methanol Mass Fraction Enhanced

8. Save the case and data files (spray3.cas.gz and spray3.dat.gz).

File → Write → Case & Data...
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16.5. Summary

In this tutorial, a spray injection was defined for an air-blast atomizer and the solution was calculated
using the discrete phase model in ANSYS Fluent. The location of methanol droplet particles after exiting
the atomizer and an isosurface of the methanol mass fraction were examined.

16.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 17: Using the VOF Model

This tutorial is divided into the following sections:
17.1. Introduction
17.2. Prerequisites
17.3. Problem Description
17.4. Setup and Solution
17.5. Summary
17.6. Further Improvements

17.1. Introduction

This tutorial examines the flow of ink as it is ejected from the nozzle of a printhead in an inkjet printer.
Using ANSYS Fluent’s volume of fluid (VOF) multiphase modeling capability, you will be able to predict
the shape and motion of the resulting droplets in an air chamber.

This tutorial demonstrates how to do the following:

• Set up and solve a transient problem using the pressure-based solver and VOF model.

• Copy material from the property database.

• Define time-dependent boundary conditions with a user-defined function (UDF).

• Patch initial conditions in a subset of the domain.

• Automatically save data files at defined points during the solution.

• Examine the flow and interface of the two fluids using volume fraction contours.

17.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.
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17.3. Problem Description

The problem considers the transient tracking of a liquid-gas interface in the geometry shown in Fig-
ure 17.1: Schematic of the Problem (p. 716). The axial symmetry of the problem enables a 2D geometry
to be used. The computation mesh consists of 24,600 cells. The domain consists of two regions: an ink
chamber and an air chamber. The dimensions are summarized in Table 17.1: Ink Chamber Dimen-
sions (p. 716).

Figure 17.1:  Schematic of the Problem

Table 17.1:  Ink Chamber Dimensions

0.015Ink Chamber, Cylindrical Region: Radius (mm)

0.050Ink Chamber, Cylindrical Region: Length (mm)

0.009Ink Chamber, Tapered Region: Final Radius (mm)
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0.050Ink Chamber, Tapered Region: Length (mm)

0.030Air Chamber: Radius (mm)

0.280Air Chamber: Length (mm)

The following is the chronology of events modeled in this simulation:

• At time zero, the nozzle is filled with ink, while the rest of the domain is filled with air. Both fluids are assumed
to be at rest. To initiate the ejection, the ink velocity at the inlet boundary (which is modeled in this simulation
by a user-defined function) suddenly increases from 0 to 3.58 m/s and then decreases according to a cosine
law.

• After 10 microseconds, the velocity returns to zero.

The calculation is run for 30 microseconds overall, that is, three times longer than the duration of the
initial impulse.

Because the dimensions are small, the double-precision version of ANSYS Fluent will be used. Air will
be designated as the primary phase, and ink (which will be modeled with the properties of liquid water)
will be designated as the secondary phase. Patching will be required to fill the ink chamber with the
secondary phase. Gravity will not be included in the simulation. To capture the capillary effect of the
ejected ink, the surface tension and prescription of the wetting angle will be specified. The surface inside
the nozzle will be modeled as neutrally wettable, while the surface surrounding the nozzle orifice will
be non-wettable.

17.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
17.4.1. Preparation
17.4.2. Reading and Manipulating the Mesh
17.4.3. General Settings
17.4.4. Models
17.4.5. Materials
17.4.6. Phases
17.4.7. Operating Conditions
17.4.8. User-Defined Function (UDF)
17.4.9. Boundary Conditions
17.4.10. Solution
17.4.11. Postprocessing

17.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.
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3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the vof_R180.zip link to download the input files.

7. Unzip vof_R180.zip file you downloaded to your working folder.

The files inkjet.msh and inlet1.c can be found in the vof directory created on unzipping the
file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Enable Double-Precision.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

Note

The double precision solver is recommended for modeling multiphase flows simulation.

11. Ensure that the Serial processing option is selected.

17.4.2. Reading and Manipulating the Mesh

1. Read the mesh file inkjet.msh.

File → Read → Mesh...

A warning message will be displayed twice in the console. You need not take any action at this point,
as the issue will be resolved when you define the solver settings in General Settings (p. 723).

2. Examine the mesh (Figure 17.2: Default Display of the Nozzle Mesh (p. 719)).
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Figure 17.2:  Default Display of the Nozzle Mesh

Tip

By zooming in with the middle mouse button, you can see that the interior of the model
is composed of a fine mesh of quadrilateral cells (see Figure 17.3: The Quadrilateral
Mesh (p. 720)).
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Figure 17.3: The Quadrilateral Mesh

3. Set graphics display options

Viewing → Display → Options...
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a. Ensure that All is selected from the Animation Option drop-down list.

Selecting All will allow you to see the movement of the entire mesh as you manipulate the Camera
view in the next step.

4. Click Apply and close the Display Options dialog box.

5. Manipulate the mesh display to show the full chamber upright.

Viewing → Display → Views...
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a. Select front from the Views selection list.

b. Select axis from the Mirror Planes selection list.

c. Click Apply.

The mesh display is updated to show both sides of the chamber.

d. Click the Camera... button to open the Camera Parameters dialog box.

Note

You may notice that the scale of the dimensions in the Camera Parameters dialog
box appear very large given the problem dimensions. This is because you have not
yet scaled the mesh to the correct units. You will do this in a later step.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.722

Using the VOF Model



i. Drag the indicator of the dial with the left mouse button in the clockwise direction until the upright
view is displayed (Figure 17.4: Mesh Display of the Nozzle Mirrored and Upright (p. 723)).

Figure 17.4:  Mesh Display of the Nozzle Mirrored and Upright

ii. Close the Camera Parameters dialog box.

e. Close the Views dialog box.

17.4.3. General Settings

1. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and report the progress in the console. Make sure
that the reported minimum volume is a positive number.

2. Scale the mesh.

Setting Up Domain → Mesh → Scale...
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a. Select Specify Scaling Factors from the Scaling group box.

b. Enter 1e-6 for X and Y in the Scaling Factors group box.

c. Click Scale and close the Scale Mesh dialog box.

3. Check the mesh.

Setting Up Domain → Mesh → Check

Note

It is a good idea to check the mesh after you manipulate it (that is, scale, convert to
polyhedra, merge, separate, fuse, add zones, or smooth and swap.) This will ensure that
the quality of the mesh has not been compromised.

4. Define the units for the mesh.

Setting Up Domain → Mesh → Units...
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a. Select length from the Quantities list.

b. Select mm from the Units list.

c. Select surface-tension from the Quantities list.

d. Select dyn/cm from the Units list.

e. Close the Set Units dialog box.

5. Retain the default setting of Pressure-Based in the Solver group box of the Setting Up Physics ribbon
tab.

Setting Up Physics → Solver

6. Select Transient from the Time list.

7. Select Axisymmetric from the drop-down list in the Solver group box (below Reference Values).

17.4.4. Models

1. Enable the Volume of Fluid multiphase model.

Setting Up Physics → Models → Multiphase...
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a. Select Volume of Fluid from the Model list.

The Multiphase Model dialog box expands to show related inputs.

b. Retain the default settings and click OK to close the Multiphase Model dialog box.

17.4.5. Materials

The default properties of air and water defined in ANSYS Fluent are suitable for this problem. In this step,
you will make sure that both materials are available for selection in later steps.

1. Add water to the list of fluid materials by copying it from the ANSYS Fluent materials database.

Setting Up Physics → Materials → Create/Edit...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.726

Using the VOF Model



a. Click Fluent Database... in the Create/Edit Materials dialog box to open the Fluent Database Mater-
ials dialog box.

i. Select water-liquid (h2o < l >) from the Fluent Fluid Materials selection list.
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Scroll down the Fluent Fluid Materials list to locate water-liquid (h2o < l >).

ii. Click Copy to copy the information for water to your list of fluid materials.

iii. Close the Fluent Database Materials dialog box.

b. Click Change/Create and close the Create/Edit Materials dialog box.

17.4.6. Phases

In the following steps, you will define water as the secondary phase. When you define the initial solution,
you will patch water in the nozzle region. In general, you can specify the primary and secondary phases
whichever way you prefer. It is a good idea to consider how your choice will affect the ease of problem setup,
especially with more complicated problems.

Setting Up Physics → Phases → List/Show All...

1. Specify air (air) as the primary phase.

In the Phases dialog box, select phase 1 – Primary Phase and click Edit... to open the Primary
Phase dialog box.
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a. Enter air for Name.

b. Retain the default selection of air in the Phase Material drop-down list.

c. Click OK to close the Primary Phase dialog box.

2. Specify water (water-liquid) as the secondary phase.

In the Phases dialog box, select phase 2 – Secondary Phase and click Edit... to open the Secondary
Phase dialog box.

a. Enter water-liquid for Name.

b. Select water-liquid from the Phase Material drop-down list.

c. Click OK to close the Secondary Phase dialog box.

3. Specify the interphase interaction.

In the Phases dialog box, click Interaction... to open the Phase Interaction dialog box.
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a. Click the Surface Tension tab.

b. Enable Surface Tension Force Modeling.

The surface tension inputs is displayed and the Continuum Surface Force model is set as the default.

c. Enable Wall Adhesion so that contact angles can be prescribed.

d. Select constant from the Surface Tension Coefficient drop-down list.

e. Enter 73.5 dyn/cm for Surface Tension Coefficient.

f. Click OK to close the Phase Interaction dialog box.

4. Close the Phases dialog box.

17.4.7. Operating Conditions

1. Set the operating reference pressure location.

Setup  → Boundary Conditions → Operating Conditions...
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You will set the Reference Pressure Location to be a point where the fluid will always be 100  air.

a. Enter 0.10 mm for X.

b. Enter 0.03 mm for Y.

c. Click OK to close the Operating Conditions dialog box.

17.4.8. User-Defined Function (UDF)

1. Interpret the UDF source file for the ink velocity distribution (inlet1.c).

User Defined → User Defined → Functions → Interpreted...

a. Enter inlet1.c for Source File Name.

If the UDF source file is not in your working directory, then you must enter the entire directory path
for Source File Name instead of just entering the file name. Alternatively, click the Browse... button
and select inlet1.c in the vof directory that was created after you unzipped the original file.

b. Click Interpret.

731
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



The UDF defined in inlet1.c is now visible and available for selection as udf membrane_speed in the
drop-down lists of relevant graphical user interface dialog boxes.

c. Close the Interpreted UDFs dialog box.

17.4.9. Boundary Conditions

1. Set the boundary conditions at the inlet (inlet) for the mixture by selecting mixture from the Phase drop-
down list in the Boundary Conditions task page.

Setup → Boundary Conditions → inlet Edit...

a. Select udf membrane_speed from the Velocity Magnitude drop-down list.

b. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions at the inlet (inlet) for the secondary phase by selecting water-liquid from
the Phase drop-down list in the Boundary Conditions task page.

Setup  → Boundary Conditions → inlet → water-liquid Edit...

a. Click the Multiphase tab and enter 1 for the Volume Fraction.
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b. Click OK to close the Velocity Inlet dialog box.

3. Set the boundary conditions at the outlet (outlet) for the secondary phase by selecting water-liquid from
the Phase drop-down list in the Boundary Conditions task page.

Setup → Boundary Conditions → outlet → water-liquid Edit...

a. Click the Multiphase tab and retain the default setting of 0 for the Backflow Volume Fraction.

b. Click OK to close the Pressure Outlet dialog box.

4. Set the conditions at the top wall of the air chamber (wall_no_wet) for the mixture by selecting mixture
from the Phase drop-down list in the Boundary Conditions task page.

Setup → Boundary Conditions → wall_no_wet Edit...
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a. Enter 175 degrees for Contact Angles.

b. Click OK to close the Wall dialog box.

Note

This angle affects the dynamics of droplet formation. You can repeat this simulation
to find out how the result changes when the wall is hydrophilic (that is, using a small
contact angle, say 10 degrees).

5. Set the conditions at the side wall of the ink chamber (wall_wet) for the mixture.

Setup → Boundary Conditions → wall_wet Edit...
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a. Retain the default setting of 90 degrees for Contact Angles.

b. Click OK to close the Wall dialog box.

17.4.10. Solution

1. Set the solution methods.

Solving → Solution → Methods...
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a. Enable Non-Iterative Time Advancement.

The non-iterative time advancement (NITA) scheme is often advantageous compared to the iterative
schemes as it is less CPU intensive. Although smaller time steps must be used with NITA compared
to the iterative schemes, the total CPU expense is often smaller. If the NITA scheme leads to convergence
difficulties, then the iterative schemes (for example, PISO, SIMPLE) should be used instead.

b. Select Fractional Step from the Scheme drop-down list in the Pressure-Velocity Coupling group
box.

c. Retain the default selection of Least Squares Cell Based from the Gradient drop-down list in the
Spatial Discretization group box.

d. Retain the default selection of PRESTO! from the Pressure drop-down list.

e. Select QUICK from the Momentum drop-down list.

f. Select Compressive from the Volume-Fraction drop-down list.

2. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure Plot is selected in the Options group box.

b. Click OK to close the Residual Monitors dialog box.

3. Initialize the solution after reviewing the default initial values.

Solving → Initialization → Options...
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a. Retain the default settings for all the parameters and click Initialize (either in the ribbon or in the
Solution Initialization task page.

4. Define a register for the ink chamber region.

Setting Up Domain → Adapt → Mark/Adapt Cells → Region...
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a. Retain the default setting of 0 mm for X Min and Y Min in the Input Coordinates group box.

b. Enter 0.10 mm for X Max.

c. Enter 0.03 mm for Y Max.

d. Click Mark.

ANSYS Fluent will report in the console that 1500 cells were marked for refinement while zero cells
were marked for coarsening.

Tip

You can display and manipulate adaption registers, which are generated using the
Mark command, using the Manage Adaption Registers dialog box. Click the Man-
age... button in the Region Adaption dialog box to open the Manage Adaption
Registers dialog box. For details, see Adapting the Mesh (p. 174).

e. Close the Region Adaption dialog box.

5. Patch the initial distribution of the secondary phase (water-liquid).

Solving → Initialization → Patch...
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a. Select water-liquid from the Phase drop-down list.

b. Select Volume Fraction from the Variable list.

c. Enter 1 for Value.

d. Select hexahedron-r0 from the Registers to Patch selection list.

e. Click Patch and close the Patch dialog box.

6. Request the saving of data files every 200 steps.

Solving → Activities → Autosave...
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a. Enter 200 for Save Data File Every (Time Steps).

b. Ensure that time-step is selected from the Append File Name with drop-down list.

c. Enter inkjet for the File Name.

ANSYS Fluent will append the time step value to the file name prefix (inkjet). The standard .dat
extension will also be appended. This will yield file names of the form inkjet-1-00200.dat,
where 200 is the time step number.

Optionally, you can add the extension .gz to the end of the file name (for example, inkjet.gz),
which instructs ANSYS Fluent to save the data files in a compressed format, yielding file names of the
form inkjet-1-00200.dat.gz.

d. Click OK to close the Autosave dialog box.

7. Save the initial case file (inkjet.cas.gz).

File → Write → Case...

8. Run the calculation.

Solving → Run Calculation
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a. Enter 1.0e-8 seconds for the Time Step Size (s).

Note

Small time steps are required to capture the oscillation of the droplet interface and
the associated high velocities. Failure to use sufficiently small time steps may cause
differences in the results between platforms.

b. Enter 3000 for the Number of Time Steps.

c. Click Calculate.

The solution will run for 3000 iterations.

17.4.11. Postprocessing

1. Read the data file for the solution after 6 microseconds (inkjet-1-00600.dat.gz).

File → Read → Data...

2. Create and display a filled contour of water volume fraction after 6 microseconds (Figure 17.5: Contours
of Water Volume Fraction After 6 μs (p. 744)).

Postprocessing → Graphics → Contours → New...
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a. Change the Contour Name to contour-volume-fraction.

b. Enable Filled in the Options group box.

c. Select Phases... and Volume fraction from the Contours of drop-down lists.

d. Select water-liquid from the Phase drop-down list.

e. Click Save/Display.

Tip

In order to display the contour plot in the graphics window, you may need to click the

Fit to Window button.

3. Display contours of water volume fraction after 12, 18, 24, and 30 microseconds (Figure 17.6: Contours of
Water Volume Fraction After 12 μs (p. 744) — Figure 17.9: Contours of Water Volume Fraction After 30
μs (p. 746)).

a. Read the data file for the solution after 12 microseconds (inkjet-1-01200.dat.gz).

File → Read → Data...

b. Reload the contour graphic saved in the previous step.

Results → Graphics → Contours → contour-volume-fraction Display

c. Repeat these steps for the 18, 24, and 30 microseconds files.
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Figure 17.5:  Contours of Water Volume Fraction After 6 μs

Figure 17.6:  Contours of Water Volume Fraction After 12 μs
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Figure 17.7:  Contours of Water Volume Fraction After 18 μs

Figure 17.8:  Contours of Water Volume Fraction After 24 μs
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Figure 17.9:  Contours of Water Volume Fraction After 30 μs

17.5. Summary

This tutorial demonstrated the application of the volume of fluid method with surface tension effects.
The problem involved the 2D axisymmetric modeling of a transient liquid-gas interface, and postpro-
cessing showed how the position and shape of the surface between the two immiscible fluids changed
over time.

For additional details about VOF multiphase flow modeling, see the Fluent Theory Guide.

17.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 18: Modeling Cavitation

This tutorial is divided into the following sections:
18.1. Introduction
18.2. Prerequisites
18.3. Problem Description
18.4. Setup and Solution
18.5. Summary
18.6. Further Improvements

18.1. Introduction

This tutorial examines the pressure-driven cavitating flow of water through a sharp-edged orifice. This
is a typical configuration in fuel injectors, and brings a challenge to the physics and numerics of cavit-
ation models because of the high pressure differentials involved and the high ratio of liquid to vapor
density. Using the multiphase modeling capability of ANSYS Fluent, you will be able to predict the
strong cavitation near the orifice after flow separation at a sharp edge.

This tutorial demonstrates how to do the following:

• Set boundary conditions for internal flow.

• Use the mixture model with cavitation effects.

• Calculate a solution using the pressure-based coupled solver.

18.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

18.3. Problem Description

The problem considers the cavitation caused by the flow separation after a sharp-edged orifice. The

flow is pressure driven, with an inlet pressure of 5 x 105 Pa and an outlet pressure of 9.5 x 104 Pa. The

orifice diameter is 4 x 10–3 m, and the geometrical parameters of the orifice are D/d = 2.88 and L/d =
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4, where D, d, and L are the inlet diameter, orifice diameter, and orifice length respectively. The geometry
of the orifice is shown in Figure 18.1: Problem Schematic (p. 748).

Figure 18.1:  Problem Schematic

18.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
18.4.1. Preparation
18.4.2. Reading and Checking the Mesh
18.4.3. Solver Settings
18.4.4. Models
18.4.5. Materials
18.4.6. Phases
18.4.7. Boundary Conditions
18.4.8. Operating Conditions
18.4.9. Solution
18.4.10. Postprocessing

18.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.
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6. Click the cavitation_R180.zip link to download the input files.

7. Unzip the cavitation_R180.zip file you downloaded to your working folder.

The mesh file cav.msh can be found in the cavitation directory created after unzipping the file.

8. Use the Fluent Launcher to start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

11. Enable Double Precision.

Note

The double precision solver is recommended for modeling multiphase flows simulation.

18.4.2. Reading and Checking the Mesh

1. Read the mesh file cav.msh.

File → Read → Mesh...

As ANSYS Fluent reads the mesh file, it will report the progress in the console. You can disregard the
warnings about the use of axis boundary conditions, as you will make the appropriate change to the
solver settings in the next step.

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure
that the reported minimum volume is a positive number.

3. Check the mesh scale.

Setting Up Domain → Mesh → Transform → Scale...
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a. Retain the default settings.

b. Close the Scale Mesh dialog box.

4. Examine the mesh (Figure 18.2: The Mesh in the Orifice (p. 751)).
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Figure 18.2: The Mesh in the Orifice

As seen in Figure 18.2: The Mesh in the Orifice (p. 751), half of the problem geometry is modeled, with an
axis boundary (consisting of two separate lines) at the centerline. The quadrilateral mesh is slightly graded
in the plenum to be finer toward the orifice. In the orifice, the mesh is uniform with aspect ratios close
to , as the flow is expected to exhibit two-dimensional gradients.

When you display data graphically in a later step, you will mirror the view across the centerline to obtain
a more realistic view of the model.

Since the bubbles are small and the flow is high speed, gravity effects can be neglected and the problem
can be reduced to axisymmetrical. If gravity could not be neglected and the direction of gravity were not
coincident with the geometrical axis of symmetry, you would have to solve a 3D problem.

18.4.3. Solver Settings

1. Specify an axisymmetric model.

751
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Seup → General

a. Retain the default selection of Pressure-Based in the Type list.

The pressure-based solver must be used for multiphase calculations.

b. Select Axisymmetric in the 2D Space list.

Note

A computationally intensive, transient calculation is necessary to accurately simulate the
irregular cyclic process of bubble formation, growth, filling by water jet re-entry, and
break-off. In this tutorial, you will perform a steady-state calculation to simulate the
presence of vapor in the separation region in the time-averaged flow.

18.4.4. Models

1. Enable the multiphase mixture model.

Setting Up Physics → Models → Multiphase...
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a. Select Mixture in the Model list.

The Multiphase Model dialog box will expand.

b. Clear Slip Velocity in the Mixture Parameters group box.

In this flow, the high level of turbulence does not allow large bubble growth, so gravity is not important.
It is also assumed that the bubbles have same velocity as the liquid. Therefore, there is no need to
solve for the slip velocity.

c. Click OK to close the Multiphase Model dialog box.

2. Enable the realizable -  turbulence model with standard wall functions.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon (2 eqn) in the Model list.

b. Select Realizable in the k-epsilon Model list.

c. Retain the default of Standard Wall Functions in the Near-Wall Treatment list.

d. Click OK to close the Viscous Model dialog box.

18.4.5. Materials

For the purposes of this tutorial, you will be modeling the liquid and vapor phases as incompressible.
Note that more comprehensive models are available for the densities of these phases, and could be
used to more fully capture the affects of the pressure changes in this problem.

1. Create a new material to be used for the primary phase.

Setup → Materials → Fluid  New...
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a. Enter water for Name.

b. Enter 1000 kg/m3 for Density.

c. Enter 0.001 kg/m–s for Viscosity.

d. Click Change/Create.

A Question dialog box will open, asking if you want to overwrite air. Click Yes.

2. Copy water vapor from the materials database and modify the properties of your local copy.

a. In the Create/Edit Materials dialog box, click the Fluent Database... button to open the Fluent
Database Materials dialog box.
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i. Select water-vapor (h2o) from the Fluent Fluid Materials selection list.

Scroll down the list to find water-vapor (h2o).

ii. Click Copy to include water vapor in your model.

water-vapor appears under Fluid in the Materials task page

iii. Close the Fluent Database Materials dialog box.
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b. Enter 0.02558 kg/m3 for Density.

c. Enter 1.26e-06 kg/m–s for Viscosity.

d. Click Change/Create and close the Create/Edit Materials dialog box.

18.4.6. Phases

Setup → Models → Multiphase (Mixture) → Phases Edit...
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1. Specify liquid water as the primary phase.

a. In the Phases dialog box, select phase 1 – Primary Phase and click Edit... to open the Primary Phase
dialog box.

b. Enter liquid for Name.

c. Retain the default selection of water from the Phase Material drop-down list.

d. Click OK to close the Primary Phase dialog box.

2. Specify water vapor as the secondary phase.

a. In the Phases dialog box, select phase 2 – Secondary Phase and click Edit... to open the Secondary
Phase dialog box.
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b. Enter vapor for Name.

c. Select water-vapor from the Phase Material drop-down list.

d. Click OK to close the Secondary Phase dialog box.

3. Enable the cavitation model.

a. In the Phases dialog box, click Interaction... to open the Phase Interaction dialog box.

b. In the Mass tab, set Number of Mass Transfer Mechanisms to 1.

The dialog box expands to show relevant modeling parameters.

c. Click OK in the dialog box that appears.

d. Ensure that liquid is selected from the From Phase drop-down list in the Mass Transfer group box.

e. Select vapor from the To Phase drop-down list.

f. Select cavitation from the Mechanism drop-down list.

The Cavitation Model dialog box will open to show the cavitation inputs.
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i. Retain the default settings.

ii. Retain the value of 3540 Pa for Vaporization Pressure.

The vaporization pressure is a property of the working liquid, which depends mainly on the tem-
perature and pressure. The default value is the vaporization pressure of water at 1 atmosphere
and a temperature of 300 K.

iii. Click OK to close the Cavitation Model dialog box.

g. Click OK to close the Phase Interaction dialog box.

4. Close the Phases dialog box.

18.4.7. Boundary Conditions

For the multiphase mixture model, you will specify conditions for the mixture (that is, conditions that apply
to all phases) and the conditions that are specific to the primary and secondary phases. In this tutorial,
boundary conditions are required only for the mixture and secondary phase of two boundaries: the pressure
inlet (consisting of two boundary zones) and the pressure outlet. The pressure outlet is the downstream
boundary, opposite the pressure inlets.

Setup → Boundary Conditions
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1. Set the boundary conditions at inlet_1 for the mixture. Ensure that mixture is selected from the Phase
drop-down list in the Boundary Conditions task page.

Setup → Boundary Conditions → inlet_1 → Edit...
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a. Enter 500000 Pa for Gauge Total Pressure.

b. Enter 449000 Pa for Supersonic/Initial Gauge Pressure.

If you choose to initialize the solution based on the pressure-inlet conditions, the Supersonic/Initial
Gauge Pressure will be used in conjunction with the specified stagnation pressure (the Gauge Total
Pressure) to compute initial values according to the isentropic relations (for compressible flow) or
Bernoulli’s equation (for incompressible flow). Otherwise, in an incompressible flow calculation, ANSYS
Fluent will ignore the Supersonic/Initial Gauge Pressure input.

c. Retain the default selection of Normal to Boundary from the Direction Specification Method drop-
down list.

d. Select K and Epsilon from the Specification Method drop-down list in the Turbulence group box.

e. Enter 0.02 m2/s2 for Turbulent Kinetic Energy.

f. Retain the value of 1 m2/s3 for Turbulent Dissipation Rate.

g. Click OK to close the Pressure Inlet dialog box.

2. Set the boundary conditions at inlet-1 for the secondary phase.

Setup → Boundary Conditions → inlet_1

a. Select vapor from the Phase drop-down list.

b. Click Edit... to open the Pressure Inlet dialog box.
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i. In the Multiphase tab, retain the default value of 0 for Volume Fraction.

ii. Click OK to close the Pressure Inlet dialog box.

3. Copy the boundary conditions defined for the first pressure inlet zone (inlet_1) to the second pressure
inlet zone (inlet_2).

Setup → Boundary Conditions → inlet_1

a. Select mixture from the Phase drop-down list.

b. Click Copy... to open the Copy Conditions dialog box.

i. Select inlet_1 from the From Boundary Zone selection list.

ii. Select inlet_2 from the To Boundary Zones selection list.

iii. Click Copy.

A Question dialog box will open, asking if you want to copy inlet_1 boundary conditions to in-
let_2. Click OK.
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iv. Close the Copy Conditions dialog box.

4. Set the boundary conditions at outlet for the mixture.

Setup → Boundary Conditions → outlet → Edit...

a. Enter 95000  for Gauge Pressure.

b. Select K and Epsilon from the Specification Method drop-down list in the Turbulence group box.

c. Enter 0.02 m2/s2 for Backflow Turbulent Kinetic Energy.

d. Retain the value of 1 m2/s3 for Backflow Turbulent Dissipation Rate.

e. Click OK to close the Pressure Outlet dialog box.

5. Set the boundary conditions at outlet for the secondary phase.

Setup → Boundary Conditions → outlet

a. Select vapor from the Phase drop-down list.

b. Click Edit... to open the Pressure Outlet dialog box.
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i. In the Multiphase tab, retain the default value of 0 for Backflow Volume Fraction.

ii. Click OK to close the Pressure Outlet dialog box.

18.4.8. Operating Conditions

1. Set the operating pressure.

Setup → Boundary Conditions → Operating Conditions...

a. Enter 0 Pa for Operating Pressure.

b. Click OK to close the Operating Conditions dialog box.

18.4.9. Solution

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Retain the selection of PRESTO! from the Pressure drop-down list in the Spatial Discretization group
box.

c. Select QUICK for Momentum and Volume Fraction.

d. Retain First Order Upwind for Turbulent Kinetic Energy and Turbulent Dissipation Rate.

e. Enable Pseudo Transient.

f. Enable High Order Term Relaxation.

The message appears in the console informing you of changing AMG cycle type for Volume Fraction,
Turbulent Kinetic Energy, and Turbulent Dissipation Rate to F-cycle.

The relaxation of high order terms will help to improve the solution behavior of flow simulations
when higher order spatial discretizations are used (higher than first).

2. Set the solution controls.
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Solving → Controls → Controls...

a. Set the pseudo transient explicit relaxation factor for Volume Fraction to 0.3.

3. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Enter 1e-05 for the Absolute Criteria of continuity, x-velocity, y-velocity, k, and epsilon.

Decreasing the criteria for these residuals will improve the accuracy of the solution.

c. Click OK to close the Residual Monitors dialog box.

4. Initialize the solution.

Solving → Initialization

a. Select Hybrid  initialization method from the Initialization group.

b. Click More Settings... to open the Hybrid Initialization dialog box.

c. Enable Use Specified Initial Pressure on Inlets in the Initialization Options group box. The velocity
will now be initialized to the Initial Gauge Pressure value that you set in the Pressure Inlet boundary
condition dialog box. For more information on initialization options, see hybrid initialization in the
Fluent User's Guide.

d. Click OK to close the Hybrid Initialization dialog box.
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e. Click Initialize to initialize the solution.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity
and pressure fields than standard initialization. This will help to improve the conver-
gence behavior of the solver.

5. Save the case file (cav.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 400 iterations.

Solving → Run Calculation → Advanced...

a. Enter 400 for Number of Iterations.

b. Click Calculate.

The solution will converge in approximately 340 iterations.

7. Save the data file (cav.dat.gz).
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File → Write → Data...

18.4.10. Postprocessing

1. Create and plot a definition of pressure contours in the orifice (Figure 18.3: Contours of Static Pres-
sure (p. 771)).

Postprocessing → Graphics → Contours → New...

a. Change Contour Name to contour-static-pressure

b. Enable Filled in the Options group box.

c. Retain the default selection of Pressure... and Static Pressure from the Contours of drop-down lists.

d. Click Save/Display and close the Contours dialog box.

The contour-static-pressure contour definition appears under the Results/Graphics/Con-
tours tree branch. Once you create a plot definition, you can use a right-click menu to display
this definition at a later time, for instance, in subsequent simulations with different settings ;or
in combination with other plot definitions.
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Figure 18.3:  Contours of Static Pressure

Note the dramatic pressure drop at the flow restriction in Figure 18.3: Contours of Static Pressure (p. 771).
Low static pressure is the major factor causing cavitation. Additionally, turbulence contributes to cavitation
due to the effect of pressure fluctuation (Figure 18.4: Mirrored View of Contours of Static Pressure (p. 773))
and turbulent diffusion (Figure 18.5: Contours of Turbulent Kinetic Energy (p. 774)).

2. Mirror the display across the centerline (Figure 18.4: Mirrored View of Contours of Static Pressure (p. 773)).

Viewing → Display → Views...

Mirroring the display across the centerline gives a more realistic view.
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a. Select symm_2 and symm_1 from the Mirror Planes selection list.

b. Click Apply and close the Views dialog box.
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Figure 18.4:  Mirrored View of Contours of Static Pressure

3. Create and plot a contour definition of the turbulent kinetic energy (Figure 18.5: Contours of Turbulent
Kinetic Energy (p. 774)).

Postprocessing → Graphics → Contours → New...

a. Change Contour Name to contour-tke

b. Enable Filled in the Options group box.

c. Select Turbulence... and Turbulent Kinetic Energy(k) from the Contours of drop-down lists.

d. Click Save/Display.
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Figure 18.5:  Contours of Turbulent Kinetic Energy

In this example, the mesh used is fairly coarse. However, in cavitating flows the pressure distribution is
the dominant factor, and is not very sensitive to mesh size.

4. Create and plot a contour definition of the volume fraction of water vapor (Figure 18.6: Contours of Vapor
Volume Fraction (p. 775)).

Postprocessing → Graphics → Contours → New...

a. Change Contour Name to contour-vf-vapor

b. Enable Filled in the Options group box.

c. Select Phases... and Volume fraction from the Contours of drop-down lists.

d. Select vapor from the Phase drop-down list.
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e. Click Save/Display and close the Contours dialog box.

Figure 18.6:  Contours of Vapor Volume Fraction

The high turbulent kinetic energy region near the neck of the orifice in Figure 18.5: Contours of Turbulent
Kinetic Energy (p. 774) coincides with the highest volume fraction of vapor in Figure 18.6: Contours of
Vapor Volume Fraction (p. 775). This indicates the correct prediction of a localized high phase change
rate. The vapor then gets convected downstream by the main flow.

18.5. Summary

This tutorial demonstrated how to set up and resolve a strongly cavitating pressure-driven flow through
an orifice, using multiphase mixture model of ANSYS Fluent with cavitation effects. You learned how
to set the boundary conditions for an internal flow. A steady-state solution was calculated to simulate
the formation of vapor in the neck of the flow after the section restriction at the orifice. A more compu-
tationally intensive transient calculation is necessary to accurately simulate the irregular cyclic process
of bubble formation, growth, filling by water jet re-entry, and break-off.
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18.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh.
Mesh adaption can also ensure that the solution is independent of the mesh. These steps are demon-
strated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 19: Using the Mixture and Eulerian Multiphase Models

This tutorial is divided into the following sections:
19.1. Introduction
19.2. Prerequisites
19.3. Problem Description
19.4. Setup and Solution
19.5. Summary
19.6. Further Improvements

19.1. Introduction

This tutorial examines the flow of water and air in a tee junction. Initially you will solve the problem
using the less computationally intensive mixture model. You will then switch to the more accurate Eu-
lerian model and compare the results of these two approaches.

This tutorial demonstrates how to do the following:

• Use the mixture model with slip velocities.

• Set boundary conditions for internal flow.

• Calculate a solution using the pressure-based coupled solver with the mixture model.

• Use the Eulerian model.

• Calculate a solution using the multiphase coupled solver with the Eulerian model.

• Display the results obtained using the two approaches for comparison.

19.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.
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19.3. Problem Description

This problem considers an air-water mixture flowing upwards in a duct and then splitting in a tee
junction. The ducts are 25 mm in width, the inlet section of the duct is 125 mm long, and the top and
the side ducts are 250 mm long. The schematic of the problem is shown in Figure 19.1: Problem Spe-
cification (p. 778).

Figure 19.1:  Problem Specification

19.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
19.4.1. Preparation
19.4.2. Mesh
19.4.3. General Settings
19.4.4. Models
19.4.5. Materials
19.4.6. Phases
19.4.7. Boundary Conditions
19.4.8. Operating Conditions
19.4.9. Solution Using the Mixture Model
19.4.10. Postprocessing for the Mixture Solution
19.4.11. Higher Order Solution using the Mixture Model
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19.4.12. Setup and Solution for the Eulerian Model
19.4.13. Postprocessing for the Eulerian Model

19.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the mix_eulerian_multiphase_R180.zip link to download the input files.

7. Unzip mix_eulerian_multiphase_R180.zip to your working folder.

The file tee.msh can be found in the mix_eulerian_multiphase folder created after unzipping
the file.

8. Use Fluent Launcher to enable Double Precision and start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Run in Serial under Processing Options.

Note

The double precision solver is recommended for modeling multiphase flow simulations.

19.4.2. Mesh

1. Read the mesh file tee.msh.
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File → Read → Mesh...

As ANSYS Fluent reads the mesh file, it will report the progress in the console.

19.4.3. General Settings

1. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Ensure
that the reported minimum volume is a positive number.

2. Examine the mesh (Figure 19.2: Mesh Display (p. 780)).

Extra

You can use the right mouse button to probe for mesh information in the graphics win-
dow. If you click the right mouse button on any node in the mesh, information will be
displayed in the ANSYS Fluent console about the associated zone, including the name of
the zone. This feature is especially useful when you have several zones of the same type
and you want to distinguish between them quickly.

Figure 19.2:  Mesh Display

3. Retain the default settings for the pressure-based solver.
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Setup → General

19.4.4. Models

1. Select the mixture multiphase model with slip velocities.

Setting Up Physics → Models → Multiphase...

a. Select Mixture in the Model list.

The Multiphase Model dialog box will expand to show the inputs for the mixture model.
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b. Ensure that Slip Velocity is enabled in the Mixture Parameters group box.

You need to solve the slip velocity equation because there will be significant difference in velocities
for the different phases.

c. Enable Implicit Body Force in the Body Force Formulation group box.

This treatment improves solution convergence by accounting for the partial equilibrium of the pressure
gradient and body forces in the momentum equations. It is used in VOF and mixture problems, where
body forces are large in comparison to viscous and convective forces.

d. Click OK to close the Multiphase Model dialog box.

2. Select the realizable -  turbulence model with standard wall functions.

Setting Up Physics → Models → Viscous...
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a. Select k-epsilon in the Model list.

b. Select Realizable under in the k-epsilon Model list.

The realizable -  model is recommended in cases where flow separation around sharp corners or
over bluff bodies can be expected.

c. Retain Standard Wall Functions in the Near-Wall Treatment list.

This problem does not require a particularly fine mesh, and standard wall functions will be used.

d. Click OK to close the Viscous Model dialog box.

19.4.5. Materials

1. Copy the properties for liquid water from the materials database so that it can be used for the primary
phase.
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Setup → Materials → Fluid → air Edit...

a. Click the Fluent Database... button to open the Fluent Database Materials dialog box.

i. Select water-liquid (h2o < l >) from the Fluent Fluid Materials selection list.

Scroll down the list to find water-liquid (h2o < l >).

ii. Click Copy to copy the properties for liquid water to your model.

iii. Close the Fluent Database Materials dialog box.

b. Close the Create/Edit Materials dialog box.

19.4.6. Phases

In the following steps you will define the liquid water and air phases that flow in the tee junction.
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1. Specify liquid water as the primary phase.

Setup → Models → Multiphase → Phases → phase-1 Edit...

a. Enter water for Name.

b. Select water-liquid from the Phase Material drop-down list.

c. Click OK to close the Primary Phase dialog box.

2. Specify air as the secondary phase.

Setup → Models → Multiphase → Phases → phase-2 Edit...
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a. Enter air for Name.

b. Retain the default selection of air from the Phase Material drop-down list.

c. Enter 0.001 m for Diameter.

d. Click OK to close the Secondary Phase dialog box.

3. Check that the drag coefficient is set to be calculated using the Schiller-Naumann drag law.

Setup → Models → Multiphase → Phases → Phases Interactions Edit...

a. Click the Drag tab.
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b. Retain the default selection of schiller-naumann from the Drag Coefficient drop-down list.

The Schiller-Naumann drag law describes the drag between the spherical particle and the surrounding
liquid for a wide range of conditions provided the bubbles remain approximately spherical. In this
case, the bubbles have a diameter of 1 mm which is within the spherical regime.

c. Click OK to close the Phase Interaction dialog box.

19.4.7. Boundary Conditions

For this problem, you need to set the boundary conditions for three boundaries: the velocity inlet and the
two outflows. Since this is a mixture multiphase model, you will set the conditions at the velocity inlet that
are specific for the mixture (conditions that apply to all phases) and also conditions that are specific to the
primary and secondary phases.

1. Set the boundary conditions at the velocity inlet (velocity-inlet-4) for the mixture.

Setup → Boundary Conditions → velocity-inlet-4 Edit...
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a. Retain the default selection of Intensity and Viscosity Ratio as the turbulence Specification Method.

b. Retain the default of 5 % for Turbulent Intensity.

c. Retain the default of 10 for Turbulent Viscosity Ratio.

d. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions at the velocity inlet (velocity-inlet-4) for the primary phase (water).

Setup → Boundary Conditions → velocity-inlet-4 → water Edit...

a. Retain the default selection of Magnitude, Normal to Boundary from the Velocity Specification
Method drop-down list.

b. Retain the default selection of Absolute from the Reference Frame drop-down list.

c. Enter 1.53 m/s for Velocity Magnitude.
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d. Click OK to close the Velocity Inlet dialog box.

Note

Note that you can also open the Velocity Inlet dialog box by double-clicking the
Setup/Boundary Conditions/velocity-inlet-4/water tree item.

3. Set the boundary conditions at the velocity inlet (velocity-inlet-4) for the secondary phase (air).

Setup → Boundary Conditions → velocity-inlet-4 → air Edit...

a. Retain the default selection of Magnitude, Normal to Boundary from the Velocity Specification
Method drop-down list.

b. Retain the default selection of Absolute from the Reference Frame drop-down list.

c. Enter 1.53 m/s for Velocity Magnitude.

In multiphase flows, the volume rate of each phase is usually known. Volume rate divided by the inlet
area gives the superficial velocity, which is the product of the inlet physical velocity and the volume
fraction. When you have two phases, you must enter two physical velocities and the volume fraction
of the secondary phase. Here it is assumed that bubbles at the inlet are moving at the same physical
speed as the water.

d. Click the Multiphase tab and enter 0.02 for Volume Fraction.

e. Click OK to close the Velocity Inlet dialog box.

Note

Note that you can also open the Velocity Inlet dialog box by double-clicking the
Setup/Boundary Conditions/velocity-inlet-4/air tree item.

4. Set the boundary conditions at outflow-5 for the mixture.
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Setup → Boundary Conditions → outflow-5 Edit...

a. Click Edit... to open the Outflow dialog box.

i. Enter 0.62 for Flow Rate Weighting.

ii. Click OK to close the Outflow dialog box.

5. Set the boundary conditions at outflow-3 for the mixture.

Setup → Boundary Conditions → outflow-3 Edit...

a. Enter 0.38 for Flow Rate Weighting.

b. Click OK to close the Outflow dialog box.

19.4.8. Operating Conditions

1. Set the gravitational acceleration.

Setup → Boundary Conditions → Operating Conditions...

a. Enable Gravity.

The Operating Conditions dialog box will expand to show additional inputs.

b. Enter -9.81 m/s2 for Y in the Gravitational Acceleration group box.

c. Enable Specified Operating Density.

d. Enter 0 kg/m3 for Operating Density.
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ANSYS Fluent redefines the fluid pressure by removing the hydrostatic component based on an average
density in the domain or a user-specified operating density. By setting the operating density to 0 you
force the hydrostatic pressure to appear explicitly in the postprocessed results. For more information,
refer to the Fluent User's Guide.

e. Click OK to close the Operating Conditions dialog box.

19.4.9. Solution Using the Mixture Model

You will begin by calculating a preliminary solution using first-order discretization for momentum,
volume fraction and turbulence quantities. You will then change to higher-order methods to refine the
solution.

1. Set the solution parameters.

Solving → Solution → Methods...

a. Select Coupled from the Scheme drop-down list.

b. Confirm that PRESTO! is selected from the Pressure drop-down list.
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The PRESTO! method for pressure is a good choice when buoyancy and inertial forces are present.

2. Set the solution controls.

Solving → Solution → Controls...

a. Enter 40 for Flow Courant Number.

b. Enter 0.4 for Volume Fraction in the Under-Relaxation Factors group box.

3. Enable the plotting of residuals during the calculation.

Solving → Reports → Residuals...
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a. Ensure that Plot is enabled in the Options group box.

b. Enter 1e-05 for Absolute Criteria for continuity.

c. Click OK to close the Residual Monitors dialog box.

4. Initialize the solution.

Solving → Initialization → Hybrid

a. Select Hybrid as the initialization Method (Initialization group).

b. Click Initialize.

Note

For flows in complex topologies, hybrid initialization will provide better initial velocity
and pressure fields than standard initialization. In general, this will help in improving
the convergence behavior of the solver.

5. Save the case file (tee_1a.cas.gz).

File → Write → Case...

6. Start the calculation by requesting 1400 iterations.
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Solving → Run Calculation

7. Save the case and data files (tee_1a.cas.gz and tee_1a.dat.gz).

File → Write → Case & Data...

8. Check the total mass flow rate for each phase.

Postprocessing → Reports → Fluxes...

a. Retain the default selection of Mass Flow Rate in the Options list.

b. Select water from the Phase drop-down list.

c. Select outflow-3, outflow-5, and velocity-inlet-4 from the Boundaries selection list.

d. Click Compute.

Note that the net mass flow rate of water is a small fraction of the inlet and outlet flow rates (<0.1%),
indicating that mass is conserved.

e. Select air from the Phase drop-down list and click Compute again.

Again, note that the net mass flow rate of air is small compared to the inlet and outlet flow rates.

f. Close the Flux Reports dialog box.

19.4.10. Postprocessing for the Mixture Solution

1. Display the static pressure field in the tee (Figure 19.3: Contours of Static Pressure (p. 796)).

Postprocessing → Graphics → Contours → Edit...
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a. Enable Filled in the Options group box.

b. Retain the default selection of Pressure... and Static Pressure from the Contours of drop-down lists.

c. Click Display.
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Figure 19.3:  Contours of Static Pressure

In Figure 19.3: Contours of Static Pressure (p. 796) the hydrostatic pressure gradient is readily apparent in
the vertical arm — a result of setting the Operating Density to 0.

2. Display contours of velocity magnitude (Figure 19.4: Contours of Velocity Magnitude (p. 797)).

Postprocessing → Graphics → Contours → Edit...

a. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

b. Select water from the Phase drop-down list.

c. Click Display.
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Figure 19.4:  Contours of Velocity Magnitude

3. Display the volume fraction of air (Figure 19.5: Contours of Air Volume Fraction (p. 798)).

Postprocessing → Graphics → Contours → Edit...

a. Select Phases... and Volume fraction from the Contours of drop-down lists.

b. Select air from the Phase drop-down list.

c. Click Display and close the Contours dialog box.
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Figure 19.5:  Contours of Air Volume Fraction

When gravity acts downwards, it induces stratification in the side arm of the tee junction. In Fig-
ure 19.5: Contours of Air Volume Fraction (p. 798), you can see that the gas (air) tends to concentrate on
the upper part of the side arm. In this case, gravity acts against inertia that tends to concentrate gas on
the low pressure side, thereby creating gas pockets. In the vertical arm, both the gas and the water have
velocities in the same direction, and therefore there is no separation. The outflow split modifies the relation
between inertia forces and gravity to a large extent, and has an important role in flow distribution and
on the gas concentration.

19.4.11. Higher Order Solution using the Mixture Model

In this step you will change to higher order discretization schemes and continue the calculation to refine
the solution.

1. Revisit the Solution Methods task page and make the following selections:

ValueSettingGroup

PRESTO!PressureSpatial Discretization

Third-Order MUSCLMomentum

QUICKVolume Fraction

Third-Order MUSCLTurbulent Kinetic Energy

Third-Order MUSCLTurbulent Dissipation Rate

2. Run the calculation for an additional 1400 iterations.

3. Save the case and data files as tee_1b.cas.gz and tee_1b.dat.gz
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File → Write → Case & Data...

4. Plot the contours of air volume fraction using the higher order method on the same scale as in Fig-
ure 19.5: Contours of Air Volume Fraction (p. 798).

Postprocessing → Graphics → Contours → Edit...

a. Select Phases... and Volume fraction from the Contours of drop-down lists.

b. Select air from the Phase drop-down list.

c. Disable Auto Range and Clip to Range.

d. Enter 0 and 3.70e-1 for Min and Max, respectively.

e. Click Display and close the Contours dialog box.

Figure 19.6:  Contours of Air Volume Fraction — Higher Order Solution

19.4.12. Setup and Solution for the Eulerian Model

The mixture model is a simplification of the Eulerian model and is valid only when bubble inertia can be
neglected. This assumption can be violated in the recirculation pattern. The Eulerian model also offers
models for various non-drag forces that are not available when using the mixture model. As a result, the
Eulerian model is expected to make a more realistic prediction in this case. You will use the solution obtained
using the mixture model as an initial condition for the calculation using the Eulerian model. Because you
have already computed a reasonable initial solution, you will continue with the higher order discretization
methods.
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1. Select the Eulerian multiphase model.

Setting Up Physics → Models → Multiphase...

a. Select Eulerian in the Model list.

b. Click OK to close the Multiphase Model dialog box.

2. Specify the drag and lift laws to be used for computing the interphase momentum transfer.

Setup → Models → Multiphase → Phases → Phases Interactions Edit...

a. In the Drag tab, retain the default selection of schiller-naumann from the Drag Coefficient drop-
down list.

b. In the Lift tab, select legendre-magnaudet from the Lift Coefficient drop-down list.

Lift forces can arise when the gradient of the primary phase velocity field has a component normal
to the bubble flow.

c. Click OK to close the Phase Interaction dialog box.

Note

For this problem, there are no parameters to be set for the individual phases other than
those that you specified when you set up the phases for the mixture model calculation.
If you use the Eulerian model for a flow involving a granular secondary phase, you will
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need to set additional parameters. There are also other options in the Phase Interaction
dialog box that may be relevant for other applications.

For details on setting up an Eulerian multiphase calculation, see the Fluent User's Guide.

3. Select the multiphase turbulence model.

Setting Up Physics → Models → Viscous...

a. Retain the default selection of Mixture in the Turbulence Multiphase Model list.

In this case the dispersed phase volume concentration is relatively small so the mixture turbulence
model is sufficient to capture the important features of the turbulent flow.

b. Click OK to close the Viscous Model dialog box.

4. Confirm that the solution parameters are set to use the higher-order discretization schemes.
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Revisit the Solution Methods task page and verify that the settings are as follows:

ValueSettingGroup

CoupledSchemePressure-Velocity Coupling

Third-Order MUSCLMomentumSpatial Discretization

QUICKVolume Fraction

Third-Order MUSCLTurbulent Kinetic Energy

Third-Order MUSCLTurbulent Dissipation Rate

5. Set the solution controls

Solution Controls

a. Enter 40 for Flow Courant Number.

b. Enter 0.5 for Momentum and for Pressure in the Explicit Relaxation Factors group box.

c. Confirm that Volume Fraction is set to 0.4 in the Under-Relaxation Factors group box.

6. Continue the solution by requesting 1400 additional iterations.

Solving → Run Calculation → Calculate
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7. Check that the mass imbalance is small (less than about 0.2 %) using the Flux Reports dialog box
as for the Mixture model solution.

Postprocessing → Reports → Fluxes...

8. Save the case and data files (tee_2.cas.gz and tee_2.dat.gz).

File → Write → Case & Data...

19.4.13. Postprocessing for the Eulerian Model

1. Display the static pressure field in the tee for the mixture (Figure 19.7: Contours of Static Pressure — Eulerian
Model (p. 804)).

Postprocessing → Graphics → Contours → Edit...

a. Select Pressure... from the Contours of drop-down list.

By default, Dynamic Pressure will be displayed in the lower Contours of drop-down list. This will
automatically change to Static Pressure after you select the appropriate phase in the next step.

b. Select mixture from the Phase drop-down list.

The lower Contours of drop-down list will now display Static Pressure.

c. As before, disable Auto Range (Clip to Range will be enabled) and set the Min and Max values to
match those in Figure 19.3: Contours of Static Pressure (p. 796).
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d. Click Display.

Figure 19.7:  Contours of Static Pressure — Eulerian Model

2. Display contours of velocity magnitude for water (Figure 19.8: Contours of Water Velocity Magnitude —
Eulerian Model (p. 805)).

Postprocessing → Graphics → Contours → Edit...

a. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

b. Retain the selection of water from the Phase drop-down list.

Since the Eulerian model solves individual momentum equations for each phase, you can choose the
phase for which solution data is plotted.

c. Set the range to match that in Figure 19.4: Contours of Velocity Magnitude (p. 797).

d. Click Display.
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Figure 19.8:  Contours of Water Velocity Magnitude — Eulerian Model

3. Display the volume fraction of air (Figure 19.9: Contours of Air Volume Fraction — Eulerian model (p. 806)).

Postprocessing → Graphics → Contours → Edit...

a. Select Phases... and Volume fraction from the Contours of drop-down lists.

b. Select air from the Phase drop-down list.

c. Set the range to match that in Figure 19.5: Contours of Air Volume Fraction (p. 798).

d. Click Display and close the Contours dialog box.
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Figure 19.9:  Contours of Air Volume Fraction — Eulerian model

Compare the volume fraction plot in Figure 19.9: Contours of Air Volume Fraction — Eulerian model (p. 806)
with the volume fraction plot using the mixture model in Figure 19.6: Contours of Air Volume Fraction
— Higher Order Solution (p. 799). Notice that the path of the concentrated air stream in the side arm
extends farther into the side arm before drifting to the top surface. As is apparent from the velocity plots,
there is a substantial velocity gradient across the side arm as a result of the recirculation near the lower
corner of the tee junction. As the dispersed phase bubbles travel along the side arm with the flow, this
velocity gradient induces a lift force which tends to oppose the buoyancy force thereby delaying the ac-
cumulation of the air concentration along the top surface of the side arm.

19.5. Summary

This tutorial demonstrated how to set up and solve a multiphase problem using the mixture model and
the Eulerian model. You learned how to set boundary conditions for the mixture and both phases. The
solution obtained with the mixture model was used as a starting point for the calculation with the Eu-
lerian model. After completing calculations for each model, you displayed the results to allow for a
comparison of the two approaches. For more information about the mixture and Eulerian models, see
the Fluent User's Guide.

19.6. Further Improvements

This tutorial guides you through the steps to reach an initial set of solutions. You may be able to obtain
a more accurate solution by adapting the mesh. Mesh adaption can also ensure that the solution is in-
dependent of the mesh. These steps are demonstrated in Introduction to Using ANSYS Fluent: Fluid
Flow and Heat Transfer in a Mixing Elbow (p. 121).
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Chapter 20: Modeling Solidification

This tutorial is divided into the following sections:
20.1. Introduction
20.2. Prerequisites
20.3. Problem Description
20.4. Setup and Solution
20.5. Summary
20.6. Further Improvements

20.1. Introduction

This tutorial illustrates how to set up and solve a problem involving solidification and will demonstrate
how to do the following:

• Define a solidification problem.

• Define pull velocities for simulation of continuous casting.

• Define a surface tension gradient for Marangoni convection.

• Solve a solidification problem.

20.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

20.3. Problem Description

This tutorial demonstrates the setup and solution procedure for a fluid flow and heat transfer problem
involving solidification, namely the Czochralski growth process. The geometry considered is a 2D
axisymmetric bowl (shown in Figure 20.1: Solidification in Czochralski Model (p. 808)), containing liquid
metal. The bottom and sides of the bowl are heated above the liquidus temperature, as is the free
surface of the liquid. The liquid is solidified by heat loss from the crystal and the solid is pulled out of
the domain at a rate of 0.001  and a temperature of 500 . There is a steady injection of liquid at
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the bottom of the bowl with a velocity of  and a temperature of 1300 . Material
properties are listed in Figure 20.1: Solidification in Czochralski Model (p. 808).

Starting with an existing 2D mesh, the details regarding the setup and solution procedure for the solid-
ification problem are presented. The steady conduction solution for this problem is computed as an
initial condition. Then, the fluid flow is enabled to investigate the effect of natural and Marangoni
convection in a transient fashion.

Figure 20.1:  Solidification in Czochralski Model

In the above figure,  is the mushy zone constant. For details on modeling the solidification/melting
process, refer to momentum equations in the Fluent Theory Guide.

20.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
20.4.1. Preparation
20.4.2. Reading and Checking the Mesh
20.4.3. Specifying Solver and Analysis Type
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20.4.4. Specifying the Models
20.4.5. Defining Materials
20.4.6. Setting the Cell Zone Conditions
20.4.7. Setting the Boundary Conditions
20.4.8. Solution: Steady Conduction
20.4.9. Solution:Transient Flow and Heat Transfer

20.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the solidification_R180.zip link to download the input files.

7. Unzip the solidification_R180.zip file you downloaded to your working folder.

The file solid.msh can be found in the solidification directory created after unzipping the
file.

8. Use Fluent Launcher to start the 2D single precision (disable Double Precision) version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

20.4.2. Reading and Checking the Mesh

1. Read the mesh file solid.msh.
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File → Read → Mesh...

As the mesh is read by ANSYS Fluent, messages will appear in the console reporting the progress of the
reading.

A warning about the use of axis boundary conditions is displayed in the console. You are asked to consider
making changes to the zone type or change the problem definition to axisymmetric. You will change the
problem to axisymmetric swirl later in this tutorial.

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make
sure that the minimum volume is a positive number.

3. Examine the mesh (Figure 20.2: Mesh Display (p. 810)).

Figure 20.2:  Mesh Display

20.4.3. Specifying Solver and Analysis Type

1. Select Axisymmetric Swirl from the 2D Space list.

Setup → General
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The geometry comprises an axisymmetric bowl. Furthermore, swirling flows are considered in this problem,
so the selection of Axisymmetric Swirl best defines this geometry.

Also, note that the rotation axis is the X axis. Hence, the X direction is the axial direction and the Y direction
is the radial direction. When modeling axisymmetric swirl, the swirl direction is the tangential direction.

2. Add the effect of gravity on the model.

Setup → General → Gravity
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a. Enable Gravity.

b. Enter -9.81  for X in the Gravitational Acceleration group box.

20.4.4. Specifying the Models

1. Define the solidification model.

Setup → Models → Solidification & Melting Edit...
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a. Enable the Solidification/Melting option in the Solidification and Melting dialog box.

The Solidification and Melting dialog box will expand to show the related parameters.

b. Retain the default value of 100000 for the Mushy Zone Constant.

This default value is acceptable for most cases.

c. Enable the Include Pull Velocities option.

By including the pull velocities, you will account for the movement of the solidified material as it is
continuously withdrawn from the domain in the continuous casting process.

When you enable this option, the Solidification and Melting dialog box will expand to show the
Compute Pull Velocities option. If you were to enable this additional option, ANSYS Fluent would
compute the pull velocities during the calculation. This approach is computationally expensive and
is recommended only if the pull velocities are strongly dependent on the location of the liquid-solid
interface. In this tutorial, you will patch values for the pull velocities instead of having ANSYS Flu-
ent compute them.

For more information about computing the pull velocities, see the Fluent User's Guide.

d. Click OK to close the Solidification and Melting dialog box.

An Information dialog box opens, telling you that available material properties have changed for
the solidification model. You will set the material properties later, so you can click OK in the dialog
box to acknowledge this information.

Note

ANSYS Fluent will automatically enable the energy calculation when you enable the so-
lidification model, so you need not visit the Energy dialog box.

20.4.5. Defining Materials

In this step, you will create a new material and specify its properties, including the melting heat, solidus
temperature, and liquidus temperature.

1. Define a new material.

Setup → Materials → Fluid → air Edit...

813
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



a. Enter liquid-metal for Name.

b. Select polynomial from the Density drop-down list in the Properties group box.

c. Configure the following settings In the Polynomial Profile dialog box:

i. Set Coefficients to 2.

ii. In the Coefficients group box, enter 8000 for 1 and -0.1 for 2.

As shown in Figure 20.1: Solidification in Czochralski Model (p. 808), the density of the material is
defined by a polynomial function: .

iii. Click OK to close the Polynomial Profile dialog box.

d. In the Question dialog box, click Yes to overwrite fluid-1 and add the new material (liquid-metal) to
the Fluent Fluid Materials drop-down list.

e. Click OK in the information dialog box.

f. Select liquid-metal from the Fluent Fluid Materials drop-down list to set the other material properties.
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g. Enter 680  for Cp (Specific Heat).

h. Enter 30  for Thermal Conductivity.

i. Enter 0.00553  for Viscosity.

j. Enter 100000  for Pure Solvent Melting Heat.

Scroll down the group box to find Pure Solvent Melting Heat and the properties that follow.

k. Enter 1150  for Solidus Temperature.

l. Enter 1150  for Liquidus Temperature.

m. Click Change/Create and close the Create/Edit Materials dialog box.

20.4.6. Setting the Cell Zone Conditions

1. Set the cell zone conditions for the fluid (fluid).

Setup → Cell Zone Conditions → fluid Edit...
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a. Select liquid-metal from the Material Name drop-down list.

b. Click OK to close the Fluid dialog box.

20.4.7. Setting the Boundary Conditions

1. Set the boundary conditions for the inlet (inlet).

Setup → Boundary Conditions → inlet Edit...
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a. Enter 0.00101  for Velocity Magnitude.

b. Click the Thermal tab and enter 1300  for Temperature.

c. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions for the outlet (outlet).

Setup → Boundary Conditions → outlet Edit...

Here, the solid is pulled out with a specified velocity, so a velocity inlet boundary condition is used with
a positive axial velocity component.

a. From the Velocity Specification Method drop-down list, select Components.
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The Velocity Inlet dialog box will change to show related inputs.

b. Enter 0.001  for Axial-Velocity.

c. Enter 1  for Swirl Angular Velocity.

d. Click the Thermal tab and enter 500  for Temperature.

e. Click OK to close the Velocity Inlet dialog box.

3. Set the boundary conditions for the bottom wall (bottom-wall).

Setup → Boundary Conditions → bottom-wall Edit...

a. Click the Thermal tab.
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i. Select Temperature in the Thermal Conditions group box.

ii. Enter 1300  for Temperature.

b. Click OK to close the Wall dialog box.

4. Set the boundary conditions for the free surface (free-surface).

Setup → Boundary Conditions → free-surface Edit...

The specified shear and Marangoni stress boundary conditions are useful in modeling situations in which
the shear stress (rather than the motion of the fluid) is known. A free surface condition is an example of
such a situation. In this case, the convection is driven by the Marangoni stress and the shear stress is
dependent on the surface tension, which is a function of temperature.
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a. Select Marangoni Stress in the Shear Condition group box.

The Marangoni Stress condition allows you to specify the gradient of the surface tension with respect
to temperature at a wall boundary.

b. Enter -0.00036  for Surface Tension Gradient.

c. Click the Thermal tab to specify the thermal conditions.
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i. Select Convection from the Thermal Conditions group box.

ii. Enter 100  for Heat Transfer Coefficient.

iii. Enter 1500  for Free Stream Temperature.

d. Click OK to close the Wall dialog box.

5. Set the boundary conditions for the side wall (side-wall).

Setup → Boundary Conditions → side-wall Edit...

a. Click the Thermal tab.
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i. Select Temperature from the Thermal Conditions group box.

ii. Enter 1400  for the Temperature.

b. Click OK to close the Wall dialog box.

6. Set the boundary conditions for the solid wall (solid-wall).

Setup → Boundary Conditions → solid-wall Edit...
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a. From the Wall Motion group box, select Moving Wall.

The Wall dialog box is expanded to show additional parameters.

b. in the Motion group box, in the lower box, select Rotational.

The Wall dialog box is changed to show the rotational speed.

c. Enter 1.0  for Speed.

d. Click the Thermal tab to specify the thermal conditions.
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i. Select Temperature from the Thermal Conditions selection list.

ii. Enter 500  for Temperature.

e. Click OK to close the Wall dialog box.

20.4.8. Solution: Steady Conduction

In this step, you will specify the discretization schemes to be used and temporarily disable the calculation of
the flow and swirl velocity equations, so that only conduction is calculated. This steady-state solution will
be used as the initial condition for the time-dependent fluid flow and heat transfer calculation.

1. Set the solution parameters.

Solving → Solution → Methods...
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a. Select Coupled from the Scheme drop-down list in the Pressure-Velocity Coupling group box.

b. Select PRESTO! from the Pressure drop-down list in the Spatial Discretization group box.

The PRESTO! scheme is well suited for rotating flows with steep pressure gradients.

c. Retain the default selection of Second Order Upwind from the Momentum, Swirl Velocity, and Energy
drop-down lists.

d. Enable Pseudo Transient.

The Pseudo Transient option enables the pseudo transient algorithm in the coupled pressure-based
solver. This algorithm effectively adds an unsteady term to the solution equations in order to improve
stability and convergence behavior. Use of this option is recommended for general fluid flow problems.

2. Enable the calculation for energy.

Solving → Controls → Equations...
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a. Deselect Flow and Swirl Velocity from the Equations selection list to disable the calculation of flow
and swirl velocity equations.

b. Click OK to close the Equations dialog box.

3. Confirm the Relaxation Factors.

Solving → Controls → Controls...

Retain the default values.

4. Enable the plotting of residuals during the calculation.
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Solving → Reports → Residuals...

a. Ensure Plot is enabled in the Options group box.

b. Click OK to accept the remaining default settings and close the Residual Monitors dialog box.

5. Initialize the solution.

Solving → Initialization

a. Retain the Method at the default ofHybrid in the Initialization group.

For flows in complex topologies, hybrid initialization will provide better initial velocity and pressure
field than standard initialization. This in general will help in improving the convergence behavior of
the solver.

b. Click Initialize.

6. Define a custom field function for the swirl pull velocity.

Parameters & Customization → Custom Field Functions New...

In this step, you will define a field function to be used to patch a variable value for the swirl pull velocity
in the next step. The swirl pull velocity is equal to , where  is the angular velocity, and  is the radial
coordinate. Since  = 1 rad/s, you can simplify the equation to simply . In this example, the value of 
is included for demonstration purposes.
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a. From the Field Functions drop-down lists, select Mesh... and Radial Coordinate.

b. Click the Select button to add radial-coordinate in the Definition field.

If you make a mistake, click the DEL button on the calculator pad to delete the last item you added
to the function definition.

c. Click the  button on the calculator pad.

d. Click the 1 button.

e. Enter omegar for New Function Name.

f. Click Define.

The omegar item appears under the Parameters & Customisation/Parameters tree branch.

Note

To check the function definition or delete the custom field function, click Manage....
Then in the Field Function Definitions dialog box, from the Field Functions selection
list, select omegar to view the function definition.

g. Close the Custom Field Function Calculator dialog box.

7. Patch the pull velocities.

Solving → Initialization → Patch...

As noted earlier, you will patch values for the pull velocities, rather than having ANSYS Fluent compute
them. Since the radial pull velocity is zero, you will patch just the axial and swirl pull velocities.
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a. From the Variable selection list, select Axial Pull Velocity.

b. Enter 0.001  for Value.

c. From the Zones to Patch selection list, select fluid.

d. Click Patch.

You have just patched the axial pull velocity. Next you will patch the swirl pull velocity.

e. From the Variable selection list, select Swirl Pull Velocity.

Scroll down the list to find Swirl Pull Velocity.

f. Enable the Use Field Function option.
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g. Select omegar from the Field Function selection list.

h. Ensure that fluid is selected from the Zones to Patch selection list.

i. Click Patch and close the Patch dialog box.

8. Save the initial case and data files (solid0.cas.gz and solid0.dat.gz).

File → Write → Case & Data...

9. Start the calculation by requesting 20 iterations.

Solving → Run Calculation → Advanced...

a. In the Run Calculation task page, select User Specified for the Time Step Method in both the Fluid
Time Scale and the Solid Time Scale group boxes.

b. Retain the default values of 1 and 1000 for the Pseudo Time Step (s) in the Fluid Time Scale and the
Solid Time Scale group boxes, respectively.

c. Enter 20 for Number of Iterations.

d. Click Calculate.
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The solution will converge in approximately 12 iterations.

10. Create and display the definition of filled temperature contours (Figure 20.3: Contours of Temperature for
the Steady Conduction Solution (p. 832)).

Postprocessing → Graphics → Contours → New...

a. Enter temperature for Contour Name.

b. Enable the Filled option.

c. Select Temperature... and Static Temperature from the Contours of drop-down lists.

d. Click Save/Display (Figure 20.3: Contours of Temperature for the Steady Conduction Solution (p. 832)).

The temperature contour definition appear under the Results/Graphics/Contours tree branch.

831
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 20.3:  Contours of Temperature for the Steady Conduction Solution

11. Display filled contours of temperature to determine the thickness of mushy zone.

Postprocessing → Graphics → Contours → Edit...
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a. Disable Auto Range in the Options group box.

The Clip to Range option is automatically enabled.

b. Enter 1100 for Min and 1200 for Max.

c. Click Display (See Figure 20.4: Contours of Temperature (Mushy Zone) for the Steady Conduction
Solution (p. 833)) and close the Contours dialog box.

Figure 20.4:  Contours of Temperature (Mushy Zone) for the Steady Conduction Solution

12. Save the case and data files for the steady conduction solution (solid.cas.gz and solid.dat.gz).

File → Write → Case & Data...

20.4.9. Solution: Transient Flow and Heat Transfer

In this step, you will turn on time dependence and include the flow and swirl velocity equations in the calcu-
lation. You will then solve the transient problem using the steady conduction solution as the initial condition.

1. Enable a time-dependent solution by selecting Transient from the Time list.

Setup → General
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2. Set the solution parameters.

Solving → Solution → Methods...

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.834

Modeling Solidification



a. Retain the default selection of First Order Implicit from the Transient Formulation drop-down list.

b. Ensure that PRESTO! is selected from the Pressure drop-down list in the Spatial Discretization group
box.

3. Enable calculations for flow and swirl velocity.

Solving → Controls → Equations...
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a. Select Flow and Swirl Velocity and ensure that Energy is selected from the Equations selection list.

Now all three items in the Equations selection list will be selected.

b. Click OK to close the Equations dialog box.

4. Set the Under-Relaxation Factors.

Solving → Controls → Controls...
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a. Enter 0.1 for Liquid Fraction Update.

b. Retain the default values for other Under-Relaxation Factors.

5. Save the initial case and data files (solid01.cas.gz and solid01.dat.gz).

File → Write → Case & Data...

6. Run the calculation for 2 time steps.

Solving → Run Calculation → Advanced...
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a. Enter 0.1 s for Time Step Size.

b. Set the Number of Time Steps to 2.

c. Retain the default value of 20 for Max Iterations/Time Step.

d. Click Calculate.

7. Display filled contours of the temperature after 0.2 seconds using the temperature contours definition
that you created earlier.

Results → Graphics → Contours → temperature Display
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Figure 20.5:  Contours of Temperature at t=0.2 s

8. Create and display the definition of stream function contours (Figure 20.6: Contours of Stream Function at
t=0.2 s (p. 840)).

Postprocessing → Graphics → Contours → New...

a. Enter stream-function for Contour Name.

b. Disable Filled in the Options group box.

c. Select Velocity... and Stream Function from the Contours of drop-down lists.

d. Click Save/Display.

The stream-function contour definition appear under the Results/Graphics/Contours tree
branch.
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Figure 20.6:  Contours of Stream Function at t=0.2 s

As shown in Figure 20.6: Contours of Stream Function at t=0.2 s (p. 840), the liquid is beginning to circulate
in a large eddy, driven by natural convection and Marangoni convection on the free surface.

9. Create and display the definition of liquid fraction contours by modifying the stream-function contour
definition (Figure 20.7: Contours of Liquid Fraction at t=0.2 s (p. 841)).

Postprocessing → Graphics → Contours → New...

a. Enter liquid-fraction for Contour Name.

b. Enable Filled in the Options group box.

c. Select Solidification/Melting... and Liquid Fraction from the Contours of drop-down lists.

d. Click Save/Display and close the Contours dialog box.
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Figure 20.7:  Contours of Liquid Fraction at t=0.2 s

The liquid fraction contours show the current position of the melt front. Note that in Figure 20.7: Contours
of Liquid Fraction at t=0.2 s (p. 841), the mushy zone divides the liquid and solid regions roughly in half.

10. Continue the calculation for 48 additional time steps.

Solving → Run Calculation → Advanced...

a. Enter 48 for Number of Time Steps.

b. Click Calculate.

After a total of 50 time steps have been completed, the elapsed time will be 5 seconds.

11. Display filled contours of the temperature after 5 seconds using the contour definition created earlier
(Figure 20.8: Contours of Temperature at t=5 s (p. 842)).

Results → Graphics → Contours → temperature Display
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Figure 20.8:  Contours of Temperature at t=5 s

As shown in Figure 20.8: Contours of Temperature at t=5 s (p. 842), the temperature contours are fairly
uniform through the melt front and solid material. The distortion of the temperature field due to the re-
circulating liquid is also clearly evident.

In a continuous casting process, it is important to pull out the solidified material at the proper time. If
the material is pulled out too soon, it will not have solidified (that is, it will still be in a mushy state). If
it is pulled out too late, it solidifies in the casting pool and cannot be pulled out in the required shape.
The optimal rate of pull can be determined from the contours of liquidus temperature and solidus tem-
perature.

12. Display contours of stream function (Figure 20.9: Contours of Stream Function at t=5 s (p. 843)).

Results → Graphics → Contours → stream-function Display

As shown in Figure 20.9: Contours of Stream Function at t=5 s (p. 843), the flow has developed more fully
by 5 seconds, as compared with Figure 20.6: Contours of Stream Function at t=0.2 s (p. 840) after 0.2
seconds. The main eddy, driven by natural convection and Marangoni stress, dominates the flow.
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Figure 20.9:  Contours of Stream Function at t=5 s

To examine the position of the melt front and the extent of the mushy zone, you will plot the contours
of liquid fraction.

13. Display filled contours of liquid fraction (Figure 20.10: Contours of Liquid Fraction at t=5 s (p. 844)).

Results → Graphics → Contours → liquid-fraction Display

The introduction of liquid material at the left of the domain is balanced by the pulling of the solidified
material from the right. After 5 seconds, the equilibrium position of the melt front is beginning to be es-
tablished (Figure 20.10: Contours of Liquid Fraction at t=5 s (p. 844)).

843
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 20.10:  Contours of Liquid Fraction at t=5 s

14. Save the case and data files for the solution at 5 seconds (solid5.cas.gz and solid5.dat.gz).

File → Write → Case & Data...

20.5. Summary

In this tutorial, you studied the setup and solution for a fluid flow problem involving solidification for
the Czochralski growth process.

The solidification model in ANSYS Fluent can be used to model the continuous casting process where
a solid material is continuously pulled out from the casting domain. In this tutorial, you patched a
constant value and a custom field function for the pull velocities instead of computing them. This ap-
proach is used for cases where the pull velocity is not changing over the domain, as it is computationally
less expensive than having ANSYS Fluent compute the pull velocities during the calculation.

For more information about the solidification/melting model, see the Fluent User's Guide.

20.6. Further Improvements

This tutorial guides you through the steps to reach an initial set of solutions. You may be able to obtain
a more accurate solution by using an appropriate higher-order discretization scheme and by adapting
the mesh. Mesh adaption can also ensure that the solution is independent of the mesh. These steps
are demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 121).
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Chapter 21: Using the Eulerian Granular Multiphase Model with
Heat Transfer

This tutorial is divided into the following sections:
21.1. Introduction
21.2. Prerequisites
21.3. Problem Description
21.4. Setup and Solution
21.5. Summary
21.6. Further Improvements
21.7. References

21.1. Introduction

This tutorial examines the flow of air and a granular solid phase consisting of glass beads in a hot gas
fluidized bed, under uniform minimum fluidization conditions. The results obtained for the local wall-
to-bed heat transfer coefficient in ANSYS Fluent can be compared with analytical results [1].

This tutorial demonstrates how to do the following:

• Use the Eulerian granular model.

• Set boundary conditions for internal flow.

• Compile a User-Defined Function (UDF) for the gas and solid phase thermal conductivities.

• Calculate a solution using the pressure-based solver.

21.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

In order to complete the steps to compile the UDF, you will need to have a working C compiler installed
on your machine.
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21.3. Problem Description

This problem considers a hot gas fluidized bed in which air flows upwards through the bottom of the
domain and through an additional small orifice next to a heated wall. A uniformly fluidized bed is ex-
amined, which you can then compare with analytical results [1]. The geometry and data for the problem
are shown in Figure 21.1: Problem Schematic (p. 846).

Figure 21.1:  Problem Schematic

21.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
21.4.1. Preparation
21.4.2. Mesh
21.4.3. Solver Settings
21.4.4. Models
21.4.5. UDF
21.4.6. Materials
21.4.7. Phases
21.4.8. Boundary Conditions
21.4.9. Solution
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21.4.10. Postprocessing

21.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the eulerian_granular_heat_R180.zip link to download the input files.

7. Unzip eulerian_granular_heat_R180.zip to your working folder.

The files, fluid-bed.msh and conduct.c, can be found in the eulerian_granular_heat
folder created after unzipping the file.

8. Use Fluent Launcher to enable Double Precision and start the 2D version of ANSYS Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about the Fluent Launcher, see starting ANSYS Fluent using the Fluent
Launcher in the Fluent Getting Started Guide.

9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Run in Serial by selecting Serial under Processing Options.

11. Ensure that Set up Compilation Environment for UDF is enabled in the Environment tab of the Fluent
Launcher window. This will allow you to compile the UDF.

Note

The double precision solver is recommended for modeling multiphase flow simulations.
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21.4.2. Mesh

1. Read the mesh file fluid-bed.msh.

File → Read → Mesh...

As ANSYS Fluent reads the mesh file, it will report the progress in the console.

2. Check the mesh.

Setting Up Domain → Mesh → Check

ANSYS Fluent will perform various checks on the mesh and will report the progress in the console. Make
sure that the reported minimum volume is a positive number.

3. Examine the mesh (Figure 21.2: Mesh Display of the Fluidized Bed (p. 848)).

Extra

You can use the right mouse button to check which zone number corresponds to each
boundary. If you click the right mouse button on one of the boundaries in the graphics
window, its zone number, name, and type will be printed in the ANSYS Fluent console.
This feature is especially useful when you have several zones of the same type and you
want to distinguish between them quickly.

Figure 21.2:  Mesh Display of the Fluidized Bed
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21.4.3. Solver Settings

1. Enable the pressure-based transient solver.

Setup → General

a. Retain the default selection of Pressure-Based from the Type list.

The pressure-based solver must be used for multiphase calculations.

b. Select Transient from the Time list.

2. Set the gravitational acceleration.

Setup → General → Gravity

a. Enter -9.81  m/s2 for the Gravitational Acceleration in the Y direction.

21.4.4. Models

1. Enable the Eulerian multiphase model for two phases.
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You will use the default settings for the Eulerian model, so you can enable it directly from the tree by
right-clicking the Multiphase node and choosing Eulerian from the context menu.

Setup → Models → Multiphase Eulerian

2. Enable heat transfer by enabling the energy equation.

Setup → Models → Energy On

An Information dialog box appears reminding you to confirm the property values. Click OK in the
Information dialog box to continue.

3. Retain the default laminar viscous model.

The decision to use the laminar model should be based on the Stokes number for the particles suspended
in the fluid flow.

Setup → Models → Viscous Model → Laminar

21.4.5. UDF

1. Compile the user-defined function,conduct.c, that will be used to define the thermal conductivity for
the gas and solid phase.

User Defined → User Defined → Functions → Compiled...

a. Click the Add... button below the Source Files option to open the Select File dialog box.

i. Select the file conduct.c and click OK in the Select File dialog box.

b. Click Build.

ANSYS Fluent will create a libudf folder and compile the UDF. Also, a Warning dialog box will
open asking you to make sure that UDF source file and case/data files are in the same folder.
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c. Click OK to close the Warning dialog box.

d. Click Load to load the UDF.

Extra

If you decide to read in the case file that is provided for this tutorial on the Customer
Portal, you will need to compile the UDF associated with this tutorial in your working
folder. This is necessary because ANSYS Fluent will expect to find the correct UDF libraries
in your working folder when reading the case file.

21.4.6. Materials

1. Modify the properties for air, which will be used for the primary phase.

Setup → Materials → air → Create/Edit...

The properties used for air are modified to match data used by Kuipers et al. [1]

a. Enter 1.2 kg/m3 for Density.

b. Enter 994 J/kg-K for Cp.

c. Select user-defined from the Thermal Conductivity drop-down list to open the User Defined Functions
dialog box.

i. Select conduct_gas::libudf from the available list.

ii. Click OK to close the User Defined Functions dialog box.

d. Click Change/Create.
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2. Define a new fluid material for the granular phase (the glass beads).

Setup → Materials → air → Create/Edit...

a. Enter solids for Name.

b. Enter 2660  kg/m3 for Density.

c. Enter 737 J/kg-K for Cp.

d. Retain the selection of user-defined from the Thermal Conductivity drop-down list.

e. Click the Edit... button to open the User Defined Functions dialog box.

i. Select conduct_solid::libudf in the User Defined Functions dialog box and click OK.

A Question dialog box will open asking if you want to overwrite air.

ii. Click No in the Question dialog box.

f. Select solids from the Fluent Fluid Materials drop-down list.

g. Click Change/Create and close the Materials dialog box.

21.4.7. Phases

You will now configure the phases.

1. Define air as the primary phase.

Setup → Multiphase → Phases → phase-1 - Primary Phase → Edit...
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a. Enter air for Name.

b. Ensure that air is selected from the Phase Material drop-down list.

c. Click OK to close the Primary Phase dialog box.

2. Define solids (glass beads) as the secondary phase.

Setup → Multiphase → Phases → phase-2 - Secondary Phase → Edit...
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a. Enter solids for Name.

b. Select solids from the Phase Material drop-down list.

c. Enable Granular.

d. Retain the default selection of Phase Property in the Granular Temperature Model group box.

e. Enter 0.0005 m for Diameter.
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f. Select syamlal-obrien from the Granular Viscosity drop-down list.

g. Select lun-et-al from the Granular Bulk Viscosity drop-down list.

h. Select constant from the Granular Temperature drop-down list and enter 1e-05.

i. Enter 0.6 for the Packing Limit.

j. Click OK to close the Secondary Phase dialog box.

3. Define the interphase interactions formulations to be used.

Setup → Multiphase → Phase Interactions Edit...

a. In the Drag tab, select syamlal-obrien from the Drag Coefficient drop-down list.

b. In the Heat tab, select gunn from the Heat Transfer Coefficient drop-down list.

The interphase heat exchange is simulated, using a drag coefficient, the default restitution coefficient
for granular collisions of 0.9, and a heat transfer coefficient. Granular phase lift is not very relevant
in this problem, and in fact is rarely used.

c. Click OK to close the Phase Interaction dialog box.

21.4.8. Boundary Conditions

For this problem, you need to set the boundary conditions for all boundaries.

Setup → Boundary Conditions
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1. Set the boundary conditions for the lower velocity inlet (v_uniform) for the primary phase.

Setup → Boundary Conditions → v_uniform

For the Eulerian multiphase model, you will specify conditions at a velocity inlet that are specific to the
primary and secondary phases.

a. Select air from the Phase drop-down list.

b. Click the Edit... button to open the Velocity Inlet dialog box.
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i. Retain the default selection of Magnitude, Normal to Boundary from the Velocity Specification
Method drop-down list.

ii. Enter 0.25 m/s for the Velocity Magnitude.

iii. Click the Thermal tab and enter 293 K for Temperature.

iv. Click OK to close the Velocity Inlet dialog box.

2. Set the boundary conditions for the lower velocity inlet (v_uniform) for the secondary phase.

Setup → Boundary Conditions → v_uniform

a. Select solids from the Phase drop-down list.

b. Click the Edit... button to open the Velocity Inlet dialog box.

i. Retain the default Velocity Specification Method and Reference Frame.

ii. Retain the default value of 0 m/s for the Velocity Magnitude.

iii. Click the Thermal tab and enter 293 K for Temperature.
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iv. Click the Multiphase tab and retain the default value of 0 for Volume Fraction.

v. Click OK to close the Velocity Inlet dialog box.

3. Set the boundary conditions for the orifice velocity inlet (v_jet) for the primary phase.

Setup → Boundary Conditions → v_jet

a. Select air from the Phase drop-down list.

b. Click the Edit... button to open the Velocity Inlet dialog box.

i. Retain the default Velocity Specification Method and Reference Frame.

ii. Enter 0.25 m/s for the Velocity Magnitude.

In order for a comparison with analytical results [1] to be meaningful, in this simulation you will
use a uniform value for the air velocity equal to the minimum fluidization velocity at both inlets
on the bottom of the bed.

iii. Click the Thermal tab and enter 293 K for Temperature.

iv. Click OK to close the Velocity Inlet dialog box.

4. Set the boundary conditions for the orifice velocity inlet (v_jet) for the secondary phase.

Setup → Boundary Conditions → v_jet

a. Select solids from the Phase drop-down list.

b. Click the Edit... button to open the Velocity Inlet dialog box.
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i. Retain the default Velocity Specification Method and Reference Frame.

ii. Retain the default value of 0 m/s for the Velocity Magnitude.

iii. Click the Thermal tab and enter 293 K for Temperature.

iv. Click the Multiphase tab and retain the default value of 0 for the Volume Fraction.

v. Click OK to close the Velocity Inlet dialog box.

5. Set the boundary conditions for the pressure outlet (poutlet) for the mixture phase.

Setup → Boundary Conditions → poutlet

For the Eulerian granular model, you will specify conditions at a pressure outlet for the mixture and for
both phases.

The thermal conditions at the pressure outlet will be used only if flow enters the domain through this
boundary. You can set them equal to the inlet values, as no flow reversal is expected at the pressure
outlet. In general, however, it is important to set reasonable values for these downstream scalar values,
in case flow reversal occurs at some point during the calculation.

a. Select mixture from the Phase drop-down list.

b. Click the Edit... button to open the Pressure Outlet dialog box.

i. Retain the default value of 0 Pascal for Gauge Pressure.

ii. Click OK to close the Pressure Outlet dialog box.

6. Set the boundary conditions for the pressure outlet (poutlet) for the primary phase.

Setup → Boundary Conditions → poutlet

a. Select air from the Phase drop-down list.

b. Click the Edit... button to open the Pressure Outlet dialog box.
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i. In the Thermal tab, enter 293 K for Backflow Total Temperature.

ii. Click OK to close the Pressure Outlet dialog box.

7. Set the boundary conditions for the pressure outlet (poutlet) for the secondary phase.

Setup → Boundary Conditions → poutlet

a. Select solids from the Phase drop-down list.

b. Click the Edit... button to open the Pressure Outlet dialog box.

i. In the Thermal tab, enter 293 K for the Backflow Total Temperature.

ii. In the Multiphase tab, retain default settings.

iii. Click OK to close the Pressure Outlet dialog box.

8. Set the boundary conditions for the heated wall (wall_hot) for the mixture.

Setup → Boundary Conditions → wall_hot

For the heated wall, you will set thermal conditions for the mixture, and momentum conditions (zero
shear) for both phases.

a. Select mixture from the Phase drop-down list.

b. Click the Edit... button to open the Wall dialog box.
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i. In the Thermal tab, select Temperature from the Thermal Conditions list.

ii. Enter 373 K for Temperature.

iii. Click OK to close the Wall dialog box.

9. Set the boundary conditions for the heated wall (wall_hot) for the primary phase.

Setup → Boundary Conditions → wall_hot

a. Select air from the Phase drop-down list.

b. Click the Edit... button to open the Wall dialog box.
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c. Retain the default No Slip condition and click OK to close the Wall dialog box.

10. Set the boundary conditions for the heated wall (wall_hot) for the secondary phase (solids) same as that
of the primary phase.

Setup → Boundary Conditions → wall_hot

For the secondary phase, you will retain the default no slip condition as for the primary phase.

11. Set the boundary conditions for the adiabatic wall (wall_ins).

Setup → Boundary Conditions → wall_ins

For the adiabatic wall, retain the default thermal conditions for the mixture (zero heat flux), and the
default momentum conditions (no slip) for both phases.

21.4.9. Solution

1. Select the second order implicit transient formulation and higher-order spatial discretization schemes.

Solving → Solution → Methods...

a. Select Second Order Implicit from the Transient Formulation drop-down list.
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b. Modify the discretization methods in the Spacial Discretization group box.

i. Select Second Order Upwind for Momentum.

ii. Select Quick for Volume Fraction and Energy.

2. Set the solution parameters.

Solving → Controls → Controls...

a. Enter 0.5 for Pressure.

b. Enter 0.2 for Momentum.

3. Ensure that the plotting of residuals is enabled during the calculation.

Solving → Reports → Residuals...

4. Define a custom field function for the heat transfer coefficient.

User Defined → Field Functions → Custom...

Initially, you will define functions for the mixture temperature, and thermal conductivity, then you will
use these to define a function for the heat transfer coefficient.
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a. Define the function t_mix.

i. Select Temperature... and Static Temperature from the Field Functions drop-down lists.

ii. Ensure that air is selected from the Phase drop-down list and click Select.

iii. Click the multiplication symbol in the calculator pad.

iv. Select Phases... and Volume fraction from the Field Functions drop-down list.

v. Ensure that air is selected from the Phase drop-down list and click Select.

vi. Click the addition symbol in the calculator pad.

vii. Similarly, add the term solids-temperature * solids-vof.

viii.Enter t_mix for New Function Name.

ix. Click Define.

b. Define the function k_mix.

i. Select Properties... and Thermal Conductivity from the Field Functions drop-down lists.
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ii. Select air from the Phase drop-down list and click Select.

iii. Click the multiplication symbol in the calculator pad.

iv. Select Phases... and Volume fraction from the Field Functions drop-down lists.

v. Ensure that air is selected from the Phase drop-down list and click Select.

vi. Click the addition symbol in the calculator pad.

vii. Similarly, add the term solids-thermal-conductivity-lam * solids-vof.

viii.Enter k_mix for New Function Name.

ix. Click Define.

c. Define the function ave_htc.

i. Click the subtraction symbol in the calculator pad.

ii. From the Field Functions drop-down lists, select Custom Field Functions... and k_mix and click
Select.

iii. Use the calculator pad and the Field Functions lists to complete the definition of the function.

iv. Enter ave_htc for New Function Name.

v. Click Define and close the Custom Field Function Calculator dialog box.

5. Define the point surface in the cell next to the wall on the plane .

Setting Up Domain → Surface → Create → Point...
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a. Enter 0.28494 m for x0 and 0.24 m for y0 in the Coordinates group box.

b. Enter y=0.24 for New Surface Name.

c. Click Create and close the Point Surface dialog box.

6. Create a surface report definition for the heat transfer coefficient.

Solving → Reports → Definitions → New → Surface Report → Facet Average
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a. Enter surf-mon-1 for Name of the surface report definition.

b. In the Create group box, enable Report File, Report Plot and Print to Console.

c. Select Custom Field Functions... and ave_htc from the Field Variable drop-down lists.

d. Select y=0.24 from the Surfaces selection list.

e. Click OK to save the surface report definition settings and close the Surface Report Definition dialog
box.

surf-mon-1-rplot and surf-mon-1-rfile that are automatically generated by Fluent appear in
the tree (under Solution/Monitors/Report Plots and Solution/Monitors/Report Files, respect-
ively).

f. Rename the report output file.

Solution → Monitors → Report Files → surf-mon-1-rfile Edit...
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i. Enter htc-024.out for Output File Base Name.

ii. Click OK to close the Edit Report File dialog box.

7. Initialize the solution.

Solving → Initialization → Options...
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a. Select all-zones from the Compute from drop-down list.

b. Retain the default values and click Initialize.

8. Define an adaption register for the lower half of the fluidized bed.

Setting Up Domain → Adapt → Mark/Adapt Cells → Region...

This register is used to patch the initial volume fraction of solids in the next step.
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a. Enter 0.3 m for Xmax and 0.5 m for Ymax in the Input Coordinates group box.

b. Click Mark.

c. Click the Manage... button to open the Manage Adaption Registers dialog box.

i. Ensure that hexahedron-r0 is selected from the Registers selection list.

ii. Click Display and close the Manage Adaption Registers dialog box.

After you define a region for adaption, it is a good practice to display it to visually verify that it
encompasses the intended area.
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Figure 21.3:  Region Marked for Patching

d. Close the Region Adaption dialog box.

9. Patch the initial volume fraction of solids in the lower half of the fluidized bed.

Solving → Initialization → Patch...

a. Select solids from the Phase drop-down list.
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b. Select Volume Fraction from the Variable selection list.

c. Enter 0.598 for Value.

d. Select hexahedron-r0 from the Registers to Patch selection list.

e. Click Patch and close the Patch dialog box.

At this point, it is a good practice to display contours of the variable you just patched, to ensure that the
desired field was obtained.

10. Display contours of Volume Fraction of solids (Figure 21.4: Initial Volume Fraction of Granular Phase
(solids) (p. 872)).

Postprocessing → Graphics → Contours → Edit...

a. Enable Filled in the Options group box.

b. Select Phases... from the upper Contours of drop-down list.

c. Select solids from the Phase drop-down list.

d. Ensure that Volume fraction is selected from the lower Contours of drop-down list.

e. Click Display and close the Contours dialog box.

Figure 21.4:  Initial Volume Fraction of Granular Phase (solids)

11. Save the case file (fluid-bed.cas.gz).
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File → Write → Case...

12. Start calculation.

Solving → Run Calculation → Advanced...

a. Set 0.00015 for Time Step Size(s).

b. Set 12000 for Number of Time Steps.

c. Enter 50 for Max Iterations/Time Step.

d. Click Calculate.

The plot of the value of the mixture-averaged heat transfer coefficient in the cell next to the heated wall
versus time is in excellent agreement with results published for the same case [1].
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Figure 21.5:  Plot of Mixture-Averaged Heat Transfer Coefficient in the Cell Next to the Heated
Wall Versus Time

13. Save the case and data files (fluid-bed.cas.gz and fluid-bed.dat.gz).

File → Write → Case & Data...

21.4.10. Postprocessing

1. Display the pressure field in the fluidized bed (Figure 21.6: Contours of Static Pressure (p. 876)).

Postprocessing → Graphics → Contours → Edit...
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a. Select mixture from Phase drop-down list.

b. Select Pressure... and Static Pressure from the Contours of drop-down lists.

c. Click Display.
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Figure 21.6:  Contours of Static Pressure

Note the build-up of static pressure in the granular phase.

2. Display the volume fraction of solids (Figure 21.7: Contours of Volume Fraction of Solids (p. 877)).

a. Select solids from the Phase drop-down list.

b. Select Phases... and Volume fraction from the Contours of drop-down lists.

c. Click Display and close the Contours dialog box.

d. Zoom in to show the contours close to the region where the change in volume fraction is the greatest.

Note that the region occupied by the granular phase has expanded slightly, as a result of fluidization.
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Figure 21.7:  Contours of Volume Fraction of Solids

21.5. Summary

This tutorial demonstrated how to set up and solve a granular multiphase problem with heat transfer,
using the Eulerian model. You learned how to set boundary conditions for the mixture and both phases.
The solution obtained is in excellent agreement with analytical results from Kuipers et al. [1].

21.6. Further Improvements

This tutorial guides you through the steps to reach an initial solution. You may be able to obtain a more
accurate solution by using an appropriate higher-order discretization scheme and by adapting the mesh
further. Mesh adaption can also ensure that the solution is independent of the mesh. These steps are
demonstrated in Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 121).

21.7. References

1. J. A. M. Kuipers, W. Prins, and W. P. M. Van Swaaij “Numerical Calculation of Wall-to-Bed Heat Transfer
Coefficients in Gas-Fluidized Beds", Department of Chemical Engineering, Twente University of Technology,
in AIChE Journal, July 1992, Vol. 38, No. 7.

877
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

References



Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.878



Chapter 22: Postprocessing

This tutorial is divided into the following sections:
22.1. Introduction
22.2. Prerequisites
22.3. Problem Description
22.4. Setup and Solution
22.5. Summary

22.1. Introduction

This tutorial demonstrates the postprocessing capabilities of Fluent using a 3D model of a flat circuit
board with a heat generating electronic chip mounted on it. The flow over the chip is laminar and involves
conjugate heat transfer.

The heat transfer involves conduction in the chip and conduction and convection in the surrounding
fluid. The physics of conjugate heat transfer such as this are common in many engineering applications,
including the design and cooling of electronic components.

In this tutorial, you will read the case and data files (without doing the calculation) and perform a
number of postprocessing exercises.

This tutorial demonstrates how to do the following:

• Add lights to the display at multiple locations.

• Create surfaces for the display of 3D data.

• Display filled contours of temperature on several surfaces.

• Display velocity vectors.

• Mirror a display about a symmetry plane.

• Create animations.

• Create a scene.

• Display results on successive slices of the domain.

• Display pathlines.

• Plot quantitative results.

• Overlay and “explode” a display.

• Annotate the display.
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22.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the Fluent tree and ribbon structure. Some steps in the setup and solution
procedure will not be shown explicitly.

22.3. Problem Description

The problem considered is shown schematically in Figure 22.1: Problem Specification (p. 880). The con-
figuration consists of a series of side-by-side electronic chips, or modules, mounted on a circuit board.
Air flow, confined between the circuit board and an upper wall, cools the modules. To take advantage
of the symmetry present in the problem, the model will extend from the middle of one module to the
plane of symmetry between it and the next module.

As shown in the figure, each half-module is assumed to generate 2.0 Watts and to have a bulk conduct-

ivity of 1.0 -K. The circuit board conductivity is assumed to be one order of magnitude lower:

0.1 -K. The air flow enters the system at 298 K with a velocity of 1 m/s. The Reynolds number of
the flow, based on the module height, is about 600. The flow is therefore treated as laminar.

Figure 22.1:  Problem Specification

22.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
22.4.1. Preparation
22.4.2. Reading the Mesh
22.4.3. Manipulating the Mesh in the Viewer
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22.4.4. Adding Lights
22.4.5. Creating Isosurfaces
22.4.6. Generating Contours
22.4.7. Generating Velocity Vectors
22.4.8. Creating an Animation
22.4.9. Displaying Pathlines
22.4.10. Creating a Scene With Vectors and Contours
22.4.11. Advanced Overlay of Pathlines on a Scene
22.4.12. Creating Exploded Views
22.4.13. Animating the Display of Results in Successive Streamwise Planes
22.4.14. Generating XY Plots
22.4.15. Creating Annotation
22.4.16. Saving Picture Files
22.4.17. Generating Volume Integral Reports

22.4.1. Preparation

To prepare for running this tutorial:

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the postprocess_R180.zip link to download the input files.

7. Unzip the postprocess_R180.zip file you downloaded to your working folder.

The files chip.cas.gz and chip.dat.gz can be found in the postprocess folder created after
unzipping the file.

8. Use Fluent Launcher to start the 3D version of Fluent.

Fluent Launcher displays your Display Options preferences from the previous session.

For more information about Fluent Launcher, see starting ANSYS Fluent using the Fluent Launcher
in the Fluent Getting Started Guide.
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9. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

10. Ensure that the Serial processing option is selected.

11. Ensure that the Double Precision option is disabled.

22.4.2. Reading the Mesh

1. Read in the case and data files chip.cas.gz and chip.dat.gz.

File → Read → Case & Data...

When you select the case file, Fluent will read the data file automatically.

22.4.3. Manipulating the Mesh in the Viewer

1. Display the mesh surfaces board-top and chip.

Setting Up Domain → Mesh → Display...

a. Retain the default enabling of the Edges option and disable the Faces option in the Options group
box.

b. Deselect all surfaces and select board-top and chip from the Surfaces selection list.

Click  to deselect all surfaces. Click  and select Surface Type under Group By to list the surfaces
by type, as shown above.

c. Click the Colors... button to open the Mesh Colors dialog box.

i. Select Color by ID in the Options group box.

ii. Click Reset Colors to reset the mesh colors to the default settings and close the Mesh Colors dialog
box.
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d. Click Display.

2. Rotate and adjust the magnification of the view.

Use the left mouse button to rotate the view. Use the middle mouse button to adjust the magnification
until you obtain an enlarged display of the circuit board in the region of the chip, as shown in Fig-
ure 22.2: Mesh Display of the Chip and Board Surfaces (p. 883).

Figure 22.2:  Mesh Display of the Chip and Board Surfaces

Extra

You can click the right mouse button on one of the mesh boundaries displayed in the
graphics window and its surface group, ID, and name will be displayed in the console.
This feature is especially useful when you have several zones of the same type and you
want to distinguish between them.
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3. Display the mesh faces.

Setting Up Domain → Mesh → Display...

a. Disable Edges and enable Faces in the Options group box.

b. Click Display and close the Mesh Display dialog box.

22.4.4. Adding Lights

1. Add lighting effects.

The default light settings add a white light at the position (1,1,1). The default light is defined in the Lights
dialog box by the Light ID 0 with Direction vectors (X, Y, Z) as (1, 1, 1).

Viewing → Display → Options...

a. Make sure that the Lights On option is enabled in the Lighting Attributes group box.

b. Retain Gouraud as the selected Lighting method.

Flat is the most basic lighting whereas Gouraud gives better color gradation. Note that Gouraud
rounds off corners, and so should be used with caution on highly angular geometries.
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c. Click Apply and close the Display Options dialog box.

Shading will be added to the surface mesh display (Figure 22.3: Graphics Window with Default
Lighting (p. 885)).

Figure 22.3:  Graphics Window with Default Lighting

2. Add lights in two directions, (-1, 1, 1) and (-1, 1, -1).

Viewing → Graphics → Lights...
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You can also open the Lights dialog box by clicking the Lights... button in the Display Options dialog
box.

a. Set Light ID to 1.

b. Enable Light On.

c. Enter -1,1, and 1 for X, Y, and Z respectively in the Direction group box.

d. Retain the selection of Gouraud in the Lighting Method drop-down list.

e. Make sure that the Headlight On option is enabled.

The Headlight On option provides constant lighting effect from a light source directly in front of the
model, in the direction of the view. You can turn off the headlight by disabling the Headlight On
option (the results of this action are shown in Figure 22.4: Display with Additional Lighting: - Headlight
Off (p. 887)).
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Figure 22.4:  Display with Additional Lighting: - Headlight Off

f. Click Apply.

g. Similarly, add a second light (Light ID= 2 with Light On enabled) with a Direction of (-1,1,-1).

The result will be more softly shaded display (Figure 22.5: Display with Additional Lighting (p. 888)).
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Figure 22.5:  Display with Additional Lighting

h. Close the Lights dialog box.

Extra

You can use the left mouse button to rotate the ball in the Active Lights window to gain a
perspective view on the relative locations of the lights that are currently active, and see the
shading effect on the ball at the center.

You can also change the color of one or more of the lights by selecting the color from the
Color drop-down list or by moving the Red, Green, and Blue sliders.
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22.4.5. Creating Isosurfaces

To display results in a 3D model, you will need surfaces on which the data can be displayed. Fluent creates
surfaces for all boundary zones automatically. Several surfaces have been renamed after reading the case
file. Examples are board-sym and board-ends, which correspond to the side and end faces of the circuit
board.

You can define additional surfaces for viewing the results, such as a plane in Cartesian space. In this exercise,
you will create a horizontal plane cutting through the middle of the module with a Y value of 0.25 inches.
You can use this surface to display the temperature and velocity fields.

1. Create a surface of constant Y coordinate.

Postprocessing → Surface → Create → Iso-Surface...

a. Select Mesh... and Y-Coordinate from the Surface of Constant drop-down lists.

b. Click Compute.

The Min and Max fields display the Y extents of the domain.

c. Enter 0.25 for Iso-Values.

d. Enter y=0.25in for New Surface Name.

Tip

When you are creating multiple postprocessing surfaces, it can be helpful to group

surfaces by type for viewing in lists (Click  and select Surface Type under Group
By). All iso-surfaces will be grouped together.
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e. Click Create and close the Iso-Surface dialog box.

2. Create a clipped surface for the X coordinate of the fluid (fluid-sym).

Setting Up Domain → Surface → Create → Iso-Clip...

a. Select Mesh... and X-Coordinate from the Clip to Values of drop-down lists.

b. Select fluid-sym from the Clip Surface selection list. You can type fluid into the Filter Text box to
quickly find this surface.

c. Click Compute.

The Min and Max fields display the X extents of the domain.

d. Enter 1.9 and 3.9 for Min and Max respectively.

This will isolate the area around the chip.

e. Enter fluid-sym-x-clip for New Surface Name.

f. Click Clip.

3. Create a clipped surface for the Y coordinate of the fluid (fluid-sym).

Setting Up Domain → Surface → Create → Iso-Clip...
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a. Select Mesh... and Y-Coordinate from the Clip to Values of drop-down lists.

b. Retain the selection of fluid-sym from the Clip Surface selection list.

c. Click Compute.

The Min and Max fields display the Y extents of the domain.

d. Enter 0.1 and 0.5 for Min and Max respectively.

This will isolate the area around the chip.

e. Enter fluid-sym-y-clip for New Surface Name.

f. Click Clip and close the Iso-Clip dialog box.

22.4.6. Generating Contours

1. Display filled contours of temperature on the symmetry plane (Figure 22.6: Filled Contours of Temperature
on the Symmetry Surfaces (p. 893)).

Postprocessing → Graphics → Contours → New...

891
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



a. Enter temperature_contour for Contour Name.

b. Ensure Filled, Node Values, Global Range, and Auto Range are enabled in the Options group box.

c. Select Smooth for Coloring.

d. Select Temperature... and Static Temperature from the Contours of drop-down lists.

e. Click  and select Surface Type under Group By (if surfaces are not already grouped by type).

f. Select board-sym, chip-sym, and fluid-sym (under Symmetry in the Surfaces selection list.)

g. Click Save/Display.

h. Rotate and adjust the magnification of the view using the left and middle mouse buttons, respectively,
to obtain the view as shown in Figure 22.6: Filled Contours of Temperature on the Symmetry Sur-
faces (p. 893).

Tip

If the model disappears from the graphics window at any time, or if you are having
difficulty manipulating it with the mouse, do one of the following:

• Click the Fit to Window button in the graphics toolbar.

• Open the Views dialog box by right-clicking Graphics in the tree (under Results)
and selecting Views... from the menu that opens, and then use the Default button
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to reset the view. You could also click Camera... in this dialog box to open the
Camera Parameters dialog box, where you could select orthographic from the
Projection drop-down list to reduce the likelihood of zooming through the geo-
metry.

• Press the Ctrl + L to revert to a previous view.

The peak temperatures in the chip appear where the heat is generated, along with the higher temperatures
in the wake where the flow is recirculating.

Figure 22.6:  Filled Contours of Temperature on the Symmetry Surfaces

2. Display filled contours of temperature for the clipped surface (Figure 22.7: Filled Contours of Temperature
on the Clipped Surface (p. 894)).

Results → Graphics → Contours → temperature_contour Edit...
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a. Click  to deselect all surfaces from the Surfaces selection list and then select fluid-sym-x-clip and
fluid-sym-y-clip.

b. Click Save/Display.

A clipped surface appears, colored by temperature (Figure 22.7: Filled Contours of Temperature on
the Clipped Surface (p. 894)).

Figure 22.7:  Filled Contours of Temperature on the Clipped Surface

3. Display filled contours of temperature on the plane, y=0.25in (Figure 22.8: Temperature Contours on the
Surface, Y= 0.25 in. (p. 895)).

Results → Graphics → Contours → temperature_contour Edit...

a. Click  to deselect all surfaces from the Surfaces selection list and then select y=0.25in.
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b. Click Save/Display and close the Contours dialog box.

The filled temperature contours will be displayed on the y=0.25in plane.

c. Orient the view to display the contours.

4. Change the location of the colormap in the graphics window.

Left-click the colormap in the graphics window and drag it to the bottom of the graphics window.
This can also be accomplished using the Display Options dialog box.

Tip

You can increase/decrease the size of the colormap by dragging the corners of the box
that appears when you hover over the colormap.

Figure 22.8: Temperature Contours on the Surface, Y= 0.25 in.
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In Figure 22.8: Temperature Contours on the Surface, Y= 0.25 in. (p. 895), the high temperatures in the
wake of the module are clearly visible. You can also display other quantities such as velocity magnitude
or pressure using the Contours dialog box.

22.4.7. Generating Velocity Vectors

Velocity vectors provide an excellent visualization of the flow around the module, depicting details of the
wake structure.

1. Display velocity vectors on the symmetry plane through the module centerline (Figure 22.9: Velocity Vectors
in the Module Symmetry Plane (p. 898)).

Postprocessing → Graphics → Vectors → New...

a. Enter velocity_vector for Vector Name.

b. Confirm that Velocity is selected under Vectors of and that Color by is set to Velocity... and Velocity
Magnitude.

c. Ensure Global Range, Auto Range, and Auto Scale are the only enabled Options.

d. Enter 1.9 for Scale.

e. Click  to deselect all surfaces from the Surfaces selection list and then select fluid-sym.

f. Click Save/Display and close the Vectors dialog box.
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g. Orient the view to display the vectors.

Extra

You can display velocity vectors for the clipped surfaces.

Results → Graphics → Vectors → velocity_vector Edit...

a. Deselect all surfaces from the Surfaces selection list and then select fluid-sym-x-clip and
fluid-sym-y-clip.

b. Click Save/Display.

2. Rotate and adjust the magnification of the view to observe the vortex near the stagnation point and in the
wake of the module (Figure 22.9: Velocity Vectors in the Module Symmetry Plane (p. 898)).
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Figure 22.9: Velocity Vectors in the Module Symmetry Plane

3. Plot velocity vectors in the horizontal plane intersecting the module (Figure 22.10: Velocity Vectors Inter-
secting the Surface (p. 900)).

Postprocessing → Graphics → Vectors → Edit...

a. Enable Draw Mesh in the Options group box to open the Mesh Display dialog box.
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i. Ensure that Faces is enabled in the Options group box.

ii. Retain the selection of board-top and chip from the Surfaces selection list.

iii. Click the Colors... button to open the Mesh Colors dialog box.

A. Select Color by Type in the Options group box.

B. Select wall from the Types selection list.

C. Select light blue from the Colors selection list and close the Mesh Colors dialog box.

iv. Click Display and close the Mesh Display dialog box.

b. Enter 3.8 for Scale.
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c. Deselect all surfaces.

d. Select y=0.25in from the Surfaces selection list.

e. Click Display and close the Vectors dialog box.

f. Rotate the view and reduce the magnification to obtain the view as shown in Figure 22.10: Velocity
Vectors Intersecting the Surface (p. 900).

Figure 22.10: Velocity Vectors Intersecting the Surface

4. Mirror the image about the chip symmetry plane (Figure 22.11: Velocity Vectors After Mirroring (p. 902)).

Viewing → Display → Views...
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a. Select symmetry-18 from the Mirror Planes selection list.

Note

This zone is the centerline plane of the module and its selection will create a mirror
of the entire display about the centerline plane.

b. Click Apply and close the Views dialog box.

The display will be updated in the graphics window (Figure 22.11: Velocity Vectors After Mirror-
ing (p. 902)).
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Figure 22.11: Velocity Vectors After Mirroring

22.4.8. Creating an Animation

Using Fluent, you can animate the solution. For information on animating the solution, see Using Dynamic
Meshes (p. 501). In this tutorial, you will animate between two static views of the graphics window.

You will display the surface temperature distribution on the module and the circuit board by selecting the
corresponding boundaries. You will also create the key frames and view the transition between the key
frames, dynamically, using the animation feature.

1. Display filled contours of surface temperature on the board-top and chip surfaces. (Figure 22.12: Filled
Temperature Contours on the Chip and Board Top Surfaces (p. 904)).

Results → Graphics → Contours → temperature_contour Edit...
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a. Ensure that Filled is enabled in the Options group box.

b. Retain the selection of Temperature... and Static Temperature from the Contours of drop-down lists.

c. Deselect all surfaces.

d. Select board-top and chip from the Surfaces selection list.

e. Click Save/Display and close the Contours dialog box.

f. Reorient the display as needed to obtain the view shown in Figure 22.12: Filled Temperature Contours
on the Chip and Board Top Surfaces (p. 904).

Figure 22.12: Filled Temperature Contours on the Chip and Board Top Surfaces (p. 904) shows the high
temperatures on the downstream portions of the module and relatively localized heating of the circuit
board around the module.
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Figure 22.12:  Filled Temperature Contours on the Chip and Board Top Surfaces

2. Create the key frames by changing the point of view.

Postprocessing → Animation → Scene Animation...
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You will use the current display (Figure 22.12: Filled Temperature Contours on the Chip and Board Top
Surfaces (p. 904)) as the starting view for the animation (Frame = ).

a. Click Add in the Key Frames group box to create the first frame for your animation.

This will store the current display as Key-1.

b. Magnify the view to focus on the module region.

c. Enter 100 for Frame in the Key Frames group box.

d. Click Add to create the tenth frame for your animation.

This will store the new display as Key-100.
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The magnified view will be the one-hundredth key frame of the animation, with intermediate displays
(2 through 99) to be filled in during the animation.

e. Rotate the view and adjust the magnification so that the downstream side of the module is in the
foreground (Figure 22.13: Filled Temperature Contours on the Chip and Board Top Surfaces (p. 906)).

Figure 22.13:  Filled Temperature Contours on the Chip and Board Top Surfaces

f. Enter 200 for Frame.

g. Click Add to create the two-hundredth frame for your animation.
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This will store the new display as Key-200.

Note

You can check the display view of any of your saved key frames by selecting it in the
Keys list.

3. View the scene animation by clicking the “play” button ( ) in the Playback group box.

Note

If your computer is having difficulty displaying the animation with 200 frames, you can
increase the increment to 50.

While effective animation is best conducted on “high-end” graphics workstations, you can view scene
animations on any workstation. If the graphics display speed is slow, the animation playback will take
some time and will appear choppy, with the redrawing very obvious. On fast graphics workstations, the
animation will appear smooth and continuous and will provide an excellent visualization of the display
from a variety of spatial orientations. On many machines, you can improve the smoothness of the anim-
ation by enabling the Double Buffering option in the Display Options dialog box.

To produce a slower animation, increase the number of frames between the key frames. The more sparsely
you place your key frames, the more transition frames Fluent creates between the key frames and
therefore stretching out your animation.

Note

You can also make use of animation tools of Fluent for transient cases as demonstrated
in Modeling Transient Compressible Flow (p. 267).

Extra

You can change the Playback Mode if you want to “auto repeat” or “auto reverse” the

animation. When you are in either of these modes, you can click the “stop” button ( )
to stop the continuous animation.

4. Close the Animate dialog box.

22.4.9. Displaying Pathlines

Pathlines are the lines traveled by neutrally buoyant particles in equilibrium with the fluid motion. Pathlines
are an excellent tool for visualization of complex three-dimensional flows. In this example, you will use
pathlines to examine the flow around and in the wake of the module.

1. Create a rake from which the pathlines will emanate.

Postprocessing → Surface → Create → Line/Rake...
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a. Select Rake from the Type drop-down list.

A rake surface consists of a specified number of points equally spaced between two specified endpoints.
A line surface (the other option in the Type drop-down list) is a line that includes the specified end-
points and extends through the domain; data points on a line surface will not be equally spaced.

b. Retain the default value of 10 for Number of Points.

This will generate 10 pathlines.

c. Enter a starting coordinate of (1.0, 0.105, 0.07) and an ending coordinate of (1.0, 0.25,
0.07) in the End Points group box.

This will define a vertical line in front of the module, about halfway between the centerline and edge.

d. Enter pathline-rake for New Surface Name.

You will refer to the rake by this name when you plot the pathlines.

e. Click Create and close the Line/Rake Surface dialog box.

2. Draw the pathlines (Figure 22.14: Pathlines Display (p. 910)).

Postprocessing → Graphics → Pathlines... → Edit...
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a. Enable Draw Mesh in the Options group box to open the Mesh Display dialog box.

i. Ensure that Faces is enabled in the Options group box.

ii. Retain the selection of board-top and chip from the Surfaces selection list.

These surfaces should already be selected from the earlier exercise where the mesh was displayed
with velocity vectors.

iii. Close the Mesh Display dialog box.

b. Enter 0.001 inch for Step Size.

c. Enter 6000 for Steps.

Note

As a general guideline to follow when you are setting these two parameters is that
if you want the particles to advance through a domain of length , the Step Size
times the number of Steps should be approximately equal to .

d. Set Path Coarsen to 5.

Coarsening the pathline simplifies the plot and reduces the plotting time. The coarsening factor spe-
cified for Path Coarsen indicates the interval at which the points are plotted for a given pathline in
any cell.

e. Select pathline-rake from the Release from Surfaces selection list.
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f. Click Display.

The pathlines will be drawn on the surface.

g. Rotate and magnify the view so that the flow field is in front and the wake of the chip is visible as shown
in Figure 22.14: Pathlines Display (p. 910).

Figure 22.14:  Pathlines Display

3. Write the pathlines to a file.

a. Enable Write to File in the Options group box.

The Display button changes to a Write... button.

b. Select Fieldview from the Type drop-down list.

c. Click the Write... button to open the Select File dialog box.
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i. Enter chip-pathline for Fieldview File.

ii. Click OK to close the Select File dialog box.

Fluent will save the file in the Fieldview format with a .fvp extension.

4. Display pathlines as spheres.

Postprocessing → Graphics → Pathlines... → Edit...

a. Disable Write to File in the Options group box.

b. Select sphere from the Style drop-down list.

c. Click the Attributes... button to open the Path Style Attributes dialog box.
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i. Enter 0.0005 for Diameter.

ii. Click OK to close the Path Style Attributes dialog box.

d. Enter 1 inch for Step Size and 1000 for Steps respectively.

e. Set Path Skip to 2 and Path Coarsen to 1.

f. Retain the selection of pathline-rake in the Release from Surfaces selection list.

g. Click Display.

The spherical pathlines will be drawn along the surface.

Figure 22.15:  Sphere Pathlines Display

h. Select Surface ID from the lower Color by drop-down list.
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i. Click Display and close the Pathlines dialog box.

This will color the pathlines by the surface they are released from (Figure 22.16: Sphere Pathlines
Colored by Surface ID (p. 913)).

Figure 22.16:  Sphere Pathlines Colored by Surface ID

Note

As an optional exercise, you can create solution animations for pathlines using the Animation
Sequence dialog box.

Solution → Calculation Activities → Solution Animations Edit...

913
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



22.4.10. Creating a Scene With Vectors and Contours

Scenes allow you to display multiple graphics plots in single window.

1. Open the Scene dialog box.

Results → Scene New...

2. Enable temperature_contour and velocity_vector.

3. Increase the transparency of temperature_contour using the Transparency slider.

4. Click Save & Display to create the scene and display it in the graphics window.

5. Drag the velocity vector colormap to the top of the graphics window and modify the orientation and zoom
of the scene to match Figure 22.17: Temperature Contours and Velocity Vectors Scene (p. 915).
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6. Figure 22.17: Temperature Contours and Velocity Vectors Scene

Note

As an optional exercise, you can add a mesh graphics object to the scene as well, by selecting
Mesh... from the New Object drop-down in the Scene dialog box. Once the mesh graphics
object is saved/created, select it from the Graphics Objects list and click Save & Display in
the Scene dialog box.

22.4.11. Advanced Overlay of Pathlines on a Scene

The advanced overlay capability, provided in the Scene Description dialog box, allows you to display more
results on top of an existing display, including those not supported by the scene created in the previous
section. You can demonstrate this capability by adding pathlines to the scene that you just plotted.

1. Enable the overlays feature.
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Viewing → Graphics → Compose...

a. Enable Overlays in the Scene Composition group box.

b. Click Apply and close the Scene Description dialog box.

2. Add a plot of particle surface ID pathlines to the velocity vector and temperature scene.

Postprocessing → Graphics → Pathlines → Edit...

a. Disable Draw Mesh under Options.
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b. Click Display and close the Pathlines dialog box.

c. Use the mouse to obtain the view that is shown in Figure 22.18: Overlay of Pathlines on Velocity Vectors
and Temperature Contours Scene (p. 917).

Figure 22.18:  Overlay of Pathlines on Velocity Vectors and Temperature Contours Scene

22.4.12. Creating Exploded Views

The Scene Description dialog box stores each display that you request and allows you to manipulate the
displayed items individually. This capability can be used to generate “exploded” views, in which results are
translated or rotated out of the physical domain for enhanced display. As shown in the Scene Description
dialog box, you can experiment with this capability by displaying “side-by-side” velocity vectors and temper-
ature contours on a streamwise plane in the module wake.

1. Clear the temperature contours, velocity vectors, and pathlines from the current display.
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Click the Close Tab button ( ) to clear the graphics window (located at on the right-hand side of
the graphics window tab).

2. Create a plotting surface at X = 3 inches (named x=3.0in), just downstream of the trailing edge of the
module.

Postprocessing → Surface → Create → Iso-Surface...

Tip

For details on creating an isosurface, see Creating Isosurfaces (p. 889).

3. Add the display of filled temperature contours on the x=3.0in surface.

Postprocessing → Graphics → Contours → Edit...
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a. Disable Draw Mesh under Options.

b. Deselect all surfaces in the Surfaces list.

c. Select x=3.0in from the Surfaces selection list.

d. Click Display and close the Contours dialog box.

The filled temperature contours will be displayed on the x=3.0in surface.

4. Add the velocity vectors on the x=3.0in plotting surface.

Postprocessing → Graphics → Vectors → Edit...
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a. Enable the Draw Mesh option in the Options group box to open the Mesh Display dialog box.

i. Retain the default settings.

ii. Close the Mesh Display dialog box.

b. Enter 1.9 for Scale.

c. Set Skip to 2.

d. Deselect all surfaces.

e. Select x=3.0in from the Surfaces selection list.

f. Click Display and close the Vectors dialog box.

The display will show the vectors superimposed on the contours of temperature at =3.0 in.

5. Create the exploded view by translating the contour display, placing it above the vectors (Figure 22.19: Ex-
ploded Scene Display of Temperature and Velocity (p. 922)).

Viewing → Graphics → Compose...

a. Select temperature_contour-9 from the Names selection list.

b. Click the Transform... button to open the Transformations dialog box.
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i. Enter 1 inch for Y in the Translate group box.

ii. Click Apply and close the Transformations dialog box.

The exploded view allows you to see the contours and vectors as distinct displays in the final scene
(Figure 22.19: Exploded Scene Display of Temperature and Velocity (p. 922)).

c. Deselect Overlays.

d. Click Apply and close the Scene Description dialog box.

e. Magnify the view, as shown in Figure 22.19: Exploded Scene Display of Temperature and Velocity (p. 922).
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Figure 22.19:  Exploded Scene Display of Temperature and Velocity

22.4.13. Animating the Display of Results in Successive Streamwise Planes

You may want to march through the flow domain, displaying a particular variable on successive slices of
the domain. While this task could be accomplished manually, plotting each plane in turn, or using the Scene
Description and Animate dialog boxes, here you will use the Sweep Surface dialog box to facilitate the
process. To illustrate the display of results on successive slices of the domain, you will plot contours of velocity
magnitude on planes along the  axis.

1. Delete the vectors and temperature contours from the display.

Click the Close Tab button ( ) to clear the graphics window (located at on the right-hand side of
the graphics window tab).

2. Display the mesh on surfaces board-top and chip.

Postprocessing → Graphics → Mesh → Edit...
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3. Use the mouse to reduce the magnification of the view in the graphics window so that the entire board
surface is visible.

4. Generate contours of velocity magnitude and sweep them through the domain along the X axis.

Postprocessing → Animation → Sweep Surface...

a. Retain the default settings in the Sweep Axis group box.

b. Retain the default value of 0 m for Initial Value in the Animation group box.

c. Retain 0.1651 m for Final Value.

Warning

The units for the initial and final values are in meters, regardless of the length
units being used in the model. Here, the initial and final values are set to the
Min Value and Max Value, to generate an animation through the entire domain.

d. Enter 20 for Frames.

e. Select Contours from the Display Type list to open the Contours dialog box.
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i. Disable Draw Mesh under Options.

ii. Select Velocity... and Velocity Magnitude from the Contours of drop-down lists.

iii. Click OK to close the Contours dialog box.

f. Click Animate and close the Sweep Surface dialog box.

You will see the velocity contour plot displayed at 20 successive streamwise planes. Fluent will automat-
ically interpolate the contoured data on the streamwise planes between the specified end points. Especially
on high-end graphics workstations, this can be an effective way to study how a flow variable changes
throughout the domain.

Note

You can also make use of animation tools of Fluent for transient cases as demonstrated in
Modeling Transient Compressible Flow (p. 267).

22.4.14. Generating XY Plots

XY plotting can be used to display quantitative results of your CFD simulations. Here, you will complete the
review of the module cooling simulation by plotting the temperature distribution along the top centerline
of the module.

1. Define the line along which to plot results.

Postprocessing → Surface → Create → Line/Rake...
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a. Select Line from the Type drop-down list.

b. Enter the coordinates of the line using a starting coordinate of (2.0,0.4,0.01) and an ending co-
ordinate of (2.75,0.4,0.01) in the End Points group box.

These coordinates define the top centerline of the module.

c. Enter top-center-line for New Surface Name.

d. Click Create and close the Line/Rake Surface dialog box.

2. Plot the temperature distribution along the top centerline of the module (Figure 22.20: Temperature Along
the Top Centerline of the Module (p. 928)).

Postprocessing → Plots → XY Plot → New...
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a. Retain the default Plot Direction of (1,0,0).

b. Select Temperature... and Static Temperature from the Y Axis Function drop-down lists.

c. Select top-center-line from the Surfaces selection list.

This will plot temperature vs. the X coordinate along the selected line (top-center-line).

d. Click the Axes... button to open the Axes - Solution XY Plot dialog box.
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i. Retain the selection of X in the Axis list.

ii. Disable Auto Range in the Options group box.

iii. Enter 2.0 for Minimum and 2.75 for Maximum in the Range group box.

iv. Click Apply and close the Axes - Solution XY Plot dialog box.

e. Click Save/Plot and close the Solution XY Plot dialog box.

The temperature distribution (Figure 22.20: Temperature Along the Top Centerline of the Module (p. 928))
shows the temperature increase across the module surface as the thermal boundary layer develops
in the cooling air flow.
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Figure 22.20: Temperature Along the Top Centerline of the Module

22.4.15. Creating Annotation

You can annotate the display with the text of your choice.

Viewing → Graphics → Annotate...

1. Enter the text describing the plot (for example,Temperature Along the Top Centerline) in the
Annotation Text field.
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2. Select 20 from the Size drop-down list in the Font Specification group box.

3. Click Add.

A Working dialog box will appear telling you to select the desired location of the text using the mouse-
probe button.

4. Click the right mouse button in the graphics window where you want the text to appear, and you will see
the text displayed at the selected location (Figure 22.21: A Display with Annotation (p. 929)).

Extra

If you want to move the text to a new location on the screen, select the text in the Names
selection list, click Delete Text, and click Add once again, defining a new position with
the mouse.

Note

Depending on the size of the graphics window and the picture file format you choose,
the font size of the annotation text you see on the screen may be different from the font
size in a picture file of that graphics window. The annotation text font size is absolute,
while the rest of the items in the graphics window are scaled to the proportions of the
picture file.

Figure 22.21:  A Display with Annotation

5. Close the Annotate dialog box.
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22.4.16. Saving Picture Files

You can save picture files of the graphics window in many different formats, including PostScript, encapsulated
PostScript, TIFF, PNG, PPM, JPEG, VRML and window dumps. Here, the procedure for saving a color PostScript
file is shown.

Click the Save Picture icon-  in the toolbar to open the Save Picture dialog box.

1. Select JPEG from the Format list.

2. Retain the default selection of Color from the Coloring list.

3. Click the Save... button to open the Select File dialog box.

a. Enter a name for Hardcopy File.

b. Click OK to close the Select File dialog box.

4. Close the Save Picture dialog box.

22.4.17. Generating Volume Integral Reports

Reports of volume integrals can be used to determine the volume of a particular fluid region (that is, a fluid
zone), the sum of quantities, or the maximum and minimum values of particular variables. Here we will use
the volume integral reports to determine the maximum and minimum temperature in the chip, board, and
the airflow.

Postprocessing → Reports → Volume Integrals...
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1. Select Maximum from the Report Type list.

2. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

3. Select solid-1 from the Cell Zones selection list.

4. Click Compute to calculate the maximum temperature.

The maximum temperature in the solid-1 cell zone (the chip) is displayed.

5. Select Minimum in the Report Type group box and click Compute.

The minimum temperature in the solid-1 cell zone (the chip) is displayed.

6. Repeat the operations to determine the maximum and minimum temperatures in the solid-2 and fluid-8
cell zones, corresponding to the board and fluid volume, respectively.

22.5. Summary

This tutorial demonstrated the use of many of the extensive postprocessing features available in Fluent.

For more information on these and related features, see reporting alphanumeric data and displaying
graphics in the Fluent User's Guide.
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Chapter 23: Using the Adjoint Solver – 2D Laminar Flow Past a
Cylinder

This tutorial is divided into the following sections:
23.1. Introduction
23.2. Prerequisites
23.3. Problem Description
23.4. Setup and Solution
23.5. Summary

23.1. Introduction

ANSYS Fluent’s adjoint solver is used to compute the sensitivity of quantities of interest in a fluid system
with respect to the user-specified inputs, for an existing flow solution. Importantly, this also includes
the sensitivity of the computed results with respect to the geometric shape of the system. The adjoint
design change tool is a powerful component that can use the sensitivity information from one or more
adjoint solutions to guide systematic changes that result in predictable improvements in the system
performance, which can be made subject to various types of design constraints if desired.

This tutorial provides an example of how to generate sensitivity data for flow past a circular cylinder,
how to postprocess the results, and how to use the data to perform a multi-objective design change
that reduces drag and increases lift by morphing the mesh. The tutorial makes use of a previously
computed flow solution, and demonstrates how to do the following:

• Load the adjoint solver add-on.

• Select the observable of interest.

• Access the solver controls for advancing the adjoint solution.

• Set convergence criteria and plot and print residuals.

• Advance the adjoint solver.

• Postprocess the results to extract sensitivity data.

• Use the design change tool to modify the cylinder shape to simultaneously reduce the drag and increase
the lift.

23.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)
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• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.

23.3. Problem Description

The configuration is a circular cylinder, bounded above and below by symmetry planes. The flow is
laminar and incompressible with a Reynolds number of 40, based on the cylinder diameter. At this
Reynolds number, the flow is steady.

23.4. Setup and Solution

The following sections describe the setup steps for this tutorial:
23.4.1. Preparation
23.4.2. Step 1: Load the Adjoint Solver Add-on
23.4.3. Step 2: Define Observables
23.4.4. Step 3: Compute the Drag Sensitivity
23.4.5. Step 4: Postprocess and Export Drag Sensitivity
23.4.6. Step 5: Compute Lift Sensitivity
23.4.7. Step 6: Modify the Shape

23.4.1. Preparation

1. Set up a working folder on the computer you will be using.

2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the adjoint_cylinder_R180.zip link to download the input files.

7. Unzip adjoint_cylinder_R180.zip.

The files cylinder_tutorial.cas and cylinder_tutorial.dat can be found in the ad-
joint_cylinder folder created after unzipping the file.

8. Use Fluent Launcher to start the 2D version of ANSYS Fluent, with the Double Precision and Display
Mesh After Reading options enabled.
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For more information about starting ANSYS Fluent using the Fluent Launcher, see the Fluent Getting
Started Guide, available in the help viewer or on the ANSYS Customer Portal (http://support.an-
sys.com/documentation).

9. Load the converged case and data file for the cylinder geometry.

File → Read → Case & Data...

When prompted, browse to the location of the case and data files and select cylinder_tutori-
al.cas to load. The corresponding data file will automatically be loaded as well.

Note

After you read in the mesh, it will be displayed in the embedded graphics windows,
since you enabled the appropriate display option in Fluent Launcher.

The data file contains a previously computed flow solution that will serve as the starting point for
the adjoint calculation. Part of the mesh and the velocity field are shown below:
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Figure 23.1:  Mesh Close to the Cylinder Surface
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Figure 23.2:  Contours of Velocity Magnitude

23.4.2. Step 1: Load the Adjoint Solver Add-on

The adjoint solver add-on is loaded into ANSYS Fluent by typing the following in the console:

>define/models/addon-module 

to display the following:

Fluent Addon Modules:
      0. None
      1. MHD Model
      2. Fiber Model 
      3. Fuel Cell and Electrolysis Model
      4. SOFC Model with Unresolved Electrolyte
      5. Population Balance Model
      6. Adjoint Solver  
      7. Single-Potential Battery Model
      8. Dual-Potential MSMD Battery Model
      9. PEM Fuel Cell Model
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      10. Macroscopic Particle Model
Enter Module Number: [0] 6 

Enter 6 to load the adjoint module. After the adjoint module is loaded, buttons become available in
the Design tab of the ribbon within ANSYS Fluent.

23.4.3. Step 2: Define Observables

Begin setting up the adjoint solver by opening the Adjoint Observables dialog box. Here you will
create lift and drag observables.

Design → Adjoint-Based → Observable...

Figure 23.3:  Adjoint Observables Dialog Box

1. Click the Manage... button to open the Manage Adjoint Observables dialog box.

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.938

Using the Adjoint Solver – 2D Laminar Flow Past a Cylinder



Figure 23.4:  Manage Adjoint Observables Dialog Box

2. Click the Create... button in the Manage Adjoint Observables dialog box to open the Create New Ob-
servable dialog box.

Figure 23.5:  Create New Observable Dialog Box

3. In the Create New Observable dialog box:

a. Ensure that Observable types is selected.
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b. Select force from the selection list.

c. Enter force-drag for Name.

d. Click OK to close the dialog box.

4. In the Manage Adjoint Observables dialog box, the newly created force-drag observable appears and
must now be configured. (Figure 23.6: Manage Observables Dialog Box (p. 940)):

a. Select force-drag in the Observables list.

Figure 23.6:  Manage Observables Dialog Box

b. Select wall under Wall Zones. This is the cylinder wall on which you want the force to be evaluated.

c. Ensure that the X-Component direction is set to 1 and the Y-Component direction is set to 0.

d. Click Apply to commit the settings for force-drag.

5. Repeat the process in the Manage Adjoint Observables dialog box to create a lift observable with the
following settings:
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force-liftName

wallWall Zones

0X-Component

1Y-Component

Tip

If the Name field is not available in the Create New Observable dialog box, select a
different observable type and then select force again to make it available.

When you have configured the force-lift observable, click OK to commit the settings for force-lift and
close the Manage Adjoint Observables dialog box.

23.4.4. Step 3: Compute the Drag Sensitivity

1. In the Adjoint Observables dialog box (Figure 23.7: Adjoint Observables Dialog Box (p. 941)) specify that
you will solve for the drag sensitivity.

Figure 23.7:  Adjoint Observables Dialog Box

a. Select force-drag in the list of Observable Names.

The selection in the Adjoint Obervables dialog box determines the observable for which sensitivities
will be computed. You will first compute the drag sensitivities.

b. Select Minimize from the Sensitivity Orientation list, because you are trying to reduce the drag force.
This indicates that postprocessed results for the drag sensitivity will be displayed such that a reduction
in drag is achieved by a design change in the positive sensitivity direction.

c. Click Evaluate to print the value of the drag force on the wall in the console.
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Observable name: force-drag 
Observable Value (n) = 1271.7444 

This value is in SI units, with n denoting Newtons.

2. Adjust the solution controls.

The default solution control settings are chosen to provide robust solution advancement for a wide
variety of problems, including those having complex geometry, high local flow rates, and turbulence.
Given sufficient iterations, a converged result can often be obtained without modifying the controls.

For this simple laminar flow case, more aggressive settings will yield faster convergence.

Open the Adjoint Solution Controls dialog box (Figure 23.8: Adjoint Solution Controls Dialog
Box (p. 942)).

Design → Adjoint-Based → Solver Controls...

Figure 23.8:  Adjoint Solution Controls Dialog Box

a. Disable the Solution-Based Controls Initialization and Auto-Adjust Controls options.

This prevents Fluent from automatically choosing and adjusting the solution controls for you.

b. Enable Show Advancement Controls.
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c. Ensure that the Apply Preconditioning option is enabled.

Preconditioning can help the calculation progress in a stable manner.

d. Enter 100 for Courant Number.

Higher Courant Number values correspond to more aggressive settings / faster convergence,
which is appropriate for a simple case such as this.

e. Enter 0.05 for Artificial Compressibility.

f. Click OK to close the dialog box.
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3. Configure the adjoint solution monitors by opening the Adjoint Residual Monitors dialog box (Fig-
ure 23.9: Adjoint Residual Monitors Dialog Box (p. 944)).

Design → Adjoint-Based → Monitors...

Figure 23.9:  Adjoint Residual Monitors Dialog Box

In the Adjoint Residual Monitors dialog box, you set the adjoint equations that will be checked
for convergence, as well as set the corresponding convergence criteria.

a. Make sure that the Print to Console and Plot options are enabled.

b. Keep the default values of 1e-05 for Adjoint continuity and Adjoint velocity, and 0.001 for Adjoint
local flow rate. These settings are adequate for most cases. Make sure that the Check Convergence
options are enabled.

c. Click OK to close the dialog box.

4. Run the adjoint solver using the Run Adjoint Calculation dialog box (Figure 23.10: Run Adjoint Calculation
Dialog Box (p. 944)).

Design → Adjoint-Based → Calculate...

Figure 23.10:  Run Adjoint Calculation Dialog Box

a. Click the Initialize button. This initializes the adjoint solution everywhere in the problem domain to
zero.
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b. Set the Number of Iterations to 200. The adjoint solver is fully configured to start running for this
problem.

c. Click the Calculate button to advance the solver to convergence.

Figure 23.11:  Residuals for the Converged Solution

d. When the calculation is complete, Close the Run Adjoint Calculation dialog box.

23.4.5. Step 4: Postprocess and Export Drag Sensitivity

In this section, postprocessing options for the adjoint solution are presented.

23.4.5.1. Boundary Condition Sensitivity

1. Open the Adjoint Reporting dialog box (Figure 23.12: Adjoint Reporting Dialog Box (p. 946)).

Design → Adjoint-Based → Reporting...
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Figure 23.12:  Adjoint Reporting Dialog Box

2. Select inlet under Boundary choice and click the Report button to display a report in the console of the
available scalar sensitivity data on the inlet:

Updating shape sensitivity data.
Done.

Boundary condition sensitivity report: inlet
Observable: force-drag
Velocity Magnitude (m/s): 40  Sensitivity ((n)/(m/s)): 54.553894
Decrease Velocity Magnitude to decrease force-drag

3. Close the Adjoint Reporting dialog box.

23.4.5.2. Momentum Source Sensitivity

1. Open the Contours dialog box.

Postprocessing → Graphics → Contours → Edit...

2. Select Sensitivities... and Sensitivity to Body Force X-Component (Cell Values) from the Contours of
drop-down lists.
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Figure 23.13:  Contours Dialog Box When Plotting Adjoint Fields

3. Enter 25 for Levels.

4. Click Display to view the contours (Figure 23.14: Adjoint Sensitivity to Body Force X-Component Con-
tours (p. 948)) and then Close the Contours dialog box.
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Figure 23.14:  Adjoint Sensitivity to Body Force X-Component Contours

Figure 23.14: Adjoint Sensitivity to Body Force X-Component Contours (p. 948) shows how sensitive
the drag on the cylinder is to the application of a body force in the -direction in the flow. If a body
force is applied directly upstream of the cylinder, for example, the disturbed flow is incident on the
cylinder and modifies the force that it experiences.

The contours also show how the computed drag is affected by lack of convergence in the original
X-momentum equation for the flow.

23.4.5.3. Shape Sensitivity

1. Open the Vectors dialog box (Figure 23.15: Vectors Dialog Box (p. 949))

Postprocessing → Graphics → Vectors → Edit...
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Figure 23.15: Vectors Dialog Box

2. Select Sensitivity to Shape from the Vectors of drop-down list.

3. Select Sensitivities... and Sensitivity to Mass Sources (Cell Values) from the Color by drop-down
lists.

4. Select wall from the Surfaces selection list.

5. Click the Display button to view the vectors (Figure 23.16: Shape Sensitivity Colored by Sensitivity to
Mass Sources (Cell Values) (p. 950)) and then Close the Vectors dialog box.
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Figure 23.16:  Shape Sensitivity Colored by Sensitivity to Mass Sources (Cell Values)

This plot shows how sensitive the drag on the cylinder is to changes in the surface shape. The drag is
affected more significantly if the cylinder is deformed on the upstream rather than the downstream
side. Maximum effect is achieved by narrowing the cylinder in the cross-stream direction.

23.4.5.4. Exporting Drag Sensitivity Data

Before computing the sensitivity for the force-lift observable, you need to define the region that will
be subject to geometry morphing, and export the drag sensitivity data so it can be used later in the
multi-objective optimization.

1. Open the Design Tool dialog box.

Design → Adjoint-Based → Design Tool...
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Figure 23.17: The Design Tool Dialog Box

2. In the Region tab, define the region that will be modified for the design change.

a. Ensure that Cartesian is selected from the Region Geometry drop-down list.

b. Click Get Bounds....

c. Select wall in the Bounding Box Definition dialog box and click OK.

This will initialize the morphing region to the bounding box around the cylinder wall.

d. Click Update Region to update the view of the bounding box illustration in the graphics window.

You can use the Mesh Display dialog box to also display the mesh, in order to review it prior to
morphing.
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e. Click Larger Box several times until the X and Y Limits are ±1.907349 m (Figure 23.18: Morphing
Region Around Cylinder (p. 952)).

Figure 23.18:  Morphing Region Around Cylinder

f. Click Export Sensitivities... and save the sensitivity data as force-drag.s.

23.4.6. Step 5: Compute Lift Sensitivity

1. Select force-lift from the Observable Names selection list and select Maximize from the Sensitivity
Orientation list in the Adjoint Observables dialog box.

Design → Adjoint-Based → Observable...
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2. Initialize and Calculate the adjoint solution using the Run Adjoint Calculation dialog box to obtain the
sensitivities for the force-lift observable.

Design → Adjoint-Based → Calculate...

You can export the sensitivity data for the lift observable as you did for the drag, but it is not strictly
necessary if you plan to perform the multi-objective optimization in the current Fluent session.

23.4.7. Step 6: Modify the Shape

In this section, you will load the previously saved force-drag sensitivity data and perform the multi-
objective design change.

1. Open the Design Tool dialog box if it is not already open.

Design → Adjoint-Based → Design Tool...

force-lift is now displayed in the Design Change tab because it is the currently selected observable.
The Design Change tab functions as a dashboard for the design modification, where you can select
which boundaries are subject to modification, enable or disable conditions that you have defined,
specify relative weighting if you have multiple freeform objectives, and view predicted results. You
will return to it to perform the design change after you have configured the objectives and the
morphing region.

2. Load the previously saved force-drag sensitivity data.

a. Open the Objectives tab.

The force-lift observable is already listed because Include current data is enabled.
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b. Click Manage Data... to open the Manage Sensitivity Data dialog box.

c. Click Import Sensitivities... and select the force-drag.s file you created earlier. Click OK.

d. Close the Manage Sensitivity Data dialog box.

3. Define the objective for each observable.

For this example, you will seek a design change that increases the lift and results in a 10% reduction
in drag.

a. In the Objectives tab, select the force-lift observable. The current value of the lift is displayed along
with options to specify the objective for the lift.

b. Select Increase Value from the Objective list.

This indicates that you want to increase the lift, but are not prescribing a specific target change.

c. Enter 100 for Target/Reference Change.

This setting is used to normalize the scale of the change in value of the observable, which can be
important in cases where multiple observables are considered that may be of different scales.
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d. Click Apply.

e. Select force_drag.s in the list of observables.

f. Select Target Change In Value from the Objective list.

This indicates that you are prescribing a specific change in the value of the observable, rather than
a freeform increase or decrease.

g. Enter -10 for Target/Reference Change and enable the As Percentage option.

10% is a generally a reasonable maximum target change for a design change. Using a target
change that is too large may result in very large deformations and/or overshooting the local op-
timum.

h. Click Apply.
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4. Configure the morphing region.

You already specified the dimensions of the region earlier when exporting the force-drag sensitivity.
Now you will also configure the control-point density.

a. Click the Region Conditions tab in the Design Tool dialog box.

b. Enter 30 for Points in the X Motion and Y Motion group boxes.

c. Click Apply.

Many other settings are available in the Region Conditions tab, including constraints on control-
point motion, symmetry conditions, and continuity conditions. For additional information, see the
section on defining region conditions in the Fluent Advanced Add-On Modules manual, available
in the help viewer or on the ANSYS Customer Portal (http://support.ansys.com/documentation).

5. Compute the design change and modify the mesh.

a. Return to the Design Change tab.

b. Select wall in the Zones To Be Modified selection list.

Only zones that are selected in the Zones To Be Modified list (or that have prescribed motions
applied) will be modified as part of the design change.
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c. If multiple freeform objectives were defined (that is, multiple objectives with Increase Value or De-
crease Value selected in the Objectives tab), you would need to specify the Weight for each. In this
case only one objective (force-lift) is freeform, so no input is required for Weight.

d. Retain the default settings of Control-point spacing for Freeform Scaling Scheme, and 0.1 for
Freeform Scale Factor.

These settings allow you to adjust the magnitude of the attempted design change (Freeform Scale
Factor) and the basis for the scaling (Freeform Scaling Scheme).

e. Click Calculate Design Change.

The Results list is updated to reflect the Expected change for each observable.

Note that the drag is predicted to decrease by 10% as you requested, and the lift is predicted
to increase.

f. Click the Modify Mesh button to apply the calculated mesh deformation that will reposition the
boundary and interior nodes of the mesh. Information regarding the mesh modification is printed
in the console:

Updating mesh (steady, mesh iteration = 00001, pseudo time step 1.0000e+00)... 
Dynamic Mesh Statistics:
Minimum Volume    = 3.46260e-04
Maximum Volume    = 6.36270e-01
Maximum Cell Skew = 3.69343e-01 (cell zone 11)
Minimum Orthogonal Quality = 6.30657e-01 (cell zone 11)

g. Display the new mesh geometry.

Postprocessing → Graphics → Mesh → Edit...

The effect on the mesh is shown in Figure 23.19: Mesh After Deformation (p. 958):
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Figure 23.19:  Mesh After Deformation

h. Re-converge the conventional flow calculation for this new geometry in the Run Calculation task
page.

Solving → Run Calculation → Calculate

The currently loaded case file already has report definitions defined for lift and drag, or you
can Evaluate the new values in the Adjoint Observables dialog box.

Design → Adjoint-Based → Observable...

The new values for drag and lift are reported to be:

Observable name: force-drag
Observable Value (n): 1151.3445
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Observable name: force-lift
Observable Value (n): 122.92812

Note that the drag has changed by -120.4 N or -9.5% compared to the drag on the undeformed
cylinder. This value compares very well with the change of -127.2 N (-10%) that was predicted
from the adjoint solver. The lift has increased by 122.4 N, which again compares very well with
the predicted change of 127.6 N.

23.5. Summary

This tutorial has demonstrated how to use the adjoint solver add-on to compute the sensitivity of the
drag and lift on a circular cylinder to various inputs for a previously computed flow field. The process
of setting up and running the adjoint solver was illustrated. The steps to perform various forms of
postprocessing were also described. The design change tool was used to make a multi-objective change
to the design that reduced the drag and increased the lift in a predictable manner.

This example considered multiple objectives at a single flow condition. Another powerful application
of the design tool is to perform multi-objective design changes using sensitivities computed for multiple
flow conditions. This allows you to identify design changes that improve performance across a range
of anticipated operating conditions, potentially of differing importance. The design tool also offers a
rich set of additional capabilities for including prescribed deformations, bounding planes / surfaces,
and fixed-wall constraints in your multi-objective design change. For full details about how to use the
design tool, refer to the Fluent Advanced Add-On Modules documentation, available in the help viewer
or on the ANSYS Customer Portal (http://support.ansys.com/documentation).
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Chapter 24: Simulating a Single Battery Cell Using the MSMD Battery
Model

This tutorial is divided into the following sections:
24.1. Introduction
24.2. Prerequisites
24.3. Problem Description
24.4. Setup and Solution
24.5. Summary
24.6. Appendix
24.7. References

24.1. Introduction

This tutorial is used to show how to set up a battery cell simulation in ANSYS Fluent.

This tutorial demonstrates how to do the following:

• Load the Battery module add-on

• Set up a battery cell simulation using the NTGK battery submodel

• Perform the calculations for different battery discharge rates and compare the results using the postprocessing
capabilities of ANSYS Fluent

• Use the reduced order method (ROM) in a battery simulation

• Simulate a battery pulse discharge

• Introduce external and internal short-circuits in a battery simulation

24.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.
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24.3. Problem Description

The discharge behavior of a lithium-ion battery described in the Kim’s paper [2] will be modeled in this
tutorial. You will use the NTGK model. The battery is a 14.6 Ah LiMn2O4 cathode/graphite anode battery.
The geometry of the battery cell is shown in Figure 24.1: Schematic of the Battery Cell Problem (p. 962).
You will study the battery’s behavior at different discharge rates.

Figure 24.1:  Schematic of the Battery Cell Problem

For external and internal short-circuit treatment, you will consider an extreme case where external and
internal short-circuits occur at the same time. You will simulate post-short-circuit battery processes. You
can assume that the internal short is caused by a nail penetration occurring near the center of the
battery.

24.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
24.4.1. Preparation
24.4.2. Reading and Scaling the Mesh
24.4.3. Loading the MSMD battery Add-on
24.4.4. NTGK Battery Model Setup
24.4.5. Postprocessing
24.4.6. Simulating the Battery Pulse Discharge Using the ECM Model
24.4.7. Using the Reduced Order Method (ROM)
24.4.8. External and Internal Short-Circuit Treatment

24.4.1. Preparation

1. Set up a working folder on the computer you will be using.
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2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the battery_cell_R180.zip link to download the input files.

7. Unzip battery_cell_R180.zip.

The input file unit_battery.msh, unit_battery.cas, and unit_battery.dat can be
found in the battery_cell folder created after unzipping the file.

8. Use Fluent Launcher to start the 3D version of ANSYS Fluent.

9. Enable Double Precision.

10. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

11. Select either Serial or Parallel under Processing Options. In this tutorial, Serial is selected for demon-
stration only.

24.4.2. Reading and Scaling the Mesh

1. Read the mesh file unit_battery.msh.

File → Read → Mesh...

When prompted, browse to the location of the unit_battery.msh and select the file.

Once you read in the mesh, it is displayed in the embedded graphics windows.

The geometry is already in the correct scale. You don’t need to scale it.

2. Check the mesh.

Setting Up Domain → Mesh → Check

24.4.3. Loading the MSMD battery Add-on

1. To load the MSMD battery add-on into ANSYS Fluent, type the following in the console window:
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define/models/addon-module 

A list of ANSYS Fluent add-on modules is displayed.

Fluent Addon Modules:
 0. none
 1. MHD Model
 2. Fiber Model
 3. Fuel Cell and Electrolysis Model
 4. SOFC Model with Unresolved Electrolyte
 5. Population Balance Model
 6. Adjoint Solver  
 7. Single-Potential Battery Model
 8. Dual-Potential MSMD Battery Model
 9. PEM Fuel Cell Model
10. Macroscopic Particle Model
Enter Module Number: [0] 8 

2. Enter 8 to load the MSMD battery itself.

During the loading process, a scheme library containing the graphical and text user interface, and
a library of user-defined functions (UDFs) containing a set of UDFs for the battery module are loaded
into ANSYS Fluent. Fluent reports the progress in the console.

Once the MSMD battery add-on is loaded, MSMD Battery Model appears in the Models task page
and under the Models tree branch. The UDF library also becomes visible as a new entry in the UDF
Library Manager dialog box.

24.4.4. NTGK Battery Model Setup

The following sections describe the setup steps for this tutorial:
24.4.4.1. Specifying Solver and Models
24.4.4.2. Defining New Materials for Cell and Tabs
24.4.4.3. Defining Cell Zone Conditions
24.4.4.4. Defining Boundary Conditions
24.4.4.5. Specifying Solution Settings
24.4.4.6. Obtaining Solution

24.4.4.1. Specifying Solver and Models

1. In the Solver group of the Setting Up Physics ribbon tab, enable a time-dependent calculation.

Setting Up Physics → Solver → Transient

2. To solve for the temperature field, enable the Energy equation (in the Models group).

Setting Up Physics → Models → Energy

3. Enable the battery model.

Setting Up Physics → Models → More → Dual Potential MSMD Battery Model

a. In the MSMD Battery Model dialog box, select Enable MSMD Battery Model.

The dialog box expands to display the battery model’s settings.
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Figure 24.2:  Model Options

b. Under the Model Options tab (Figure 24.2: Model Options (p. 965)), configure the following battery
operation conditions:

i. Under E-Chemistry Models, retain the default selection of NTGK Empirical Model.

ii. Ensure that Solving Transport Equation is selected for Solution Method for E-field.

iii. Under Electrical Parameters, retain the default value of 14.6 Ah for Nominal Cell Capacity.

iv. Retain the default selection of Specified C-Rate and the value of 1 for C-Rate.

v. Retain the default value of 3 V for Min. Stop Voltage.
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c. Under the Model Parameters tab, retain the default settings for Y and U coefficients. For details, see
the Fluent Advanced Add-On Modules documentation on the ANSYS Customer Portal (http://support.an-
sys.com/documentation).

Note

• If in your case, Y and U functions are not in the same function form as in the Kim’s paper,
you need to modify the cae_user.c source code file. See the Fluent Advanced Add-On
Modules documentation on the ANSYS Customer Portal (http://support.ansys.com/docu-
mentation) for details.

• For a given battery, you can perform a set of constant current discharging tests, and then
use the battery's parameter estimation tool to obtain the Y and U functions. See the Fluent
Advanced Add-On Modules documentation on the ANSYS Customer Portal (http://sup-
port.ansys.com/documentation) for details.

d. Under the Conductive Zones tab (Figure 24.3: Conductive Zones (p. 967)), configure the following set-
tings:

Value or SelectionControl or ListGroup

e-zoneZone (s)Active Components

tab_nzoneZone (s)Tab Components

tab_pzone

For this single cell case, there are no busbar zones. Electro-chemical reactions occur only in the
active zone. Battery tabs are usually modeled as passive zones, in which the potential field is
also solved.
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Figure 24.3:  Conductive Zones

e. Under the Electric Contacts tab (Figure 24.4: Electric Contacts (p. 968)), configure the contact surface
and external connector settings as follows:

Value or SelectionControl or ListGroup

tab_nNegative TapExternal Connectors

tab_pPositive Tap

The corresponding current or voltage boundary condition will be applied to those boundaries
automatically.

Under the Electric Contacts tab, you can also define extra contact resistance for each zone.

967
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



Figure 24.4:  Electric Contacts

f. Click the Print Battery System Connection Information button.

ANSYS Fluent prints the battery connection information in the console window:

Battery Network Zone Information:
-------------------------------------
 Battery Serial 1
   Parallel 1
        N-Tab  zone:  tab_nzone
        Active zone:  e_zone
        P-Tab  zone:  tab_pzone
-----------------------------------

 Active zone list at  odd level: e_zone
 Active zone list at even level:

Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information
of ANSYS, Inc. and its subsidiaries and affiliates.968

Simulating a Single Battery Cell Using the MSMD Battery Model



Number of battery series stages =1; Number of batteries in parallel per series stage=1
****************END OF BATTERY CONNECTION INFO**************

g. Verify that the connection information is correct.

h. Click OK to close the MSMD Battery Model dialog box.

In the background, Fluent automatically hooks all the necessary UDFs for the problem.

24.4.4.2. Defining New Materials for Cell and Tabs

Define the new e_material material for the battery’s cell, p_material for the positive tab, and n_material
for the negative tab.

In the battery model, two user defined scalars, uds0 and uds1, are solved for the positive and negative
potentials, respectively. To specify the electric conductivity of the active material you need to define
the UDS diffusivity.

Important

For the battery active material, you must define the electric conductivity via the UDS diffus-
ivity on a per-scalar basis. ANSYS Fluent will use these two UDS scalars to solve the differential
equations; for details, see the Fluent Advanced Add-On Modules documentation on the
ANSYS Customer Portal (http://support.ansys.com/documentation).

For the battery passive conductive zones, such as tabs or busbars, you must define the UDS
diffusivity using a user-defined function (UDF) and define the material’s electric conductivity
using the Electrical Conductivity entry field.

1. Create the electric material.

Setting Up Physics → Materials → Create/Edit...
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a. In the Create/Edit Materials dialog box, select solid from the Material Type drop-down list.

b. Enter e_material for Name and e for Chemical Formula.

c. Under Properties, set Density to 2092 [kg/m3].

d. Set CP (Specific Heat) to 678 [J/kg-K].

e. Set Thermal Conductivity to 18.2 [W/m-K].

f. Ensure that define-per-uds is selected from the UDS Diffusivity drop-down list and click Edit... next
to UDS Diffusivity.

Note

If the UDS Diffusion Coefficients are defined through the defined-per-uds option,
the Fluent solver does not use the value for Electrical Conductivity.

g. In the UDS Diffusion Coefficients dialog box, specify the user-defined scalars.
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i. Select uds-0 in the User-Defined Scalar Diffusion list.

ii. Retain constant from the Coefficient drop-down list.

iii. Set Coefficient to 1.19e6 [1/ohm-m].

iv. In a similar way, set uds-1 to 9.83e5 [1/ohm-m] and close the UDS Diffusion Coefficients dialog
box.

Note

The units for UDS Diffusivity are 1/ohm-m, and cannot be modified.

v. In the Question dialog box, click No to retain aluminum and add the new material (e_material) to
the materials list.

Note

Refer to Appendix (p. 1001) for information on how to calculate the battery cell
property values.

h. Ensure that e_material (e) is selected from the Fluent Solid Materials drop-down list.

i. Click Change/Create.

2. Create a new material for the positive tab by modifying copper from the solid material database.
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The UDS Diffusivity for tab materials must be defined through the UDF as described below.

a. In the Create/Edit Materials dialog box, click Fluent Database....

b. In the Fluent Database Materials dialog box, make sure that solid is selected for Material Type.

c. Select copper from Fluent Solids Materials and click Copy and then Close.

The Create/Edit Materials dialog box now displays the copied properties for copper.

d. Enter p_material for Name and pmat for Chemical Formula.

e. Under Properties, select user-defined from the UDS Diffusivity drop-down list.

f. In the User-Defined Functions dialog box that opens, verify that battery_e_cond::msmdbatt is selected
and click OK.
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Fluent hooks the battery_e_cond::msmdbatt UDF to the busbar material.

g. In the Question dialog box, click Yes to overwrite copper.

The new material (p_material) appears under Materials.

h. Set the Electrical Conductivity to 1.0e7 [1/ohm-m].

i. Click Change/Create.

3. Create a new material for the negative tab with the same properties as the material for the positive tab.

Note

You do not need to create two different materials for the positive and negative tabs if
the positive and negative tabs are made of the same material. In this tutorial, the two
different tab materials with the same physical properties have been created for demon-
stration purposes only.

a. From Fluent Solid Materials drop-down list, select p_material.

b. Enter n_material for Name and nmat for Chemical Formula.

c. Click Change/Create.

d. In the Question dialog box, click No to retain p_material and add the new material (n_material) to the
materials list.

e. Close the Create/Edit Materials dialog box.

24.4.4.3. Defining Cell Zone Conditions

Assign e_material to the cell zone, p_material to the positive tab and n_material to the negative tab.

1. Assign e_material to the e_zone zone.

Setup → Cell Zone Conditions → e_zone → Edit...

a. In the Solid dialog box, select e_material from the Material Name drop-down list.
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b. Click OK.

2. In a similar manner, assign p_material to tab_pzone and n_material to tab_nzone.

24.4.4.4. Defining Boundary Conditions

Define the thermal boundary conditions for all walls for the cell, and positive and negative tabs.

1. Set the convection boundary condition for wall_active.

Setup → Boundary Conditions → wall_active → Edit...

a. In the Wall dialog box, under the Thermal tab, under Thermal Conditions, enable Convention.

b. Set Heat Transfer Coefficient to 5 [w/m2K].

c. Retain the default value of 300 [K] for Free Stream Temperature.

d. Click OK to close the Wall dialog box.

You do not need to change the settings under the UDS tab since the boundary conditions
for the two UDS scalars have been set automatically when you defined the cell zone condi-
tions.

2. Copy the boundary conditions for wall_active to wall_p and wall_n.

Setup → Boundary Conditions → wall_active → Copy...

24.4.4.5. Specifying Solution Settings

1. Turn off the flow equation.

Solving → Controls → Equations...

a. In the Equations dialog box, deselect Flow from the Equation selection list.

b. Click OK.
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2. Remove the convergence criteria to ensure that automatic convergence checking does not occur.

Solving → Reports → Residuals...

a. In the Residual Monitors dialog box, select none from the Convergence Criterion drop-down list.

b. Click OK.

3. Create a surface report definition for the voltage at the positive tab.

Solving → Reports → Definitions → New → Surface Report → Area-Weighted Average

a. In the Surface Report Definition dialog box, enter voltage_vp for Name.

b. Select User Defined Scalars... and Potential Phi+ from the Field Variable drop-down lists.

c. From the Surfaces selection list, select tab_p.
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d. In the Create group box, enable Report File, Report Plot and Print to Console.

e. Click OK to save the voltage_vp report definition and close the Surface Report Definition dialog box.

f. Rename the report output file.

Solution → Monitors → Report Files → voltage_vp-rfile Edit...

i. Enter ntgk-1c.out for Output File Base Name.

ii. Click OK to close the Edit Report File dialog box.

g. Modify the attributes of the plot axes.

Solution → Monitors → Report Plots → voltage_vp-rplot Edit...

i. In the Edit Report Plot dialog box, under the Plot Window group box, click the Axes... button to
open the Axes dialog box.

ii. Select the X axis and set Precision to 0.

iii. Click Apply.

iv. Select the Y axis and set Precision to 2.

v. Set Precision to 2.
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vi. Click Apply and close the Axes dialog box.

Note

You must click Apply to save the modified settings for each axis.

vii. Make sure that time-step is selected from the Get Data Every drop-down list.

viii.Click OK to close the Edit Report Plot dialog box.

4. Create a volume report definition for the maximum temperature in the domain.

Solving → Reports → Definitions → New → Volume Report → Max...

a. In the Volume Report Definition dialog box, enter max_temp for Name.
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b. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

c. From the Cell Zones selection list, select all zones.

d. In the Create group box, enable Report File, Report Plot and Print to Console.

e. Click OK to save the volume report definition settings and close the Volume Report Definition dialog
box.

f. Rename the report output file.

Solution → Monitors → Report Files → max_temp-rfile Edit...

i. Enter max-temp-1c.out for Output File Base Name.

ii. Click OK to close the Edit Report File dialog box.

g. Modify the axis attributes by setting the Precision to 0 for the X axis and to 2 for the Y axes (in a
manner similar to the surface plot definition).

h. Click OK.

5. Save the case file.

File → Write → Case...

24.4.4.6. Obtaining Solution

1. Initialize the field variables using the Standard Initialization method.

Solving → Initialization

a. Retain the selection of the Standard method (Initialization group).

b. Click Initialize.

You do not need to modify Initial Values in the Solution Initialization task page, because these
values are not used for initialization. The ANSYS Fluent solver automatically computes the initial
condition for UDS0 and UDS1.

2. Run the simulation.

Solving → Run Calculation

a. Set Time Step Size to 30 seconds and No. of Time Steps to 100.

b. Click Calculate.

The residual plot, the report for voltage at the positive tap and the history of the maximum
temperature in the domain are shown in Figure 24.5: Residual History of the Simulation (p. 979),
Figure 24.6: Report Plot of Discharge Curve at 1 C (p. 979), and Figure 24.7: History of Maximum
Temperature in the Domain (p. 980), respectively.
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Figure 24.5:  Residual History of the Simulation

Figure 24.6:  Report Plot of Discharge Curve at 1 C
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Figure 24.7:  History of Maximum Temperature in the Domain

3. Save the case and data files (unit_battery.cas.gz and unit_battery.cas.gz).

File → Write → Case & Data...

24.4.5. Postprocessing

In this section, postprocessing capabilities for the MSMD battery model solution are demonstrated.

1. Display the contour plot of the phase potential for the positive electrode.

Postprocessing → Graphics → Contours → Edit...
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a. In the Contours dialog box, in the Options group box, enable Filled.

b. From the Contours of drop-down list, select User Defined Scalars... and Potential Phi+.

c. Click the Toggle Tree View button next to the Surfaces filter and from the drop-down list, select
Surface Type (under Group by).

d. From the Surfaces selection list, under Wall, select tab_p, wall_active, and wall_p.

e. Click Display and close the Contours dialog box.
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Figure 24.8:  Contour Plot of Phase Potential for the Positive Electrode

2. In a similar manner, display the contour plot of the phase potential for the negative electrode.

Postprocessing → Graphics → Contours → Edit...
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a. In the Contours dialog box, in the Options group box, enable Filled.

b. From the Contours of drop-down list, select User Defined Scalars... and Potential Phi-.

c. From the Surfaces selection list, select tab_n,wall_active, and wall_n.

d. Click Display and close the Contours dialog box.
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Figure 24.9:  Contour Plot of Phase Potential for the Positive Electrode

3. Display the contour plot of the temperature.

Postprocessing → Graphics → Contours → Edit...
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a. In the Contours dialog box, in the Options group box, enable Filled.

b. From the Contours of drop-down list, select Temperature... and Static Temperature.

c. Select Wall in the Surfaces selection list.

The surfaces listed under Wall are automatically selected in the Surfaces list.

d. Click Display and close the Contours dialog box.

Note

Use the Axes dialog box to set the precision for the colormap labels.
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Figure 24.10:  Contour Plot of Temperature

4. Display the vector plot of current density.

Postprocessing → Graphics → Vectors → Edit...
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a. In the Vectors dialog box, select current-density-j from the Vectors of drop-down list.

b. Select User Defined Memory... and Magnitude of Current Density from the Color by drop-down
list.

c. Click the Toggle Tree View button next to the Surfaces filter and from the drop-down list, select
Surface Type (under Group by).

d. From the Surfaces selection list, select Wall.

e. In the Options group, enable Draw Mesh and in the Mesh Display dialog box, set the mesh display
options as desired.

f. Click Display and close the Vectors dialog box.
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Figure 24.11: Vector Plot of Current Density

5. Save the case file as ntgk.cas.gz. You will use this saved case later to treat electric short-circuits.

6. Repeat the simulation for the following charge rates and time steps:

Number of Time StepsC-Rate

2300.5 C

235 C

Make the following changes in the model’s settings:

a. In the MSMD Battery Model dialog box, under the Model Options tab, specify the value listed in the
above table for the C-Rate.

b. Modify the output filename for the voltage_vp-rfile report file by entering ntgk-C-Rate.out for
Output File Base Name in the corresponding Edit Report File dialog box, where C-Rate is the value
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of the battery discharge rate. (For example, for C-Rate = 0.5 C, you will enter ntgk-0.5c.out for the
filename).

c. Similarly, modify the output filename for max_temp-rfile by entering max-temp-C-Rate.out for
Output File Base Name in the corresponding Edit Report File dialog box.

d. Initialize and run the solution for the number of the times steps specified in the above table.

Note

The Fluent solver will stop either after completing the specified number of time steps
or when the Min. Stop Voltage condition is reached.

7. Display the discharge curves for the positive tab for the different discharge rates.

Postprocessing → Plots → File...

a. In the File XY Plot dialog box, click Add....

b. In the Select File dialog box, change File of Types to All Files (*), click ntgk-0.5c.out and
click OK.

c. Under Legend Entries, in the lowest text-entry box, enter 0.5c and click Change Legend Entry.

d. Do the same for ntgk-1c.out and ntgk-5c.out and change their legend entries accordingly.

e. In the Legend Title text-entry box, enter Discharge Rate.

f. Click Plot and close the File XY Plot dialog box.

Note

Use the Axes dialog box to set the precision for the plot axes.

The Figure 24.12: NTGK Model: Discharge Curves (p. 990) shows the discharge curves for different
discharge rates in the function of time.
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Figure 24.12:  NTGK Model: Discharge Curves

8. In a manner similar to the previous step, load the files max-temp-0.5c.out,max-temp-1c.out, and
max-temp-5c.out and display the maximum temperature curves in the domain.

Figure 24.13: NTGK Model: Maximum Temperature in the Domain (p. 991) shows the maximum tem-
perature curves in the simulation for different discharge rates.
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Figure 24.13:  NTGK Model: Maximum Temperature in the Domain

24.4.6. Simulating the Battery Pulse Discharge Using the ECM Model

1. In the MSMD Battery Model dialog box, under E-Chemistry Models, select Equivalent Circuit Model.

2. Under Electrical Parameters, retain the default value of 14.6 Ah for Nominal Cell Capacity.

3. Retain the default selection of Specified C-Rate and enter 1 for C-Rate.

4. Under the Model Parameters tab, retain the battery specific parameters.

For a given battery, these model parameters can be obtained using the battery's HPPC testing data.
See Using the Dual-Potential MSMD Battery Model Text User Interface in the ANSYS Fluent Advanced
Add-On Modules for details.

5. Click OK to apply the ECM battery model settings and close the MSMD Battery Model dialog box

6. Click OK in the Warning dialog box informing you that the re-initialization of the battery model is required.

7. Disable writing the maximum temperature in the domain over time to a file.

Solutions → Report Definitions → max_temp Edit...

a. In the Volume Report Definition dialog box, under Report Files, deselect max_temp-rfile.

b. Click OK to close the Volume Report Definition dialog box.

8. In a similar manner, disable writing the time-dependent voltage at the positive tab to a file.
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9. In the Solution Initialization task page, click Initialize to re-initialize the field variables.

10. Simulate the battery pulse discharge by changing the battery operating conditions each time after running
the calculation for five minutes.

a. In the Run Calculation task page, set Number of Time Steps to 10 and click Calculate.

b. Once the calculation is complete, set C-Rate to 0 and run the calculation for 10 more time steps.

c. Continue the simulation by alternating the value of C-Rate between 1 C and 0 C until, until the battery
is fully discharged.

Note

Instead of doing this manually, you can use the Using Profile option in the MSMD
Battery Model dialog box and load a profile file with specified C-rate fluctuations to
drive the whole process. For more information about the usage of a profile file, refer
to Specifying Battery Model Options in the ANSYS Fluent Advanced Add-On Modules..

The battery pulse discharge is summarized in Figure 24.14: Battery Pulse Discharge (p. 992).

Figure 24.14:  Battery Pulse Discharge

24.4.7. Using the Reduced Order Method (ROM)

You will use the ntgk.cas.gz case file that you saved earlier to illustrate how to use the ROM for
time-efficient calculations. This section assumes that you are already familiar with the ANSYS Fluent
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battery model; only the steps related specifically to using the ROM for problem solution are discussed
here.

1. Read the NTGK model case file ntgk.cas.gz.

2. Initialize the problem.

3. In the Run Calculation task page, enter 3 for Number of Time Steps and click Calculate.

Click No in the Question dialog box when asked if you would like to append the new data to the
existing file, and then click OK in the Warning dialog box to overwrite the existing file.

4. Once the calculation is complete, enable the ROM.

Setup → Models → MSMD Battery Model Edit...

a. In the MSMD Battery Model dialog box, select Reduced Order Method.

b. Set Number of Sub-Steps/Time Step to 10.

5. Continue running your simulation from the direct method solution.

The solution of the simulation using the ROM is significantly faster than when using the direct
method without any changes in results.

24.4.8. External and Internal Short-Circuit Treatment

You will again use the ntgk.cas.gz case file that you saved earlier to illustrate how to treat external
and internal short-circuits in a battery simulation. It is assumed that the battery is experiencing external
and internal short-circuit simultaneously. This extreme case will be used to demonstrate the problem
setup and postprocessing in a short simulation. This section assumes that you are already familiar with
the ANSYS Fluent battery model, only the steps related to short simulation are emphasized here.

24.4.8.1. Setting up and Solving a Short-Circuit Problem

1. Read the NTGK model case file ntgk.cas.gz.

2. Set up the external electric short-circuit.

a. In the MSMD Battery Model dialog box, under the Model Options tab, in the Solution Options group
box, enable Specified Resistance.

b. For External Resistance, enter 0.5 Ohm and click OK.

3. Set up the internal electric short-circuit in the center of the battery cell.

a. Mark the short-circuit zone shown in Figure 24.15: Internal Short Circuit Region Marked for Patch-
ing (p. 994) using the region adaption feature.

Setting Up Domain → Adapt → Mark/Adapt Cells → Region...
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Figure 24.15:  Internal Short Circuit Region Marked for Patching

i. In the Region Adaption dialog box, enter the following values for Input Coordinates.

Z MaxZ MinY MaxY MinX MaxX Min

1-10.02-0.010.01-0.01

ii. Under Options, retain the default selection of Inside.

iii. Under Shapes, retain the default selection of Hex.

iv. Click Mark.

Fluent reports in the console that 12 cells were marked for refinement.

Extra

If you want to display the marked cells, perform the following steps:

A. In the Region Adaption dialog box, click Manage....

B. In the Manage Adaption Registers dialog box, click Options.

C. In the Adaption Display Option dialog box, under Options, enable Draw Mesh.

D. In the Mesh Display dialog box, ensure that Edges and Faces are enabled under
Options, and All is enabled under Edge Type, and click Close.

E. Ensure that Wireframe is enabled under Refine and click OK

F. Click Display.
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4. Initialize the field variables using the standard initialization method.

5. Patch the internal short circuit zone with the short resistance value.

Solving → Initialization → Patch...

a. In the Solution Initialization task page, click Patch.

b. In the Patch dialog box, select Short Circuit Resistance under Variable.

c. Select hexehedron-r0 under Registers to Patch.

d. For Value, enter 5.0e-7.

e. Click Patch and close the Patch dialog box.

6. Save the case file as ntgk_short_circuit.cas.gz.

7. Run the simulation for 5 seconds.

Solving → Run Calculation

a. Set Time Step Size to 1 second and No. of Time Steps to 5.

b. Click Calculate.

8. Save the case and data files (ntgk_short_circuit.cas.gz and ntgk_short_circuit.dat.gz).

24.4.8.2. Postprocessing

1. Compute the battery tab voltage .

Postprocessing → Reports → Surface Integrals...
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a. In the Surface Integrals dialog box, from the Report Type drop-down list, select Area-Weighted Av-
erage.

b. From the Field Variable drop-down lists, select User Defined Scalar... and Potential Phi+.

c. In the Surfaces filter, type t to display surface names that begin with "t" and select tab_p from the
selection list.

d. Click Compute.

The battery tab voltage of approximately 4.078 V is printed in the Area-Weighted Average field
and in the Fluent console.

2. Compute the battery tab current .

Postprocessing → Reports → Volume Integrals...
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a. In the Report Type group box, select Volume Integrals.

b. From the Field Variable drop-down lists, select User Defined Memory... and Volumetric Current
Source.

c. From the Cell Zones selection list, select e_zone.

d. Click Compute.

Fluent reports in the Total Volume Integral field and in the console that the total volume integral
for the volumetric current source is approximately 8.155 A.

The computed values of the battery tab current and voltage satisfy the tab boundary condition

.

3. Display the vector plot of current at the positive and negative current collectors.

Postprocessing → Graphics → Vectors → Edit...

a. In the Vectors dialog box, select current-density-jp from the Vectors of drop-down list.

b. Select User Defined Memory... and Magnitude of Current Density from the Color by drop-down
lists.

c. From the Surfaces selection list, select Wall.

The surfaces of the "wall" type are automatically selected in the Surfaces list.

d. Click Display.

e. In a similar manner, display the current for the negative current collector by selecting current-density-
jn from the Vectors of drop-down list.

The Figure 24.16: The Vector Plots of Current at the Positive and Negative Current Collectors (p. 998)
demonstrates the vector plots of electric current flow in the positive and negative current col-
lectors in the battery cell side by side. The plots clearly show that besides providing tab current,
short current flows form positive electrode to the negative electrode through the short area.
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Figure 24.16: The Vector Plots of Current at the Positive and Negative Current Collectors

f. Close the Vectors dialog box.

4. Display the contour plot of the temperature as you did previously.

Postprocessing → Graphics → Contours → Edit...
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a. In the Contours dialog box, under Options, enable Filled.

b. From the Contours of drop-down list, select Temperature... and Static Temperature.

c. From the Surface Types selection list, select wall.

d. Click Display and close the Contours dialog box.
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Figure 24.17:  Contour Plot of Temperature

Figure 24.17: Contour Plot of Temperature (p. 1000) shows a temperature hotspot in the internal
shorted area of the battery cell.

5. Check for different electric current flow rates in the manner described in step 2.

a. Generate volume integral reports for the field variables listed in the table below.

Reported ValueNotationField Variable

15.844 AVolumetric Short Current Source

23.999 AVolumetric ECHEM Current Source

b. Verify that the total produced electric current equals to the sum of tab and short current, that is
.
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6. Check for different types of heat generation rates.

a. As you did for the current source reports, generate reports for the field variables listed in the table below.

Reported ValueNotationField Variable

0.0339 WVolumetric Ohmic Source

1.092 WElectrochemistry Source

64.607 WShort-Circuit Heat Source

65.733 WTotal Heat Generation Source

b. Verify that the total heat generation rate is the sum of different contributions, that is
.

Note that, as battery's temperature increases, thermal runaway may occur. If thermal runaway starts,
some undesirable exothermic decomposition reactions will occur. For thermal runaway simulations, the
default electrochemistry model cannot be used. Short treatment can only capture the thermal ramp-up
process before the onset of thermal runaway.

24.5. Summary

In this tutorial, you studied how to solve a battery cell problem using the NTGK submodel with the
default settings. You then used the ROM to speed up the computation time of the battery model sim-
ulation. In addition, you learned how to use the MSMD model capability to treat external and internal
short-circuits.

For more information about using the Dual-Potential MSMD Battery model, see the Fluent Advanced
Add-On Modules documentation on the ANSYS Customer Portal (http://support.ansys.com/documenta-
tion).

24.6. Appendix

The battery cell cross-section is shown in the figure below.
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You can estimate the material properties for your battery cell using the following correlations:

• For density , heat capacity , and thermal conductivity :

where  is the effective property value of a material property (such as density, heat capacity, or

thermal conductivity), is the thickness. The subscripts , , and  refer to current collector, electrode,
and separator, respectively. The superscripts  and  refer to positive and negative, respectively.

• For electric conductivity :

The material properties are taken from Kim’s papers [2] and [1]. The computed material properties for
the battery cell presented in the tutorial are shown in the table below.

TotalZone

322101451215020 [um]

209289602500120015002700 [kg/m3]

678385700700700900 [J/kg-K]

18.2398515238 [W/m-K]

 = 1.19e66.33e710013.93.83e7 [s/m]

 = 9.83e5
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Chapter 25: Simulating a 1P3S Battery Pack Using the MSMD Battery
Model

This tutorial is divided into the following sections:
25.1. Introduction
25.2. Prerequisites
25.3. Problem Description
25.4. Setup and Solution
25.5. Summary

25.1. Introduction

This tutorial is used to show how to set up a battery pack (battery system connected in parallel/series
pattern) simulation in ANSYS Fluent. All the three submodels are available for a pack simulation.

This tutorial illustrates how to do the following:

• Load the Battery module add-on

• Set up a battery pack simulation using the NTGK battery submodel in ANSYS Fluent

• Define active, tab, and busbar conductive zones

• Define electric contacts for the contact surface and external connectors

• Define electric conductivity for the active material using the user-defined scalars

• Define electric conductivity for the passive material using the user-defined function

• Obtain the battery pack simulation results and perform postprocessing activities

Most problem setup procedures are similar to the single cell simulation. The differences in the problem
setup will be emphasized in this tutorial.

25.2. Prerequisites

This tutorial is written with the assumption that you have completed one or more of the introductory
tutorials found in this manual:

• Introduction to Using ANSYS Fluent in ANSYS Workbench: Fluid Flow and Heat Transfer in a Mixing El-
bow (p. 1)

• Parametric Analysis in ANSYS Workbench Using ANSYS Fluent (p. 73)

• Introduction to Using ANSYS Fluent: Fluid Flow and Heat Transfer in a Mixing Elbow (p. 121)

and that you are familiar with the ANSYS Fluent tree and ribbon structure. Some steps in the setup and
solution procedure will not be shown explicitly.
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25.3. Problem Description

This problem considers a small 1P3S battery pack, that is, the three battery cells connected in series. A
schematic of the problem is shown in Figure 25.1: Schematic of the Battery Pack Problem (p. 1006).

Figure 25.1:  Schematic of the Battery Pack Problem

The discharging process of the battery pack is occurring under constant power of 200 W. The nominal
cell capacity is 14.6 Ah.

You will create a material for the battery cells (an active material) and define the electric conductivity
for the active material using the user-defined scalars (UDS). You will create a material for busbars and
tabs (a passive material) and define the electric conductivity for the passive material using the provided
user-defined function (UDF). You will use the same material for busbars and tabs.

In this tutorial, you will use the NTGK battery submodel to simulate the discharging process under
constant power conditions.

25.4. Setup and Solution

The following sections describe the setup and solution steps for this tutorial:
25.4.1. Preparation
25.4.2. Reading and Scaling the Mesh
25.4.3. Loading the MSMD battery Add-on
25.4.4. Battery Model Setup
25.4.5. Postprocessing

25.4.1. Preparation

1. Set up a working folder on the computer you will be using.
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2. Go to the ANSYS Customer Portal, https://support.ansys.com/training.

Note

If you do not have a login, you can request one by clicking Customer Registration on
the log in page.

3. Enter the name of this tutorial into the search bar.

4. Narrow the results by using the filter on the left side of the page.

a. Click ANSYS Fluent under Product.

b. Click 18.0 under Version.

5. Select this tutorial from the list.

6. Click the battery_pack_R180.zip link to download the input files.

7. Unzip battery_pack_R180.zip.

The input file 1P3S_battery_pack.msh, 1P3S_battery_pack.cas, and 1P3S_bat-
tery_pack.dat can be found in the battery_pack folder created after unzipping the file.

8. Use Fluent Launcher to start the 3D version of ANSYS Fluent.

9. Enable Double Precision.

10. Ensure that the Display Mesh After Reading and Workbench Color Scheme options are enabled.

11. Select either Serial or Parallel under Processing Options. In this tutorial, Serial is selected for demon-
stration only.

25.4.2. Reading and Scaling the Mesh

1. Read the mesh file 1P3S_battery_pack.msh.

File → Read → Mesh...

When prompted, browse to the location of the 1P3S_battery_pack.msh and select the file.

Once you read in the mesh, it is displayed in the embedded graphics windows.

2. Check the mesh.

Setting Up Domain → Mesh → Check

3. Scale the mesh.

Setting Up Domain → Mesh → Scale

a. In the Scale Mesh dialog box, select Specify Scaling Factors in the Scaling group.

1007
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution

https://support.ansys.com/training


b. Enter 0.1 for X, Y and Z in the Scaling Factors group.

c. Click Scale and close the Scale Mesh dialog box.

4. Check the mesh.

Setting Up Domain → Mesh → Check

25.4.3. Loading the MSMD battery Add-on

1. To load the MSMD battery add-on into ANSYS Fluent, type the following in the console window:

define/models/addon-module 

A list of ANSYS Fluent add-on modules is displayed.

Fluent Addon Modules:
 0. none
 1. MHD Model
 2. Fiber Model
 3. Fuel Cell and Electrolysis Model
 4. SOFC Model with Unresolved Electrolyte
 5. Population Balance Model
 6. Adjoint Solver  
 7. Single-Potential Battery Model
 8. Dual-Potential MSMD Battery Model
 9. PEM Fuel Cell Model
10. Macroscopic Particle Model
Enter Module Number: [0] 8 

2. Enter 8 to load the MSMD battery itself.

During the loading process, a scheme library containing the graphical and text user interface, and
a library of user-defined functions (UDFs) containing a set of UDFs for the battery module are loaded
into ANSYS Fluent. Fluent reports the progress in the console.
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Once the MSMD battery add-on is loaded, MSMD Battery Model appears in the Model task page
and under the Models tree branch. The UDF library also becomes visible as a new entry in the UDF
Library Manager dialog box.

25.4.4. Battery Model Setup

The following sections describe the setup steps for this tutorial:
25.4.4.1. Specifying Solver and Models
25.4.4.2. Defining New Materials
25.4.4.3. Defining Cell Zone Conditions
25.4.4.4. Defining Boundary Conditions
25.4.4.5. Specifying Solution Settings
25.4.4.6. Obtaining Solution

25.4.4.1. Specifying Solver and Models

1. Enable a time-dependent calculation by selecting Transient in the Solver group of the Setting Up Physics
tab.

Setting Up Physics → Solver → Transient

2. To solve for the temperature field, enable the Energy equation (in the Models group).

Setting Up Physics → Models → Energy

3. Enable the battery model.

Setting Up Physics → Models → More → Dual Potential MSMD Battery Model

a. In the MSMD Battery Model dialog box, select Enable MSMD Battery Model.

The dialog box expands to display the battery model’s settings.
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Figure 25.2:  Model Options

b. Under the Model Options tab (Figure 25.2: Model Options (p. 1010)), configure the following battery
operation conditions:

i. Under E-Chemistry Models, enable NTGK Empirical Model.

ii. In the Electrical Parameters group, retain the default value of 14.6 Ah for Nominal Cell Capacity.

iii. Enable Specified System Power in the Solution Options group and set System Power to 200
W.

c. Under the Model Parameters tab, retain the default settings for Y and U coefficients. For details, see
the Fluent Advanced Add-On Modules documentation on the ANSYS Customer Portal (http://support.an-
sys.com/documentation).

d. Under the Conductive Zones tab (Figure 25.3: Conductive Zones (p. 1011)), configure the following set-
tings:
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Value or SelectionControl or ListGroup

cell_1Zone (s)Active Components

cell_2

cell_3

n_tabzone_1Zone (s)Tab Components

n_tabzone_2

n_tabzone_3

p_tabzone_1

p_tabzone_2

p_tabzone_3

bar1Zone (s)Busbar Components

bar2

Figure 25.3:  Conductive Zones

e. Under the Electric Contacts tab (Figure 25.4: Electric Contacts (p. 1012)), configure the contact surface
and external connector settings as follows:

Value or SelectionControl or ListGroup

tab_nNegative TapExternal Connectors

tab_pPositive Tap

1011
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



The corresponding current or voltage boundary condition will be applied to those boundaries
automatically.

Figure 25.4:  Electric Contacts

f. Click the Print Battery System Connection Information button.

ANSYS Fluent prints the battery connection information in the console window:

Battery Network Zone Information:
-------------------------------------
 Battery Serial 1 
   Parallel 1
        N-Tab  zone:  n_tabzone_1
        Active zone:  cell_1
        P-Tab  zone:  p_tabzone_1
 Battery Serial 2
   Parallel 1
       N-Tab  zone:  n_tabzone_2
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       Active zone:  cell_2
       P-Tab  zone:  p_tabzone_2
 Battery Serial 3
   Parallel 1
       N-Tab  zone:  n_tabzone_3
       Active zone:  cell_3
       P-Tab  zone:  p_tabzone_3
-----------------------------------
 Busbar zone 1: bar1
 Busbar zone 2: bar2

 Active zone list at  odd level: cell_1 cell_3
 Active zone list at even level: cell_2 

 Number of battery seriel =3; Number of parallel per serial=1
****************END OF BATTERY CONNECTION INFO**************

g. Verify that the connection information is correct. If an error message appears or if the connections are
not what you want, redefine the conductive zones in the Conductive Zones tab (Figure 25.3: Conductive
Zones (p. 1011)). Repeat this process until you confirm that the battery connections are set correctly.

Important

To set a valid connection, you must connect the negative tab to the positive tab
through conductive zones.

h. Click OK to close the MSMD Battery Model dialog box.

In the background, Fluent automatically hooks all the necessary UDFs for the problem.

25.4.4.2. Defining New Materials

Define the new e_material material for all the battery’s cells and busbar_material material for the battery
pack’s busbars and tabs.

Important

For the battery active material, you must define the electric conductivity via the UDS diffus-
ivity on a per-scalar basis. ANSYS Fluent will use these two UDS scalars to solve the differential
equations; for details, see the Fluent Advanced Add-On Modules documentation on the
ANSYS Customer Portal (http://support.ansys.com/documentation).

For the battery passive material(s), you must define the UDS diffusivity using a user-defined
function (UDF).

1. Create the electric material.

Setup → Materials → Solid → aluminum Edit...
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a. In the Create/Edit Materials dialog box, enter e_material for Name and e for Chemical Formula.

b. Set Thermal Conductivity to 20.

c. Under Properties, ensure that define-per-uds is selected from the UDS Diffusivity drop-down list
and click Edit... next to UDS Diffusivity.

d. In the UDS Diffusion Coefficients dialog box, set the constant value of 1.0 e6 for the both user-defined
scalars.

i. Select uds-0 in the User-Defined Scalar Diffusion list.

ii. Retain constant from the Coefficient drop-down list.

iii. Set 1.0 e6 [s/m] for Coefficient.
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iv. In a similar way, set uds-1 to 1.0 e6 and close the UDS Diffusion Coefficients dialog box.

Note

• The units for UDS Diffusivity are s/m, and cannot be modified.

• In this tutorial, the electric conductivities are the same for the two scalars UDS0 and
UDS1, so you will need to define only one material for all cell zones. If the electric
conductivities are different for positive and negative electrodes, you will need to define
two different materials, as described in the Fluent Advanced Add-On Modules docu-
mentation on the ANSYS Customer Portal (http://support.ansys.com/documentation).

v. In the Question dialog box, click No to retain aluminum and add the new material (e_material) to
the materials list.

e. Ensure that e_material (e) is selected from the Fluent Solid Materials drop-down list.

f. Click Change/Create.

Note

If the UDS Diffusion Coefficients are defined through the defined-per-uds option,
the Fluent solver does not use the value for Electrical Conductivity.

2. Create the busbar_material material for busbars and tabs by modifying e-material you have created in the
previous step.

Setup → Materials → Solid → e-material Edit...
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As stated in the problem description, you will use the same material for busbars and tabs.

Note

If the busbar and tab materials are different, you need to define the two different mater-
ials and assign them to the busbars and tabs, respectively.

The UDS Diffusivity for both busbar and tab materials must be defined through the UDF as described
below.

a. In the Create/Edit Materials dialog box, enter busbar_material for Name and bus for Chemical
Formula.

b. Under Properties, select user-defined from the UDS Diffusivity drop-down list.

c. In the User-Defined Functions dialog box that opens, verify that battery_e_cond::msmdbatt is selected
and click OK.

d. In the Question dialog box, click No to retain e-material and add the new busbar_material material
to the materials list.

Fluent hooks the battery_e_cond::msmdbatt UDF to the busbar material.

e. Ensure that busbar_material (bus) is selected from the Fluent Solid Materials drop-down list.

f. Set Thermal Conductivity to 20.

g. Retain the default value of 3.541 e7 [1/ohm-m] for Electrical Conductivity.

h. Click Change/Create.

i. Close the Create/Edit Materials dialog box.

25.4.4.3. Defining Cell Zone Conditions

Assign e_material to all the cell zones and busbar_material to all the tabs and busbars.

1. Assign e_material to the cell_1 cell zone.
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Setup → Cell Zone Conditions → cell_1 → Edit...

a. In the Solid dialog box, select e_material from the Material Name drop-down list.

b. Click OK.

2. Copy the cell zone condition for the cell_1 zone to the cell_2 and cell_3 cell zones.

Setup → Cell Zone Conditions → cell_1 → Copy...

a. In the Copy Conditions dialog box, select cell_1 in the From Cell Zone list.

b. In the To Cell Zones list, select cell_2 and cell_3.

c. Click Copy.

d. Click OK in the Question dialog box to copy the cell zone conditions and close the Copy Conditions
dialog box.

3. In a similar manner, assign busbar_material to all the tabs and busbars cell zones.

25.4.4.4. Defining Boundary Conditions

Define the thermal boundary conditions for all walls for the cells, busbars, and tabs. The boundary
conditions for the two UDSs have been set automatically when you defined the cell zone conditions.

1. Set the convection boundary condition for wall-cell_1.

Setting Up Physics → Zones → Boundaries

a. In the Boundary Conditions task page, double-click wall-cell_1.

b. In the Wall dialog box, under the Thermal tab, configure the following settings:

i. Under Thermal Conditions, enable Convention.

ii. Set Heat Transfer Coefficient to 5 [w/m2K].

iii. Set Free Stream Temperature to 300 [K].

iv. Click OK to close the Wall dialog box.

2. Copy the boundary conditions for wall-cell_1 to wall-cell_2,wall-cell_3 and all the tab
and busbar wall zones (a boundary zones that have names starting with the "wall" string and containing
the "bar" or "tabzone" string).

Setup → Boudnary Conditions → wall-cell_1 → Copy...
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25.4.4.5. Specifying Solution Settings

1. Turn off the flow equation.

Solving → Controls → Equations...

a. In the Equations dialog box, deselect Flow from the Equation selection list.

b. Click OK.

2. Remove the convergence criteria to ensure that automatic convergence checking does not occur.

Solving → Reports → Residuals...

a. In the Residual Monitors dialog box, select none from the Convergence Criterion drop-down list.

b. Click OK.

3. Create a surface report definition for the voltage at the positive tab.

Solving → Reports → Definitions → New → Surface Report → Area-Weighted Average
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a. In the Surface Report Definition dialog box, enter surf-mon-1 for Name.

b. Select User Defined Scalars... and Potential Phi+ from the Field Variable drop-down lists.

c. From the Surfaces selection list, select tab_p.

d. In the Create group box, enable Report Plot and Print to Console.

e. Click OK to save the surface report definition and close the Surface Report Definition dialog box.

f. Modify the attributes of the plot axes.

Solution → Monitors → Report Plots → surf-mon-1-rplot Edit...

i. In the Edit Report Plot dialog box, under the Plot Window group box, click the Axes... button to
open the Axes dialog box.

ii. Select the X axis and set Precision to 0.
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iii. Click Apply.

iv. Select the Y axis and set Precision to 2.

v. Set Precision to 2.

vi. Click Apply and close the Axes dialog box.

Note

You must click Apply to save the modified settings for each axis.

vii. Click OK to close the Edit Report Plot dialog box.

g. Ensure that time-step is selected from the Get Data Every drop-down list.

h. Click OK.

4. Create a volume report definition to monitor the maximum temperature in the domain.

Solving → Reports → Definitions → New → Volume Report → Max...
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a. In the Volume Report Definition dialog box, enter vol-mon-1 for Name.

b. Select Temperature... and Static Temperature from the Field Variable drop-down lists.

c. From the Cell Zones selection list, select all zones.

d. In the Create group box, enable Report Plot and Print to Console.

e. Click OK to save the volume report definition settings and close the Volume Report Definition dialog
box.

f. Modify the attributes of the plot axes.

Solution → Monitors → Report Plots → vol-mon-1-rplot Edit...

i. In the Edit Report Plot dialog box, under the Plot Window group box, click the Axes... button to
open the Axes dialog box.
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ii. Select the X axis and set Precision to 0.

iii. Click Apply.

iv. Select the Y axis and set Precision to 2.

v. Click Apply and close the Axes dialog box.

vi. Ensure that time-step is selected from the Get Data Every drop-down list.

vii. Click OK to close the Edit Report Plot dialog box.

5. Save the case file.

File → Write → Case...

25.4.4.6. Obtaining Solution

1. Initialize the field variables using the Standard Initialization method.

Solution → Solution Initialization

a. Retain the selection of Standard from the Initialization Methods group box.

b. Click Initialize.

You do not need to modify the Initial Values in the Solution Initialization task page, because
these values are not used for initialization. The ANSYS Fluent solver automatically computes the
initial condition for UDS0 and UDS1.

2. Run the simulation.

Solving → Run Calculation

a. Set Time Step Size to 30 seconds and No. of Time Steps to 50.

b. Click Calculate and run the simulation up to 1500 seconds.

The residual plot, the history of the voltage at the positive tap and the history of the maximum
temperature in the domain are shown in Figure 25.5: Residual History of the Simulation (p. 1023),
Figure 25.6: Surface Report Plot of Discharge Curve at 200W (p. 1023), and Figure 25.7: Volume
Report Plot of Maximum Temperature in the Domain (p. 1024), respectively.
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Figure 25.5:  Residual History of the Simulation

Figure 25.6:  Surface Report Plot of Discharge Curve at 200W
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Figure 25.7: Volume Report Plot of Maximum Temperature in the Domain

25.4.5. Postprocessing

In this section, postprocessing options for the MSMD battery model solution are presented.

1. Display the vector plot of current density.

Postprocessing → Graphics → Vectors → Edit...
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a. In the Vectors dialog box, select current-density-j from the Vectors of drop-down list.

b. Select User Defined Memory... and Magnitude of Current Density from the Color by drop-down
list.

c. Click the Toggle Tree View button next to the Surfaces filter and from the drop-down list, select
Surface Type (under Group By).

d. From the Surfaces selection list, select Wall.

The surfaces of the "wall" type are automatically selected in the Surfaces list.

e. In the Options group, enable Draw Mesh and set the mesh display options as desired.

f. Set Scale to 0.003.

g. Click Vector Options....

i. In the Vector Options dialog box, enable Fixed Length.

1025
Release 18.0 - © SAS IP, Inc. All rights reserved. - Contains proprietary and confidential information

of ANSYS, Inc. and its subsidiaries and affiliates.

Setup and Solution



All vectors in your plot will be displayed with the same lengths.

ii. Click Apply and close the Vector Options dialog box.

h. Click Display and close the Contours dialog box.
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Figure 25.8: Vector Plot of Current Density

Note

Use the Headlight and Lighting display options under the Viewing ribbon tab to
manipulate the graphics display.

2. Display the contour plot of the temperature.

Postprocessing → Graphics → Contours → Edit...
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a. In the Contours dialog box, in the Options group box, enable Filled.

b. From the Contours of drop-down list, select Temperature... and Static Temperature.

c. Click the Toggle Tree View button next to the Surfaces filter and from the drop-down list, select
Surface Type (under Group By).

d. From the Surfaces selection list, select Wall.

e. Click Display and close the Contours dialog box.
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Figure 25.9:  Contour Plot of Temperature

3. In a similar manner, display the contour of Ohmic heat source.

Postprocessing → Graphics → Contours → Edit...
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a. From the Contours of drop-down list, select User Defined Memory... and Volumetric Ohmic Source.

b. Click Display.
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Figure 25.10:  Ohmic Heat Generation Rate

4. In a similar manner, display the contour of the total heat source.

Postprocessing → Graphics → Contours → Edit...
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a. From the Contours of drop-down list, select User Defined Memory... and Total Heat Generation
Source.

b. Click Display.
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Figure 25.11: Total Heat Generation Rate

25.5. Summary

This tutorial has demonstrated the use of the MSMD battery add-on to perform electrochemical and
heat transfer simulations for battery packs. You have learned how to set up and solve the problem for
the battery pack of the 1P3S configuration using the NTGK Battery submodel. You have also learned
some of the postprocessing capabilities available in the MSMD battery model.

As an exercise, you can obtain solutions using the Equivalent Circuit Model and Newman P2D Model.
For details, see the Fluent Advanced Add-On Modules documentation on the ANSYS Customer Portal
(http://support.ansys.com/documentation).
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